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Abstract 
 
The primary objective of the project titled “Demonstration of an Advanced Integrated Control 
System for Simultaneous Emissions Reduction” was to demonstrate at proof-of-concept scale the 
use of an online software package, the “Plant Environmental and Cost Optimization System” 
(PECOS), to optimize the operation of coal- fired power plants by economically controlling all 
emissions simultaneously. It combines physical models, neural networks, and fuzzy logic control 
to provide both optimal least-cost boiler setpoints to the boiler operators in the control room, as 
well as optimal coal blending recommendations designed to reduce fuel costs and fuel-related 
derates. The goal of the project was to demonstrate that use of PECOS1 would enable coal- fired 
power plants to make more economic use of U.S. coals while reducing emissions.  
 
The integrated approach taken in PECOS balances the complex and often competing 
interrelationships between factors such as coal quality, coal blending, permissible NOx and SO2 
limits, stack gas opacity, CO emissions, and plant heat rate from an economic point of view to 
reduce overall costs. PECOS carries out plant-wide optimization, taking all of the above factors 
into account, and provides plant operators with least-cost setpoints for controllable variables. 
PECOS consists of a group of core modules along with two main solution modules, termed 
Coalogic and Optifire. 
 
Two plant sites with different designs and different concerns were selected to allow the 
demonstration testing to cover a wide range of the highly varied environmental and operational 
issues represented among coal- fired power stations: TransAlta’s Keephills Plant in Alberta, 
Canada, and Dairyland Power’s Genoa Station in Wisconsin.  
 
Installation of Coalogic at Keephills was designed to effectively manage and blend the five coal 
seams used by the plant such that the seams identified to produce high opacity are always mixed 
with appropriate amounts of low opacity-producing seams, thereby significantly reducing 
opacity derates. The use of Coalogic reduced annual opacity-related derates from a high of 
70,000 MWh in 1995 to below 10,000 MWh. Because of this, TransAlta was able to save about 
$2,000,000 in the first year of Coalogic use alone. These savings continue and are the reason for 
the success of Coalogic and its acceptance at the plant. 
 
At Genoa, the plant is receiving two different coal types in the yard, one a low-cost, and low-
heating-value Powder River Basin (PRB) coal, the other a higher-cost, higher-heating-value 
Illinois coal. The plant used the same blend of these two coals for all operating conditions during 
the week, which was designed to have a high enough heating value to generate the maximum 
predicted power for the coming week. At lower loads, which typically occur on weeknights and 
weekends, the mills were capable of using a lower heating value coal blend without derating 
allowing for the potential for saving fuel costs by using more of the cheaper PRB coal. By properly 

                                                 
1 The software designations of Plant Environmental and Cost Optimization System (PECOS), Coalogic, and Optifire 
were originally referenced as Supervisory Optimization and Control System (SOCS), Coal Blend Automation 
System (CBAS), and Boiler and NOx Control System (BANCS) respectively during the early developmental phases 
of the project. The terms PECOS, Coalogic, and Optifire are used throughout this report to reflect the nomenclature 
of the commercial products that were developed within this program. 



matching coal quality to load, possible through the use of Coalogic, the project participants had 
estimated potential annual fuel cost savings of the order of $600,000. 
 
Optifire was also installed at both plants. Optifire was designed to provide plant operators with 
optimal values for all control setpoints such that the operating costs are minimized while 
simultaneously maintaining all- important operating constraints—including NOx emission 
limits—within prescribed limits. In both cases, detailed physical and neural models were 
successfully developed producing simulation capable of predicting heat rate and performance data 
within 1% accuracy. At Keephills, though the plant does not use Optifire to change control 
setpoints, primarily because concerns about NOx emissions have significantly eased as a result 
of capital improvements in the boiler and changing coal quality, the product is used by personnel 
to provide accurate, real-time heat rate and cost reporting. 
 
Based on this demonstration, PECOS has been successfully launched in the marketplace as two 
distinct but synergistic products: Coalogic, which has been installed at 30 boilers in North 
America, and Optifire, which has been installed at Duke Energy’s Marshall Station and is 
undergoing evaluation. 
 
Primary funding for this project was provided by the Department of Energy’s National Energy 
Technology Laboratory (DOE NETL), DOE Contract No. DE-AC22-95PC95254. Additional 
funding and/or in-kind cost sharing was provided by Praxis Engineers, the Electric Power 
Research Institute (EPRI), and the host participants, TransAlta Utilities and Dairyland Power 
Cooperative. Initial funding for support in developing the PECOS concept was received from 
DOE’s Small Business Initiative Research (SBIR) Program, DOE Grant No. DE-FG03-
93ER81495. 
 
Keywords: coal blending, coal yard management, boiler optimization, NOx control, SO2 control, 
opacity control, power plant control systems 
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EXECUTIVE SUMMARY 

The primary goal of the project “Demonstration of an Advanced Integrated Control System for 
Simultaneous Emissions Reduction” was to demonstrate the use of an online software package, 
“Plant Environmental and Cost Optimization System” (PECOS2) to optimize the performance of 
two coal- fired power plants in terms of coal quality control, boiler efficiency, and emissions 
compliance. The basic assumption in PECOS is that to effectively optimize the performance of a 
power plant from both economic and environmental perspectives, all aspects of its operation 
must be considered simultaneously. Accordingly, PECOS takes into consideration all areas of 
plant operation, i.e., coal quality, boiler parameters, emissions, steam cycle, and quality of ash 
for disposal or sale. However, at any given site only a subset of these parameters needs to be 
used depending upon their relevance to the site. The purpose of the subject project was to 
integrate all the modules of PECOS, customize it for two sites, and demons trate its use in the 
field. 
 
PECOS has two main solution modules, termed Coalogic and Optifire. Coalogic tracks and 
predicts the flow of coal from its receipt in the yard to the burners, then uses this information to 
recommend the best way to load coal in order to reduce fuel costs, reduce fuel-related derates—
often those associated with emissions—and improve boiler performance. The main goal of 
Coalogic is to assure the delivery of the right coal to the boilers at the right time. The assumption 
is that when a power plant has different types of coals available, it should always use the most 
economic coal blend while meeting all emissions and operational constraints and taking into 
consideration the conditions in the boiler. For example, the plant can use cheaper coals at lower 
loads and more expensive coals at higher loads. Similarly, the boiler feed can be blended to 
avoid derates associated with certain coals under certain conditions. Coalogic calculates the coal 
blend recommendations that meet projected conditions by modeling the coal flow through the 
coal yard to the boiler, including the stockpiles, conveyors, gates, crushers, silos/bunkers and 
other equipment. The resulting information is used to make coal yard operation 
recommendations to meet the projected coal quality needs of the boiler. 
 
The other key solution module of PECOS is Optifire. Its main goal is to operate the boiler at 
least cost at all times while simultaneously maintaining all- important operating constraints—
including NOx emission limits—within prescribed limits. It advises the plant operators on the 
optimal values for all controllable setpoints in order to achieve this goal. 
 
Primary funding for this project was provided by the Department of Energy’s National Energy 
Technology Laboratory (DOE NETL), DOE Contract No. DE-AC22-95PC95254. Additional 
funding and/or in-kind cost sharing was provided by Praxis Engineers, the Electric Power 
Research Institute (EPRI), and the host participants, TransAlta Utilities and Dairyland Power 
Cooperative. Initial funding for support in developing the PECOS concept was received from 

                                                 
2 The software designations of Plant Environmental and Cost Optimization System (PECOS), Coalogic, and Optifire 
were originally referenced as Supervisory Optimization and Control System (SOCS), Coal Blend Automation 
System (CBAS), and Boiler and NOx Control System (BANCS) respectively during the early developmental phases 
of the project. The terms PECOS, Coalogic, and Optifire are used throughout this report to reflect the nomenclature 
of the commercial products that were developed within this program. 
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DOE’s Small Business Initiative Research (SBIR) Program, DOE Grant No. DE-FG03-
93ER81495. 
 
The project team consisted of Praxis Engineers as the primary contractor, with significant 
participation from the personnel at the two host demonstration sites. 

Project Achievements 
Praxis Engineers completed the development and demonstration of PECOS at the Keephills 
demonstration site. Both of the main solution modules, Coalogic and Optifire, were successfully 
installed and run online at TransAlta’s Keephills station.  
 
Both TransAlta and Dairyland provided a large amount of time at the operator and management 
levels, provided plant data, and participated in project meetings. Their assistance and advice was 
a key factor in the success of the project. It was also crucial in making PECOS into a marketable 
product. 
 
The Keephills plant, located outside of Edmonton in Canada, has 2 identical units producing a 
total maximum output of 800 MW gross. The Combustion Engineering boilers are tangentially 
fired each with a rated capacity of 1,156,000 kg/hr of steam. Air is supplied to the boilers by 
both forced draft and primary air fans that are preheated through a unique trisector regenerative 
air heater. On the backend, both units have cold-side electro static precipitators. Neither unit is 
fitted with a scrubber, as sulfur emissions are not a concern at the site. Five Raymond bowl mills 
that are supplied coal from cylindrical 8-hour silos feed the boilers. 
 
At Keephills, Coalogic’s main function is to get the right coal to the burners at the right time. It 
does so by tracking all coals in the system from their entry into the yard, through the storage 
stockpiles and mill silos and on into the boiler. It makes blending recommendations such that the 
coal blend addresses the primary economic issue associated with coal quality at the plant—
eliminating costly opacity derates. 
 
Keephills is a mine mouth plant that uses five different seams, each with a different quality. One 
of the seams from the mine (the top seam) was identified as the culprit in causing the opacity 
problems due to its poor ash quality. This was due principally to the low sodium content in the 
ash of this seam, which acts to degrade precipitator collection efficiency. 
 
This seam represents over 70% of the total coal used at the plant, while the remaining 30% 
comes from bottom seams that do not cause opacity-related problems. By blending the top seam 
with an appropriate amount of bottom seam coal from the mine, which varies with operational 
conditions, while still using the same amount of top seam coal, Coalogic effectively eliminated 
the derates, reducing them from an annual level of 70,000 MWh to less than 10,000 MWh. 
Because of the reduced derates, TransAlta was able to save about $2,000,000 in the first year of 
Coalogic use alone, with continuing savings each year.  
 
After the software was installed, key personnel at the plant were provided with training in its use. 
In addition, a User’s Manual was developed for the Coalogic installation at Keephills, which is 
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available to the plant personnel both in hard copy and as a Windows online help application. The 
hard copy version of the Coalogic manual is attached as Appendix A. 
 
Since the completion of the project, Keephills has continued to use Coalogic. As testimony to the 
high regard that Coalogic earned at Keephills, TransAlta subsequently procured Coalogic for use 
at its Centralia Station in Washington State.  
 
At Keephills, Optifire was designed to provide plant operators with optimal values for all control 
setpoints such that the operating costs are minimized while simultaneously maintaining all-
important operating constraints—including NOx emission limits—within prescribed limits. 
Detailed physical and neural models were successfully developed producing on-line simulation 
capable of predicting heat rate and performance data within 1% accuracy. Though the plant does 
not use Optifire to change control setpoints, primarily because concerns about NOx emissions 
have significantly eased as a result of capital improvements in the boiler and changing coal 
quality, the product is used by personnel to provide accurate, real-time heat rate and cost 
reporting. 
 
After the Optifire software was installed, key personnel at the plant were provided with training 
in its use. A User’s Manual was developed for the Optifire installation at Keephills, which is 
available to the plant personnel both in hard copy and as a Windows online help application. The 
hard copy version of the Optifire manual is attached as Appendix B. 
 
EPRI selected Dairyland Power Cooperative to participate in the project by making their Genoa 
plant available as a demonstration site for the project. The Genoa plant, located just outside 
LaCrosse, Wisconsin, has a single unit producing a total maximum output of 350 MW gross. The 
Combustion Engineering super critical, double reheat boiler is tangentially fired with a rated 
capacity of 2,354,000 lb/hr of steam. Air is supplied to the boiler by forced draft fans that are 
preheated through a standard bisector regenerative air heater. The furnace has state of the art low 
NOx burners complete with close coupled and separated overfire air. On the backend, the unit 
has a hot-side electro static precipitator. The unit does not have a scrubber, as sulfur emissions 
are not a concern at the site. Four Raymond bowl mills that are supplied coal from cylindrical 8-
hour silos feed the boiler. 
 
The plant uses two coal types, and Illinois No. 6 coal and a Powder River Basin (PRB) coal. The 
Illinois coal has a significantly higher energy content and lower moisture than the PRB, but is 
more expensive. At full load, the coal blend must have at least 35% of the Illinois coal to avoid 
mill-related derates. At lower loads, more of the cheaper PRB can be used as long as slagging 
issues are curtailed, primarily by increased soot blowing. The goal of the plant was to use as 
much of the PRB as possible to reduce fuel costs without causing derates. By properly matching 
coal quality to load, possible through the use of Coalogic, the project participants had estimated 
potential annual fuel cost savings of the order of $600,000. Praxis Engineers performed silo flow 
tests on the bunkers and installed a PECOS server machine at the plant. 
 
The core part of Optifire was also developed for Genoa. Considerable modeling work was done to 
produce performance models capable of accurately predicting key parameters such as heat rate 
within 1% accuracy for the unique boiler system and its inherent NOx control complexity. 
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Unfortunately, since the plant was in the process of upgrading their control system and this 
upgrade project was repeatedly postponed, the plant was not made available to the project until 
early in 1998, after a delay of nearly 18 months. This delay contributed to significant time and 
cost overruns on the project. By the time Dairyland was willing to allow work to proceed, the 
project’s schedule and budget could not accommodate the impact of the delay. Hence the 
installation of PECOS at Dairyland Power could not be completed. 

Current Status 
As a result of this project, Praxis Engineers developed both of the main PECOS solution modules 
into successful products: Coalogic and Optifire. Both of these products have been sold to other 
power plants. 
 
As of July 2001, Coalogic has been installed at 30 boilers throughout North America, 24 of 
which were installed in the last eighteen months. These sales represent 6% of the total 
deregulated coal- fired utility market in North America. Details about each Coalogic installation 
are provided in Table 1. The savings numbers indicated in the table were derived from reduced 
fuel- related derates at mine mouth plants (Keephills), from reduced fuel-related derates and fuel 
costs at plants that use both local and purchased coals (Centralia), and primarily from reduced 
fuel costs at plants that purchase all of their coals from outside sources (Marshall and the plants 
at the “Unnamed Utility”). Details about user experience and the benefits Coalogic provides are 
given in Section 5, Conclusions and Commercial Applications. 
 

Table 1. Coalogic Installations 

Utility Plant Location Units MW Annual Savings 
Duke Energy Marshall North Carolina, US 4 400 (2), 600 (2) $2 million 
TransAlta Keephills Alberta, Canada 2 400 (2) $2 million 
TransAlta Centralia  Washington, US 2 650 (2) $2 million 
GRE Coal Creek North Dakota, US 2 300 (2) --- 
Unnamed Utility Plant A Eastern US 7 150 (4), 650 (2), 300 $10 million 
Unnamed Utility Plant B Eastern US 3 900 (3) $5 million 
Unnamed Utility Plant C Eastern US 5 150 (3), 250, 650 $7 million 
Unnamed Utility Plant D Eastern US 3 150 (2), 250 $3 million 
Unnamed Utility Plant E Eastern US 2 200 (2) $2 million 

 
Note: The “Unnamed Utility,” where Coalogic is installed system-wide, cannot be identified 
because they brokered a Confidentiality Agreement due to the highly competitive nature of the 
Eastern US power market and the advantage Coalogic brings in reducing costs. 
 
Optifire has been sold to and installed at only one other power plant—Duke Energy’s Marshall 
Steam Station (where Coalogic is also installed). Currently it is being put through assessment 
tests at the plant. Optifire sales have been less rapid than those of Coalogic for two  reasons: 1) it 
faces greater competition from other boiler optimization packages while Coalogic has no 
competition, and 2) the savings it produces are not as high as those produced by Coalogic since 
there is generally less room for improvement on heat rate than on coal costs or derate avoidance. 
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Optifire still has significant marketability because it deals with two issues particularly relevant to 
utilities in regulated states competing in the face of imposing and expensive-to-meet 
environmental limits – NOx reduction and efficiency improvement. Based on computational 
assessments at the Marshall installation, Optifire has the capability of improving heat rate by the 
order of 50-100 Btus, which can significantly reduce operating costs in a competitive 
marketplace. Optifire can also simultaneously reduce NOx emissions on the order of 10-15%, 
which for some plants, particularly those using PRB coals, could be enough to meet NOx 
regulations without resorting to expensive post processing technology like catalysis. 
 
Praxis Engineers has recently widened the marketing campaign for both products to Asia and 
Australia, and has been requested to present three written proposals for Coalogic in these regions 
within the last four months. We anticipate that we will continue to sell both products in the 
future.
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1.0 INTRODUCTION 

1.1 Project Outline 
The objective of the project titled “Demonstration of an Advanced Integrated Control System for 
Simultaneous Emissions Reduction” was to demonstrate the use of an online software package, 
“Plant Environmental and Cost Optimization System” (PECOS3) at two coal- fired power plants 
to optimize their performance in terms of coal quality control, boiler efficiency, and emissions 
compliance. The basic assumption in PECOS is that to effectively optimize the performance of a 
power plant from both economic and environmental perspectives, all aspects of its operation 
must be considered simultaneously. Accordingly, PECOS takes into consideration all areas of 
plant operation, i.e., coal quality, boiler parameters, emissions, steam cycle, and quality of ash 
for disposal or sale. However, at any given site only a subset of these parameters needs to be 
used depending upon their relevance to the site. The purpose of the subject project was to 
integrate all the modules of PECOS, customize it for two sites, and demonstrate its use in the 
field.  
 
PECOS has two main solution modules, termed Coalogic and Optifire.  
 
Coalogic tracks and predicts the flow of coal from its receipt in the yard to the burners, then uses 
this information to recommend the best way to load coal in order to reduce fuel costs, reduce 
fuel- related derates, and improve boiler performance. The main goal of Coalogic is to assure the 
delivery of the right coal to the boilers at the right time. The assumption is that when a power 
plant has available different types of coals, it should always use the most economic coal blend 
while meeting all operational constraints and taking into consideration the conditions in the 
boiler. For example, the plant can use cheaper coals at lower loads and more expensive coals at 
higher loads. Similarly, the boiler feed can be blended to avoid derates associated with certain 
coals under certain conditions. Coalogic calculates the coal blend recommendations that meet 
projected conditions by modeling the coal flow through the coal yard to the boiler, including the 
stockpiles, conveyors, gates, crushers, silos/bunkers and other equipment. The resulting 
information is used to make coal yard operation recommendations to meet the projected coal 
quality needs of the boiler. 
 
Optifire is an online advisory software module, which recommends boiler-side control setpoints 
designed to reduce costs to operators in real time. Optifire determines these setpoints by 
automatically assessing the many economic trade-offs inherent in the system while making sure 
that important safety, environmental (in particular NOx) and operational constraints are not 
violated. Optifire combines both physical and neural models to simulate plant performance. It 
models virtually all of the equipment and systems associated with the plant and automatically 
collects data from the existing plant data highway to be used in its models. Optifire uses online 
data to validate and adapt its models to provide accurate plant modeling even when plant 

                                                 
3 The software designations of Plant Environmental and Cost Optimization System (PECOS), Coalogic, and Optifire 
were originally referenced as Supervisory Optimization and Control System (SOCS), Coal Blend Automation 
System (CBAS), and Boiler and NOx Control System (BANCS) respectively during the early developmental phases 
of the project. The terms PECOS, Coalogic, and Optifire are used throughout this report to reflect the nomenclature 
of the commercial products that were developed within this program. 
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conditions are changing with time. Based on these models, Optifire uses a powerful optimizer to 
calculate least-cost setpoints within the specified operational constraints.  

1.2 Project Objectives 
The primary objective of the subject project was to develop and implement the software online 
and determine if it was capable of successfully optimizing the performance of a coal- fired power 
plant in terms of coal quality control, boiler efficiency, and emissions.  
 
The scope of work consisted of evaluating the performance of PECOS in proof-of-concept 
testing at two utility sites while resolving uncertainties about its capabilities, limitations, and 
costs of implementation. The two utility sites selected for this demonstration represent a diverse 
array of subsystems and issues in optimization of operations. The major portion of the work was 
carried out at TransAlta Utilities' Keephills Power Plant in Alberta, Canada. At this plant the key 
issues involve management of coal quality to reduce fuel-related derates, especially those caused 
by opacity, by properly blending coals, improving boiler control and performance, and providing 
accurate real-time performance and cost calculations, in particular heat rate. The second host site 
was Dairyland Power Cooperative's Genoa Power Station in Genoa, Wisconsin, where the goals 
were to blend coals to match Btu content to operating load in the most economic way, while 
improving boiler performance, including controlling NOx emissions. 

1.3 Product Description and Background 
PECOS represents an umbrella software structure that supports the computational solution 
modules that are attached to it. PECOS contains the core modules that handle obtaining the real-
time online data from a variety of plant data sources, passing required data to the solution 
modules, recording the data obtained from the plant sources as well as the data calculated by the 
solution modules, and interfacing through the Local Area Network (LAN) with the client 
computers. 

1.3.1 PECOS Architecture  

The general architecture of PECOS is illustrated in Figure 1. The system comprises several basic 
components residing on an in-house host computer (the server). The PECOS clients, residing on 
workstations at the plant and at various locations within the utility, communicate with the 
PECOS server across the LAN or Wide Area Network (WAN) using TCP/IP or some other 
protocol. The basic components are listed below: 
 
• PECOS Server/Host Computer (hardware) 
• PECOS GUI Client s 
• Event Manager 
• Automation Manager 
• Database 
• Data Acquisition Modules 
• Data Validation Module 
• Data Translation Module 
• Data Archive Module 
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• PECOS Admin Tool. 
 
In addition to these core modules, solution modules can be added to the framework, including: 
 
• Coalogic – A solution module that manages the coal yard by tracking and predicting the flow 

of coal from its receipt in the yard to the burners, then uses this information to recommend 
the best way to load coal. 

• Optifire  – A solution module that manages the boiler by modeling all boiler and steam cycle 
operations, then uses this information to recommend optimal control setpoint values designed 
to operate the boiler at least cost while simultaneously maintaining all important operating 
constraints—including NOx emission limits—within prescribed limits.  

 
Each of the basic components and solution modules is described in greater detail below. 

Figure 1. PECOS Architecture 

PECOS Server/Host Computer 
The heart of the system is the PECOS server or host computer. It is where most of the software 
modules reside and is the center of activity for client interactions. It is a state of the art IBM 
compatible personal computer that can run server software (i.e. Windows NT Server, Microsoft 
Structured Query Language (SQL) Server). The exact specifications for the PECOS server are 
dependent on the number of PECOS modules installed, the brand of computer accepted at the 
plant (e.g., Compaq or Dell), and are continually updated as more powerful PCs become cost 
effective and the older models are no longer available. 
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The operating system is Microsoft Windows NT Server. Microsoft SQL Server is used as the 
database, although this is not a requirement. With minimal adjustments to the PECOS software, 
SQL Server can be replaced by any Open Database Connectivity (ODBC) capable database. A 
tape drive or some other backup device is included, so that a weekly backup can be made of the 
archived data. A UPS is highly recommended, although many plants have UPS systems for the 
entire computer room and a dedicated UPS is not necessary. Praxis Engineers requires remote 
access to the PECOS Server in order to do maintenance and upgrades. This is usually handled 
through a dial-up connection to the utility network, but if this is not available, a modem and 
phone line are required. 

PECOS Client (Graphical User Interface) 
The PECOS graphical user interface (GUI) communicates with the PECOS server, displays 
information, and receives manual inputs from the user. It is the customer’s interface with PECOS 
and presents to the user online measured data, calculated data and control recommendations that 
should be enacted for optimal plant operations. 
 
This PECOS client module is seated on the user's computer and is linked to the PECOS server 
via a LAN or WAN connection using remote Object Linking and Embedding (OLE) automation. 
As illustrated in the figures below, the GUI is designed with standard Windows based 
functionality, and look and feel, with navigational properties similar to Microsoft ExplorerTM. 
Figure 2 displays a screen capture from the Keephills Coalogic GUI, and Figure 3 shows a 
screen capture from the Keephills Optifire GUI. Both Coalogic and Optifire screens can be 
accessed from the same GUI. Details about each GUI are provided in the software manuals for 
Coalogic and Optifire, in Appendix A and B respectively. 
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Figure 2. Example Screen Capture from Keephills Coalogic GUI 

 
Figure 3. Example Screen Capture from Keephills Optifire GUI 
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PECOS Event Manager 
The Event Manager is the core of the PECOS software and is essentially the traffic control 
officer for the PECOS system. The Event Manager is the first PECOS module to start up and  the 
last one to shut down. The other PECOS modules can be turned on and off independently, but 
the Event Manager must always be running. Its primary functions are to: 
 
• Route messages to all modules 
• Initialize data points upon start up 
• Initialize specified data points to the value used in the previous session (provide data 

persistence) 
• Utilize shared memory segments for data passing 
• Check and report on the status of other PECOS modules  
• Disconnect inactive modules. 

PECOS Automation Manager 
The Automation Manager is the interface between the remote PECOS clients and the Event 
Manager. Its primary functions are to: 
 
• Handle all client requests, acting as an interface between the client GUIs and the Event 

Manager 
• Receive data from the client GUIs and pass it on to the Event Manager 
• Generate and send messages from the client GUIs to the Event Manager. 

PECOS Database 
The PECOS database is a powerful module that houses a vast array of functionality. PECOS uses 
Microsoft SQL Server. However, PECOS was designed so tha t it is relatively easy to substitute 
MS SQL Server with a different database, such as Oracle. The functionality of the database is to: 
 
• Define all of the data points 
• Define mappings between plant point names (e.g., Aspen Technology Historian Tag Names) 

and PECOS point names 
• Define the data points whose values need to persist between PECOS server sessions and 

record the values in a table 
• Define data validation minimum, maximum and default values, and validation and 

replacement routines to be used for data entry, both manual and automatic (real-time data 
collection from the plant) 

• Contain tables for storing security information such as usernames and passwords, computer 
systems that can be used for accessing PECOS, and security access levels associated with 
each user 

• Contain tables for archiving data, validation actions and messages that are sent from the 
client and between modules. 
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PECOS Data Acquisition Modules 
PECOS can include one or more data acquisition modules for getting data from the plant and 
writing data to the plant. The data acquisition module’s primary functions are to: 
 
• Connect to the plant data source 
• Periodically request data or write data to the plant data source current value table 
• Detect connection problems and attempt reconnection. 

PECOS Data Validation Module 
Before data are sent to the Event Manager from any module, including the PECOS GUI, the data 
are sent to the Data Validation Module. The points for validation and the routines to be used for 
validating the data are defined in the database. An interpreted programming language, Tcl (Tool 
Command Language), is used to perform the validations. Using Tcl and the database to define 
the Tcl expressions and values makes the validation module very flexible and easy to update. 
The programmer simply has to change an entry in the Data Validation table in the database to 
add or delete or make changes to a validation routine. 

PECOS Data Translation Module 
After data validation, data points are sent to the Data Translation Module. The Data Translation 
Module is primarily used to translate data points from one set of engineering units to another. 
For example, the measured coal flow may be available only in klb/hr, but the PECOS 
computation module expects all coal flow data in the form of tons per hour (tph). However, it 
can also be used to calculate aggregates (such as total boiler coal flow as the sum of the 
individual mill coal flows) and moving averages. 
 
The Data Translation Module also uses the database to define the translations and Tcl to perform 
them. 

PECOS Data Archive Module 
All data defined in the PECOS database can be archived at defined intervals or upon update. 
Data are divided into several different categories and the archive type and interval can be defined 
differently for each data point category. The archived data are stored in a table in the database. 
 
The archived data are used for: 
 
• Displaying trend graphs on the GUI 
• Calculations that require historical data 
• Development of calculations and computation routines in Optifire and Coalogic 
• Troubleshooting. 
 
In addition to archiving data, the Data Archive Module also archives validations. If a data point 
is determined to be invalid, and the raw value is substituted with a default value or a calculated 
value, the date and time of the validation,  the validation routine ID, the original value, and the 
substituted value are archived in the database. 
 



Demonstration of an Advanced Integrated Control System for Simultaneous Emissions Reduction   DE-AC22-95PC95254 
Final Report, February 2002  Page 13 
 
Finally, the Data Archive Module archives messages. Messages are used to send commands from 
the GUI to the various PECOS modules, and to send commands between PECOS modules. The 
message archive is used for reviewing what was done and for troubleshooting. 

PECOS Admin Tool  
Part of the PECOS product is a web-based tool for use by the PECOS System Administrator for 
a given site. The PECOS Admin Tool provides the following functionality: 
 
• It is used to update the PECOS configuration information located in the NT registry, such as 

the current client version number, the cycle period of the Coal Tracking model, and the data 
acquisition host name used by the Data Acquisition Module 

• It is used to set the value of modeling constants. Modeling constants are variables that are 
expected to rarely change, so it was decided not to allow the everyday user to access them. 
However, since they may change every once in a while, the Admin Tool can be used to 
update the values. 

• It is used to administer the user accounts, passwords and security settings 
• The latest update to the PECOS client is available through the PECOS Admin Tool. 

1.3.2 Coalogic 

Coalogic is the module of PECOS designed as a tool for coal management. Coalogic is designed 
to aid in cost reduction and avoidance of derates or operational problems due to fuel quality in 
real time. There are four major components of Coalogic, which allow it to assist with blend 
management:  
 
• Coal Tracking Model – tracks all coal through the coal storage and handling system, into 

the silos and through to the mills, and displays the coal quantity and quality in the piles and 
silo in real time 

• Silo Flow Model – tracks the flow of coal through the silos 
• Pile Model – tracks the flow of coal through the stockpiles 
• Blend Advisor – blending strategy software, which works with information provided by the 

Coal Tracking Model to provide the right blend of fuel to the boiler at the right time.  

Coal Tracking Model 
The purpose of the Coal Tracking Model is to follow the coal as it moves from the point of 
receipt through to the burners. Coal can be received into the yard by train, truck, barge or ship. 
From its point of entry, the Coal Tracking Model uses models for piles, silos, conveyors, feeders, 
gates, cascade conveyor systems and trippers which are customized for a particular site to track 
the coal through the system. In silos and piles, the movement and mixing of the coal is modeled 
by the Silo Flow Model and Pile Model, respectively. 
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Coal Tracking Model Inputs: Electronic 

The required plant data received through one or more PECOS Data Acquisition Modules include 
but are not limited to: 
 
• Equipment On/Off Status  – On/off status of coal yard and silo equipment including 

conveyors and feeders 
• Mill Flow Rates – Mass rate out of each mill of every silo. This can be in the form of a mass 

flow rate (tph, kpph) or a calibrated feeder RPM. 
• Gate Positions  – Indication of all gate positions within the yard and the silo house 
• Stackout Locations  – Indication of which pile or piles the incoming coal is being stacked 

out to (these data may be entered manually) 
• Reclaim Locations  – Indication of which pile or piles the coal is currently being reclaimed 

from (these data may be entered manually) 
• Tripper Positions  – Indication of which silo is being loaded based on tripper positions in the 

silo house 
• Silo Levels – Online indication of the levels over each mill in a silo. This can be in the form 

of a mass percent, distance from the top of the silo, or tons. 
• Coal Flow Rates – Online indication of the tonnage rates associated with the belts feeding 

the system within the yard and into the silo house 
• Coal Analyzer Data – If an online coal analyzer exists, the coal quality as measured by this 

system should be available to the Coal Tracking model. 

Coal Tracking Model Inputs: Manual 

The Coal Tracking Model requires the manual entry of essential data that are not measured 
electronically. The preference is to acquire all data electronically for overall accuracy. However, 
some of the following data may have to be entered manually: 
 
• Incoming Coal Quality – As coal is received into the yard, its quality must be entered into 

the Coal Yard Model. These parameters would typically include, but are not limited to, 
heating value, ash, moisture, and sulfur. 

• Coal Delivery – Some systems do not electronically record the position of the boom 
supplying coal to the coal yard, for example 

• Startup Adjustment – This feature is used to initialize the program by computationally 
“emptying” and/or “filling” the silos and piles at first startup to correspond to the actual 
situation. 

 
In addition, there is configuration information that is gathered from the plant and through plant 
visits such as positioning of gates, and conveyor lengths and capacities. These data are used to 
define and arrange the numerous equipment models that comprise the Coal Tracking Model. 

Coal Tracking Model Outputs 

The Coal Tracking Model outputs the current state of the coal yard and silos or bunkers. This 
information includes, but is not limited to: 
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• Current inventory in all piles, including mass and quality (this data may come from the Pile 

Model) 
• Current inventory of all silos and bunkers (this data may come from the Silo Flow Model) 
• Current quality of coal feeding the boiler 
• Current coal flow rate and quality of coal on various conveyors that are not measured or 

manually entered. 

Silo Flow Model 
The Coal Tracking Model uses the Praxis Engineers’ Silo Flow™ Model. The Silo Flow Model 
accurately models the flow of coal through silos. The storage of coal in silos presents a unique 
problem in that the coals are not generally discharged from the silo in the sequence in which they 
were loaded into the silo. Therefore, even when a silo has a large amount of one coal in it, if 
another coal is loaded on top, the second coal can begin to show up at the silo discharge before 
the first coal is fully withdrawn.  This phenomenon is called “funnel flow” and is characterized 
by a free surface with very fast flow in the center of the silo, and much slower flow (“dead” 
zones) towards the outside walls as depicted in Figure 4. 

Figure 4. Silo Flow Patterns 

Because the relationship between the sequence of loading a coal into a silo and the sequence of 
its discharge is not simple, silos typically do not follow a straightforward first- in-first-out (FIFO) 
pattern. An example  of this phenomenon is presented in Figure 5. This figure shows the 
discharge from a silo that has been loaded with layers of four different coals with ash contents of 
10, 12, 14, and 16%, respectively. As the figure shows, the output sequence of coal quality (in 
terms of ash content) does not match the FIFO assumption. It is a complex blend where some of 
the coal loaded at the beginning is discharged at the end, and some of the coal loaded in the 
middle discharges very quickly. 

Free Surface

Dead Zone
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Figure 5. Difference Between FIFO and Actual Silo Exit Coal Quality 

The actual sequence of output quality is determined by a number of factors. These factors 
include the quantity and quality of coal already in the silo, the timing and rate of loading and 
discharge operations, the geometry of the silo, the interactions between coals in different feeder 
areas, and the flow properties of the particular coals.  
 
The Silo Flow Model is configured for each silo at the power plant to ensure its accuracy. A 
team of engineers visits the site and performs a tracer test, which involves spraying a small 
amount of a tracer chemical on the coal entering the silos and taking fineness samples at the mill. 
Subsequent lab testing of the samples for the  tracer gives a time history of the inherent mixing in 
the silo. The tracer test results are used to customize the Silo Flow Model for the site. The test 
typically takes one week to perform and requires no significant change in the normal operation 
of the coal yard. 

Silo Flow Model Inputs 

The inputs to the Silo Flow Model come directly from the Coal Tracking Model, but may 
originate as manual input or electronic plant data. The inputs to the Silo Flow Model include: 
 
• Current silo level 
• Amount of coal flowing into the silo 
• Amount of coal flowing out of the silo 
• Quality of coal flowing into the silo. 
 
In addition, there are tuning parameters and configuration data such velocity profile and silo 
dimensions that are determined by analyzing the tracer test results and reviewing information 
received from the plant such as equipment diagrams. 

Silo Flow Model Outputs 

The outputs of the Silo Flow Model include: 
 
• Information on the properties of the coal in the silos 
• Information on the properties of the coal feeding the boilers in real time. 
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The typical coal properties that are displayed for each silo include: 
 
• Heating value 
• Ash 
• Moisture 
• Sulfur. 
 
Note: There is no technical limitation on the number of properties that can be tracked. As long 
as the appropriate data are made available to the Coal Tracking Model, they can be tracked, 
including coal cost. 

Pile Model 
The Coal Tracking Model uses the Pile Model. The Pile Model is designed to represent the flow 
and storage of coals in a pile that is built by adding coal to the top using a boom. Coal is 
withdrawn from the bottom through an underground reclaim feeder. The model is fully three-
dimensional and adaptable to a wide variety of pile shapes and flow conditions. For ease of 
viewing, the pile contents are mapped to a two-dimensional display in the order in which coal 
layers will be withdrawn from the pile. 
 
The coal pile is modeled using an array of rectangular elements, called channels. The channel 
size is representative of the primary flow channel within the pile. Cells within each channel track 
the volume and type of coal they represent. This representation of the pile is shown in Figure 6. 

Figure 6. Coal Pile Representation 

Coal is withdrawn from the primary flow channel. If the model detects that a surface correction 
is needed, coal from adjacent channels is used to maintain the discharge angle conditions defined 
for the coal pile. Coal is also withdrawn from channels adjacent to the primary channel. Coal 
discharged in this manner is withdrawn at a point in the channel consistent with a conical surface 
modeled by the discharge angle and discharge point to preserve dead-storage coal information at 
the bottom of each channel. 
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In summary, coal can be removed from a channe l in one of four ways: 
 
• By being discharged from the discharge point (primary channels only) 
• At the top of the channel through surface corrections toward the primary channel 
• By being discharged at the live/dead storage interface in expanded flow modeling, or 
• By a reclaim operation (pile turnover). 
 
The advantages of modeling coal pile operations using this approach include: 
 
• The simple geometry of the flow channels allows faster computation, which, in turn, allows 

for increased model resolution 
• The vertical flow channels simplify the pile representation, which, in turn, allows modeling 

of coal flow acted upon by two discharge points 
• The rectangular coordinate system allows for extensibility to a variety of loadout and reclaim 

situations. 

Pile Model Outputs 

The Coal Tracking Model GUI displays the coal piles at the plant, the status of the pile (whether 
it is being stacked out to or reclaimed from) and all of the coal properties currently associated 
with each coal pile. The typical coal properties displayed fo r each pile are: 
 
• Heating value 
• Ash 
• Moisture 
• Sulfur. 

Blend Advisor 
Coalogic includes a Blend Advisor that advises the user on how to operate the coal yard and load 
the silos most effectively. The goal of the Blend Advisor is to provide blending 
recommendations that produce the appropriate coal quality at the burners at all times with the 
objectives of minimizing fuel- related costs. 
 
The first step in the calculation process is to determine which of the coal sources, which can take 
the form of piles, barges, or trains, in the yard are available to be used to provide coal to the 
bunkers. For each possible coal pile that can be reclaimed, each of possible blend combination 
that can be produced is then computationally run through the Coal Tracking Model to determine 
the appropriate timing and mixing of the coals as they move through the system. The subsequent 
performance of each blend is then summed up over its residence time in the bunker. These 
calculations can be aided by using a series of fuzzy engines to reduce the number of choices in 
the overall decision-making process. 
 
In addition, depending on the site, feedback from measured data can be used to impact what is 
considered the best coal blend. For example, at Keephills, an electrostatic precipitator (ESP) 
deconditioning factor is estimated using the average value of the stack opacity measured for the 
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previous four hours and the current coal ash sodium levels for that time period. This is then used 
to determine the specific coal blend that is needed to ensure that no opacity problems occur. 
 
The Blend Advisor then eliminates those solutions that violate any constraints, if any, which 
have been entered by the user, and presents the remaining blend producing the best result to the 
user as the Blend Recommendation. 

Blend Advisor Inputs 

The inputs to the Blend Advisor can include but are not limited to: 
 
• Forecasted coal deliveries to the plant 
• Projected power production by the plant 
• Coal source availability 
• Equipment operational status 
• User-defined coal quality targets. 

Blend Advisor Outputs  

The outputs of the Blend Advisor include but are not limited to: 
 
• Recommended coal loading combinations and the relative loading amounts in tons or tph 

from each coal source to produce the desired coal properties for the current coal loading 
• Predicted coal quality for the recommended blends. 

1.3.3 Optifire  

Optifire is an online advisory software module, which recommends boiler-side control setpoints 
designed to reduce costs to operators in real time. Optifire determines these setpoints by 
automatically assessing the many economic trade-offs inherent in the system while making sure 
that important safety, environmental (in particular NOx) and operational constraints are not 
violated. 
 
Optifire combines both physical and neural models to simulate plant performance. It models 
virtually all of the equipment and systems associated with the plant and automatically collects 
data from the existing plant data highway to be used in its models. Optifire uses online data to 
validate and adapt its models to provide accurate plant modeling even when plant conditions are 
changing with time. Based on these models, Optifire uses a powerful optimizer to calculate least-
cost setpoints within the specified operational constraints.  
 
The benefits provided by Optifire include: 
 
• Provides the operators with online control setpoints designed to reduce costs in real time 
• Assists in tighter control of NOx emissions 
• Assists in maintenance by highlighting measured data that have not passed data validation 

routines 
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• Provides the ability to change the limits on plant constraints so that the setpoints it 

recommends can be tailored to meet specified safety, environmental, and operational 
constraints 

• Provides detailed online cost information to highlight where costs are being incurred, thus 
giving more insight to maintenance and pricing strategies. 

 
There are two main components to Optifire: 
 
• Simulator – A computational model of the plant that predicts its performance for any set of 

control setpoints 
• Optimizer – A model that calculates the boiler control setpoints that result in least-cost 

operation of the plant while meeting safety, environmental, and operating constraints. 

Simulator 
The Simulator is a customized computational model of the all of the equipment at the plant that 
predicts both piece-by-piece and overall performance for any set of control setpoints. The 
Simulator calculates all of the important performance variables. 
 
The goal of the Simulator is threefold. First, it provides an accurate calculation of cur rent plant 
variables to show that its predictions are valid in comparison to the online measured data. 
Second, it calculates important quantities that are not measured online, including heat rate and 
plant costs. Lastly, it provides data that the Optimizer uses to determine the optimal boiler 
control setpoints that don’t violate any constraints. 

Simulator Calculations 

To make its calculations, the Simulator uses mathematical models guided by online measured 
data, empirical constants, and manual inputs. The models used include those based purely on 
physics as well as neural models that rely on online data to make their predictions. The most 
important online data used are setpoints, which are critical control parameters that dictate how 
the plant is operating. Setpoints have a significant impact on the results of a simulation. 
 
Typical setpoints used by Optifire include most of the controllable variables at the plant, the 
number and range of which is dependent on the boiler configuration. These can include excess 
oxygen, mill and fan bias, burner tilts, windbox and furnace pressure drops, mill exit 
temperatures, super-heat (SH) and reheat (RH) steam temperature and pressure, economizer 
bypass, cooling water pump on/off status, and all air damper positions. 
 
The Simulator models each piece of equipment at the plant. The individual models for each piece 
of equipment are then computationally configured together based on how they are arranged at the 
plant. Control systems are used to operate groups of equipment that work together to produce 
specified setpoints. The entire package is used for each simulation. 
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The plant is divided into the following systems: 
 
• A coal-handling model supplied by Coalogic that provides the coal quality and coal costs 

entering each of the feeders in real time to Optifire. A mill model calculates how the coal is 
pulverized before entering the furnace. 

• An air handling model that contains all of the equipment necessary to supply the air to the 
mills and furnace 

• A gas handling model that contains all of the equipment necessary to transport the gas from 
the boiler out through the stack 

• A furnace and boiler model that calculates combustion and heat transfer related variables 
occurring within. Emissions such as NOx and CO are modeled using neural models 

• A steam cycle model that contains all of the equipment in the steam cycle necessary to 
produce the steam power. The primary purpose of the steam cycle model is to calculate the 
net turbine heat rate and net turbine power for the current conditions. 

 
Based on the value of the control setpoints, the Simulator calculates the predicted performance of 
each piece of equipment, as well as efficiency and cost terms such as boiler efficiency, heat rate, 
and cost of generation. 

Optimizer 
The Optimizer calculates the boiler control setpoints that result in least-cost operation of the 
plant while meeting safety, environmental, and operating constraints. The Optimizer also 
calculates all of the resulting plant performance variables for the optimal setpoints. 
 
The goal of the Optimizer is to help the plant operators run the plant at lower costs without 
violating any constraints (called “constrained variables” in the software). It is designed to be 
flexible, so that the user can adjust plant constrained variables or place restraints on setpoints as 
needed. 

Optimizer Calculations 

The Optimizer performs a series of simulations by calling the Simulator, each call with a 
different set of setpoints. The optimization proceeds in an intelligent and efficient fashion, 
moving toward the optimal set of setpoints quickly. The methodology used by the Optimizer to 
arrive at the optimum setpoints relies heavily on Genetic Algorithms (GAs). GAs are an 
optimization technique that mimics evolution and natural selection. In essence, GAs create 
computational “families” that are allowed to cross-breed and randomly mutate, with the genes of 
the strongest families of each generation being passed on to the next. Over time, the most 
dominant or optimum family of setpoints is determined. 
 
GAs are used primarily for their unique ability to randomly search the entire computational space 
for the optimum, which makes this technique the most likely to find the global optimum and not 
get trapped at a local optimum. 
 
The objective function that the Optimizer minimizes is the sum of the total cost of operation plus 
any penalties that arise due to violation of constraints placed on constrained variables. 
Constrained variables represent important plant parameters that must be maintained between 
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prescribed limits for safety, environmental or operational reasons. An example of a constrained 
variable is opacity, which must fall below a set regulatory limit in order to avoid a derate. 
Another example of a constrained variable is the superheat steam exit temperature out of the 
boiler, which must be kept below a certain value because of thermal limits on the turbine blades. 
 
Constrained variables impact the optimization by placing an economic penalty on the proposed 
setpoints if they violate either the minimum or maximum limit. However, unlike the constraints 
placed on setpoints, constrained variable limits can be violated by the optimization. For example, 
if the user lowers the NOx upper limit to a very low value, the optimizer may find a solution with 
NOx higher than the upper limit, simply because the system cannot possibly produce NOx any 
lower. 

Optifire Inputs: Electronic 
Optifire collects data from the plant data historian using intermediary software. The data 
acquisition interval is approximately 10 seconds. 
 
The required data collected from the data historian include: 
 
A. Global  
Gross Power Output 
Net Power Output 
 
B. Coal Side 
Coal Handling 
Equipment On/Off Status 
Feeder Speeds 
Conveyor Weigh Scales 
Gate Positions 
Tripper Car Position 
Silo Level Indicators 
 
Feeders 
On/Off Status 
Coal Feed Rate or Feeder Speed 
 
Mills 
On/Off Status 
Bias 
Exit Temperature  
 
C. Air and Gas Side 
Fans 
On/Off Status 
Bias 
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Air Heaters 
On/Off Status 
Air Inlet Temperature 
Air Exit Temperature 
Gas Inlet Temperature 
Gas Exit Temperature 
 
Burners 
Windbox Pressure 
Damper Positions Including OFA Dampers 
Tilt Angle 
 
Boiler 
Economizer O2 
Economizer Gas Exit Temperature 
SH Steam Inlet and Exit Temperature and Pressure 
RH Steam Inlet and Exit Temperature and Pressure 
RH Steam Exit Temperature and Pressure 
Economizer Feed Water Inlet Temperature, Pressure, and Flow Rate 
SH Spray Temperature and Flow Rate 
RH Spray Temperature and Flow Rate 
 
Stack 
Gas Temperature 
CO2 
O2 
NOx 
CO 
SO2 
Opacity 
 
D. Steam Side 
Turbines 
Steam Inlet and Exit Temperature, Pressure, and Flow Rate 
 
Condenser 
Condenser Back Pressure 
Steam Inlet Temperatures and Flow Rates 
Condensate Exit Temperature and Flow Rate 
Cooling Water Inlet and Exit Temperature and Flow Rate 
 
Pumps 
On/Off Status 
Water Inlet and Exit Temperature, Pressure, and Flow Rate 
Pump Power 
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Feed Water Heaters 
Feed Water Inlet and Exit Temperature and Flow Rate 
Steam Inlet Temperature, Pressure, and Flow Rate from Turbines 
Drain Inlet and Exit Temperature, Pressure, and Flow Rate 

Optifire Inputs: Manual 
Optifire requires the manual entry of essential data that are either not measured or not stored 
electronically. Typically, these data are only relevant Unit Costs. The obvious preference for the 
system is to acquire all data electronically. However, typically Unit Cost data is not available 
electronically and must be entered manually. Typical Unit Cost data include fixed unit costs, 
O&M unit costs, ash sales and handling unit costs, cycling unit costs, scrubber unit costs, and 
emission unit costs such as SO2 credits. 

Optifire Inputs: User Controls 
The Optifire user has the opportunity to enter/edit data manually through the Optifire GUI. The 
data that the user can edit include: 
 
• Setpoint Constraints – The user can adjust the setpoint min/max constraints within the GUI. 

These constraints will never by violated and the recommended optimal setpoints will always 
fall between them. A typical reason for adjusting a setpoint constraint is if, for example, an 
air damper cannot be moved over its full range because of control problems. 

• Fixing a Setpoint  – The user can “fix” a setpoint to a particular setting within the GUI. 
Optifire will then not include that setpoint in the optimization calculations, adjusting the 
other setpoints around its fixed value. 

• Constrained Variable Constraints – The user can adjust the constrained variable min/max 
constraints within the GUI. These constraints can be violated but only if the cost savings 
associated with doing so outweigh the penalty for violating the constraint. Penalty weights 
can be adjusted by the user to ensure some constrained variable constraints are never violated 
e.g., Superheat Temperature. 

 

Optifire Outputs: Optimal Setpoints 
The Optifire GUI displays the calculated values for the optimal least-cost setpoints both in 
tabular form and in “slider” form – a graphical representation that resembles a control board 
slider. The optimal setpoints are presented side-by-side with the current setpoint values, as well 
as the minimum and maximum constraints for the setpoints as entered by the user. 

Optifire Outputs: Calculated Current and Optimal Values 
The Optifire GUI displays both the calculated values for all performance and cost variables that 
will be obtained when using the recommended optimal setpoints and the current values obtained 
from the current setpoints. The optimized and current variables are displayed side-by-side (with 
their relevant validation min/max limits) in tables, bar charts, and trend graphs. The user has 
control over which variables are displayed in the bar charts and trend graphs. Constrained 
variable values are also displayed in slider form. 
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1.4 Project Funding 
The project funding was provided by the U.S. Department of Energy’s National Energy 
Technology Laboratory (DOE NETL), Praxis Engineers, TransAlta Utilities, and the Electric 
Power Research Institute (EPRI). TransAlta also provided the use of their Keephills Plant and a 
large amount of time at the management and operator levels. 
 
Praxis Engineers also provided the use of its Silo Flow Model at the host sites. 
 
EPRI provided some cash for the project with the proviso that PECOS would be made 
compatible with a similar product called the “Advisory Plant and Environmental Control 
System” (APECS) that they were developing. While EPRI followed the progress of the project in 
its early phases, their interest waned when they discontinued the work on APECS. The primary 
reason for this was EPRI’s committee structure that emphasized dynamic NOx minimization 
rather than overall cost optimization, which is the focus of PECOS. This partially contributed to 
the work stoppage at Dairyland. 

1.5 Project Participants and Their Contribution 
The project was carried out under the overall management of Praxis Engineers, Inc. Praxis 
Engineers coordinated directly with the DOE NETL Contracting Officer’s Representative 
(COR), providing updates, presentations, and reports throughout the course of the project. Praxis 
Engineers also led direct interactions with the personnel at both sites who were instrumental in 
providing information, data, and expertise for the project. The main project contact at TransAlta 
was Andrew Hickinbotham and at Dairyland Power it was Duane Hill. Needless to say, many 
other personnel at each site participated actively in the project. 
 
The Project Manager for Praxis Engineers was Ms. Suzanne Shea, who was responsible for 
providing overall project management and interfacing with the DOE Project Manager. The 
Engineering Team consisted primarily of mechanical and chemical engineers assigned to various 
tasks including plant data reduction, model customization, system integration, and product 
testing and evaluation. The Software Team consisted primarily of software engineers charged 
with the task of customizing and maintaining the code for PECOS and its solution modules 
Coalogic and Optifire, and calibrating it for the two host sites. Many of the team members 
crossed over between the two teams, as needed.  

1.6 Problems Encountered 
In general, the project was extraordinarily successful, resulting in the full-scale online 
demonstration of two products, Coalogic and Optifire, which are available in the marketplace. 
Coalogic is the market leader in coal management software, having been installed at 28 other 
boilers after the completion of this project. However, as may be expected with a project of this 
complexity, several problems were encountered during the project, which are detailed below for 
each of the host sites. 
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1.6.1 TransAlta’s Keephills Plant 

The principal problem encountered at Keephills was a change in the plant’s goals with respect to 
NOx emissions. At the beginning of the project, NOx emissions were a key concern and one of 
the main reasons for the plant’s interest in Optifire. During the course of the project, several 
things occurred to reduce the plant’s concerns about NOx emissions: 
 
• The boiler control system was upgraded, making in particular burner damper control better, 

and significantly improving NOx performance 
• Significant maintenance on the boiler improved the mixing in the upper section where “poor 

man’s over fire air” was being used, lowering NOx emissions 
• Coal quality changed, with an overall reduction in fuel nitrogen in the bottom seams, which 

consequently lowered NOx. 
 
Because concerns about NOx became less urgent at the plant, the plant operators became more 
reluctant to use a system they thought they didn’t need. Previous unsatisfactory experience with 
an in-house boiler control software product further exacerbated the issue, as did the plant 
operators’ concern over the quality of NOx-related input data. Ultimately this led to Optifire not 
being used for its fully intended purpose, even though it was successfully installed online at the 
plant and passed initial quality assurance (QA) testing performed by Praxis Engineers. The plant 
does, however, use Optifire’s accurate heat rate and costs calculations for reporting purposes. 
 
None of these problems had any impact on the use of Coalogic at the plant, which was 
successfully installed, fully accepted, and is still used to this day. However, the implementation 
of Coalogic for Keephills had to be changed in the middle of the project because of a major 
control system upgrade at the plant. This required a completely new data acquisition model to be 
created and required another round of QA and testing, greatly increasing the time, effort, and 
cost of the project. 

1.6.2 Dairyland Power’s Genoa Station 

The principal problem encountered at Genoa was a delay in getting a new data acquisition 
system (DAS) installed for both the boiler and coal yards at the plant. Coalogic could not be 
installed at the plant with the DAS package being used at the start of the PECOS project as it did 
not provide the real- time online coal yard data essential for Coalogic to work properly. In 
addition, the plant was unwilling to install Optifire until they finalized the upgrade of their boiler 
control system as the operators would have to relearn the system when the new controls were in 
place. Many alterations were made to the Optifire code to attempt to make it compatible with 
both control systems and  also to allow the operators to manually enter coal quality data if 
Coalogic was not in place. The delay in the DAS installation led to significant delays in the 
schedule of the project, and ultimately led to PECOS not being successfully installed at Genoa. 

1.7 Project Overruns 
A number of factors led to an overrun in project costs of over $300,000. The main causes were 
the delays in getting the data acquisition systems in place at both sites, but primarily at the 
Dairyland Power site. This delayed and lengthened the project well beyond the period initially 



Demonstration of an Advanced Integrated Control System for Simultaneous Emissions Reduction   DE-AC22-95PC95254 
Final Report, February 2002  Page 27 
 
scheduled for it, as manpower utilization became inefficient. Other reasons that contributed to 
the overrun were a sudden sharp increase in demand for qualified software engineers in the 
Silicon Valley, which led to a sharp increase in prevailing salary rates for these personnel, and 
the need to use some contract software labor in place of in-house personnel who could not be 
easily hired. Praxis Engineers absorbed the costs of these overruns as part of its ongoing 
commitment to the successful commercialization of the PECOS technology, thus significantly 
exceeding its cost share commitment on the project. 

1.8 Project Achievements 
In spite of difficulties, both technical and financial, Praxis Engineers was able to complete the 
development and demonstration of PECOS. Its two main solution modules, Coalogic and 
Optifire, were both successfully installed and run online at TransAlta’s Keephills plant. Coalogic 
has remained in use at Keephills, and based on its tremendous success at the plant, TransAlta has 
procured other units of Coalogic for use at its Centralia Station in Washington state. 
 
Both TransAlta and Dairyland provided a large amount of time at the operator and management 
levels, provided plant data, and participated in project meetings. Their assistance and advice was 
a key factor in the success of the project. It was also crucial in making PECOS into a marketable 
product. 

1.8.1 TransAlta’s Keephills Plant 

TransAlta’s Keephills plant, located outside of Edmonton in Canada, has 2 identical units 
producing a total maximum output of 800 MW gross. The Combustion Engineering boilers are 
tangentially fired each with a rated capacity of 1,156,000 kg/hr of steam. Air is supplied to the 
boilers by both forced draft and primary air fans that are preheated through a unique trisector 
regenerative air heater. On the backend, both units have cold-side electro static precipitators. 
Neither unit is fitted with a scrubber, as sulfur emissions are not a concern at the site. Five 
Raymond bowl mills that are supplied coal from cylindrical 8-hour silos feed the boilers. 
 
Coalogic’s main function at Keephills is to get the right coal to the burners at the right time. It 
does so by tracking all coals in the system from their entry into the yard, through the storage 
stockpiles and mill silos and on into the boiler and making blending decisions such that the coal 
blend used at the plant improves the primary economic issue associated with coal quality—
eliminating costly opacity derates.  
 
Keephills is a mine mouth plant that uses five different seams, each with a different quality. One 
of the seams from the mine (the top seam) was identified as the culprit in causing the opacity 
problems due to its poor ash quality. This was due principally to the low sodium content in the 
ash of this seam, which acts to degrade precipitator collection efficiency. 
 
This seam represents over 70% of the total coal used at the plant, while the remaining 30% 
comes from bottom seams that do not cause opacity-related problems. By blending the top seam 
with an appropriate amount of bottom seam coal from the mine, which varies with operational 
conditions, while still using the same amount of top seam coal, Coalogic effectively eliminated 
the derates, reducing them from an annual level of 70,000 MWh to less than 10,000 MWh. 
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Because of the reduced derates, TransAlta was able to save about $2,000,000 in the first year of 
Coalogic use alone, with continuing savings each year.  
 
Optifire was designed to provide plant operators with optimal values for all control setpoints 
such that the operating costs are minimized while simultaneously maintaining all- important 
operating constraints—including NOx emission limits—within prescribed limits. Detailed 
physical and neural models were successfully developed producing on-line simulation capable of 
predicting heat rate and performance data within 1% accuracy. Though the plant does not use 
Optifire to change control setpoints, primarily because concerns about NOx emissions have 
significantly eased as a result of capital improvements in the boiler and changing coal quality, 
the product is used by personnel to provide accurate, real-time heat rate and cost reporting. 

1.8.2 Dairyland Power’s Genoa Station 

Dairyland Power’s Genoa plant, located just outside LaCrosse, Wisconsin, has a single unit 
producing a total maximum output of 350 MW gross. The Combustion Engineering super 
critical, double reheat boiler is tangentially fired with a rated capacity of 2,354,000 lb/hr of 
steam. Air is supplied to the boiler by forced draft fans that are preheated through a standard 
bisector regenerative air heater. The furnace has state of the art low NOx burners complete with 
close coupled and separated overfire air. On the backend, the unit has a hot-side electro static 
precipitator. The unit does not have a scrubber, as sulfur emissions are not a concern at the site. 
Four Raymond bowl mills that are supplied coal from cylindrical 8-hour silos feed the boiler. 
 
The Genoa plant uses two coal types, and Illinois No. 6 coal and a Powder River Basin (PRB) 
coal. The Illinois coal has a significantly higher energy content and lower moisture than the 
PRB, but is more expensive. At full load, the coal blend must have at least 35% of the Illinois 
coal to avoid mill-related derates. At lower loads, more of the cheaper PRB can be used as long 
as slagging issues are curtailed, primarily by increased soot blowing. The goal of the plant was to 
use as much of the PRB as possible to reduce fuel costs without causing derates. By properly 
matching coal quality to load, possible through the use of Coalogic, the project participants had 
estimated potential annual fuel cost savings of the order of $600,000. Praxis Engineers performed 
silo flow tests on the bunkers and installed a PECOS server machine at the plant. 
 
The core part of Optifire was also developed for Genoa. Considerable modeling work was done to 
produce performance models capable of accurately predicting key parameters such as heat rate 
within 1% accuracy for the unique boiler system and its inherent NOx control complexity. 
 
Unfortunately, since the plant was in the process of upgrading their control system and this 
upgrade project was repeatedly postponed, the plant was not made available to the project until 
early in 1998, after a delay of nearly 18 months. This delay contributed to significant time and 
cost overruns on the project. By the time Dairyland was willing to allow work to proceed, the 
project’s schedule and budget could not accommodate the impact of the delay. Hence the 
installation of PECOS at Dairyland Power could not be completed. 
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2.0 PROJECT PLANNING AND COORDINATION (TASK 1) 

The Project Planning and Coordination activities under Task 1 are briefly described in this 
section. The Management Plan (Task 1.1) outlined detailed work activities for the entire project. 
The task breakdown developed under the Management Plan is outlined in this section, but the 
detailed reporting for the two main demonstration tasks (Tasks 2 and 3) is provided in Sections 3 
and 4 respectively. 

2.1 Management Plan (Task 1.1) 
A Management Plan for detailed execution of the demonstration project at the two host sites was 
developed soon after contract award and submitted to DOE. The plan was broken down into 
detailed tasks, using the task numbering contained in the contract statement of work.  
 
The work program focused on evaluation of the performance of PECOS in proof-of-concept 
testing at two utility sites. Its goal was to resolve uncertainties about its capabilities, limitations, 
and costs of implementation. It was envisaged that demonstration at the two sites would allow 
the performance of PECOS to be tested under different conditions representing a subset of the 
possibilities presented by the highly diverse designs of coal- fired power stations. 
 
The two utility sites selected for this demonstration represent a diverse array of subsystems and 
issues in optimization of operations. At TransAlta Utilities' Keephills Plant in Alberta, Canada, 
the key issues involved management of coal quality, coal mining and deliveries, coal blending, 
opacity control, NOx and SO2 control, reduction of derates, and reduced use of opacity control. 
At Dairyland Power Cooperative's Genoa Power Station near LaCrosse, Wisconsin, the key 
issues included minimization of generation costs, increased use of low-cost Powder River Basin 
(PRB) coals, maintenance of NOx and SO2 emission targets, sales of ash, combustion efficiency, 
coal blending, and flexibility in meeting changing load requirements. 
 
As outlined in the plan, the work to be done under this project was broken into three main 
categories: 
 
• Customization of PECOS to each host site. This involved training and calibrating models, 

preparing site-specific data input/output (I/O) routines to access plant data online, and 
customizing the PECOS graphical user interface (GUI) to the specific variables and 
requirements at each site. 

• Integration and installation of PECOS, and training of the utility personnel in its operation 
• Demonstration of PECOS in operation at each host site. 
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(Task 2) Demonstration of PECOS at Keephills Plant  

Site-Specific Specifications and Requirements (Subtask 2.1)  

Site-Specific Specifications and Requirements (Subtask 2.1.1) 

The objective of this subtask was to prepare a site-specific specifications and requirements 
document for the online version of PECOS for Unit 1 at TransAlta's Keephills Station. The 
specifications would define the functionality of the supervisory optimization software at Keephills 
in the following areas: 
 
• Optimization objectives and constraints 
• Appropriate subsystem models 
• User interface requirements 
• Data and instrumentation requirements 
• Control system interface requirements. 
 
TransAlta Utilities' corporate priorities such as over-compliance with all regulatory emissions 
requirements and minimized overall generation costs would be used to define the site-specific 
optimization objective function.  
 
To develop the site-specific specifications, Praxis Engineers would evaluate available host site 
design information, operating procedures and philosophy, operating data, and operator experience. 
The following items were identified for review: 
 
• General description of the plant 
• Boiler type and design heat rate 
• Coal quality issues 
• Coal yard instrumentation 
• NOx control system and NOx limits 
• Environmental control and constraints for SO2, NOx, and opacity or particulates 
• Averaging strategies for emissions and process variables 
• Heat rate and plant efficiency goals 
• Location and performance of the CEMs for NOx, CO, SO2, O2, CO2, and opacity 
• Approaches to blending for coal quality control 
• Carbon-in-ash and ash sales 
• Constraints on coal availability, superheat temperatures, and other operator setpoints and 

related operating variables 
• Costs of ash disposal, derates due to emissions exceedances, chemicals for opacity control, 

and plant coals 
• Operational philosophy of the plant 
• Operating data. 

Execution of this subtask would entail a visit to Keephills to review and discuss design data, 
operating data, and functional requirements before finalizing the specifications. 
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Instrumentation and Host Computer Hardware Requirements (Subtask 2.1.2) 

The objective of this subtask was to carry out a detailed evaluation of instrumentation, data 
acquisition hardware, and host computer requirements for Keephills, based on conditions current at 
the time of project initiation. This review was to be based on PECOS data requirements, instrument 
availability, and TransAlta's estimate of the current accuracy of each required instrument. Plans 
and specifications for instrumentation and data acquisition upgrades were to be finalized after the 
review. The quality of the data provided by the available sensors were to be evaluated based on 
plant maintenance, I&C, and engineering records and assessments, and corrective actions—where 
necessary—were to be recommended.  
 
It was anticipated that most of the data required by PECOS were available through digital 
connection to the plant’s pre-existing NOxSmart, Heat Rate Monitor, Continuous Emissions 
Monitors (CEMs), and coal reclaim systems. 
 
The types of data that were to be acquired for online use by PECOS included: 
 
• Coal handling system data, obtained through the coal reclaim PLC. The PLC processor 

required upgrading to connect to the Host Computer. 
• Emissions data, obtained through NOxSmart and the CEMs 
• Boiler operation data, obtained through NOxSmart and the Heat Rate Monitor. A few 

additional data points of this type needed to be added to the NOxSmart data acquisition system 
and passed through to PECOS via the NOxSmart PC.  

Data Collection (Subtask 2.2) 
The objective of this subtask was to prepare detailed lists of the data required for customization of 
PECOS to the specific configuration and performance parameters of Keephills Unit 1. Design and 
test data were to be collected by TransAlta plant personnel, and online operations data sets were to 
be acquired from the Keephills data acquisition systems. These data were to be transmitted to 
Praxis Engineers as hard copy and PC data files respectively. 
 
The customization data requirements included the following: 
 
• Unit design information 
• Operating philosophy 
• Coal yard operations and coal quality 
• Environmental constraints and averaging strategies regarding NOx, SO2, and opacity 
• Startup/boiler tuning data 
• NOx and opacity control test data 
• Methods of computing heat rate at the plant 
• Normal operations data for full and partial loads using all normal coal blends. 

Installation of DAS Modifications and Hardware Acquisition (Subtask 2.3) 
The objective of this subtask was to purchase the PECOS Host Computer equipment and data 
acquisition I/O hardware and software specified in Subtask 2.1.2, and install I/O modifications at 
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Keephills. TransAlta handled the installation. Based on an analysis of instrumentation 
requirements for the coal yard, it was understood that TransAlta would install the following items: 
 
• 18 feeder on/off indicators 
• 2 weigh scale indicators 
• 10 low/high level switches in the silos 
• 6 position indicators for gates to divert coal flow 
• 1 frozen coal crusher on/off indicator. 
 
A Bailey computer interface unit (CIU) was also added to collate all plant data acquisition for 
transmission to PECOS.  

PECOS Customization at Keephills Plant (Subtask 2.4) 

Data Analysis and Model Customization (Subtask 2.4.1) 

The objective of this subtask was to analyze electronic plant data logs and customize the PECOS 
models to accurately represent Keephills subsystem performance in PECOS. The purpose of these 
analyses was to: 
 
• Calibrate and train, respectively, the analytical and neural net models of plant subsystem 

performance which PECOS uses in order to optimize operations 
• Develop site-specific criteria for use by the adaptive software algorithms of PECOS to keep the 

models accurate as plant performance shifts over time 
• Define the boundaries of applicability of the site-specific models as initially installed. 

PECOS Site-Specific Software Configuration for Keephills Unit 1 (Subtask 2.4.2) 

The objective of this subtask was to configure the PECOS software to the Keephills plant 
flowsheet, enter site-specific models (developed in Subtask 2.4.1) into the PECOS configuration, 
code site-specific data acquisition and user interface objects, and integrate the completed PECOS 
product for Keephills and test it off-line. 

Silo Flow Model Customization (Subtask 2.4.3) 

The objective of this subtask was to customize the Praxis Engineers’ Silo Flow Model software to 
model the pulverizer silos at Keephills, and confirm its performance by performing a tracer-based 
test series. Customization of the Silo Flow Model was to be accomplished by obtaining data on the 
geometry of the silos, geometry and operational modes of loading and discharge points, and the 
flow properties of the coals in use at the site. The geometric and operational data were to be 
gathered from drawings of the silos, tripper gallery, and handling system, a walk-through of the 
handling system and tripper gallery, and discussions with operations personnel. The flow 
properties of the coals would then be predicted based on our experience at other sites, and the 
initial customization of the Silo Flow Model would be completed. Its calibration would then be 
fine-tuned through two series of tracer-based tests of actual Keephills silo operation. 
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PECOS Installation and Validation at Keephills Plant (Subtask 2.5) 

Installation and Startup (Subtask 2.5.1) 

The objective of this subtask was to install PECOS at Keephills Unit 1. It was to be connected to 
the Keephills data acquisition systems via the new Bailey CIU by TransAlta I&C personnel. Praxis 
Engineers personnel were then to test PECOS performance once it was connected to the plant. An 
operational history of PECOS recommendations online was to be collected and evaluated using the 
same criteria used in off-line testing. Any adjustments to the software identified as being required 
during this startup testing were to be implemented at this time. 

PECOS Training for TransAlta Operators and Engineers (Subtask 2.5.2) 

The objective of this subtask was to provide two training courses for TransAlta personnel. Two 
one-day courses were to be given to TransAlta engineers. The training courses were to include 
PECOS theory and design, operation, discussion of results using actual examples, and training 
exercises using the PECOS computer in the control room. 
 
In addition, three one-day courses were to be given to Keephills operators covering PECOS 
purpose and operation. These courses were to be similar to the course provided for the engineers, 
but the content was to be adjusted to focus on operational issues, online use, and training using the 
PECOS computer.  

PECOS Testing Online in Advisory Mode at Keephills (Subtask 2.5.3) 

The objective of this subtask was to validate PECOS performance at Keephills in online operation 
using the criteria outlined in Subtask 2.4.2. Engineers from Praxis Engineers and TransAlta would 
carry out controlled tests to assess the benefits of using PECOS recommendations. Any required 
adjustments to the software would be made at this time. 

(Task 3) Demonstration of PECOS at Dairyland's Genoa Plant 

The objective of this task was to customize PECOS for Dairyland Power’s Genoa Station Unit 3, 
install it, and demonstrate its operation there. 

Site-Specific Specifications and Requirements (Subtask 3.1) 
It was anticipated that the subtasks under this task would require only minimal effort because 
specifications, data acquisition systems, and a large quantity of site data would already be available 
from the EPRI-funded “Advisory Plant and Environmental Control System” (APECS) 
demonstration. A brief review was to be carried out to ensure that no changes had taken place 
requiring corrective action. 

Data Collection (Subtask 3.2)  
The objective of this subtask was to obtain online performance data collected by Genoa Station 
plant personnel from the data acquisition systems for use in PECOS model calibration under 
Subtask 3.4.1. These data were to be provided in both spreadsheet and R*TIME historian file 
formats. It was envisaged that plant design and configuration data would already be available to 
Praxis Engineers from the EPRI-funded APECS work. 
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Installation of DAS Modifications and Hardware Acquisition (Subtask 3.3)  
It was envisaged that work under this subtask would already have been carried out as part of 
EPRI’s APECS demonstration and would not need to be repeated here. 

PECOS Customization (Subtask 3.4) 

Data Analysis and Model Customization (Subtask 3.4.1) 

The objective of this subtask was to analyze electronic plant data logs and customize PECOS 
models to accurately represent Genoa Station subsystem performance in PECOS. The purpose and 
approach taken in these analyses were enumerated in the description of Subtask 2.4.1 for work at 
Keephills. The models to be calibrated for Genoa Unit 3 included: 
 
• Coal yard model 
• Mill model 
• Steam air heater model 
• Air handling model including fan and air heater submodels 
• Emissions models for NOx, CO, and SO2 
• Unburned carbon model 
• Furnace model including combustion and heat release submodels 
• Boiler heat transfer model including submodels for various heat transfer surfaces 
• Steam cycle/heat rate model including turbine, pumps, and heater submodels 
• Condenser model 
• Electrostatic precipitator model 
• Gas handling model. 

PECOS Site-Specific Software Configuration for Genoa Unit 3 (Subtask 3.4.2) 

The objective of this subtask was to configure the PECOS software for the Genoa Station plant 
flowsheet, enter site-specific models developed in Subtask 3.4.1 into the PECOS configuration, 
code site-specific data acquisition and user interface objects, and integrate the completed PECOS 
product for Genoa Station and test it off- line. 

Silo Flow Model Customization (Subtask 3.4.3) 

The objective of this subtask was to customize the Praxis Engineers’ Silo Flow Model software to 
model the pulverizer silos at Genoa Station, and to confirm its performance through a tracer-based 
test series. The customization procedure was to be the same as that described in Subtask 2.4.3. 

PECOS Installation and Validation (Subtask 3.5)  

Installation and Startup (Subtask 3.5.1) 

The objective of this subtask was to install PECOS at Genoa Station Unit 3 on the Host Computer. 
Praxis Engineers personnel were to test PECOS performance once its modules were installed. An 
operational history of PECOS recommendations online was to be collected and evaluated for the 
same criteria used in off- line testing at both sites. Any minor adjustments to the software that are 
identified as being required during this startup testing were to be implemented at this time. 
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PECOS Training for Genoa Operators and Engineers (Subtask 3.5.2) 

The objective of this subtask was to offer two types of training courses for Dairyland Power 
Cooperative personnel, consisting of two one-day courses for engineers covering PECOS design 
and operation, and three one-day courses for Genoa Station operators covering PECOS purpose 
and operation. The basic training course was to be customized to cover Genoa’s data points and 
user interface.  

PECOS Testing Online in Advisory Mode at Genoa Station (Subtask 3.5.3) 

The objective of this subtask was to validate PECOS performance at Genoa Station in online 
operation using the test method and evaluation criteria listed in Subtask 2.5.3. 

(Task 4) Project Reporting/Deliverables  

The objective of this task was to prepare required project reports and project deliverables, which 
include all reports specified in the Reporting Requirements Checklist, DOE F1332.1.  
 
All reports were submitted as required, until delays at the host sites impacted the project schedule 
and finally the budget. In spite of the fact that Praxis Engineers picked up the costs of project 
overruns in the interests of completing the project, there was an impact on the timely delivery of 
project reports. The subject report constitutes the final deliverable for this project.  

2.2 Host Site Agreements (Task 1.2) 
Praxis Engineers concluded Host Site Agreements with each of the two utilities designated as 
demonstration sites for the PECOS technology, TransAlta Utilities and Dairyland Power 
Cooperative. Copies of the Host Site Agreements were appended to the Management Plan. 

2.3 Project Meetings (Task 1.3) 
Praxis Engineers personnel attended the Project Kickoff Meeting at DOE NETL to review the 
objectives of the project, discuss the Management Plan, and other contractual issues. Praxis 
Engineers also actively participated in the Annual Contractor’s Review Meetings in 1996 and 
1997, presenting papers for inclusion in the conference proceedings and making formal 
presentations at the conference. 

2.4 Project Tracking and Coordination (Task 1.4) 
The Praxis Engineers Project Manager was responsible for project tracking and management 
activities, and interfacing with DOE, TransAlta, and EPRI, as necessary. At various times, 
depending on the project tasks at hand, other members of the team took the lead in interfacing 
with the host utilities. 
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3.0 DEMONSTRATION OF PECOS AT TRANSALTA’S KEEPHILLS PLANT (TASK 2) 

3.1 Site-Specific Specifications and Requirements (Subtask 2.1)  

Subtask 2.1.1: Site-Specific Specifications and Requirements 

Under this subtask, site-specific specifications and requirements were prepared for the online 
version of the “Plant Environmental and Cost Optimization System” (PECOS) for Unit 1 at 
TransAlta’s Keephills plant.  
 
The specifications defined the functionality of PECOS at Keephills in the following areas: 
 
Optimization Objectives and Constraints – The specifications for the optimization objectives 
and constraints for both Coalogic and Optifire are described in detail in Section 3.4, Subtask 2.4.1. 
These specifications were developed after a thorough interaction with Keephills personnel to 
ensure that the products provided the functionality needed to give accurate and reliable optimal 
recommendations without violating any safety, environmental, or operational constraints. 
 
Appropriate Subsystem Models – The subsystem models for Coalogic and Optifire are 
described in detail in Section 3.4, Subtask 2.4.1. The subsystem models for both products were 
sufficiently detailed to accurately model the entire plant operations, from the coal yard through to 
the boiler and steam cycle. Virtually every piece of equipment at the plant was modeled to achieve 
the goal of providing an economic optimization of the entire plant operations. 
 
User Interface Requirements – Considerable work was done in specifying the design and 
functionality of the Graphical User Interface (GUI). Praxis Engineers collaborated extensively with 
Keephills personnel to develop a GUI that had a look and feel that was easy to understand and 
presented in a style similar to existing board schematics already in place at the plant. GUI 
functionality was also developed in close contact with the plant. After the initial discussions, Praxis 
Engineers developed a prototype PECOS GUI that was demonstrated to the plant operators to 
gather their feedback. This resulted in the finalization of a GUI specification, which in turn was 
used to produce the GUI used for acceptance testing at the plant. On numerous occasions during 
the project, GUI functionality was added or altered based on the continuing feedback from the 
plant. Praxis Engineers has been particularly receptive to working with the site to satisfy their 
needs both to provide them with a useful product, but also as a guide to producing a GUI format 
and structure for subsequent applications of Coalogic and Optifire to other sites. Further details on 
the GUI design are provided in the User Manuals for Coalogic and Optifire, attached as Appendix 
A and Appendix B respectively. 
 
Data and Instrumentation Requirements – The data required for both Coalogic and Optifire 
are described in detail in Section 3.2, Sub task 2.2. The data specifications were designed to 
provide enough design and performance data for the equipment and processes at the plant to 
model it accurately. In terms of the specification of instrumentation requirements, it was 
determined early in the project that Keephills had sufficient instrumentation already in place to 
provide the online data needed for both Coalogic and Optifire. 
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Subtask 2.1.2: Instrumentation and Host Computer Hardware Requirements 

The following data points were added to the data to be sent to PECOS via the Bailey CIU: 
 
• 18 coal pile reclaim feeder on/off indicators 
• 2 coal conveyor belt weigh scale indicators 
• 10 low/high level switches in silos 
• 6 position indicators for gates to divert coal flow 
• 1 frozen coal crusher on/off indicator. 
 
There was some discussion regarding the need for adding measurements of the pile reclaim feeder 
flow rates. However, the resources for this upgrade were not available and could not be justified. 
Only the feeder on/off status was available electronically, making it necessary to either assume 
equal amounts of coal are being withdrawn by each reclaim feeder, having the control room 
operator manually enter the reclaim feeder speed data, or try to calculate the feeder speeds from the 
data. Using manually entered data that must be done in real-time all the time (day and night) was 
deemed a high-risk strategy because it was very likely not to be done. Therefore, this solution was 
rejected. The third alternative was to develop a software routine to analyze the weigh scale and pile 
reclaim feeder status data and calculate a flow rate for each feeder. The control room operators 
typically turn on the first feeder, wait until the weigh scale reading stabilizes, and then turn on the 
second feeder. Thereafter, the control system simply turns the feeders on and off as needed to fill 
the silos until the coal in the pile above one of the feeders runs out. 
 
Historical weigh scale and reclaim feeder status data were analyzed using the data sets collected in 
this project. Because of the highly variable and non-standard ways in which the operators 
sequenced the feeders, it was decided that programming an algorithm to robustly perform the 
calculations necessary to define the separate feeder speeds was too difficult and full of pitfalls. 
Therefore, the assumption is made in the PECOS calculations that all pile reclaim feeders that are 
“on” are reclaiming coal at the same rate. The possible error introduced by this assumption was 
calculated and deemed to be acceptable. 
 
In addition, we considered making the amount and location of coal stacked out to the pile available 
electronically. The stackout is done using relays. In order to make this data available 
electronically, the stackout system would have to be completely revamped and a laser would 
need to be added to determine the position of the stacking arm, at considerable cost to the plant. 
Even if the stackout amount and location were electronically available, the problem of coal 
quality still had to be addressed. A solution of automating the stackout location and amount, but 
having the user manually enter the coal quality is dangerous because it requires users to enter 
data in real time. The decision was made to have the coal pile stackout amount, location and 
quality manually entered by the user in near-real time. This allows the user some flexibility on 
when the data entry is done. 
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An IBM compatible personal computer (PC) was specified and purchased to be used as the PECOS 
Host Computer at Keephills. This computer housed the PECOS server, which included handling 
I/O with a Bailey CIU that was installed by TransAlta. The PECOS Host Computer was configured 
as follows: 
 

Model: Compaq Proliant 800 
CPU: Single 200 MHz Pentium Pro 
RAM: 96 MB 
HD: 4 GB (single drive, no redundancy) 
NIC: Compaq Net Flex 3 
Operating System:Microsoft Windows NT Server 4 (Service Pack 2) 
Backup: 8mm Tape Backup 
UPS: Dedicated UPS 

 
The above configuration describes the second PECOS Host computer installed at Keephills 
(although it was the first provided under this project). The first one was similar, but was not a name 
brand (i.e. Compaq). Due to increasingly frequent hardware failures, Praxis Engineers decided that 
it was necessary to replace the original PECOS Host machine with a Compaq, and to require the 
use of brand name computers for the PECOS servers in the field. This policy has worked well, both 
under this demonstration and at the later software installations at 28 other units. 
 
When Optifire was added to the PECOS server, a second CPU and additional RAM were installed. 
 
A PC was purchased for use in developing and testing an integrated PECOS customized for 
Keephills. A dedicated computer is required for this task because of the time-consuming nature 
of the off- line tests used to simulate online operations. The PC was configured as follows: 
 

CPU: Dual 180 MHz Pentium Pro 
RAM: 128 MB 
HD: 3 GB 
NIC: 3Com PCI combo Ethernet adapter with coax and 10base-T connectors 
Operating System:Microsoft Windows NT Server 4 (Service Pack 2) 
Backup: 8mm Tape Backup 

 
A clone (non-name brand) machine was purchased for this purpose. Because the machine was to 
be used only at Praxis Engineers for testing and validation of the PECOS program, the additional 
robustness gained by using a name brand PC was not deemed necessary.  
 
In addition, a second PC was bought for Praxis Engineers in-house development, again, with 
Praxis Engineers’ funds and not under this project. The first in-house machine was used to 
simulate the conditions of the product as installed at Keephills. The second machine was used for 
debugging. It was necessary to have two machines because the debug machine contains a lot of 
extra files and support software routines that do not exist on the PECOS Host machine at 
Keephills. The PECOS debug machine at Praxis Engineers had the same configuration as the 
release machine. 
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3.2 Data Collection (Subtask 2.2) 
Praxis Engineers prepared detailed lists of the data required for customization of PECOS to the 
specific configuration and performance parameters of Keephills Unit 1. 
 
The required data were divided into two categories: data needed by Coalogic and data needed by 
Optifire although there is some overlap. 
 
We requested—and received—the following Coalogic data from the Keephills plant: 
 
• Typical minimum and maximum flow rates for the coal pile reclaim feeders 
• Dimensions of the coal bunkers 
• Dimensions and layout of the coal yard equipment (conveyors, gates, etc.) 
• Approximate dimensions of the coal pile 
• Approximate amount of coal in the bunkers when the low and high level lights are tripped 
• Historical data on the amount of coal burned daily 
• Historical coal quality data from the mine 
• Historical record of coal deliveries 
• Historical records of plant derates and MWh produced 
• Historical opacity data 
• Spreadsheet coal pile model created by the TransAlta Fuels Department 
• Photographs of the coal handling system mimic panel in the Keephills control room 
• Photographs of the coal pile. 
 
The information listed above was received in a variety of ways: during plant visits, as a result of 
requests to the plant operators and Fuel’s department, and during visits by the Keephills 
personnel to Praxis Engineers for strategy discussions. 
 
In January 1996, TransAlta personnel came to Praxis Engineers offices for a meeting to help 
define the coal blending strategy that should be implemented in the version of PECOS 
customized for Keephills. They also delivered a large amount of coal quality data at this time, 
and provided information about the current operations and conventions—including restrictions—
at the Keephills plant. They also supplied several versions of the spreadsheet coal pile model in 
use at the plant. The spreadsheet coal pile model includes blending recommendations that had 
been made by the personnel in the Fuel Supply Department prior to the installation of PECOS. 
These recommendations were later used for comparison with the recommendations made by the 
PECOS Blend Advisor after it was completed. 
 
The data related to the Optifire module of PECOS that were requested and received from the 
Keephills plant are listed in Table 2. 
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Table 2. Data Received from Keephills Plant for Optifire 

Equipment Modeling Constants and Design Data Historical Data vs. Load 
Mills  • The conversion constant between mill 

amps and mill power (voltage) 
• Tempering air needed vs. mill capacity 

and mill outlet temperature setpoint 
• Limits for the minimum and maximum 

primary air-coal ratio through the mill  
• Maximum coal feed rate for each mill 
• Maximum amount of mill bias possible 

• Feeder speeds 
• Inlet and exit air temperature 
• Primary air flow rate 
• Tempering air flow rate 
• Mill and feeder power 

Fans • Fan curves for the FD, PA, and ID fans 
• Maximum amount of fan bias possible for 

the FD, PA, and ID fans 
• Rated power output 

• Inlet temperature and humidity 
• Vane position 
• Fan speed 

Trisectors 
 

• Efficiency in transferring heat for both 
the primary and secondary air sections or 
heat transfer coefficient vs. flow rate 
through the trisector 

• Design heat transfer coefficients 
• Measured air leakages in % of total flow 

rate for each section  
• Maximum volumetric capacity for each 

trisector 

• PA inlet and exit temperature 
• SA inlet and exit temperature 
• Gas inlet and exit temperature 

Boiler • Damper position control curves vs. excess 
oxygen and load 

• Design boiler efficiency vs. load 
• Design heat balances vs. load 

• Boiler efficiency 
• Excess oxygen 
• Burner tilts for east and west  
• North and south windbox/furnace DP 
• Overfire air dampers position 
• Fuel/air dampers A through E position 
• Auxiliary air dampers A/B through D/E 

position 
• Economizer CO and NOx 
• LOI  
• Economizer gas inlet and exit temperature 
• Economizer feed water inlet temperature, 

pressure, and flow rate 
• SH steam inlet and exit temperature and 

pressure 
• RH steam inlet and exit temperature and 

pressure 
• SH attemperation spray temperature and flow 

rate 
• RH attemperation spray temperature and flow 

rate 
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ESP • Maximum volumetric capacity for each 

ESP 
• ESP design conditions: Coal quality and 

inlet temperature impacts on collection 
efficiency 

• Rated power output 

• Opacity 

Turbines 
(Each Stage) 

• Design turbine efficiency vs. load 
• Design extraction temperature and 

pressure vs. load 
• Design heat balances vs. load 

• Steam inlet and exit temperature, pressure, 
and flow rate 

• Extraction steam exit temperature and 
pressure 

Condenser • Design heat transfer coefficient • Back pressure 
• Steam inlet temperature 
• Drain inlet temperature 
• Condensate exit temperature and flow rate 
• Cooling water inlet and exit temperature and 

flow rate 
Pumps • Design efficiency 

• Rated power output 
• Water inlet and exit temperature and pressure 
• Pump power 

Feed Water 
Heaters 

• Design TTD and LMTD • Feed water inlet and exit temperature and 
flow rate 

• Steam inlet temperature and pressure 
• Drain inlet and exit temperature 

General Plant 
Data 

• Design heat rates vs. load • Net plant heat rate 
• Net turbine heat rate 

 
In addition, the following coal and cost data were obtained and used in the customization of the 
Optifire models: 
 
• Coal Data:  

- Complete ultimate (C, H, O, N, S, Cl, Moisture, and Ash), proximate analysis (FC, VM, 
Moisture, and Ash) and ash analysis for each coal seam. 

• General Plant Cost Data: 
- Coal cost rate (coal cost per seam [$/(metric tonne) or $/mmBtu], transportation cost 

[$/tonne], and handling cost [$/tonne]) 
- Ash cost rate (disposal cost [$/tonne] or sale rate [$/tonne]) 
- Maintenance cost rate [$/kWh] 
- Fixed cost rate (labor, etc.) [$/kWh] 
- Water treatment cost rate [$/flow rate] 
- Generating cost [$/kWh]. 

 
After the installation of the PECOS server for data collection purposes in April 1996, Praxis 
Engineers began receiving electronic data sets from the data acquisition system (DAS) 
representing consecutive days of operation. The data were collected at approximately one-minute 
intervals. 
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3.3 Installation of DAS Modifications and Hardware Acquisition (Subtask 2.3) 
In this subtask, the PECOS Host Computer equipment and data acquisition I/O hardware and 
software specified in Subtask 2.1.2 were purchased, and I/O modifications were installed at 
Keephills by TransAlta. TransAlta installed the following items: 
 
• 18 coal pile reclaim feeder on/off indicators 
• 2 coal conveyor belt weigh scale indicators 
• 10 low/high level switches in silos 
• 6 position indicators for gates to divert coal flow 
• 1 frozen coal crusher on/off indicator. 
 
TransAlta did not install individual speed controllers on the pile reclaim feeders as was suggested. 
For the coal yard modeling by PECOS, it was assumed that all coal pile reclaim feeders that are on 
are drawing coal at the same rate, as defined by the conveyor weigh scale readings. A study was 
done to estimate the maximum possible error introduced by this assumption, which was deemed 
acceptable. 
 
A Bailey Computer Interface Unit (CIU) was installed to transmit data to PECOS via a serial 
cable. However, unexpected problems in the CIU communications were encountered during 
testing. The problem was resolved by renting a CIU. The rented CIU was used during the data 
acquisition and demonstration portions of the project, until a new data source (the Aspen 
Technology Historian) replaced the Bailey CIU. 
 
The first PECOS host computer was installed in April 1996 to collect raw plant data via the Bailey 
CIU. At this time, some of the data needed for the Optifire module were not available due to 
instrumentation problems. However, all of the data needed to proceed with the Coalogic module 
development and customization were available. 
 
These data sets were electronically transferred to Praxis Engineers and used to analyze the 
information and test the PECOS program at Praxis Engineers by “replaying” them in real time or 
near-real time. Many improvements to the model and modifications to the assumptions used in the 
modeling were made during these “real world” tests. 
 
In May 1997, Keephills Unit 1 was pulled off- line for maintenance. During this outage, a new 
boiler control system was installed. This meant that the data from the plant were no longer going to 
be available to PECOS through the Bailey CIU. Therefore, a new PECOS data acquisition module 
was developed to access the plant data from the Aspen Technology CIM/21 Historian, which is 
physically located at the nearby TransAlta Sundance plant. A Matrikon GenCS Server process runs 
on the computer that houses the Historian. The newly developed PECOS data acquisition module, 
using the Matrikon GenCS Client software, was connected to the Matrikon GenCS Server across 
the TransAlta network and was able to read in real-time plant data.  
 
Most of the data needed by PECOS were available from the Aspen Technology Historian. 
However, the Continuous Emissions Monitor (CEM) data were not being sent to the Historian. 
Another PECOS data acquisition module was therefore developed to read in the CEM data. The 
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data acquisition connections between the plant and the PECOS host computer at that time are 
shown in Figure 7. 

Figure 7. DAS Connections between Keephills Plant and PECOS Host Computer 

In 1999, the Aspen Technology Historian was able to read the CEM data as well, so the CEM 
PECOS data acquisition module was decommissioned and the CEM data points were added to the 
table of data points collected from the Historian. 

3.4 PECOS Customization at Keephills Plant (Subtask 2.4) 

Subtask 2.4.1: Data Analysis and Model Customization 

In this subtask, electronic plant data sets, historical and design data collected in the previous 
subtask, and results from the silo tracer tests were analyzed. Using the collected data, the PECOS 
models were customized to represent Keephills subsystem performance.  

Customization of Coalogic Models 

The following Coalogic models were customized for use at Keephills: 
 
• Coal Tracking Model 
• Pile Model 
• Silo Flow Model 
• Blend Advisor. 
 
In addition to configuring the existing PECOS models for the Keephills coal yard, it was necessary 
to make several changes to the functionality of the models. Some of this additional functionality 
was due to unique conditions at Keephills and some were improvements to the models that can and 
will be used at other PECOS installations. The additional functionality is described below. 
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• Coal Tracking Model: 

- Track “undefined” coal if the section of the pile from which the coal is coming is empty 
- Add restart capabilities. If the PECOS server is stopped and restarted, the information 

about the coal in the pile and silos is retained. 
- Add a “startup adjustment” capability that allows the user to empty piles and silos. Because 

the piles and silos retain the information from the last time that the PECOS program 
stopped, the user may need to adjust the current inventories, especially if the program has 
been off- line for an extended period of time, for example, when plant data sources are 
changed. 

 
• Pile Model: 

- Add “turnover” capability 
- Add the ability for the user to adjust the amount of coal in a section of the pile 
- Add manual data entry for coal receipts 
- Add the ability for the user to undo the most recent coal receipt. 

 
• Silo Flow Model: 

- Adjust the level in the silo in response to high/low level data. 
 
Customization of the Coal Tracking Model 
The Coal Tracking Model represents the part of Coalogic that accounts for how coal moves 
through the yard from the point of receipt through to the boiler. Both the Pile Model and Silo 
Model are part of the Coal Tracking Model, as well as models for the equipment that moves coal 
to the piles and from the piles into the silos and out to the mills. 
 
The Coal Tracking Model was designed to be generally applicable to any coal yard and readily 
customized using a program capable of piecing together coal yard equipment models in any 
configuration. Aspects of the general design of the Coal Tracking Model, which are applicable to 
any coal yard including Keephills, were discussed in Section 1.3. 
 
The Coal Tracking Model was customized for Keephills based on design data received from 
Keephills personnel, principal among them the overall yard layout diagram. The goal of the 
customization was to provide accurate modeling and required functionality to accurately track 
coals and account for yard operation practices at Keephills. 
 
Another important goal was to minimize the amount of user data entry required. This was 
achieved by using measured data to model coal movement and mixing. The only significant data 
entry required for the Coal Tracking Model was data associated with the coals being stacked out 
to the pile. This included manual entry of the coal seam number, its quality, the amount to be 
stacked out, and where it was to be stacked out. 
 
In addition, because of the real- time aspect of the product, the model was designed to allow the 
user to make necessary adjustments to offset late data entries or loss of data situations. This 
functionality consisted of: 
 
Tracking “Undefined” Coal – The removal of coal from the live zones of the pile at Keephills 
was performed using real-time online data. Because of this, it is imperative that shipments of 
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coal be entered into the system in a timely fashion. If for any reason a coal shipment was not 
added to a live zone of the pile, when in fact it was delivered, the system may be faced with 
conflicting information. An example of this is if the real-time online data tells the system that the 
feeder is unloading coal from a particular live zone that is empty, which means that the system 
does not know the quality of the coal tracked. When the system is faced with coal removal from 
an empty pile zone it is designed to generate “undefined” coal. Undefined coal will then travel 
through the system and into the silos with a definable mass but no properties. In the GUI, the 
presence of undefined coal was displayed with a distinct gray coloring to alert the user that the 
system has a data entry issue that needs to be resolved. The “undefined” coal eventually purges 
itself from the system. 
 
Restart Capabilities – The Coal Tracking Model was designed to be able to be “restarted” when 
the server had to be shut down and restarted or the system lost power. PECOS was designed to 
keep a complete record of coal properties and systems settings in the event that the server ceased 
to function for a period of time. When the system was restarted, PECOS reinitialized itself using 
the preserved data record upon startup. This type of automatic recovery saved the user a 
tremendous amount of time and effort in the event of an accidental server restart. 
 
Startup Adjustments – The Coal Tracking Model was created with the ability to perform 
“startup adjustments” in the event that the PECOS server was off- line for an extended period of 
time or real time data was unavailable to the system. Startup adjustments allowed the user to 
rebuild the properties of the coal in the piles or silos in case they became inaccurate during the 
shutdown period. Startup adjustments include the functionality to empty the live coal sections of 
the pile, the entire pile, or all of the silos at once.  
 
Customization of Pile Model 
The pile model was customized to represent the size, loading points, unloading points, and angle of 
repose of the pile at Keephills. The following parameters were used: 
 
Pile dimensions (feet):  
 Width = 161.65 
 Length = 641.97 
 Height = 56.69 
 
Angles of repose (degrees): 
 Loading = 35.0 
 Unloading = 50.0 
 
Loading and unloading point locations (feet): 
 80.83, 80.825 
 140.86, 80.825 
 200.90, 80.825 
 260.94, 80.825 
 320.98, 80.825 
 381.02, 80.825 
 441.06, 80.825 
 501.10, 80.825 
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 561.14, 80.825 
 
Coal Pile Turnover – Pile turnover is performed at Keephills on a regula r basis to move coal 
from dead storage areas in the pile into reclaim feeders where it is reclaimed. Bulldozers are used 
to push the coal from dead storage into live storage areas over the feeders. The turnover 
operation is performed systematically from one end of the pile to the other. When a portion of 
the pile has been turned over, piles are rebuilt “behind” the mobile equipment. 
 
During normal operation, coal is reclaimed by the reclaim feeders from live storage only. When 
the pile turnover state is activated, a reference plane is established at one end of the pile as 
shown in Figure 8. 

Figure 8. Coal Pile Turnover Plane Representation 

Initially all of the pile is on the “unprocessed” side of the plane. When the Pile Model is in the 
turnover state, it processes the live coal as it would during normal operation. However, when the 
real-time data indicate that coal is being withdrawn from a reclaim feeder whose live storage has 
been depleted, the withdrawn coal is provided by relocating the plane, “slicing” the pile, and 
moving the coal between the old and new positions of the plane to the empty reclaim feeder. This 
represents bulldozers moving dead coal into a feeder that is reclaiming the coal. The pile 
turnover operation is completed when the plane reaches the other end of the pile. 
 
Coal Pile Adjustments – Adjustments to the coal pile have to be performed occasionally to 
reconcile the actual coal live pile inventory with the inventory calculated by the Pile Model. 
These corrections should be infrequent. Possible errors, in anticipated order of severity, are most 
likely due to: 
 
• Systematic measurement errors from weigh scale inaccuracies 
• Errors in data entry 
• Differences between actual and modeled operations. 
 
To adjust the Pile Model, the operator enters the actual percentage of live coal above each 
reclaim feeder through the user interface. Excess live pile inventories are corrected by simulating 
discharge from the pile and removing the coal from the pile. Shortages in inventory are corrected 
by simulating addition of coal to the pile. 
 

Turnover Plane
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Customization of the Silo Flow Model 
The customization of Praxis Engineers’ Silo Flow Model was accomplished using data on the 
geometry of the silos, and the geometry and operational modes of loading and discharge points. 
The data to accomplish this task were collected under Subtask 2.2. 
 
In June 1996, Praxis Engineers performed several silo tracer tests to calibrate and verify the Silo 
Flow Model. Calibration involves adjusting the velocity profile and the angle of repose so that the 
flow through the Silo Flow Model matches measurements. Before performing the tests, several 
simulations of the customized Silo Flow Model were run with different velocity profiles, in order 
to determine a range of possible results and to better design the experiments. 
 
The tests consisted of spraying a tracer agent on the coal being fed to the silo at the conveyer 
gallery. Coal samples were taken at the mill and analyzed at a local laboratory for their tracer 
content. The measured tracer is indicative of how the coal mixes and flows through the silo. In 
addition, three plumb bobs were inserted into the silo at separate locations to measure the change 
in coal surface height with time. The plumb bobs were necessary since the only instrumented level 
measurements at Keephills are high and low level indicators—lasers that are tripped when the coal 
in the silo is below or above a specified level. 
 
Two types of tests were performed: three saturation tests and one spike test. For a saturation test, 
all of the coal added to the silo after the low light indicator comes in is sprayed. The expected 
result is either a sudden rise in tracer concentration to the maximum tracer concentration 
(“saturation”), which is indicative of mass flow, or a gradual increase characteristic of funnel flow.  
 
For a spike test, only the first half of the coal added to the silo is sprayed. For this test, mass flow 
would produce a square wave response, while funnel flow would produce a gradual rise followed 
by a slow decay in the measured tracer contained in the coal. 
 
The following conclusions were drawn based on the silo tests performed at Keephills: 
 
• The silos exhibit mildly funnel- like flow 
• Significant differences in the initial coal surface and subsequent coal velocities were observed 

between East and West conveyor loading 
• No dead zones were detected, either by plumb bob measurements or visually 
• Characteristic times for the silo were measured. 
 
Customization of the Blend Advisor 
The Blend Advisor is the module of Coalogic that recommends coal yard operations in order to 
avoid derate conditions while operating in a sustainable manner. Operating in a sustainable manner 
means using all the coal supplied by the mine. The Blend Advisor uses the current state data from 
the Coal Tracking Model, historical unit operations and emissions data, and user inputs. 
 
The Blend Advisor is the most customized module of Coalogic. In order to design and develop a 
Blend Advisor at an installation, the problems, current operating procedures, constraints on 
operations, and possible solutions must be very well understood. This understanding must then be 
translated into a software program with well-specified inputs and outputs. 
 



Demonstration of an Advanced Integrated Control System for Simultaneous Emissions Reduction   DE-AC22-95PC95254 
Final Report, February 2002  Page 48 
 
The first version of the Blend Advisor at Keephills was designed, developed, and installed in the 
fall of 1996. After several months of use, adjustments were made in response to feedback from the 
users. Most of the improvements involved allowing users to specify operational constraints (such 
as how many reclaim feeders were to be used and whether a particular reclaim feeder must be 
used.) 
 
The inputs to the Blend Advisor customization included: 
 
• Rules of thumb for blend selection developed by Praxis Engineers in conjunction with the Fuel 

Supply Department 
• Previous analyses of operations and conditions at the plant, including coal seam properties and 

their effects on electrostatic precipitator (ESP) deconditioning and stack opacity 
• Discussions with the plant operators.  
 
Praxis Engineers and TransAlta’s Fuel Supply Department collaborated to develop general rules 
of thumb on how the coal yard and blending operations should be undertaken to reduce the 
opacity-related derates while still using the mined seams in the same proportion as before. Part of 
this work was to establish what seams were the culprits in terms of high opacity production and 
part of it was to determine how coals should be segregated in the pile to provide appropriate 
blending control. Btu content was also deemed important, as some seams were not capable of 
making full load on their own. Based on these observations, criteria were developed to 
effectively blend coals at Keephills. 
 
The criteria developed to recommend how to pull coal from the pile included: 
 
• A blend of seam 1 and seam 6 is most preferable 
• Blends that use seam 3 and seam 4 do not burn as well; the heating value of these blends is too 

low 
• A blend of seam 2 with seams 3 or 4 is better than using seam 1 with seams 3 or 4 
• Use seam 2 straight if there are any problems at the plant 
• Conserve seam 2, since it can be used safely without blending with another coal. Its heating 

value is high enough and it does not cause opacity problems 
• Preferentially choose the reclaim feeder that is currently being used. 
 
These rules of thumb were used as a starting point for design of the Coalogic Blend Advisor. 
 
An analysis of the variation of coal properties for the different coal seams also contributed to the 
design of the Blend Advisor. Keephills receives five different seams of coal from three different 
regions in the pit. The coal quality varies by seam as well as by region. The results of a 
regression analysis of the opacity potential of different seams are shown in Table 3.  
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Table 3. Coal Opacity Potential by Seam and Region 

Pit Area Seam 1, % Seam 2, %  Seam 3, % Seam 4, % Seam 6, % 

East 18.0  17.2 17.7 14.2 10.6 
West 16.0 12.0 10.4  6.5  5.0 

North 16.0 16.0 17.0 14.3 10.8 
 
Using these data, the coals were divided into three groups: 
 
• Seam 1 
• Seam 2 
• Bottom seams (Seams 3, 4, and 6). 
 
Seams 3, 4, and 6 are grouped together based on the coal properties. Seams 4 and 6 are low 
opacity-producing seams. Despite the fact that Seam 3 has shown variations in its opacity 
potential, its heating value is similar to that of Seams 4 and 6. In addition, it has not been 
possible to conclusively determine the opacity potential of Seam 3 because it is mined in a small 
percentage. 
 
A 1995 Praxis Engineers study4 also supported the hypothesis that three other factors influence 
opacity: 
 
• Sodium content of the coal 
• Sulfur content of the coal 
• Deconditioning (sodium depletion effect) of the ESP. 
 
Discussions with the plant operators revealed information that was used to make the product more 
useable and acceptable to the customer. Examples of such information are given below. 
 
• Coal flow rates from the reclaim feeders are either 200 to 400 tonnes/hour or 150 to 350 

tonnes/hour. The absolute minimum is 150 tonnes/hour. 
• The foremost coal blend selection criterion is to use up any Seam 1 coal that is available as 

soon as possible 
• Blends of Seam 1 and Seam 3 should not be recommended because this blend causes problems 

with attaining load 
• No more than two reclaim feeders should be used at a time when pulling for only one unit. If 

three reclaim feeders are used, the coal flow through each at ~ 50 tonnes/hour is too low, and it 
is necessary for a worker to be present in the tunnel below the pile to make sure that the flow 
does not stop. 

                                                 
4 Independently funded study by Praxis Engineers titled “Coal Quality Impacts on Opacity at 
Keephills Power Plant,” March 1995. 
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• Operational suggestions should be stable for about 12 hours (i.e., they should not require 

changing reclaim feeders more frequently than every 12 hours). Coal loading operations should 
be kept as simple as possible. 

 
The goal of the Blend Advisor is to standardize the logic while also taking into account an array 
of data not available to any one person. 
 
The calculations are done using a series of fuzzy engines and a heuristic program. Several small 
fuzzy engines are used instead of one large one because this allows greater flexibility in the 
parameters that can be incorporated into the overall decision-making process. 
 
The inputs to the Coal Blend Advisor include the following: 
 
• Seam distribution above each reclaim feeder 
• Seam delivery forecast for the next 12 hours 
• Opacity potentials of the coal in the pile and the coal to be delivered 
• Sodium and sulfur content of the coal in the pile and the coal to be delivered 
• Heating values of the coals 
• Stack opacity measurements averaged over the previous four hours 
• Sodium values of the coal burned averaged over the previous four hours 
• Average power produced in the last four hours 
• Time period for which to generate a recommendation (N hours) 
• Average power generation predicted for the next N hours 
• Operational status of the reclaim feeders (working/not working and min and max flow rates) 
• A maximum opacity (user entered) 
• A minimum heating value (user entered) 
• Number of reclaim feeders to use 
• Whether the flow from the reclaim feeders should be equal 
• Whether a specific reclaim feeder is required (the Blend Advisor chooses the other one). 
 
First, the availability of each seam is calculated. The amount and location of each seam in the 
coal pile and the expected delivery are used for this calculation. The opacity potential of each 
seam is “corrected” by taking into account its sodium and sulfur properties. An ESP 
deconditioning factor is estimated using the average value of the stack opacity measured for the 
previous four hours and the sodium levels for that time period. This is used to determine a target 
opacity potential that the coal blend can have without causing opacity problems. The target coal 
blend opacity potential is further processed for power generation changes. If the predicted power 
is much higher than the power that had been generated in the previous four hours, the target 
opacity potential of the coal blend is decreased. The recommended coal blend is then calculated. 
The inputs to this calculation are the seam availability, the corrected opacity potentials, the 
heating values of the seams, and the power requirement for the next four hours. 
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Finally, the reclaim feeders to be used are determined. The inputs to this calculation are: 
 
• The target opacity potential 
• The minimum heating value, as entered by the user 
• The coal in the live coal section above each reclaim feeder 
• Minimum and maximum flow rates out of each reclaim feeder 
• Reclaim feeder status (on/off) 
• Number of reclaim feeders to use 
• Whether the flow from the reclaim feeders should be equal 
• Whether a specific reclaim feeder is required (the Blend Advisor chooses the other one). 
 
All blends (combinations of reclaim feeders) that meet the heating value and opacity potential 
constraints are sorted by an objective function. The objective function tries to: 
 
• Maximize the use of Seam 1 coal 
• Minimize the use of Seam 2 and bottom seam coal 
• Maximize the opacity potential (without exceeding the target) 
• Minimize the heating value. 
 
The best solutions (to a maximum of 10) are displayed to the user. At this point the Fuel Supply 
Department can add its own ranking of the solutions. This feature was requested because there 
are often situations that only an individual at the scene could be aware of that could make one 
solution more desirable than another. This feature, i.e., the ability at each site for users to choose 
from among several viable solutions provided by our software, has been used successfully at all 
subsequent sites. This eases operator acceptance considerably. 

Customization of Optifire Models 

The Optifire models customized for use at Keephills include the Simulator and the Optimizer. 
 
Simulator Overview 
The Simulator is a detailed model of every piece of equipment at the Keephills plant. The 
Simulator calculates all of the important performance variables. 
 
The Simulator for Keephills included the following plant systems: 
 
• Coal Handling System 

- Mills 
• Air and Gas Handling System 

- Fans  
Ø Forced Draft (FD) Fans 
Ø Primary Air (PA) Fans 
Ø Induced Draft (ID) Fans 
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- Splitters 
- Mixers 
- Trisectors 

- Stack 
• Ash Handling System 

- Electrostatic Precipitators (ESPs) 
• Boiler System 

- Furnace 
- Boiler 
- Economizer 

• Steam Cycle 
- Turbines 
Ø High Pressure Turbine (HPT) 
Ø Intermediate Pressure Turbine (IPT) 
Ø Low Pressure Turbine (LPT) 

- Feed Water Heaters (FWHs) 
Ø Drain Cooler (DC) 
Ø Deaerator (DA) 
Ø Low Pressure Feed Water Heaters (LP FWHs) 
Ø High Pressure Feed Water Heaters (HP FWHs) 

- Pumps 
Ø Condensate Extraction Pumps (CEPs) 
Ø Cooling Water Pumps (CWPs) 
Ø Boiler Feed Water Pumps (BFPs) 

- Condenser 
Ø Main Condenser 
Ø Gland Condenser (GC) 

- Mixers 
- Splitters 
- Throttle Valves 
- Steam Ejector. 

 
Three different types of modeling were employed in the Simulator: analytical, adaptive 
analytical, and neural. A description of each follows. 
 
• Analytical Modeling – Based on physical or empirical modeling. Analytical models require 

no updating with time because the performance of the device being modeled does not change 
or changes only very slowly, or there are not adequate online data available to assign the 
changes.  

• Adaptive Analytical Modeling  – Also based on physics, but contains modeling constants 
that can be updated. This was used for systems that change over moderate time frames and 
for which sufficient online data are available to assign the changes. 

• Neural Modeling – Based entirely on measured data and is used for quantities that are 
difficult to model analytically with rapid computational times. Systems modeled neurally 
required a significant amount of validated data over every operating regime. 
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The way in which each of these modeling types was applied to the plant system models 
depended on the information, data, and type of plant system available at Keephills. 
 
Simulator Inputs 
The Simulator was designed to automatically read in the current value for the control setpoints 
from the historian for its calculations. The Simulator also requires Manual Inputs. Manual Inputs 
were important data that are not measured online and hence must be manually entered by the 
user. Most Manual Inputs relate to the cost calculations, but some represented important 
technical information. At Keephills, the Manual Inputs were: 
 
• Mill A Air/Fuel Ratio 
• Mill B Air/Fuel Ratio 
• Mill C Air/Fuel Ratio 
• Mill D Air/Fuel Ratio 
• Mill E Air/Fuel Ratio 
• Mill A Fineness 
• Mill B Fineness 
• Mill C Fineness 
• Mill D Fineness 
• Mill E Fineness 
• Mill Coal Inlet Temperature 
• Outside Air Percentage 
• Outside Air Pressure 
• Outside Air Relative Humidity 
• Inside Air Temperature 
• Inside Air Pressure 
• Inside Air Relative Humidity 
• Seal Air Split 
• Trisector A SA Leakage to Gas 
• Trisector B SA Leakage to Gas 
• Trisector A PA Leakage to SA 
• Trisector B PA Leakage to SA 
• Trisector A PA Leakage to Gas 
• Trisector B PA Leakage to Gas 
• Coal Fixed Unit Cost 
• Coal Incremental Unit Cost 
• Fly Ash Disposal Unit Cost 
• Bottom Ash Disposal Unit Cost 
• Maintenance Unit Cost 
• Operating Unit Cost 
• Administration Unit Cost 
• Lab/Water Treatment Unit Cost 
• Environmental Unit Cost 
• Company Use Unit Cost. 
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The user was given the capability to update the Manual Inputs whenever they changed, which 
was infrequently. Based on the unit costs, which were designed to cover all costs associated with 
generating power including O&M and fixed costs, a detailed cost calculation was possible for 
Keephills. This proved valuable to them for reporting purposes. 
 
Simulator Model Development 
The development of the Optifire Simulator models for Keephills was a joint collaboration 
between the plant and Praxis Engineers. The principal tasks involved in the model development 
included obtaining plant equipment design data and specifications, diagrams for the plant layout, 
design performance data for each system including the controls algorithms, and finally relevant 
historical data for neural models, model tuning, and model comparison and validation. 
 
Most of the plant equipment design data and diagrams for the plant layout were obtained from 
our principal contacts and facilitators at the plant during an initial visit on June 2, 1995. In 
addition, much valuable information was gained from the boiler operators who were interviewed 
during the visit. 
 
Further data and clarifications were obtained via written and e-mail communications throughout 
the project. Another trip to the plant on April 8-12, 1996 enabled finalization of the Optifire 
design data requirements. 
 
Historical boiler and steam cycle performance data from the Bailey Heat Rate Monitor (HRM) 
system was obtained through communications with plant personnel. Emissions data was received 
from a separate data system. Overall, Praxis Engineers received three years of data ranging from 
February 1994 to the end of 1996. These data were used to train neural models, tune analytical 
models, and to compare to the final model calculations to validate their accuracy. 
 
Several unique pieces of equipment at Keephills required special models to be developed. The 
multi-air flow trisector used for air preheating, differs significantly from standard bisectors that 
are used at most coal- fired plants and required an R&D effort to develop the model. The 
economizer, the final stage in the boiler, has a bypass component that the boiler control system 
adjusts to match a PA exit temperature control setpoint entering the mills. This required a 
detailed model for the control system involving several systems. Finally, the steam cycle had 
several pieces of special equipment that required R&D modeling efforts to simulate: the steam 
ejector and the impacts of the demineralizer plant. 
 
Keephills had another unique control mechanism: They were able to control the temperature and 
humidity of their fan inlet air by manually adjusting a damper which partitioned the ratio of air 
taken from the outside with the amount taken from the inside fan room. This turned out to be an 
important control variable that became part of the control setpoints and required a special model, 
with several user-entered Manual Inputs. 
 
Neural Model Development 
Neural modeling is based entirely on measured historical data. Neural modeling computationally 
mimics the nervous system of a biological organism. The system uses inputs (stimuli) to predict 
outputs (responses) based on the training of the system. Training is done by using historical data. 
Stimuli consist of control setpoints and known inputs, while outputs are what is being modeled.  
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During the course of the Simulator development, several models were chosen to be done using 
neural models. These models were chosen based on their difficulty to be modeled analytically 
and the high quality of the historical data that was obtained for each from the plant. The 
quantities that were chosen to be modeled neurally were: 
 
• Stack NOx 
• Stack CO 
• LOI 
• Stack Opacity 
• SH Temperature 
• RH Temperature. 
 
Based on discussions with plant personnel and overall knowledge of boiler operations, the inputs 
into all of the above neural models included the following: 
 
• Gross Load 
• Coal Quality 
• Excess Oxygen 
• Mill Feeder Speeds 
• Mill Exit Temperatures 
• Burner Tilts 
• Overfire Air Damper Positions 
• Fuel/Air Damper Positions 
• Auxiliary Air Damper Positions. 
 
Large sets of data containing the above inputs matched with the parameter to be modeled 
neurally were made—after extensive data validation to eliminate poor data—and used to train 
neural networks for each. 
 
Based on the high quality of the data received for each and the accuracy of the models that were 
developed, it was decided that no special boiler testing was required to improve the operational 
regime the data covered. 
 
The models were developed using a commercial software package called Neuralware, which 
produced actual computer code that could then be fitted into the overall framework.  
 
The neural models were developed in collaboration with an outside subcontractor, Science 
Applications International Corporation (SAIC). 
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Simulator Models 
The following models were implemented in the online version of Optifire at Keephills. The 
modeling method used was either analytical, adaptive analytical, or neural. The required inputs, 
calculated outputs, modeling constants, and constrained variables were developed for each 
system. Operator-controllable setpoints in a particular system were specified. In some cases, 
these setpoints were attributable to more than one modeling system. 

 
1. Air and Gas Handling System 
2. Mill System 
3. Boiler System 
4. ESP System 
5. Stack System 
6. Ash Handling System 
7. Steam Cycle System 
8. Cost Calculations 
9.  Heat Rate Calculations 
 
The flow diagram for the system is shown in Figure 9. 

Figure 9. Flow Diagram for the Keephills Air and Gas Handling System 

The flow diagram for the Keephills steam cycle, shown in Figure 10, provides an indication of 
the level of detail and overall complexity of the model. 
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Figure 10. Keephills Steam Cycle Flow Diagram 

 
Simulator Results 
The overall goal for the development of the Simulator was to produce models that were within 
1% accuracy for predicting heat rate, emissions, and costs. 
 
Each of the equipment models calculations was compared with corresponding measured data to 
validate the model accuracy. An example of the equipment model validation testing is shown in 
Figure 11, which compares trisector model calculations vs. measured data over a range of 
operating conditions, specified by gross load. The overall accuracy of the trisector model was 
found to be within 1%. 
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Figure 11. Comparison of Calculated and Measured Trisector Temperatures for Keephills 

Ultimately, all of the equipment models combine to give an overall accuracy for the Simulator, 
which is determined by how well the model predicts total steam heat consumption at the plant. 
Figure 12 shows the accuracy of the Simulator’s calculation for heat consumption for Keephills 
over the operating range of the boiler. The accuracy attained was within the goal of 1%. 

Figure 12. Comparison of Calculated and Measured Heat Consumption for Keephills 
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important models were the NOx and LOI models. Both were found to be extremely accurate and 
well within the 1% accuracy target, over a wide range of operating conditions and setpoint 
values. Examples of validation testing results for both are shown in Figure 13 and Figure 14. 

Figure 13. Comparison of Calculated and Measured NOx for Keephills 
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Figure 14. Comparison of Calculated and Measured Loss on Ignition (LOI) for Keephills 

The Simulator was used to calculate heat rate and costs, which the plant used for reporting 
purposes. Heat rate has a direct impact on total costs, which is the most important thing the 
Simulator calculates for the Optimizer. Heat rates and costs varied as plant conditions change, 
meaning that the Simulator had to be able to predict their values over the entire operating regime. 
Figure 15 shows actual Simulator results for heat rate and total costs for Keephills over the 
operating range of the boiler, represented by a percentage of the maximum load producible. 
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Figure 15. Heat Rate and Total Costs for Keephills over Operating Range of Boiler 

Optimizer Overview 
The Optimizer was designed to determine the setpoints that result in the least-cost operation of 
the plant while meeting safety, environmental, and operating constraints.  
 
The Optimizer uses the Simulator to perform a series of simulations, each with a different set of 
setpoints in an intelligent and efficient fashion moving toward the optimal set of setpoints. The 
methodology used by the Optimizer to arrive at the optimum setpoints relies heavily on Genetic 
Algorithms (GAs). GAs are an optimization technique that mimics evolution and natural 
selection. In essence, GAs create computational “families” that are allowed to cross breed and 
randomly mutate, with the genes of the strongest families of each generation being passed on to 
the next. Over time, the most dominant or optimum family of setpoints is determined. 
 
The Optimizer also has different types of controllable parameters. Each type has a different use 
and therefore is designed for a different type of user to control. The first and foremost are 
operator-controllable setpoints. The main purpose of Optifire is to recommend optimal setpoints 
for the operator. The optimal value of the setpoints is based on constrained variables, which are 
limits on variables that are set by engineers based on safety standards, equipment limits or 
environmental regulations. 
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The 16 setpoints for Keephills were: 
 
• Mill A Bias 
• Mill B Bias 
• Mill C Bias 
• Mill D Bias 
• Mill E Bias 
• Mill A Exit Temperature 
• Mill B Exit Temperature 
• Mill C Exit Temperature 
• Mill D Exit Temperature 
• Mill E Exit Temperature 
• Excess Oxygen 
• SH Steam Pressure 
• PA Temperature 
• Fan Air Inlet Temperature 
• FD Fan Bias 
• ID Fan Bias. 
 
The 44 constrained variables for Keephills were: 
 
• Furnace Gas Exit Temperature 
• Economizer Gas Inlet Temperature 
• Economizer Gas Exit Temperature 
• Trisector A Cold End Temperature 
• Trisector B Cold End Temperature 
• FD Fan A Inlet Temperature 
• FD Fan B Inlet Temperature 
• PA Fan A Inlet Temperature 
• PA Fan B Inlet Temperature 
• ID Fan A Inlet Temperature 
• ID Fan B Inlet Temperature 
• ESP A Inlet Temperature 
• ESP B Inlet Temperature 
• Economizer Bypass 
• Carbon in Fly Ash 
• Carbon in Bottom Ash 
• FD Fan A Flow Rate 
• FD Fan B Flow Rate 
• PA Fan A Flow Rate 
• PA Fan B Flow Rate 
• ID Fan A Flow Rate 
• ID Fan B Flow Rate 
• ESP A Flow Rate 
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• ESP B Flow Rate 
• Mill A Capacity 
• Mill B Capacity 
• Mill C Capacity 
• Mill D Capacity 
• Mill E Capacity 
• FD Fan A Capacity 
• FD Fan B Capacity 
• PA Fan A Capacity 
• PA Fan B Capacity 
• ID Fan A Capacity 
• ID Fan B Capacity 
• ESP A Capacity 
• ESP B Capacity 
• Stack CO 
• Stack NOx 
• Stack Opacity 
• Stack SO2 
• Loss On Ignition (LOI) 
• SH Steam temperature 
• RH Steam Temperature. 
 
Optimizer Model Development 
The Optimizer was designed to find the set of setpoints that fall within the defined setpoint 
constraints that minimized the objective function. The objective function was defined as follows: 
 

Objective Function = Total Cost ($/hr) + ∑ Penalty Functions 
 
The total cost was simply the sum of all of the fixed and variable costs for the particular set of 
setpoints being investigated. The penalty functions were based on the Constrained Variables, 
special performance variables that are desired to be kept within a minimum and maximum 
constraint. Penalty functions ding setpoint solutions that produced constrained variable values 
outside of their bounds. The weights for the penalty functions were set based on testing. 
 
During the search for the optimum setpoints, the Optimizer methodology had several goals: 
 
• It must be able to handle nonlinear problems 
• It must be able to handle integer or discontinuous setpoints 
• It must reliably find the global minimum 
• It must be fast enough to work in real time, with the goal of completing an optimization in 

less than five minutes. 
 
Significant R&D work was undertaken to develop and test several competing methodologies for 
the optimization technique. Based upon the testing, Genetic Algorithms (GAs) were selected as 
the primary methodology for the Optifire Optimizer. GAs were used primarily for their unique 
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ability to randomly search the entire computational space for the optimum, making GAs the 
technique most likely to find the global optima and not get trapped at a local one. To help speed 
up the process, a unique hybrid optimizer that used conventional analytical techniques once the 
GA gets close to the optimal solution was used. Based on testing, this optimization methodology 
was able to achieve the goal of performing online optimizations in fewer than five minutes. 

PECOS Site-Specific Software Configuration for Keephills Unit 1 (Subtask 2.4.2) 

In this subtask, PECOS core software was configured to the Keephills plant. The configuration 
included: 
 
• Development of the Data Acquisition Module for the Bailey CIU, the Allen Bradley PLC 

(CEM data), and the Aspen Technology CIM/21 Historian and mapping of the plant data to the 
PECOS data points (repeated 3 times for each new Data Acquisition Module) 

• Data validation and translation definitions 
• Design and development of the GUI to represent the software as it applied to the Keephills site 
• Design and development of the PECOS Admin Tool for the administration of PECOS. 

Development of the Data Acquisition Module 

The Data Acquisition Module was designed so that the points and the associated plant tags for 
the points are located in a table in the database. This allows for easy configuration and update. 
Therefore, any updates to the data point mapping—either because new points are added or the 
tags of existing points change—is just a matter of updating the appropriate table in the database 
and reinitializing the Data Acquisition Module. 
 
In addition, the data access interval and information regarding the connection to the plant data 
source is located in the NT Registry. This allows for easy updating of the information without 
having to recode, recompile, and redeploy the executable. The PECOS Admin Tool was developed 
to allow the user to make changes to the NT Registry without the risk of causing problems to the 
computer. 
 
Data from the Bailey CIU were read into R*TIME on the PECOS server using software drivers 
supplied by Moore Engineering. Then the PECOS Data Acquisition Module for R*TIME was used 
to read the data into PECOS. At that time, the PECOS design was such that all plant data would 
come into PECOS through R*TIME regardless of the source. The thinking was that if R*TIME did 
not already exist in the plant, there would be an off-the-shelf solution or driver available that could 
write the data to R*TIME. Therefore, Praxis Engineers would not have to be in the business of 
writing interfaces to various plant data systems. 
 
However, it soon became apparent that Praxis Engineers would have to write software to get the 
data from the various plant data sources to R*TIME, therefore there was no benefit to including the 
intermediate step of pulling data into R*TIME. All further PECOS Data Acquisition Modules were 
written to get data directly from the data source, or as directly as possible. It was no longer 
required that R*TIME be running on the PECOS Host machine. 
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The Data Acquisition Module for the Aspen Technology CIM/21 Historian and the Allen Bradley 
PLC CEM data both used the Matrikon GenCS software and libraries. R*TIME was removed from 
the PECOS Server at this time. 

Creation of Data Validation and Translation Definitions 

The data translations needed for the PECOS installation at Keephills converted the mill feeder 
speed data into tonnes per hour. 
 
The data validations were defined after reviewing several weeks worth of electronic data collected 
and transferred to Praxis Engineers. The data were statistically analyzed, graphed, and fed through 
the models to see their effect. The most useful analysis was playing back the data to the integrated 
PECOS system and seeing how the product worked in real-world conditions. 

Customization of the GUI 

PECOS is a client/server application. This means that the majority of the computation is done on 
the PECOS host machine or server. Commands are sent to the server and data are displayed to the 
user through a PECOS client GUI, which resides on any personal computer connected to the 
PECOS server through the local area or wide area network (LAN or WAN). The only requirements 
are that the client be running Windows 95 or Windows NT, and that both the server and the client 
are running the same protocol, such as TCP/IP.  
 
The PECOS GUI was developed using platform-specific tools, specifically Microsoft Visual C++ 
and the Microsoft Foundation Class (MFC). Though this restricts the product to being able to run 
only on Microsoft Windows machines, it was felt that the benefits of using such a powerful tool 
and the fact that the Microsoft operating system was and is the market leader outweighed any 
limitations. This decision has proved to aid customer acceptance since customers prefer use of 
industry-specific platforms. 
 
The basic PECOS GUI has three panels: a tree view, used for navigation between screens, a log 
view, used to display messages about user activity, and a main view where the data of interest are 
displayed. The customization involves defining which screens are to be displayed in the main view 
and what information and commands the screens will contain. Screen captures of the GUI can be 
seen in Appendix A, CBAS (Coalogic) Software Manual for Keephills Plant, and Appendix B, 
BANCS (Optifire) Software Manual for Keephills Plant. 
 
A prototype of the Keephills customized GUI was developed in the spring of 1996. This prototype 
was shown to control room operators and upper management during a trip to Keephills in June 
1996. Based on feedback and comments gathered during this trip, further enhancements were made 
to the GUI. After installation and initial use of PECOS at the plant, further comments were 
collected from the users and more updates were made. 

Subtask 2.4.3: PECOS Integration and Off-line Testing 

In this subtask, all PECOS software modules were integrated and tested in the off-line mode to 
confirm their correct operation as customized for Keephills Unit 1. The off- line performance 
testing was carried out at Praxis Engineers using canned data logs collected and recorded by the 
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PECOS Host machine already in the field. Testing in the off- line mode continued even after the 
initial installation of the product in June 1996. 
 
This off- line testing resulted in the discovery of many opportunities to improve the accuracy and 
robustness of the models. 

3.5 PECOS Installation and Validation at Keephills Plant (Subtask 2.5) 

Installation and Startup (Subtask 2.5.1) 

Coalogic Installation and Startup 

The Coalogic module of PECOS was installed at Keephills in three phases. The phases are outlined 
below. 
 
Phase 1 – The first phase consisted of installing the PECOS server machine at the plant, 
integrating it into the TransAlta network and installing the PECOS software framework—
including in particular the data acquisition modules—so that data could begin to be obtained from 
the Bailey historian. Praxis Engineers then remotely tested the machine to make certain that the 
PECOS modules were bug-free and performing adequately. Phase 1 was performed during the 
week of April 8, 1996. 
 
Phase 2 – The second phase cons isted of installing the prototype version of Coalogic onto the 
server machine, training the users, and beginning the validation of its performance. Phase 2 was 
performed during two trips to the plant: the Coalogic prototype was installed during the week of 
October 14, 1996, and the finalized test version of Coalogic was installed and operator training 
provided during the week of December 16, 1996. Also as part of this phase, a detailed Coalogic 
User’s Manual was developed and distributed to the Keephills personnel in both hard copy and 
electronic format as a standard Windows Online Help application. After significant revisions were 
made to the Blend Advisor, at the request of Keephills personnel, a revised version of the manual 
was issued in September 1997. The hard copy version of the revised CBAS (Coalogic) User’s 
Manual is attached as Appendix A. 
 
Phase 3 – The final phase consisted of the ongoing upgrade of the Coalogic software to eliminate 
bugs and add functionality deemed necessary based on interactions with and requests from 
Keephills personnel. Upgrades consisted of new versions of the GUI, as well as upgrades in the 
core Coalogic software itself. GUI upgrades were distributed via diskette to all of the Keephills 
users while system upgrades were done remotely. 
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Optifire Installation and Startup 

The Optifire module of PECOS was also installed at Keephills in several phases. The phases are 
outlined below. 
 
Phase 1 – The first phase consisted of installing the PECOS server machine at the plant. Since the 
same server that was installed for Coalogic was also used for Optifire, this phase was performed 
during the week of April 8, 1996. 
 
Phase 2 – The second phase consisted of installing the prototype version of Optifire onto the server 
machine, training the users, and beginning to validate its performance. Phase 2 was performed 
during two trips to the plant: the Optifire prototype was installed during the week of March 16, 
1997, and the finalized test version of Optifire was installed and operator training was provided 
during the week of July 20, 1997. Also as part of this phase, a detailed Optifire User’s Manual was 
developed and distributed to the Keephills personnel in both hard copy and electronic format as a 
standard Windows Online Help application. The hard copy version of the Optifire User’s Manual 
is attached as Appendix B. 
 
Phase 3 – The final phase consisted of ongoing upgrades of the Optifire software to eliminate bugs 
and add functionality deemed necessary based on interactions with and requests from Keephills 
personnel. Upgrades consisted of new versions of the GUI, as well as upgrades in the core Optifire 
software itself. As was the case with Coalogic, GUI upgrades were distributed via diskette to all of 
the Keephills users while system upgrades were done remotely. 

PECOS Training for TransAlta Operators and Engineers (Subtask 2.5.2) 

Coalogic Training 

Formal training in the use of the Coalogic software was provided to Keephills personnel during the 
week of December 16, 1996. Two engineers from Praxis Engineers traveled to Keephills and 
provided hands-on training to each shift of control room operators (for a total of 5 shifts, 
comprising 16 operators and 5 shift supervisors) at computers set up in the control room. This was 
done because it was impossible to coordinate training sessions for operators during their down 
times in any other way. 
 
Each operator and shift supervisor was given a training program lasting several hours, then 
provided the opportunity to ask questions from the trainers who were phys ically in the control 
room the entire week. In addition, several hard copies of the Coalogic manual were given to the 
operators, along with “CBAS (Coalogic) Quick Start” sheets—one-page sheets with step-by-step 
instructions for the most important tasks (attached as Appendix D). 
 
In addition, Praxis Engineers provided training sessions to the Fuel Supply Department that was in 
charge of entering in data associated with coal quality and coal stackout. Special training sessions 
were given at the computer in the Coal Yard Control Room (the “tipple”), as well as at the Fuel 
Supply Department offices. 
 
In all cases, training focused primarily on the specific tasks that each operator was required to 
perform as their part in making Coalogic operate correctly. Examples were given to highlight 
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exactly what tasks needed to be done by each individual. An overview of Coalogic and PECOS, 
including the basic theory behind the software’s recommendations, was also given to each trainee. 
 
On each subsequent trip to Keephills, any personnel who had missed the training performed during 
the week of December 16 were given individual training sessions to get them up to speed on 
Coalogic. 

Optifire Training 

Formal training in the use of the Optifire software at Keephills was performed during the week of 
July 20, 1997. One engineer from Praxis Engineers provided hands-on training to each shift of 
control room operators, for a total of 5 shifts, comprising 16 operators and 5 shift supervisors. As 
with the Coalogic training, computers set up in the control room were used for the training.  
 
Each operator and shift supervisor was given a training program lasting several hours, then 
provided the opportunity to ask questions from the trainer who was physically in the control room 
the entire week. In addition, several hard copies of the Optifire manual were given to the operators, 
along with “BANCS (Optifire) Quick Start” sheets—one-page sheets with step-by-step instructions 
for the most important tasks (attached as Appendix E). 
 
In all cases, training focused primarily on the specific tasks that each operator was required to 
perform to make Optifire operate correctly. Examples were given to highlight exactly what tasks 
needed to be done by each individual. An overview of Optifire and PECOS, inc luding the theory 
behind the calculations, was also given to each trainee. 
 
On each subsequent trip to Keephills, any personnel who missed the training performed during the 
week of July 20 was given an individual training session to get up to speed on Optifire. 

PECOS Testing Online in Advisory Mode at Keephills (Subtask 2.5.3) 

Coalogic Testing 

The online testing of the Coalogic module of PECOS consisted of two tasks: 
 
Remote Checking of the Software through Modem Hook-up to the TransAlta Network – 
Several software tools were created to check to make sure the PECOS system was operating 
properly. In addition, Praxis Engineers performed daily checks to make certain the computational 
models were performing correctly. Based on our testing, it was found that Coalogic was online 
96% of the time. The principal reason for it being off- line was due to loss of connection to the 
Keephills historian, which was not related to PECOS but was a function of glitches in the historian 
communication module. (TransAlta subsequently initiated a program to monitor and reduce these 
historian communication problems.) Several bugs were found out along the way and were remotely 
fixed and upgraded to the PECOS server. This testing has continued through to the present at 
Keephills as part of our long-term maintenance at the site. 
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Assessment of the Blend Recommendations Made by Coalogic – This testing required 
interaction with the operators to make certain that we understood how they had used the software, 
as well as long-term data collection to determine whether Coalogic helped to reduce the problem 
with opacity-related derates that it had been primarily designed to do. To determine exactly how 
the operators were using the software, operators were given log sheets, shown in Table 4 below, 
which they were required to fill out after each use of the software for a blend recommendation 
during their shift. The logs, which were kept for over a full month’s worth of Coalogic operation, 
provided important information for determining how much the operators liked the software, what 
its weaknesses were, how it could be improved, and what benefits it provided to Keephills. 

Table 4. Sample Coalogic Log Sheets 

Are You Following the Blend Recommendations? 
Shift 1 Operators:           
 

Date/Time Yes Blend # No Comments 
     
     
     
     
     
     
     
     

 
Shift 2 Operators:           
 

Date/Time Yes Blend # No Comments 
     
     
     
     
     
     
     
     

 
In addition, a detailed analys is was performed to assess how Coalogic was performing in 
reducing opacity-related derates. Over the short term, Praxis Engineers compared the amount of 
opacity-related derates that occurred when Coalogic was being used with derates that occurred 
when Coalogic was not being used and practices that were used before the installation of 
Coalogic were followed. As seen in Figure 16, derates were significantly reduced when using 
Coalogic. 
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Figure 16. Reduction in Derates at Keephills When Using Coalogic 

Over the long term, Keephills performed their own internal auditing of how well Coalogic was 
performing in reducing opacity-related derates and determined that Coalogic saved them $2 
million in its first year of operation by reducing annual derates from 70,000 MWh to below 
10,000 MWh. 

Optifire Testing 

The online testing of the Optifire module of PECOS consisted of two tasks: 
 
Remote Checking of the Software through Modem Hook-up to the TransAlta Network – The 
remote checking of Optifire was similar in nature to the remote checking of Coalogic. Praxis 
Engineers performed daily checks to make certain the computational models were performing 
correctly. This testing was continued through to the end of Keephills’ use of the Optifire product. 
 
Optifire Acceptance Testing – A complete Optifire Acceptance Test Plan was put together (i) to 
make certain that Optifire was understood, and (ii) to assess whether Optifire was working 
properly. The Optifire Acceptance Test Plan is attached as Appendix F.  
 
The goals of the test plan were to: 
 
• Test the accuracy of the Simulator model predictions 
• Test the accuracy of the Optimizer control setpoint recommendations 
• Discover and fix any bugs 
• Improve the functionality, if deemed necessary 
• Assess the benefits to Keephills. 
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Logs (as shown in the Optifire Acceptance Test Plan) were kept for several month’s worth of 
Optifire operation at Keephills, and provided important information for determining the level of 
operator acceptance of the software, its weaknesses, how it could be improved, and what benefits it 
provided. 
 
Based on the Acceptance Test logs, Praxis Engineers fixed several bugs in the Optifire software, 
improved the way data was graphed, added several performance calculations important to 
managers, and recalibrated several models that were not accurate at lower loads. 
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4.0 DEMONSTRATION OF PECOS AT DAIRYLAND POWER COOPERATIVE’S 

GENOA POWER STATION (TASK 3) 

4.1 Site-Specific Specifications and Requirements (Subtask 3.1) 
Basic specifications, some data acquisition systems, and some site information were already be 
available from the EPRI-funded “Advisory Plant and Environmental Control System” (APECS) 
demonstration. These were used as the starting point for the Genoa specifications. 

Specifications and Requirements Document (Subtask 3.1.1) 

Under this subtask, site-specific specifications and requirements were prepared for the online 
version of PECOS for Unit 3 at Dairyland Power’s Genoa plant.  
 
The specifications defined the functionality of PECOS at Genoa in the following areas: 
 
Optimization Objectives and Constraints – The specifications for the optimization objectives 
and constraints for both Coalogic and Optifire are described in detail in Section 4.4, Subtask 
3.4.1. These specifications were developed after thorough interaction with Dairyland personnel 
to ensure that the products provided the functionality needed to give accurate and reliable 
optimal recommendations without violating any safety, environmental, or operational 
constraints. 
 
Appropriate Subsystem Models  – The subsystem models for Optifire are described in detail in 
Section 4.4, Subtask 3.4.1. Since the work for Coalogic was stalled by the delay in upgrading the 
control system at the plant, only preliminary yard modeling was done. The subsystem models for 
Optifire were sufficiently detailed to accurately model the entire boiler and steam cycle 
operations. 
 
User Interface Requirements – Praxis Engineers used Keephills as a guide for refining a 
generic GUI specification that was applicable to virtually any coal- fired power plant with minor 
customizations, including Genoa. 
 
Data and Instrumentation Requirements – The data required for both Coalogic and Optifire are 
described in detail in Section 4.2, Subtask 3.2. The data specifications were designed to provide 
enough design and performance data for the equipment and processes at the plant to model it 
accurately. In terms of the specification of instrumentation requirements, everything that was 
necessary for Optifire was already in place at the plant, except for a measurement of CO. Because 
of the expense, adding a CO sensor to the CEM was not deemed an option, with the result that we 
had to develop a special model for CO. In the case of Coalogic, on the other hand, the proposed 
upgrade to the plant control system was required to be in place to provide both the online 
instrumentation and coal yard control necessary to enable the product to work. 
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Instrumentation and Host Computer Hardware Requirements (Subtask 3.1.2) 

An IBM-compatible personal computer (PC) was specified and purchased (outside of the subject 
project) to be used as the PECOS Host Computer at Genoa. This computer housed the PECOS 
server, which handled I/O with R*TIME and the WDPF that was installed by Dairyland Power. 
The PECOS Host Computer was configured as follows: 
 

CPU: Dual 180 MHz Pentium Pro 
RAM: 128 MB 
HD: 4 GB 
NIC: Token ring 
Operating System:Microsoft Windows NT Server 4 (Service Pack 2) 
Backup: 1GB Jaz drive 

 
Note that the machine was a clone and not a name brand. This machine was bought and installed 
before we learned the important lesson that name-brand computers should be used. 
 
In addition, an IBM-compatible personal computer (PC) was specified and purchased (again, 
outside of the subject project) to be used as the PECOS data analysis and data playback server. 
When Jaz cartridges and DAT tapes containing PECOS database backups were received from the 
PECOS field installations, the data were restored to this machine. Then the data could be analyzed 
for use in modeling and used to play back the data to the PECOS server as if the data were coming 
from the plant in real time. The PECOS data analysis computer was configured as follows: 
 

CPU: Single 167 MHz Pentium 
RAM: 96 MB 
HD: 6 GB 
Operating System:Microsoft Windows NT Server 4 (Service Pack 2) 
Backup: 1GB Jaz drive and 8mm Tape Backup 

4.2 Data Collection (Subtask 3.2) 
Praxis Engineers prepared detailed lists of the data required for customization of PECOS to the 
specific configuration and performance parameters of Genoa Unit 1. 
 
The required data were divided into two categories: data needed by Coalogic (the Coal Blending 
module) and data needed by Optifire (the Boiler Optimization module), although there is some 
overlap. 
 
We requested—and received—the following Coalogic data from the Genoa plant: 
 
• Layout of the barge unloading facilities 
• Dimensions and layout of the coal yard equipment (conveyors, gates, etc.) 
• Dimensions and layout of the coal yard piles 
• Drawings with dimensions of the coal bunkers 
• Approximate amount of coal in the bunkers when the low and high level lights are tripped 
• Typical minimum and maximum flow rates for the coal pile reclaim feeders and conveyers 
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• Historical data on the amount of coal burned daily 
• Historical coal quality data 
• Blending objectives and constraints. 
 
The information listed above was received in a variety of ways: during plant visits, as a result of 
communications with Dairyland personnel, and during visits by Dairyland personnel to Praxis 
Engineers’ office for strategy discussions. 
 
Several meetings were held to discuss the coal blending strategy for Genoa. This subject was 
discussed in detail as part of Praxis Engineers’ trip to Genoa in May 1997. Coal blending 
strategy was also part of the forum held at Praxis Engineers’ office in September 1997, which 
was attended by Duane Hill from Dairyland and Praxis Engineers’ technical team. 
 
The data related to the Optifire module of PECOS that were requested and received from Genoa 
are shown in Table 5. 

Table 5. Data Received from Genoa Plant for Optifire 

Equipment Modeling Constants and Design Data Historical Data vs. Load 
Mills  • The conversion constant between mill 

amps and mill power (voltage) 
• Tempering air needed vs. mill capacity 

and mill outlet temperature setpoint 
• Limits for the minimum and maximum 

primary air-coal ratio through the mill  
• Maximum coal feed rate for each mill 
• Maximum amount of mill bias possible 

• Feeder speed 
• Inlet and exit air temperature 
• Primary air flow rate 
• Tempering air flow rate 
• Mill and feeder power 

Fans • Fan curves for the FD, ID, and exhauster 
fans 

• Maximum amount of fan bias possible for 
the FD, and ID fans 

• Rated power output 

• Vane position 
• Fan speed 

Air Heaters 
 

• Design heat transfer coefficients 
• Design air and gas mass flow rates 
• Design inlet and exit air and gas 

temperatures 
• Measured air leakages 
• Maximum volumetric capacity 

• Air inlet and exit temperature 
• Gas inlet and exit temperature 
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Boiler • Damper position control curves vs. excess 

oxygen and load 
• Design boiler efficiency vs. load 
• Design excess oxygen vs. load 
• Boiler heat balances vs. load 

• Boiler efficiency 
• Excess oxygen 
• Burner tilts 
• Windbox/furnace DP 
• SOFA and CCOFA damper position 
• Fuel/air damper position 
• Auxiliary air damper position 
• Stack NOx 
• LOI 
• Economizer gas exit temperature 
• Economizer feed water inlet temperature, 

pressure, and flow rate 
• SH steam inlet and exit temperature and 

pressure 
• RH steam inlet and exit temperature and 

pressure 
• SH spray temperature and flow rate 
• RH spray temperature and flow rate 

SO3 Flue Gas 
Conditioning 
System 

• Maximum volumetric capacity for each 
ESP 

• Rated power output 
• Design ESP particle exit concentration vs. 

opacity 

• Opacity 

ESP • Maximum volumetric capacity for each 
ESP 

• Rated power output 
• Design ESP particle exit concentration vs. 

opacity 

• Opacity 

Turbines 
(Each Stage) 

• Design turbine efficiency vs. load 
• Design extraction temperature and 

pressure vs. load 
• Heat balances vs. load 

• Steam inlet and exit temperature, pressure, 
and flow rate 

• Extraction steam exit temperature and 
pressure 

Steam Air 
Heater 

• Design heat transfer coefficient • Steam inlet and exit temperature 
• Air inlet and exit temperature 

Condenser • Design heat transfer coefficient • Back pressure 
• Steam inlet temperature 
• Drain inlet temperature 
• Condensate exit temperature and flow rate 
• Cooling water inlet and exit temperature and 

flow rate 
Pumps • Design efficiency 

• Rated power output 
• Water inlet and exit temperature and pressure 

Feed Water 
Heaters 

• Design TTD and LMTD • Feed water inlet and exit temperature and 
flow rate 

• Steam inlet temperature and pressure 
• Drain inlet and exit temperature 

General Plant 
Data 

• Design heat rates vs. load • Net plant heat rate 
• Net turbine heat rate 
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In addition, the following coal and cost data were obtained and used in the development of the 
Optifire models: 
 
• Coal Data:  

- Complete ultimate (C, H, O, N, S, Cl, Moisture, and Ash), proximate analysis (FC, 
VM, Moisture, and Ash), and ash analysis for each coal type used at the plant 

• General Plant Cost Data: 
- Coal cost rate (coal cost per seam [$/ ton or $/mmBtu], transportation cost [$/ton], 

and handling cost [$/ton]) 
- Ash cost rate (disposal cost [$/ton] or sale rate [$/ton]) 
- Maintenance cost rate [$/kWh] 
- Fixed cost rate (labor, etc.) [$/kWh] 
- Water treatment cost rate [$/flow rate] 
- Generating cost [$/kWh]. 

 
Dairyland Power sent us many diskettes containing data in the form of Excel spreadsheets. These 
data represented normal boiler operation as well as boiler data when different coal blends were 
used. 
 
After the installation of the PECOS server for data collection purposes in May 1997, Praxis 
Engineers began receiving electronic data sets from the DAS representing consecutive days of 
operation. The data were collected at approximately one-minute intervals. 

4.3 Installation of DAS Modifications and Hardware Acquisition (Subtask 3.3) 
In this subtask, the PECOS Host Computer equipment and data acquisition I/O hardware and 
software specified in Subtask 3.1.2 were purchased (under a separate contract), and Dairyland 
installed I/O modifications at Genoa.  
 
The PECOS host computer was installed in May 1997 to collect raw plant data via R*TIME. At 
this time, the data needed for the Coalogic module were not available due to instrumentation 
problems at the plant. However, most of the data needed to proceed with the Optifire module 
development and customization was available. 
 
These data sets were electronically transferred to Praxis Engineers and used to analyze the 
information. Many improvements to the model and modifications to the assumptions used in the 
modeling were made during these “real world” tests. 

4.4 PECOS Customization at Genoa Plant (Subtask 3.4) 

Data Analysis and Model Customization (Subtask 3.4.1) 

In this subtask, electronic plant data sets, historical and design data (collected in the previous 
subtask) and results from the bunker tracer tests were analyzed. Using the collected data, the 
PECOS models were customized to represent Genoa subsystem performance.  
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Customization of Coalogic Models 

The following Coalogic models were to be customized for use at Genoa: 
 
• Coal Tracking Model 
• Bunker Flow Model 
• Blend Advisor. 
 
Customization of the Coal Tracking Model 
The customization of the Coal Tracking Model was never finalized because of delays in upgrading 
the coal yard control system at Genoa. 
 
Customization of the Bunker Flow Model 
The customization of the Bunker Flow Model was to be accomplished using data on the geometry 
of the bunkers, and the geometry and operational modes of loading and discharge points. The data 
to accomplish this task were collected under Subtask 3.2. 
 
In May 1997, Praxis Engineers performed a bunker tracer test to calibrate the Bunker Flow Model. 
The tests consisted of spraying a tracer agent on the coal being fed to the bunker at the tripper 
conveyer gallery. Coal samples were taken at the mill and analyzed at a local laboratory for their 
tracer content. The measured tracer is indicative of how the coal mixes and flows through the 
bunker. 
 
The particular type of test run is termed a “spike test”. For a spike test, only the first half of the 
coal added to the bunker is sprayed. For this test, mass flow would produce a spiked response, 
while funnel flow would produce a gradual rise followed by a slow decay in the measured tracer 
contained in the coal. 
 
The following conclusions were drawn based on the bunker tests performed at Genoa: 
 
• The bunkers exhibit extreme funnel-like flow 
• Significant dead zones were detected visually 
• Characteristic times for the bunker were measured. 
 
Due to project delays at Genoa, the rectangular bunker model was never developed for the Genoa 
site.  
 
Customization of the Blend Advisor 
The Blend Advisor is the module of Coalogic that recommends how to blend coal to reduce fuel 
costs while avoiding derate conditions. The Blend Advisor uses the current state data from the Coal 
Tracking Model, historical unit operations and emissions data, and user inputs. 
 
Based on discussions with Dairyland personnel held during the May 1996 plant trip, it was agreed 
that the goal of the Blend Advisor at Genoa would be to match the heating va lue of the coal being 
fed to the boiler with the predicted power forecast for approximately 12 hours into the future, 
without exceeding sulfur constraints.  
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Genoa was receiving two different coal types in the yard, one a low-cost, low-sulfur, and low-
heating-value Powder River Basin coal, the other a higher-cost, higher-sulfur, higher-heating-value 
Illinois coal. The plant used the same blend of these two coals for all operating conditions during 
the week, which was designed to have a high enough heating value to generate the maximum 
predicted power for the coming week. At lower loads, which Genoa Unit 3 typically generated on 
weeknights and weekends, the mills were capable of using a lower heating value coal without 
derating. Since coal cost scales with heating value, using a “premium” coal blend with a high 
heating value at all loads significantly increased fuel costs. By matching coal quality to load, the 
Blend Advisor recommends coal blends such that the premium blend is fed into the boiler at the 
time of the maximum power generation and coals with lesser heating values—and lower cost—are 
used when the power requirement is lower. The general concept of matching coal quality to load is 
illustrated in Figure 17. 

Figure 17. Matching Coal Quality to Load 

During the May 1996 trip to Genoa, a coal quality control curve was developed to blend the two 
Genoa coals together to reduce fuel costs without causing mill- related or SO2-related derates. The 
coal quality control curve is shown in Figure 18. 

450

Lo
ad

 (
M

W
)

0 4 8 12 16 20
Time (hours)

150

200

250

300

350

400

Load Target

Max Load @
Best Fixed Blend

Use cheaper,
lower quality fuel 
when load is low

Use premium coal to meet
peak  load requirement



Demonstration of an Advanced Integrated Control System for Simultaneous Emissions Reduction   DE-AC22-95PC95254 
Final Report, February 2002  Page 79 
 

Figure 18. Coal Quality Control Curve for Genoa 

The biggest hurdle with this strategy was to get timely data on the predicted power generation for 
the Genoa plant. Dur ing the project, these data were not available. However, discussions were held 
about making the predicted load available to PECOS through the R*TIME system on a timely 
basis. A PECOS GUI screen was designed to allow the user to enter and edit the predicted power 
generation as a function of time. The design that was developed was the basis for projected load 
profile screens used for future applications of the product at similar sites, as shown in Figure 19. 

Figure 19. Design for Projected Load Profile Screen at Genoa 
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Customization of Optifire Models 

The Optifire models customized for use at Genoa include the Simulator and the Optimizer. 
 
Simulator Overview 
The Simulator is a detailed model of every piece of equipment at the Genoa plant. The Simulator 
calculates all of the important performance variables. 
 
The Simulator for Genoa included the following plant systems: 
 
• Coal Handling System 

- Mills 
• Air and Gas Handling System 

- Fans 
Ø Forced Draft Fans 
Ø Mill Exhauster Fans 
Ø Induced Draft Fans 

- Splitters 
- Mixers 
- Air Heaters 
- Stack 

• Ash Handling System 
- SO3 Flue Gas Conditioning System 
- Electro Static Precipitators 

• Boiler System 
- Furnace 
- Boiler 
- Economizer 

• Steam Cycle 
- Turbines 
Ø Very High Pressure Turbine (VHP) 
Ø High Pressure Turbine 
Ø Intermediate Pressure Turbine 
Ø Low Pressure Turbine 
Ø Boiler Feed Pump Turbine (BFPT) 

- Feed Water Heaters 
Ø Drain Cooler 
Ø Deaerator 
Ø Low Pressure Feed Water Heaters 
Ø High Pressure Feed Water Heaters 

- Pumps 
- Condensate Extraction Pumps 
- Cooling Water Pumps 
- Boiler Feed Water Pumps 

- Condensers 
Ø Low Pressure Condenser (LPC) 
Ø High Pressure Condenser (HPC) 
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Ø Auxiliary Condenser (AC) 
Ø Gland Condenser (GC) 

- Mixers 
- Splitters 
- Throttle Valves 
- Steam Air Heater 

 
As described in the section on customization of Optifire models for Keephills, in Section 3.4, 
Subtask 2.4.1, three different types of modeling were employed in the Simulator: analytical, 
adaptive analytical, and neural. The way in which each of these modeling types was applied to 
the plant system models depended on the information, data, and type of plant system available at 
Genoa. 
 
Simulator Inputs 
Types of Simulator inputs were described in detail in Section 3.4, Subtask 2.4.1. At Genoa, the 
Manual Inputs for Optifire were: 
 
• Mill 1 Air/Fuel Ratio 
• Mill 2 Air/Fuel Ratio 
• Mill 3 Air/Fuel Ratio 
• Mill 4 Air/Fuel Ratio 
• Mill 1 Fineness 
• Mill 2 Fineness 
• Mill 3 Fineness 
• Mill 4 Fineness 
• Mill Coal Inlet Temperature 
• Ambient Air Pressure 
• Ambient Air Relative Humidity 
• Coal Fixed Unit Cost 
• Coal Incremental Unit Cost 
• Carbon- in-Ash Sale Limit 
• Ash Disposal Unit Cost 
• Ash Sale Price 
• SO2 Sale Limit 
• SO2Sale Price 
• SO3 Cost 
• Water Treatment Unit Cost 
• O&M Unit Cost 
• Fixed Unit Cost. 
 
Simulator Model Customization 
The customization of the Optifire Simulator models for Genoa was a joint collaboration between 
the plant and Praxis Engineers. The principal tasks involved in the model development included 
obtaining plant equipment design data and specifications, diagrams for the plant layout, design 
performance data for each system including the controls algorithms, and finally relevant 
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historical data for neural models, model tuning, and model comparison and validation. In 
addition, considerable work was done to compare Optifire modeling results with a detailed plant 
simulator (PEPSE) used in-house by Dairyland for performance testing. 
 
Most of the plant equipment design data and diagrams for the plant layout was obtained during 
an initial visit to the plant in July 1995. Duane Hill, our principal contact and facilitator at the 
plant, obtained the data and transmitted it to us. Further data and clarifications were obtained via 
written and e-mail communications throughout the project. Another trip to the plant in May 1997 
enabled finalization of the Optifire design data requirements. During this trip, the detailed 
PEPSE model for the plant was discussed and handed over to Praxis Engineers to be used in 
testing the Optifire models. 
 
While the PEPSE model was used in part to assess Optifire’s modeling accuracy, it was 
primarily used to configure the model setup, particularly on the steam side. This was mainly due 
to the fact that PEPSE’s models, while excellent on the steam side, were insufficient on the 
boiler side due to its lack of detailed furnace and emission modeling. The differences between 
the PEPSE model results and Optifire on the steam cycle modeling were insignificant since the 
models themselves were based on mass and energy balances and therefore were nearly identical. 
 
Historical boiler and steam cycle performance data from the PMAX system were obtained 
through communications with Duane Hill. Overall, Praxis Engineers received a year’s worth of 
data covering the period from January 1995 to December 1995. These data were used to train 
neural models, tune analytical models, and for comparison with the final model calculations to 
validate their accuracy. 
 
Several unique pieces of equipment at Genoa required that special models be developed. The 
steam air heater—used for air preheating before entering the forced draft fans—integrates the 
steam cycle to the boiler side of operations before the boiler itself and required an R&D effort to 
develop the model. An associated control system had to be created for the steam air heater 
because the plant had the choice to have it on or off, requiring a special control setpoint to be 
added to the modeling. 
 
Genoa also had a unique system to combat opacity emissions – an SO3 flue gas conditioning 
system. Because the opacity was modeled neurally for this site, the amount of SO3 injected into 
the flue gas stream, which has a significant impact on opacity, had to be incorporated into the 
model. 
 
Neural Model Development 
Neural modeling was described in detail in Section 3.4, Subtask 2.4.1. The data modeled used 
neural networks at Genoa were: 
• Stack NOx 
• LOI 
• Stack Opacity 
• Economizer Exit Gas Temperature 
• SH Temperature 
• RH Temperature. 
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Based on discussions with plant personnel and overall knowledge of boiler operations, the inputs 
into all of the above neural models were the following: 
 
• Gross Load 
• Excess Oxygen 
• Mill Feed Rates 
• Mill Exit Temperatures 
• Air Heater Gas Inlet Temperatures 
• Burner Tilt Angle 
• Coal Quality (Moisture, Volatile Matter, Ash, Fixed Carbon, Heating Value, and Sulfur) 
• CCOFA Damper Positions 
• SOFA Damper Positions 
• Fuel/Air Damper Positions 
• Auxiliary Air Damper Positions. 
 
Large sets of data containing the above inputs matched with the parameter to be modeled 
neurally were made after extensive data validation to eliminate poor data and used to train neural 
networks for each. Based on the high quality of the data received for each and the accuracy of 
the models that were developed, it was decided that no special boiler testing was required to 
improve the operational regime the data covered. 
 
Simulator Models 
The following models were implemented in the online version of Optifire at Genoa. The 
modeling method used was either analytical, adaptive analytical, or neural. The required inputs, 
calculated outputs, modeling constants, and constrained variables were developed for each 
system. Operator-controllable setpoints in a particular system were specified. In some cases, 
these setpoints were attributable to more than one modeling system. 
 
1. Air and Gas Handling System 
2. Mill System 
3. Boiler System 
4. ESP System 
5. Stack System 
6. Ash Handling System 
7. Steam Cycle System 
8. Cost Calculations 
9. Heat Rate Calculations 
 
The flow diagram for the system is shown in Figure 20. Note that it is intrinsically different from 
the Keephills model and requires a different model framework. 
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Figure 20. Flow Diagram for the Genoa Air and Gas Handling System 

The flow diagram for the Genoa steam cycle is shown in Figure 21. This was considerably 
different from the Keephills steam cycle and required a different model structure to be 
developed. 

Figure 21. Genoa Steam Cycle Flow Diagram 

 
Simulator Results 
The overall goal for the development of the Simulator was to produce models that were within 
1% accuracy for predicting heat rate, emissions, and costs. 
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Each of the equipment models calculations was compared with corresponding measured data to 
validate the accuracy of the models. An example of the equipment model validation testing is 
shown in Figure 22, which compares air heater model calculations vs. measured data over a 
range of operating conditions, specified by gross power output. This figure illustrates the overall 
accuracy of the global heat transfer model that ties together the boiler to the air heater via the 
economizer. The overall accuracy of the models was found to be within 1%. 

Figure 22. Comparison of Calculated and Measured Air Heater Gas Inlet and Exit 

Temperatures for Genoa 

Ultimately, all of the equipment models combine to give an overall accuracy for the Simulator, 
which is determined by how well the model predicts heat rate at the plant. Figure 23 shows the 
accuracy of the Simulator’s calculation for heat rate for Genoa over the operating range of the 
boiler. The accuracy attained was within the goal of 1%. 

Figure 23. Comparison of Calculated and Measured Heat Rate for Genoa 
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Significant testing was done on the neural models used at Genoa, which were deve loped in 
collaboration with SAIC. Two of the most important models were the NOx and opacity models. 
Both were found to be extremely accurate and well within the 1% accuracy target, over a wide 
range of operating conditions and setpoint values. Examples of validation testing results, 
comparing measured vs. calculated results for both, are shown in Figure 24 and Figure 25. 

Figure 24. Comparison of Calculated and Measured NOx for Genoa 

Figure 25. Comparison of Calculated and Measured Opacity for Genoa 
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Optimizer Overview 
The Optimizer design was identical in nature to that used for Keephills and is discussed in 
Section 3.4, Subtask 2.4.1. 
 
The 31 setpoints for Genoa were: 
 
• Fan Room Temperature 
• Mill 1 Hot Air Damper 
• Mill 1 Cold Air Damper 
• Mill 1 Exit Temperature 
• Mill 2 Hot Air Damper 
• Mill 2 Cold Air Damper 
• Mill 2 Exit Temperature 
• Mill 3 Hot Air Damper 
• Mill 3 Cold Air Damper 
• Mill 3 Exit Temperature 
• Mill 4 Hot Air Damper 
• Mill 4 Cold Air Damper 
• Mill 4 Exit Temperature 
• FD Fan Bias 
• ID Fan Bias 
• Excess Oxygen 
• Burner Tilt Angle 
• Lower SOFA Damper Position 
• Middle SOFA Damper Position 
• Upper SOFA Damper Position 
• Lower CCOFA Damper Position 
• Upper CCOFA Damper Position 
• Auxiliary Air AA Damper Position 
• Auxiliary Air AB Damper Position 
• Auxiliary Air BC Damper Position 
• Auxiliary Air CD Damper Position 
• Fuel Air Damper A Position 
• Fuel Air Damper B Position 
• Fuel Air Damper C Position 
• Fuel Air Damper D Position 
• Desuperheater Temperature 
• Secondary SH Temperature. 
 
The 36 constrained variables for Genoa were: 
 
• Furnace Gas Exit Temperature 
• Economizer Gas Inlet Temperature 
• Economizer Gas Exit Temperature 
• Air Heater A Cold End Temperature 
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• Air Heater B Cold End Temperature 
• FD Fan A Inlet Temperature 
• FD Fan B Inlet Temperature 
• ID Fan A Inlet Temperature 
• ID Fan B Inlet Temperature 
• ESP A Inlet Temperature 
• ESP B Inlet Temperature 
• Carbon in Fly Ash 
• Carbon in Bottom Ash 
• FD Fan A Flow Rate 
• FD Fan B Flow Rate 
• ID Fan A Flow Rate 
• ID Fan B Flow Rate 
• ESP A Flow Rate 
• ESP B Flow Rate 
• Mill 1 Capacity 
• Mill 2 Capacity 
• Mill 3 Capacity 
• Mill 4 Capacity 
• FD Fan A Capacity 
• FD Fan B Capacity 
• ID Fan A Capacity 
• ID Fan B Capacity 
• ESP A Capacity 
• ESP B Capacity 
• Stack CO 
• Stack NOx 
• Stack Opacity 
• Stack SO2 
• Loss On Ignition (LOI) 
• SH Steam temperature 
• RH Steam Temperature. 
 
Optimizer Model Development 
The Optimizer model development was identical to that done for Keephills, described in Section 
3.4. 

PECOS Site-Specific Software Configuration for Genoa Unit 1 (Subtask 3.4.2) 

In this subtask, the PECOS core software was configured for the Genoa plant. The configuration 
included: 
 
• Development of the Data Acquisition Module for the R*TIME system and mapping of the 

plant data to the PECOS data points 
• Data validation and translation definitions 
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• Design and development of the GUI to represent the software as it applied to the Genoa site 
• Design and development of the PECOS Admin Tool for the administration of PECOS. 

Development of the Data Acquisition Module 

A Data Acquisition Module was developed to get data from R*TIME and write it to the shared 
memory used by PECOS for further processing. We used an outside subcontractor, Scientech, 
Inc., the authors of R*TIME, to help with this work. 
 
The design of the Data Acquisition Module is the same as that used for Keephills. The data 
points and the tags associated with the data points are defined in the database. The acquisition 
interval is defined in the registry. 

Creation of Data Validation and Translation Definitions 

No data translations were created for Genoa. However, data validation routines were developed for 
all of the online data required for the Optifire module as well as all of the performance data 
calculated by Optifire. 
 
Data validations were developed based on existing boundary checks for measured data that were 
obtained from the site. In addition, the PEPSE modeling developed and maintained by Dairyland 
was given to Praxis Engineers to help develop boundary ranges for performance data calculated by 
Optifire. Finally, the data validation routines that were created were compared to several months 
worth of electronic data collected and transferred to Praxis Engineers. 

Customization of the GUI 

The GUI was never fully customized for the Genoa plant because the core PECOS products were 
never completely installed and key plant data for completion of Coalogic, in particular, were never 
made available. 

PECOS Integration and Off-line Testing (Subtask 3.4.3) 

In this subtask, all the PECOS software modules were to be integrated and tested in the off- line 
mode to confirm their correct operation as customized for Genoa Unit 3. However, because of 
problems with implementation of the project at Genoa, only the Optifire module of PECOS was 
tested. The off- line performance testing was carried out at Praxis Engineers using both canned data 
logs collected and recorded by the PECOS Host machine already in the field, as well as results 
from the detailed off- line PEPSE model employed by Dairyland. 
 
This off- line testing resulted in the discovery of many opportunities to improve the accuracy and 
robustness of the Optifire models. 

4.5 PECOS Installation and Validation at Genoa Plant (Subtask 3.5) 

Installation and Startup (Subtask 3.5.1) 

The PECOS installation and validation at Genoa was never fully completed because of delays in 
the control system upgrade at the plant, necessary for PECOS to work at the site. While the control 
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system was eventually finished, the project was not resumed primarily because of changes in 
personnel and structure at the utility. 

Coalogic Installation and Startup 

The installation of Coalogic at Genoa was intended to be performed in several phases. However, 
because of the delays in the control system upgrade, only Phase 1 was completed. 
 
Phase 1 – The first phase consisted of installation of the PECOS server machine at the plant, its 
integration into the Dairyland Power network and installation of the PECOS software framework, 
including in particular the data acquisition and archive modules so that data could begin to be 
obtained from R*TIME and archived. Praxis Engineers then remotely tested the machine to make 
certain the PECOS modules were bug-free and performing adequately. Phase 1 was performed 
during the week of May 9, 1997. 

Optifire Installation and Startup 

The installation of Optifire at Genoa was also intended to be done in several phases. The phases 
consisted of: 
 
Phase 1 – The first phase consisted of installing the PECOS server machine at the plant. The same 
server installed for Coalogic was used for Optifire. Hence, Phase 1 was performed during the week 
of May 9, 1997. 
 
Phase 2 – The second phase was to consist of installing the prototype version of Optifire onto the 
server machine, training the users, and beginning the validation of its performance. The prototype 
for Optifire was developed and tested at Praxis Engineers but was never installed on the PECOS 
server in the field.  

PECOS Training for Dairyland Power Operators and Engineers (Subtask 3.5.2) 

Coalogic and Optifire Training 

Since neither product was fully installed at Genoa and the plant was not ready with its control 
system upgrades in the timeframe of the Host Site Agreement, no training was performed on-site. 

PECOS Testing Online in Advisory Mode at Genoa (Subtask 3.5.3) 

Coalogic and Optifire Testing 

Remote Checking of the Software through Modem Hook-up to the PECOS Server at Genoa 
– Praxis Engineers periodically dialed into the PECOS server at Genoa and checked to make sure 
the Data Acquisition and Data Archive modules were running and recording data properly. 
PCAnywhere was used to remotely gain control over the PECOS server. 
 
Every few months, someone at the plant was asked to replace the Jaz cartridge and send the old 
one to Praxis Engineers. The Jaz cartridge contained the weekly archives of the data collected. 
These data sets were used in the customization of the models for Genoa. 
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5.0 CONCLUSIONS 

The primary goal of the project was to demonstrate the use of an online software package, “Plant 
Environmental and Cost Optimization System” (PECOS), to optimize the performance of coal-
fired power plants in terms of coal quality control, boiler efficiency, and emissions compliance. 
Praxis Engineers developed PECOS in a two-phase project funded by the DOE SBIR program. 
The purpose of the subject project was to integrate all the modules of PECOS, customize it for 
two sites, and demonstrate its use in the field. 
 
In terms of meeting the primary goal, the project was very successful. Praxis Engineers produced 
an online software package, the “Plant Environmental and Cost Optimization System” (PECOS), 
to focus on its core objectives, cost and emissions—which was successfully installed at 
TransAlta’s Keephills coal- fired power plant. PECOS helped the plant save $2 million annually 
by improving plant performance and reducing opacity-related derates—their principal 
operational problem. The product was so successful that it is still being used at Keephills and has 
been integrally incorporated into their day-to-day operations. Based on the success of this 
project, TransAlta has purchased the software for another of their coal- fired plants, Centralia. 
 
Praxis Engineers has used the experience and technology developed during this project to launch 
two successful commercial products, Coalogic and Optifire. While the models have been updated 
and improved since the end of this project—particularly in terms of the ease of customization—
the core design and technology remain those developed during the original SBIR project, and the 
implementation techniques used are based on the customization techniques that were tested and 
refined during the subject project. Combined, Coalogic and Optifire have been installed in 30 
boilers throughout North America. A further testimony to their potential for success in the 
marketplace is that General Electric invested in the company. In conclusion, the primary goal 
was realized. 
 
Concerning the ultimately unsuccessful application of PECOS to the Genoa Station, a major 
lesson was learned: Choose the sites to install your products carefully. Site participation, 
cooperation, and overall readiness in terms of required instrumentation and infrastructure are all 
essential to the successful installation of these products. Since the end of the project, Praxis 
Engineers has undertaken significant market research to better assess not only which plants have 
an economic case, but also which plants are operationally ready for our software products.  
 
The delay in implementing the plant upgrades at Genoa plant unfortunately derailed the 
installation there, but we have also learned to make fewer assumptions regarding whether a site 
will be ready in a timely fashion. At sites where we have installed since the project, Praxis 
Engineers has taken this lesson to heart and budgeted much more time and effort to work with 
the customer on their tasks to get the site ready, so that our products can be installed on time and 
within budget. We have not had an unsuccessful installation since Genoa. 
 



Demonstration of an Advanced Integrated Control System for Simultaneous Emissions Reduction   DE-AC22-95PC95254 
Final Report, February 2002  Page 92 
 
Other conclusions drawn and lessons learned during the project are summarized below. 
 
• Based on the experience at Keephills, the PECOS team learned customization techniques and 

application approaches to allow PECOS to be able to reduce coal-related derates at virtually 
any coal- fired plant with coal-related derate problems. 

• Based on the experience at Genoa, the PECOS team learned customization techniques and 
application approaches to allow PECOS to be able to reduce fuel costs for coal- fired plants 
that want coal quality to follow load. 

• We met the objective of determining through experience the capabilities of the PECOS 
system and the costs and level of efforts required to customize and install for field 
applications. 

• As a company, Praxis Engineers in general learned that the skills to interact effectively with 
personnel across a wide range of job positions throughout a utility is critical to the successful 
implementation of a broad-based system such as PECOS. The project gave us the experience 
and confidence to foster these skills and put them at the forefront of how the company 
deploys its solutions at customer sites. 

• We learned how to conduct the fact- finding and customer interactions necessary for 
successful customization at a site. 

• We learned how to successfully train a wide range of personnel to use our software products. 
We also learned how to produce useful training materials, User Manuals, and online help 
systems that can be readily customized for any site. 

• We learned that objectives and operating procedures can change rapidly at a plant so our 
products must be flexible enough to adapt. 

• We learned that the  ability of our products to help reduce emissions is highly dependent on 
the circumstances at the plant, including its overall design, operating procedure, and range of 
available coal quality. Because of this, we have softened our emphasis on the environment 
and focus more on the cost reduction aspects of the products—while maintaining a strong 
core capability of the software to help utilities stay within emissions limits while carefully 
balancing the costs of different compliance strategies to help meet or exceed emissions goals. 

• We learned the value of separating the PECOS solution modules (Coalogic and Optifire) for 
individual implementation at sites that need some but not all of the functionality. 

• In general, we learned that the implementation of Optifire is more difficult and less cost 
effective than Coalogic. Thus we follow the approach of treating Optifire (Optifire) 
essentially as an add-on to Coalogic (Coalogic), since Optifire is designed to be more 
accurate when used in conjunction with Coalogic and by design fits seamlessly into the 
overall software structure. 

5.1 Commercial Applications of Coalogic 
Coalogic has been well accepted in the plants where it has been installed. In every case, Praxis 
Engineers has worked with the users to customize the software and the graphical user interface 
(GUI) to the particular needs of the site. In general, operators find the product simple to 
understand and easy to use as it gives them useful information about their system in real time. 
 
A key reason for this customer satisfaction is because the system is well maintained. Praxis 
Engineers can dial into each of our installations from our office to make sure things are working 



Demonstration of an Advanced Integrated Control System for Simultaneous Emissions Reduction   DE-AC22-95PC95254 
Final Report, February 2002  Page 93 
 
properly. Once installed, Coalogic has had a record of being online over 95% of the time at every 
site. When problems do occur, Praxis Engineers typically responds within a very short time – on 
average less than 24 hours. 
 
Because Coalogic is a tool used by many different parties at a plant for different reasons, 
extensive training is provided to each type of user. Praxis Engineers takes particular care to 
ensure that training sessions are both easy to understand and tailored to the specific needs of the 
site. 
 
The best testimony to the power and utility of Coalogic is that every single customer who could 
buy the product for additional plants has come back to do so. 

5.2 Coalogic Customer Case Studies 
Several case studies of actual customer operational experience are presented here, along with 
data from the sites. 

TransAlta’s Centralia Plant 

At TransAlta’s 1340-MW Centralia plant located in central Washington, Coalogic was installed 
in May 2001 and is expected to save $2 million annually from reduced fuel costs and SO2 
emission-related derates. 
 
“Coalogic was a natural choice for the TransAlta Centralia Generation plant because the 
technology has already saved $2 million at another TransAlta facility in Alberta, while enabling 
us to maximize the use of our cheaper, high-sulfur coal through the dynamic coal blending 
capability of Coalogic,” said TransAlta’s Andrew Hickinbotham, Senior Geologist, Coal 
Utilization Research, Fuel Supply. “In the initial design phase, we expect the improved sulfur 
performance and reduction in use of more expensive low-sulfur coals to save $2 million 
annually. Coalogic has been a terrific product because it allows us to burn the right fuels at the 
right time, which is critical in today’s market.” 
 
The Centralia plant will use Coalogic to reduce fuel costs by minimizing the amount of more 
expensive, low-sulfur PRB coal burned in boilers. Leveraging Coalogic, Centralia can more 
productively mix locally mined coal with PRB coal to minimize fuel costs, while still staying 
within SO2 emission limits set by the federal Environmental Protection Agency.  
 
Coalogic delivers real-time, online coal blending recommendations at Centralia that provide 
greater precision in fuel mixing than is currently available. As a result, Coalogic helps eliminate 
on-site mine seam blending—a process that is less cost effective and lacks the same controls that 
Coalogic provides. 

Duke Energy’s Marshall Steam Station 

At Duke Energy’s Marshall Steam Station, a 2,000-MW coal- fired plant with four units located 
near Charlotte, North Carolina, Coalogic was used to blend purchased high-quality, low-ash coal 
with cheaper low-quality, high-ash coal and synfuel without increasing coal-related derates, 
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particularly those related to mills (insufficient Btu) and opacity, thereby significantly reducing 
fuel costs. 
 
Each unit at Marshall typically drops load for 6-8 hours each night and for approximately 20 
hours on weekends. Using Coalogic, the cheaper high-ash coal and synfuel can be used at lower 
loads while the higher quality coal is used at full load. The coals are properly timed so that when 
load begins to pick up in the morning, the higher quality coal begins to arrive in the boiler 
thereby ensuring that no derates occur. Similarly, Coalogic ensures that only when the load is 
low, the lower quality fuels are used in the proper proportions to eliminate derates and minimize 
fuel costs. Doing this, the plant is capable of saving $2 million in fuel costs annually. 
 
To prove the concept that Coalogic will provide the right coal to the burners at the right time, 
Duke Energy undertook extensive acceptance testing of the product. The tests consisted of 
loading coals of different ash quality into the bunkers at different times and measuring the 
exiting coal ash content at the mill. The measured ash samples were then compared to the ash 
predictions of Coalogic to prove the concept that Coalogic accurately tracks the coal quality to 
the burners. The results of one of the acceptance tests are shown in Figure 26 below. The 
calculated ash was within 95% accuracy of the measured ash at all times during the test. 

Figure 26. Acceptance Test Results at Duke Energy’s Marshall Plant 
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A Plant at an Unnamed Utility 

At an unnamed utility (they cannot be named because, for competitive reasons, they have a 
confidentiality agreement with us) in the Eastern US, Coalogic was first installed at a single plant 
to blend purchased high-quality, low-ash coal with cheaper low-quality, high-ash coal without 
increasing coal-related derates, particularly those related to ash erosion on the back end of the 
boiler, significantly reducing fuel costs. 
 
Each unit at the plant typically drops load for 6-8 hours each night and for approximately 20 
hours on weekends. Using Coalogic, the cheaper high-ash coal can be used at lower loads while 
the higher quality coal is  used at full load. The coals are properly timed so that when load begins 
to pick up in the morning, the higher-quality coal begins to arrive in the boiler so that no derates 
occur. Similarly, Coalogic ensures that only when the load is low, the lower-quality fuels are 
used in the proper proportions to eliminate derates and minimize fuel costs. Doing this, the utility 
has saved $1 million in fuel costs per 1000 MW annually. 
 
To prove the concept that Coalogic provides the right coal to the burners at the right time, the 
unnamed utility undertook extensive acceptance testing of the product. The tests consisted of 
providing a projected load profile describing the change in operating conditions for the unit and 
having Coalogic calculate the required coal loadings to achieve least-cost operation. Based on 
the given load profile, shown in Figure 2, Coalogic recommended first loading high-quality low-
ash coal at the proper time and in the right amount to catch the upcoming load increase, then 
recommended a second loading of lower-quality, higher-ash coal to catch the subsequent load 
drop. The plant then measured the coal ash content at the mills and compared them with the ash 
predictions of Coalogic. 
 
As seen in Figure 27, the resulting operation during the test displayed perfect performance as the 
coal quality changes appropriately with load profile, thereby maximizing the use of cheap coal 
without causing any fuel-related derates. During the test, the calculated ash was within 95% 
accuracy of the measured ash at all times. Based on the results of this test, the unnamed utility 
ordered Coalogic for all of the other plants it owns. 
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Figure 27. Acceptance Test Results at Unnamed Utility Plant 

The savings figures for Coalogic over an extended period of time have been impressive at this 
utility. As seen in Figure 28, at one of the units, Coalogic allowed a significant increase in cheap 
coal usage compared to what the plant could do on their own. On average, the unit was using 
17 GBtu more cheap coal without increasing derates with Coalogic in place. This represents 
roughly $17,000 savings per day. 

Figure 28. Energy Savings from Using Cheaper Coals with Coalogic at Unnamed Utility Unit
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LIST OF ACRONYMS AND ABBREVIATIONS 

APECS Advisory Plant and Environmental Control System, in development by EPRI but 
development was discontinued before maturity 

BANCS Boiler And NOx Control System, one of the main solution modules of PECOS. 
BANCS has recently been renamed to Optifire. 

CBAS Coal Blend Automation System, one of the main solution modules of PECOS. 
CBAS has recently been renamed to Coalogic. 

CEM Continuous emissions monitor 
CIU Computer interface unit  
Coalogic New name for CBAS 
CPU Central processing unit 
DAS Data acquisition system 
DOE U.S. Department of Energy 
EPRI Electric Power Research Institute 
ESP Electrostatic precipitator 
GA Genetic algorithm 
GUI Graphical user interface 
HRM Heat rate monitor 
LAN Local area network 
LOI Loss on ignition 
NETL National Energy Technology Laboratory 
ODBC Open Database Connectivity 
OLE Object Linking and Embedding 
Optifire New name for BANCS 
PECOS Plant Environmental and Cost Optimization System, new name for SOCS as of 

mid-1996 
PEPSE Modeling tool for electric generators to perform integrated heat balances for power 

plants, owned by SCIENTECH Incorporated 
PMAX On-line power plant performance monitoring software, owned by SCIENTECH 

Incorporated  
PRB Powder River Basin coal 
RAM Random access memory 
RH Reheat 
R*TIME Real-Time Information System, owned by SCIENTECH Incorporated  
SH Super-heat 
SBIR Small Business Initiative Research, a DOE-sponsored research program 
SOCS Supervisory Optimization and Control System, a product developed by Praxis 

Engineers with funding from the DOE SBIR program. SOCS was renamed to 
PECOS in mid-1996. 

SQL Structured Query Language 
UPS Uninterruptible power supply 
WAN Wide area network 
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Introduction

Description of PECOS
The Plant Environmental and Cost Optimization System (PECOSJ) is an advisory
software system whose purpose is to recommend coal blends and least-cost control
system setpoints to the plant operator.  The operator will be able to minimize overall
power production costs while meeting load, staying within emissions requirements,
and observing safety and operational constraints.

PECOS also makes available information to the operators that is generally not known,
such as the properties of the coal currently being burned in the boiler.  PECOS is
designed for real-time use by operators in fossil-fired power plants.

PECOS consists of several modules:

• Coal Blend Automation System (CBAS)

• Boiler and NOx Control System (BANCS)

• Steam CYCLe OPtimization System (SCYCLOPS).

An installation of PECOS may include one or more of these modules.  Each module
consists of a model of the system and produces recommended actions for the
operator.

PECOS offers a variety of features, including:

• User-friendliness

• A powerful and versatile graphics display

• Real-time data collection

• LAN/WAN-based operation, allowing use by operators, engineers, and
managers throughout the utility.

Note: This installation of PECOS includes only the CBAS module.

Brief Overview of CBAS
The Coal Blend Automation System (CBAS) is an on-line operator tool for optimal
blend management. CBAS is designed to aid in cost reduction and avoidance of
derates or operational problems due to fuel quality in real time.  It is part of PECOS, an
on-line system that assists the operator in selecting the mix of plant control setpoints
which meet load, emissions, and operational constraints at the lowest generation
cost.

There are four major components of CBAS which allow it to assist with blend
management:
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• Coal Tracking Model tracks coal through the entire coal handling
system from receipts to the mills, and displays the coal amounts and
quality in the piles and bunkers.

• Coal Pile Model tracks the flow and storage of coal in the piles during
normal operation and during turnover.

• Silo Flow Model tracks the flow and storage of coal in the bunkers.

• Coal Blend Advisor is blending strategy software which works with the
information provided by the Coal Tracking Model to make use of the
segregated coal pile.

The benefits of CBAS include:

• Continual updating of the Coal Pile Model (using on-line syntron
operation and belt-scale data).  This reduces the odds of the coal not
being available when and where expected.

• Automated coal blend and syntron operation advice which can be
updated whenever coal availability, plant requirements, or handling
system equipment status change.

• Continually updated displays of the coal in the piles and bunkers,
showing both amounts and quality distributions at each feeder and
bunker.  This allows the operator to always be aware of the availability
of various coals.

• The ability to add blend control for additional coal-related parameters,
such as heating value for high load periods, SO2, and NOx.  All
parameters are considered in the blending recommendation.

• The ability to adapt advice to shifting coal qualities from the mine.

Organization
This User’s Guide is intended to assist you in learning how to use the PECOS and
take full advantage of the program’s capabilities. The Guide includes the following
sections:

Getting Started. An introduction to PECOS designed to get new users up and
running in a short period of time.

A brief tutorial based on how different CBAS users might use the software.

Using the Software. A reference to the commands and options available in PECOS.

CBAS Software. A description of the Coal Blend Automation System (CBAS) user
interface.

CBAS Technical Description. A discussion of the background of CBAS and the
theory behind the software.

Glossary. An explanation of the terms used in PECOS and the User’s Manual.

Index. An index of items users can look up in the manual.
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New users may want to consider reading the “Getting Started” section first, followed
by any part of the “A Tutorial on CBAS” section.

About this Manual
Special typefaces are used in this manual to help you distinguish between menu
commands, keys that you press, data that you type, and terminology found in the
glossary.

Table 1.  Printing Conventions Used in This Manual

Convention Applies to Examples

Bold Menu commands and button
names

To open a new file, choose
File, New from the File
Menu

Italic Terms explained in the
glossary at the end of this
manual

menubar, toolbar, button

“Quotation marks” PECOS data entry and dialog
box titles and names

“Time Period” box

Arial font Keys on your computer’s
keyboard

Shift, Ctrl, Alt, F1
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Getting Started

Introduction to Getting Started
This section provides a description of the minimum hardware and software required
to run PECOS, describes how to install the software, and indicates the basic
operations needed to start and exit the program.  It also provides an overview of the
basic navigational skills needed to access and view data.

PECOS is a client-server application.  Users work with PECOS through the PECOS
client program (the user interface) on a PC at their desks or workstations. Throughout
the remainder of this manual, PECOS is used to mean the PECOS client user interface.

Hardware And Software Requirements
PECOS is a client-server application.  Users work with PECOS through the PECOS
client program (the user interface) on a PC at their desks or workstations.  The PECOS
client (the user interface) is designed to run on a 486 DX2/66 or higher IBM-
compatible computer running Microsoft Windows 95 or Windows NT 3.51 or later.
The following are required to work with the PECOS client user interface:

• A hard disk and one diskette drive.  You need approximately 10
megabytes of hard disk space to install the PECOS client

• A minimum of 16 MB of random-access memory (RAM)

• A Super VGA monitor with at least 800 x 600 resolution and at least
1 megabyte video memory

• A printer if you plan to produce hardcopy output

• A Microsoft or 100%-compatible mouse.

Installing the Software
PECOS will be installed and configured at your site by Praxis Engineers, Inc.
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Known Problems
The following problems have been reported:

• There are no units defined for the Expected Coal Delivery.  The units of
Expected Coal Delivery are tonnes.

• When changes are made to the Expected Coal Delivery or the Undo
Receipt and the Cancel Changes command is given, the user is not
asked to confirm the cancellation of changes.

• When the Log window is selected, the Cut and Paste commands look
active (are not grayed out), but are not active.

• If many small (100 tonnes or less) coal receipts are entered, the coal pile
stops responding to further coal receipts.

Getting Technical Support
If you are unable to resolve a technical problem using the information in this User’s
Manual, contact  Praxis Engineers, Inc. at (408) 945-4282 (tel), or (408) 263-2821 (fax),
or support@praxisengineers.com (E-mail).

Starting and Exiting PECOS
Using PECOS effectively requires some knowledge of how to use Windows.

To start PECOS in Windows NT 3.51, open the PECOS Group in Program Manager
and double-click the PECOS icon.

To start PECOS in Windows 95 or Windows NT 4.0, from the Start menu click on
Programs, and then PECOS.

The introductory screen specifying the version of the software briefly appears.  There
may be a delay of a few seconds while the client receives current data from the server.

To exit PECOS, double-click the control menu box (in Windows NT 3.51), click on the
close box in the top right hand corner (in Windows NT 4.0 and Windows 95), or
choose the Exit command from the File menu.

Security
The current version of PECOS does not ask for a username and password.  This
functionality will be included in future versions of the software.  However, a
password is needed to get into edit mode.

PECOS Screen Design
When PECOS starts up, you will see that the main PECOS window is divided into
three sub-windows:
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• Main View window

• Tree View window

• Log window

 

All of the windows can be resized.

Main View Window
The Main View window takes up most of the screen and displays the data, diagrams,
graphs and advice.  The user decides what is displayed in the window through the
Tree View window.  The user also has some control over how the data are displayed
(usually found under the View menu).  See the section on any specific view for more
details.

Tree View Window
The Tree View window is located on the left side of the screen.  Through the Tree
View window, the user defines what is seen in the Main View window.  Detailed
directions on how to access information using the Tree View window are found in
“Using the Software:Tree View Window” on page 25 in the “Using the Software”
section.
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Log Window
The Log window is located at the bottom of the screen and displays information on
what PECOS is doing.  A typical example of a Log window message is “Receiving
1000 tonnes of Seam 4 in syntron 9...” followed by “Transaction completed”.  This
message is displayed after the user has entered a coal receipt.  Any program error
messages are displayed in this window.
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A Tutorial on CBAS

Overview of the Tutorial
This section provides a short tutorial on how the CBAS software module of PECOS is
used on a typical day.  It is meant to get users of CBAS up and running quickly.  The
features and capabilities of CBAS are described in more detail in the remaining
sections of the manual.
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First, as a CBAS user, make sure that the Tree View window is displaying the CBAS
pane.  The Tree View window is the window located at the left.  This is done by
clicking on the CBAS tab at the top of the Tree View window.  This brings up a list of
CBAS topics that can be displayed in the Main View window.

Viewing Data
CBAS displays the following data:

• Coal pile status, including coal quality

• Bunker status, including coal quality and amount of coal in the bunkers

• Properties of the coal being used in the boiler

• Real-time on-line coal handling system data, such as weigh scale
readings, on/off status of syntrons and diverter gate positions

• Coal blending recommendation.

The user has the ability to adjust the views to some extent and to access more
detailed information about some items.  In this lesson, we will view the coal pile,
adjust the view of the coal pile, and view the bunkers.

Viewing the Coal Pile
The first thing we will look at is the state of the coal pile.

 

To view the coal pile, click on the “+” sign in front of Coal Pile folder in the Tree View
window.  This will expand the folder to list all of the available coal piles.  Since there is
only one coal pile at Keephills, there is only one coal pile listed—“Pile 1”.

Next, double-click on the “Pile 1” item name.  This brings up a view of the coal pile in
the Main View window.
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The coal pile is displayed in
the Main View window when
you double-click on the
“Pile 1” item in the “Coal
Piles” folder.

The default view of the coal pile displays only the live coal.  The colors in the pile
represent different coals by properties.  The default view is to display the pile color-
coded by seam number. There are several ways to adjust the view of the coal pile
using the commands under the View menu.  The next section of the tutorial, “If you
have brought up the Blend Recommendations Table, go back to the Coal Table by
clicking on the Coal Table button.

Adjusting the Coal Pile View”, covers this.

The layers in the coal pile represent the order in which the coal is removed from the
pile.  The bottom layer of coal will come out of the pile first, the second-to-lowest
layer comes out next, etc.  More detailed information about each coal layer is
accessed by placing the mouse arrow above a layer. A balloon box appears listing
the coal properties of that layer.

The balloon gives detailed
information about the coal in
the layer at which the mouse
pointer is pointing.

The table above the coal pile is a summary of the live coal on top of each syntron.
The last column in the table shows the total values for the live coal in the pile.

Blend Advice button

The recommendations calculated by the Coal Blend Advisor are accessed by clicking
on the Blend Advice  button at the bottom of the screen.
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If you have brought up the Blend Recommendations Table, go back to the Coal Table
by clicking on the Coal Table button.

Adjusting the Coal Pile View
It is possible to display the coal pile with respect to coal properties rather than seam
number.  We will now view the coal pile in terms of heating value.

To display the coal pile color-coded by the heating value of the coal, click on the
View menu to list the menu options under View.  Then click on by HV.  The view of
the coal pile and the summary table in the Main View window change to reflect the
heating value of the coal.

To adjust the ranges of the heating value, choose the Coal Property View
Ranges command from the Options menu.  From the list of properties, click on HV.
The “Setup Property Range” dialog box appears.

Enter the minimum and maximum values for the heating value.  The total range is
automatically divided into five parts.  The first division refers to values less than the
minimum, the last to values greater than the maximum, and the three sections in the
middle are divided equally.

Click on OK after you have entered the new minimum and maximum values.  The
results are displayed in the color coding of the pile and the summary table above the
pile immediately.

Another coal pile view adjustment is to make the entire coal pile visible— dead coal
as well as live coal.
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View Dead Coal button

To view the dead coal, choose Dead Coal under the View menu or click on the
View Dead Coal button on the toolbar.  The resulting display shows the dead
coal as well as the live coal.

Viewing the Bunkers
Now we will take a look at the bunkers.

To display the Bunker Overview data, click on the “+” sign in front of the Bunkers
folder.  Choose the “Bunker Overview” item by double-clicking on the name.

A view of all of the bunkers is displayed in the Main View window.



14  •  A Tutorial on CBAS A Guide to Using PECOS

The layers represent the
order in which the coal will
be withdrawn from the
bunkers.  They are color-
coded by seam number.

The circles to the left of each bunker represent the high and low level “lights”.

The number below each bunker is the feeder speed, representing the flow of coal from
the bunker to the mill.

The properties listed below the bunkers are the mass averaged properties of the coal
feeding the boiler from all mills currently running.

The coal in the bunkers is color-coded by seam.  The layers represent the order in
which the coal will be discharged from the bunkers (similar to the layers in the coal
pile).

More detailed information about each layer of coal can be obtained by placing the
mouse pointer over the layer of coal.  A balloon appears, showing the properties of
the coal in that layer.

Each bunker can be viewed individually by clicking on the bunker name from under
the “Bunkers” folder in the Tree View window or by clicking on the desired bunker in
the “Bunker Overview” screen.
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In the views of individual bunkers, the properties of the coal currently going to the
mill from that bunker are shown.  Also shown is the status of the bunker’s high and
low level lights.

Coal Pile Data Entry
There are a few different options for data entry.  Most of the data entry is done when
the coal pile is displayed in the Main View window.  So before we begin with the data
entry lesson, make sure the coal pile is shown in the Main View window by clicking
on the “Pile 1” item under the “Coal Piles” folder.

In this lesson, we will edit seam 1 coal properties and record the receipt of Seam 1 and
Seam 3 coal.  Then we will adjust the amount of coal in the free flow above syntron 1.

Editing Coal Quality Data
The coal quality values describe the coal that is to be received.  These data must be
entered manually.

 Start Edit Button
To change the properties of the coal, the program must be put in edit mode.  To do
this, click on the Start Edit button or choose the Start Edit command from the Edit
menu.

A dialog box appears requesting a password.  Type in the password and click on OK.
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The summary table disappears and is replaced with six buttons—Coal Receipt,
Coal Quality, Exp Delivery, Adjustment, Turnover, and Undo Receipt.

Click on the Coal Quality button to bring up the “Coal Quality” data entry dialog
box.  Choose the appropriate seam number.  This is done by clicking on the down
arrow next to the “Seam #” edit box to display a drop down list of seam numbers.

In this lesson, we are editing the properties of Seam 1.  Choose Seam 1 from the drop
down list.

Move the mouse to the Opacity Potential box and click once.  A cursor appears in the
box.  Replace the current value with 20.0.

When you are done, click on the OK button.

The newly entered coal qualities are used for newly received coal.  The changes made
to the coal qualities do not affect the coal already in the pile or in the bunkers.

Entering Coal Receipt Data
Since coal receipt is not automatically measured, it is necessary to enter the data
manually.  The data that are entered include the seam number, amount, and loading
location.  It is important that the coal receipt data be entered close to the actual time
of coal receipt.

We will be recording the receipt of 3000 tonnes of Seam 1 coal at loading point 3, and
2500 tonnes of Seam 3 coal at loading point 5.
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To enter coal receipt data, click on the Coal Receipt button.  The “Seam Number
Selection” dialog box appears first.  At this point, the user chooses the seam that has
been delivered.  Only one seam can be “delivered” at a time.

Select “Seam 1” and click on the OK button.

The “Coal Receipt” dialog box appears. Since the coal was placed above syntron 3 (or
loading point 3), specify the loading point by clicking on the left or right arrow until 3
is displayed in the “Load Point” edit box.

Type in the amount of coal loaded at the location—3000 tonnes.  The dialog box
should look like this:

Coal can be received at several loading points. To load coal at another location, click
on the left or right arrows again to move the next loading point and enter the tonnage
delivered to the second location.  No more Seam 1 coal was delivered at this time, so
we don’t need to do this.

Repeat the coal receipt for Seam 3.  Start by clicking on the Coal Receipt button.
The final “Coal Receipt” dialog box should look like this:

Click on OK.
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 Save Changes Button
Now that the  data entry is complete, it is important to exit the edit mode and to
save the changes.  This is done by clicking on the Save Changes button or by
selecting the Save Changes command from the Edit menu.

The coal receipt data entries are listed in the Log window.

The coal receipt does not appear on the screen immediately after the Save Changes
command is given.  The command to load the coal onto the pile is immediately sent to
the Coal Pile Model, but the results of the coal receipt may take up to 30 seconds to
return to the user interface.

Adjusting the Coal Pile
If you compare the actual coal pile to the coal pile modeled by CBAS and find that the
amount of coal in the actual pile differs from the amount of coal that CBAS thinks is in
the pile, the pile model will need to be adjusted.  The discrepancy may be due to
slightly incorrect coal receipt data entry or because an automatically recorded signal
is not accurate (such as syntron feeder speed).

 Start Edit Button
First, the program must be put into edit mode again.  This is done by clicking on the
Start Edit button, or by choosing the Start Edit command from the Edit menu.

Enter the password when the “Password” dialog box appears and click on OK.

The summary table above the coal pile disappears and is replaced by the six coal pile
edit buttons.

To make an adjustment, begin by clicking on the Adjustment button. The “Coal Pile
Adjustments” dialog box appears.

Different syntrons are accessed through the drop down list.  The number shown in
the “% full” edit box when the “Coal Pile Adjustments” dialog box is first opened is
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the percentage of coal in the live pile above each syntron as determined by the Coal
Pile Model.  The number that needs to be entered is the actual percentage of coal in
the live pile over the syntron.

Adjustments should only be made for live piles (syntrons) that seem significantly
incorrect.

For this lesson, select “1” from the drop down list.  Change the existing value to make
the pile above syntron 1 60% full.  Click on OK.  This records the adjustment locally
and closes the “Coal Pile Adjustments” dialog box.

 Save Changes Button
In order the send the Coal Pile Adjustments to the Coal Pile Model, it is necessary to
save the changes by clicking on the Save Changes button or by choosing the
Save Changes command from the Edit menu.

The adjustment does not appear on the screen immediately after the Save Changes
command is given.  The command to adjust the pile is immediately sent to the Coal
Pile Model, but the results of the adjustment calculation may take up to 30 seconds to
return to the user interface.  However, the Log window immediately displays the data
that are sent to the server.

For information on how the adjustment is made in the Coal Pile Model, see the section
“Coal Pile Adjustments” on page 56.

Editing Blend Advisor Parameters

Blend Advice button

To view the table which lists all of the coal blend recommendations, click on the
Blend Advice button in the bottom left hand corner of the Coal Pile Main View
window.

The Coal Pile table is replaced with the Blend Recommendations Table, which lists the
top ten recommended blends calculated by the Coal Blend Advisor.
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The recommended blends are calculated based on the on-line information received by
PECOS as well as the constraints and options specified by the user.  In this exercise,
the user will learn how to adjust the Blend Advisor options.

To access the Blend Advisor options, click on the Options button which appears
when the table of blend recommendations is displayed above the coal pile.
Alternatively, click on Options on the menu bar and choose Coal Blend Advisor.
This causes the “Blending Options Setup” window to appear.

There are three sections in the “Blending Options Setup” window:

• Type of solution to be recommended

• Goals and constraints the solution ahould achieve and adhere to

• Syntron status.

The options that define the type of solution include how many syntrons to use,
whether to fix a syntron, and whether the flows of the syntrons should be equal.

The goals and constraints include the predicted average power to be generated in the
next four hours, the opacity limit, and the minimum heating value from the blend.

The syntron status options include specifying the operational status of the syntrons
and specifying a minimum and maximum flow for each syntron.

Fixing a Syntron
Sometimes it is desirable to force the Blend Advisor to use a particular syntron.  For
example, if it is known that the space above syntron #1 should be emptied, the user
can tell the Blend Advisor to include syntron #1 in all of its recommendations.

To specify that syntron #1 should be used, after “Fixed Syntron:” in the “Blending
Options Setup” window, choose “1” from the dropdown list.  Click on OK.
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The “Blending Options Setup” window closes and a recalculation of the blend
recommendations is automatically performed.  The new results are displayed in the
table.

Specifying the Number of Syntrons
Assume that the east belt has been shut down for maintenance, making it necessary
to use three syntrons.  Click on the Options button to bring up the “Blend Options
Setup” window.  From the dropdown list next to “Number of Syntrons:” choose “3”.
Click on OK.

The Blend Advisor automatically recalculates the recommendations and the new
results are displayed.

Note that each recommendation now includes three syntrons with syntron #1 as one
of the syntrons.

Tagging Out a Syntron
Sometimes it is desirable to specify which syntron should not be used.  For example, a
syntron may be out of service.

In this exercise, we will turn off syntron #9.  Click on the Options button.  In the
Syntron Status section, click on the x in front of #9.  The x disappears and the
Operational status turns to “No”.  Click on OK.
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The Blend Recommendations Table now lists blends with three syntrons that do not
include syntron #9 but do include syntron #1.  Also note that an “X” appears under
syntron #9 indicating that it is not used in the blend recommendation calculations.

The tagging out of syntron #9 has no effect on the Coal Tracking model.  It only
effects the Coal Blend Advisor and the recommendations it makes.

A possible source of confusion is that there are two syntrons at each of the nine
locations in the pile, but there is only one “on/off” switch for each syntron.  This is
because the Blend Advisor treats each pile location as a single entity.  If either the
east or the west syntron in a single location is operational, the Blend Advisor can
recommend the use of that syntron.
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Using the Software

OverviewBasic Navigation

This section provides general instructions about the use of PECOS. Details of the
application of its Coal Blending Automation functionality are given in “CBAS
Software” on page 31.

Commands and navigation in PECOS are accomplished using the menubar, the
toolbar, and the Tree View window.  All commands and functions are available from
the menubar, and the toolbar provides buttons to accomplish the most used tasks.

Most of the details in this section are repeated in the On-Line Help and can be
accessed using the Help menu.

Using the Software:Tree View Window
The Tree View window is located at the left side of the screen.  Through the Tree
View window, the user defines what is seen in the Main View window.

Each PECOS module is located in a different pane of the Tree View window and is
accessed by clicking on the tab at the top of the window.  Only the tabs for those
modules installed at your site are visible.  For example, if your site has CBAS and
BANCS, the tabs at the top of the Tree View window include CBAS and BANCS.

The Tree View window displays data relationships in the modules. You can access
information about the modules from the panes. To access items for viewing in the
Main View window, expand a folder (such as “Coal Piles” or “Bunkers”) by clicking
on the “+” to the left of the topic or by double-clicking on the folder.
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Double-clicking on the name of the item you wish to view (such as “Overview
Diagram”) brings up that item in the Main View window.

The Tree View window can be resized by dragging its borders.

The Menubar
The menubar is a standard Windows-type menu located at the top of the screen
below the title bar.

Each menu can be accessed by clicking its title or by pressing Alt + the underlined
letter of the title. For example, to access the View menu, press Alt + V. Each
command within a menu can be executed by clicking it, or by typing the underlined
letter in its title. For example, to choose the Exit command from the File menu, open
the File menu and then type x.

File menu
The File menu contains some of the standard Windows commands for file
management. The Print command prints the current window.  Only the Log window
can be printed in this version of PECOS.

Edit menu
The Edit menu contains standard editing features such as Copy, Cut, and Paste.
The Edit menu also contains the commands for Start Edit, Save Changes,
Cancel Changes and Startup Adjustment.

When editing the Coal Pile data in this version of PECOS, the toolbar and menu
cannot be accessed.  However, the Copy, Cut, and Paste commands can still be
used by employing the Windows-standard short-cut key stroke combinations.  For
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Copy, the short-cut key stroke combination is Ctrl-C, Cut is Ctrl-X, and Paste is
Ctrl-V.

The Start Edit command is used to begin data entry.  The Start Edit command is
inaccessible or “grayed out” if the current Main View window is not displaying a
screen into which data can be entered.  In this version of PECOS, the Start Edit
command is used only in the Coal Piles window to enter coal-related data.

Save Changes saves the newly entered data and exits the edit mode.  Whenever
data is entered or edited, it is important to save the changes using this command.
The Save Changes command actually sends the data to the PECOS server.  Up
until the Save Changes command is given, it is possible to change or cancel any
data entry.

Cancel Changes exits the edit mode without saving any of the changes or
registering any of the data entry.  These two commands are “grayed out” if PECOS is
not in data entry mode.

Startup Adjustment allows the user to adjust the data that are read into the
program at startup.  When PECOS starts up, it reads in the data that were saved from
the previous session.  If these data are not relevant, the user can delete some or all of
the startup data using the Startup Adjustment command.  A password is required
to access this command.

View menu
The View menu is used to display or hide the toolbar and status bar.

The View menu also allows the user to define certain aspects of the current Main
View window.  See the section describing a particular Main View window for details
on the View functionality.

Options menu
The Options menu is used to define PECOS options.

See “CBAS Software: Coal Piles” on page 32 and “CBAS Software: Coal Blend
Advisor Options” on page 44 for more details on the Coal Property View Ranges
and the Coal Blend Advisor commands, respectively.

Edit Mode Timeout

If the program is in edit mode, and no activity has occurred (such as data entry) for a
specified period of time, a dialog box appears with the warning that the program is still
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in edit mode and that the data have not been sent to the server.  This functionality is
included in the event that the user forgets to Save Changes after entering data.

The Edit Mode Timeout (the time between which the warnings appear) doubles after
each warning.  The original Edit Mode Timeout period can be adjusted using the Edit
Mode Timeout command.

Invoking this command brings up the “Edit Mode Timeout” dialog box.

Type in the amount of time in seconds that you want to be idle before the program
reminds you that you have not saved your changes and click on OK.

Equipment menu
The Equipment menu is used to mark equipment as unavailable or turned off.  For
example, if a piece of equipment is down for maintenance, it is important to mark it as
“out of use” so that the optimization algorithm does not consider it as an option.

Help menu
The Help menu provides quick on-line help about using PECOS.  Use the Contents
command to view the topics available.  The About PECOS command gives general
information about PECOS, such as the version number and how to get technical
support.
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The Toolbar

The toolbar, located below the menubar, contains buttons to Cut, Copy, Paste,
Print, and to access Help. The toolbar also has buttons which represent the
commands Start Edit, Save Changes, and Cancel Changes, and a special
View Dead Coal button used to view the dead coal in the Coal Pile window.
Buttons that do not apply to the current window are “grayed out” or inaccessible.
The toolbar may be hidden or re-displayed at any time by changing the status of the
Display Toolbar option in the View menu.

Clicking a button on the toolbar will execute the associated command. If  you position
the mouse pointer over any of the buttons on the toolbar, a message appears
describing the action the button performs. Move off the button if you do not wish to
execute the command.

Starting an Editing Session

 Start Edit Button
An editing session can be initiated by clicking the Start Edit button on the toolbar.
You must be in a window that allows data entry or data editing in order to use this
command.  If data entry is not available in the current Main View window, the button
is grayed out.  After invoking the Start Edit command, the program is in edit mode.   

Saving Changes

 Save Changes Button
After data entry has been completed, the user must commit the newly entered data to
the server, or save the data.  This is done by clicking on the Save Changes button
or by choosing the Save Changes command in the Edit menu.

If the user tries to move to a different window without saving or canceling the
changes, a dialog box appears asking the user whether the changes should be saved.
Clicking on Save Changes saves the changes and exits edit mode (as if the Save
Changes command has been invoked).  Clicking on No cancels the changes and
exits edit mode (as if the Cancel Changes command had been invoked).  Clicking
on Cancel does nothingCPECOS stays in edit mode and the current Main View
window does not change.
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Canceling Changes

 Cancel Changes Button
If a mistake has been made, it is possible to cancel the data entry and data edit by
clicking on the Cancel Changes button or by choosing Cancel Changes in the
Edit menu.  You will be asked to confirm that you want to cancel the changes before
continuing. If you want to save the changes and exit the edit mode, click on the
Save Changes button in the “Cancel Edit” dialog box.  Clicking on the Cancel
button keeps the application in edit mode and does not save or discard any of the
changes you have made.

Cutting, Copying, and Pasting

Cut, Copy, and Paste Buttons

When in edit mode, use the Copy, Cut, and Paste buttons or the Edit menu Copy
command to copy selected data to the clipboard.  To copy or cut data to the
clipboard, highlight an area and click the Copy or the Cut button.

When editing the Coal Pile data in this version of PECOS, the toolbar and menu
cannot be accessed.  However, the Copy, Cut, and Paste commands can still be
used by employing the standard Windows short-cut key stroke combinations. The
short-cut key stroke combination for Copy is Ctrl-C, Cut is Ctrl-X, and Paste is Ctrl-
V.

Viewing Dead Coal

View Dead Coal Button

When viewing the coal pile, it is possible to toggle the view of the dead coal on and
off.  This is done by choosing the Dead Coal command from the View menu or by
clicking on the View Dead Coal button on the toolbar.  For more information, see
the section “Different Views of the Coal Pile.”

Printing Current Window

 Print Button
Use the Print button or the File Menu Print command to print the current window.
In this version of PECOS, only the Log window can be printed.
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CBAS Software

Overview of CBAS
The Coal Blend Automation System (CBAS) module of PECOS has several
components including:

• A model of the coal pile

• A model of the coal handling system from the coal pile to the bunkers

• Models of all of the bunkers

• Coal Blend Advisor.

The models  track the coal from delivery in the coal yard up to the boiler and provide
the operators with information on the coal and its properties at any point in the coal
handling system.  Especially useful are the data on coal quality in the coal pile and in
the bunkers.

The Coal Blend Advisor uses the coal tracking model information to develop coal
blend recommendations and advise operators how to achieve the recommended coal
blend.

More detailed information on the CBAS technology can be found in “CBAS
Technical Description” on page 53. “CBAS Technical Description”.

The CBAS pane in the Tree View window lists three folders: Coal Piles, Coal Handling
System, and Bunkers.

The following sections describe the features of each folder and the items located
within the folders.
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Coal Piles
The Coal Piles folder contains information about the coal piles. The type of
information that can be found in the Coal Pile screen includes the amounts of coal in
various locations in the pile and the quality of the coal in the pile.  In addition, the
results of  Coal Blend Advisor calculations are displayed on the Coal Pile screen.

All of the coal piles at your plant are listed when the Coal Piles folder is expanded.

The Coal Pile is displayed in the Main View window by double-clicking on the “Coal
Pile 1” item in the Coal Piles folder.

The state of the coal pile is indicated in the top right hand corner.  The possible
states include “Normal Operation,” “S to N Turnover,” “N to S Turnover,” and
“Turnover Paused”.

A summary of the live coal in the pile is displayed in the table above the coal pile.
The data in the summary table indicate the total amount of each type of coal above
each syntron.  The categories of coal in the summary table are adjusted when the coal
pile view is changed.  See the section, “Different Views of the Coal Pile” on page 33
for more details.

Coal Pile Layers
The layers shown represent the coal in the order in which it will be reclaimed from the
pile.  For example, the bottom layer of coal will be removed from the coal pile first, the
second layer from the bottom will come out next, etc.

More detailed information on a layer of coal in the pile can be obtained by moving the
mouse over a layer.  A balloon appears which displays the coal properties of that
layer.  The balloon disappears when you move the mouse away.
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Different Views of the Coal Pile

 View Dead Coal Button
The view of the coal pile when the image is first retrieved shows only the live coal.
The dead coal in the pile can be viewed by choosing the Dead Coal command from
the View menu or by clicking on the View Dead Coal button on the toolbar.

The coal is color-coded by coal properties.  The default view of the coal pile is by
seam number.  If a layer consists of coal from more than one seam, the colors in the
band are mixed in proportion to the blend. The pile can be viewed in terms of other
coal properties by clicking on the desired coal property under the View menu.

When the coal pile is viewed in terms of a property other than seam number, the
overall range of the color coding can be adjusted.  This is done by choosing the
Coal Property Range… command in the Options menu, then choosing the
property for which you want to adjust the range.
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The “Setup Property Range” dialog box displays the minimum and maximum values of
the selected property.  These values can be adjusted by the user. The first interval of
color includes any coals whose quality is below the specified minimum. The last
interval of color represents coals with properties greater than the maximum. The
remaining color intervals are calculated by dividing the specified range into three
equal intervals.

Coal Pile Data Entry
Several types of data entry can be done through the Coal Pile window.  These
include:

• Coal Receipt

• Coal Quality

• Expected Coal Delivery

• Coal Pile Adjustment

• Coal Pile Turnover

• Coal Receipt Undo.

Start Edit Button

To get into the data editing mode, click on the Start Edit button, or click on the
Start Edit command in the Edit menu.

A dialog box appears asking for a password.  Type in the password and hit Enter or
click on OK.

If the password is accepted, the coal pile summary table disappears and is replaced
by six buttons at the top of the screen.
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Choose the type of data entry by clicking on the appropriate button.

Saving the Changes to the Server

Save Changes Button

In order to send the newly entered data to the server, you must save the changes by
clicking on the Save Changes button or by choosing Save Changes from the
Edit menu.

Note: It is very important to complete this step in the editing procedure.  If the
changes are not saved to the server, they will not be officially recorded.

After the changes have been saved, the Log window lists the changes that have been
made.

If you forget to save the changes, a dialog box appears after a predetermined period
of time, reminding you that you have entered data but not sent them to the server.

Click on Save Changes to send the changes to the server and exit edit mode.  Click
on Continue Editing to continue with your editing session.  The changes will not
have been sent to the server if you choose Continue Editing.

The idle time after which the “Attention” dialog box appears can be adjusted using
the Edit Mode Timeout command under the Options menu.  See the section “Edit
Mode Timeout” on page 28 for more details.

Cancel Changes Button

If you decide not to change the state of the pile and click on the Cancel Changes
button or choose the Cancel Changes command from the Edit menu, the state
returns to “Normal Operation.”

Coal Receipt

Coal Receipt refers to the receipt of coal from the mines.  The loading of coal onto
the pile is not automatically measured and therefore must be recorded manually.
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Note: It is important that the coal receipt data be recorded very close to the time
when it is actually loaded.

After clicking on the Coal Receipt button, the “Seam Number Selection” dialog box
appears.

The seam number to be loaded is selected at this point by choosing a seam number
from the drop down list.  Coal from the selected seam can now be loaded in multiple
load points.

After clicking on OK, the “Coal Receipt” dialog box appears.  There are nine load
points—one for each syntron.  The load point is selected by clicking on the right and
left arrows.  The selected load point is indicated by the number in the box and a large
black arrow above the coal pile points to the load point.

At each load point, the tonnes of coal loaded at that point are typed in.  After all of
the coal delivery data for that seam have been entered, click on OK.  This records the
coal receipt data just entered and closes the “Coal Receipt” dialog box.  Cancel
closes the “Coal Receipt” dialog box without recording any of the data.

The coal receipt does not appear on the screen immediately after the data have been
saved to the server (see “Saving the Changes to the Server” on page 35).  The
command to load the coal onto the pile is immediately sent to the Coal Pile Model, but
the results of the coal receipt may take up to 30 seconds to return to the user
interface.

Note: Each coal delivery is associated with a set of coal properties.  The properties
used are those listed in the “Coal Quality” dialog box at the time the Save Changes
button is clicked.  If the coal delivered is significantly different than the previous coal
delivered from the same seam, edit the coal qualities before clicking on the Save
Changes button.
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Coal Quality

The quality of the coal delivered to the plant must be recorded.  However, it is only
necessary to edit the coal qualities whenever they have changed.  It is not necessary
to edit coal qualities every time coal is delivered to the plant if the quality of the coal
has not changed significantly.

The qualities of the seams are edited by clicking on the Coal Quality button when
in edit mode.  This causes the “Coal Quality” dialog box to appear.

The coal quality applies to
the coal that will be
delivered to the pile.
Changing the coal quality
does not affect the properties
of the coal already in the pile
and bunkers.

The properties listed in the box are the existing coal properties for the specified seam.
Any changes to the data can be made by editing the appropriate numbers.

After the coal quality data have been entered, click on OK.  This will record the coal
quality data locally and close the “Coal Quality” dialog box.  Cancel closes the
“Coal Quality” dialog box without recording any of the data.

The new coal properties are assigned to the coal that is delivered to the pile.  The
properties of the coal already in the pile and in the bunkers does not change when
you edit the coal quality.

Expected Delivery

Part of the algorithm used by the Coal Blend Advisor to recommend coal blends takes
into account the expected delivery of coal in the next 24 hours.  These data are input
on a daily basis.

To enter the expected coal delivery data, click on the Exp Delivery button.  The
“Expected Coal Delivery” dialog box appears.
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Select the coal by choosing it from the drop down list.  Then enter the tonnes of coal
that are to be delivered within the next 24 hours.  If it is not known how much coal will
be delivered, type in “0” as the delivery amount.

After all the expected coal deliveries have been entered, click on OK.  This records
the expected deliveries locally and closes the “Expected Coal ” dialog box.  Cancel
closes the dialog box without saving any changes.

In order for the expected coal delivery data you have just entered to be reflected in
the blend recommendations, it is necessary to recalculate the recommendations by
clicking on the Recalculate  button.  This must be done after the changes have been
saved to the server (see “Saving the Changes to the Server” on page 35).

Coal Pile Adjustment

Sometimes it is necessary to adjust the Coal Pile model.  An adjustment may be
necessary due to slightly incorrect coal receipt data entry or because an automatically
recorded signal is not accurate (such as syntron feeder speed).

The “Coal Pile Adjustments” dialog box is accessed by clicking on the Adjustment
button when in Coal Pile edit mode.
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Different syntrons are accessed through the drop down list.  The number shown in
the “% full” edit box when the “Coal Pile Adjustments” dialog box is first opened is
the percentage of coal in the live pile above the syntron as determined by the Coal
Pile Model.  The value that needs to be entered is the actual percentage of coal in the
live pile over the syntron.

Adjustments should only be made to the live piles (syntrons) that seem significantly
incorrect.

After all of the adjustments have been entered, click on OK.  This records the
adjustments locally and closes the “Coal Pile Adjustments” dialog box.  Cancel
closes the dialog box without saving any changes.

The adjustment does not appear on the screen after the data have been saved to the
server (see “Saving the Changes to the Server” on page 35).  The command to adjust
the pile is immediately sent to the Coal Pile Model, but the results of the adjustment
calculation may take up to 30 seconds to return to the user interface.

It may be necessary to enter the actual percentage of coal several times.  If the dead
coal piles surrounding the live pile in question are not full, some of the coal gets
added to the dead coal pile, thereby adding less to the live coal pile.

For information on how the adjustment is made in the Coal Pile Model, see “Coal Pile
Adjustments” on page 56.

Coal Pile Turnover

When the coal pile turnover mode begins, it is necessary to convey this information
to the Coal Pile Model.

The “Turnover State” dialog box is accessed by clicking on the Turnover button
when in Coal Pile edit mode.  If the coal pile is in the “Normal Operation” state, the
dialog box will have two radio buttons: “Begin N to S Turnover” and “Begin S to N
Turnover”.

To begin turnover operation, click on the appropriate radio button and click on OK.
The state indication in the top right hand corner of the screen changes to indicate the
appropriate state.  Clicking on Cancel closes the dialog box and does not record the
new state of the pile.

Pile turnover calculations begin as soon as the “Begin Turnover” message is received
by the Coal Pile Model.  For more details on how turnover is modeled, see “Pile
Turnover” on page 55.

If the coal pile is in turnover mode, as indicated by the state at the top right hand
corner in the Main View window, the turnover can be paused or halted.  In this
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situation, the choices in the “Turnover State” dialog box are “Pause Turnover” and
“Abort Turnover.”

To pause a turnover operation, click on the “Pause Turnover” radio button and click
on OK.  The state of the coal pile becomes “Turnover Paused.”

If the coal pile is in the “Turnover Paused” state, the turnover can be resumed or
aborted. Resuming turnover will continue turnover at the same set of syntrons where
it left off.  Aborting turnover means that when turnover is started again later, it will
begin at one end of the pile or the other. The instructions for resuming or aborting
turnover are the same as for pausing turnover.  However, the radio button options in
the “Turnover State” dialog box are now “Resume” or “Abort Turnover.”

Undo Coal Receipt

Use the Undo Receipt
command only for receipts
that have already been sent
to the server.

It is possible to undo the most recent coal receipt data entries using the Undo
Receipt command.  This function has been added to give the user a little leeway on
making errors or entering false information by mistake.

Only the most recent coal delivery on each syntron can be removed.  The only time
the undo coal receipt command cannot be used for the most recent coal delivery is if
the coal has already left the pile and gone to the bunkers.

The Undo Receipt command only needs to be used if the receipt information has
already been sent to the server using the Save Changes command.  If the coal
receipts have not already been saved to the server, changes to the coal receipt can be
made by changing the values through the Receipt command while still in edit mode.

Start Edit Button

Since the undo receipt command is only needed if the changes have already been
saved, it is probable that the user is not in edit mode when he/she realizes that an
error has been made.  To undo a coal receipt, first get into edit mode by clicking on
the Start Edit button on the toolbar.
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Click on the Undo Receipt button that appears at the top of the Main View window
when in edit mode.  This brings up the “Undo Coal Receipt” dialog box.

Click on the selection box next to the syntron from which you want to undo the latest
receipt.  Then click on OK.

Click on the Save Changes button on the toolbar to send the command to the
server and exit edit mode.  The Log window displays the message “Undo coal receipt
on syntron #”.

The coal does not immediately disappear above syntron 4, however.  It may take up
to 30 seconds for the changes to be displayed on your PECOS client.

Startup Adjustment

When PECOS starts up, it reads in data from the previous session.  This means that if
the server goes down for a short period of time, all of the data are not lost: the coal in
the coal pile and the bunkers is still there.

However, it is possible that the down time was long enough that the data are no
longer valid.  Therefore, the user has the ability to clear out data in the pile and in the
bunkers.  This is done using the Startup Adjustment command under the Edit
menu.

After clicking on the Startup Adjustment command, the user is asked for a
password.
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Type in the password and click on OK to bring up the “Startup Adjustment” dialog
box.

The user can choose to either empty the live coal in the pile (the free flow) or the
entire pile.  The coal can also be emptied from all the bunkers.

If the program has been down for a few hours, the coal should be emptied from the
bunkers.  If the program has been down for a day or a few days, the coal should be
emptied from the bunkers and from the live coal pile.  If the program has been down
during a coal pile turnover, the coal should be emptied from the bunkers and from the
entire pile.

After the selections have been made, click on OK.  A dialog box comes up asking the
user to confirm the desired action.

Click on OK if this is really what you want to do.  Click on Cancel if you want to
reconsider.  If you clicked on OK, the Log window displays a message confirming
your actions.  The results of the command will not appear immediately.  It may take up
to 30 seconds for the new state of the pile and the bunkers to show up.

If you have emptied the bunkers and the real-time data indicate that the high level
lights are on in the bunkers, they will immediately fill back up to 61% full with
unknown coal.

Coal Blend Advisor Recommendations
The Blend Advisor has the following functionality:

• Lists many blend recommendations in order of preference

• Displays the blend recommended by Fuels

• Displays the target blend opacity potential which takes into account the
ESP conditioning and the power to be generated
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• Displays information about each blend

− opacity potential

− heating value

− other coal properties

• User can request a blend using two or three syntrons

• User can fix a syntron

• User can specify that the flows from the syntrons must be equal

• User can specify opacity and heating value targets for the
recommended blend

The results of the Coal Blend Advisor are displayed on the Coal Pile screen.  To
bring up the Blend Recommendations Table, click on the Blend Advice  button
located in the bottom left hand corner of the Coal Pile Main View window.  The table
of properties above the schematic of the coal pile is replaced by a table listing all the
blend options, in order of preference according to the defined goals.

The Blend Advice  button is replaced by three buttons: Coal Table, Options, and
Recalculate .  The Coal Table button brings back the table of coal properties.
Options accesses the Blend Advisor calculation options.  It is described in greater
detail later.  Recalculate  forces the Blend Advisor to recalculate the blend advice.

Above the table of Blend Recommendations is the time of calculation and the target
opacity potential of the blend.  None of the recommended blends can exceed this
value.  The target opacity potential takes into account the opacity limit entered by the
user, the amount of sodium in the coal that has been burned in the previous few
hours, the historical measured opacity and the power to be generated in the next few
hours.
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The first column of the table, labeled “Fuels” is where the staff at Fuels Supply can
enter their preferences of blends.

The last two columns list the properties of the blend.  More properties of the blend
can be accessed in a manner similar to the coal pile and bunkers: move the mouse to a
row and a balloon appears listing all the properties of the blend.

Blend Recommendation
Recalculation Button

The Blend Advisor automatically recalculates the recommendations at fixed intervals.
The user can force a recalculation at any time by clicking on the Recalculate
button.

For more information on how the Coal Blend Advisor calculates the
recommendations, see “Coal Blend Advisor” on page 59.

Coal Blend Advisor Options

Blend Advisor Options
Button

The user has control over a few parameters in the Coal Blend Advisor calculations.
These are accessed through the Options button at the bottom of the Coal Pile screen
when the Blend Recommendations Table is visible.  The Coal Blend Advisor Options
can also be accessed through the Coal Blend Advisor command under the
Options menu.

The expected coal delivery also affects the Coal Blend Advisor calculations.  This
value can be adjusted while in the coal pile edit mode.  See “Expected Delivery” on
page 38 for more information on this data entry.

To access the Blend Advisor options, click on the Options button which appears
when the table of blend recommendations is displayed above the coal pile.
Alternatively, click on Options on the menu bar and choose Coal Blend Advisor.
This causes the “Blending Options Setup” window to appear.

There are three sections in the “Blending Options Setup” window:



A Guide to Using PECOS CBAS Software  •  43

• Type of solution to recommend

• Goals and constraints for the solution to achieve and adhere to

• Syntron status.

The options that define the type of solution include how many syntrons to use,
whether to fix a syntron, and whether the flows of the syntrons should be equal.

The goals and constraints include the predicted average power to be generated in the
next four hours by Unit 1, the opacity limit, and the minimum heating value from the
blend.

The syntron status options include specifying the operational status of the syntrons
and specifying a minimum and maximum flow for each syntron.

When all options have been updated as desired, click on OK to close the “Blending
Options Setup” window.  The Blend Advisor will automatically recalculate the table
of blend recommendations.

Type of Solution

The user can specify the number of syntrons to use (two or three), whether a
particular syntron has to be used (“fix” a syntron),  and whether the flows from all of
the syntrons must be equal.  All of these choices are made by choosing an option
from the appropriate drop down menu.

Goals and Constraints

Goals and constraints on the coal blend recommendation calculations include setting
the upper limit for the allowable opacity from the stack, the lower limit of the heating
value for any recommended blend and the expected average Unit 1 power generation
for the next four hours.

The power forecast is used by the blend advisor to adjust the target opacity potential
for the blend.  If amount of generated power is to be increased in the next four hours,
the target opacity potential is decrease.  If no value or zero is entered, the default is
the assumption that the average power to be generated for the next four hours is the
same as the average power generated in the previous four hours.

Syntron Status

It is important to let the Coal Blend Advisor know if a syntron is not operational.
This will prevent the Coal Blend Advisor from recommending the use of non-
operational syntrons.

The operational status of the syntrons can also be specified through the Syntrons
command in the Equipment menu.

The “Syntron Operational Status” dialog box lists all of the syntrons.  The user can
tag out a syntron, or make its status non-operational by clicking on the check box
next to the syntron number.  The operational status column reads “No” if the check
box has been unchecked.

Tagging out a syntron has no effect on the Coal Handling System model.  Therefore,
it is possible to use the “Syntron Operational Dialog” box to indicate when you do
not want the Coal Blend Advisor to recommend a syntron for any reason, whether it
is operational or not.
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If only one syntron is non-operational (east or west), the user has the option to tag
out the syntron or leave it operational.  Again, the only effect of turning off a syntron
is to remove it from the list of possible syntrons for the Coal Blend Advisor to
recommend.

The user can also specify the minimum and maximum flow rates for each syntron
through the “Blending Options Setup” window.  Again, these values effect only the
recommendations calculated by the Blend Advisor.  They have no effect on the Coal
Handling System model calculations.

To change a minimum or maximum flow rate, simply put the cursor in the appropriate
box, delete the old value and type in a new one.

Coal Handling System
The Coal Handling System folder contains information about the status of the coal
handling system from the coal pile to the bunkers.  The type of information that can
be found in the Coal Handling system screens includes the on-line measured digital
and analog coal-related data.

There are two views of the measured data: an Overview Diagram and Coal Plant Data.
The Overview Diagram, as the name suggests, is a diagram of the coal handling
system with the data recorded in the diagram.  The Coal Plant Data view presents the
data in table and graphs formats.

Overview Diagram
The Overview Diagram is displayed in the Main View window by double-clicking on
the “Overview Diagram” item in the Coal Handling System folder.
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The “lights” indicate the on/off status of the syntrons, the frozen coal crusher, the
frozen coal crusher east and west train diverter gates, the Unit 1 and Unit 2 diverter
gates and the Unit 1 bunker high and low level lights.  Currently, the high and low
level lights of the Unit 2 Coal Bunkers are not being recorded.  The values of the East
and West belt-scale readings are also displayed.

The closed status of the bunker gates are displayed with a bar under the arrow
feeding the bunker (rather than a “light”).  The bunker gate status data are
represented differently from the other data because these data are entered manually
using Bunker Gates command under the Equipment menu.

There is no data entry in the “Overview Diagram.”  Therefore, the Start Edit button
and command are grayed out.

Coal Plant Data
Coal plant data are displayed in the Main View window by double-clicking on the
“Coal Plant Data” item in the Coal Handling System folder.



46  •  CBAS Software A Guide to Using PECOS

The same data that are displayed on the Overview Diagram are also displayed in the
Coal Plant Data screen.  In addition, the feeder speeds from the bunkers are
displayed.

There is no data entry in the “Coal Plant Data.”  Therefore, the Start Edit button and
command are grayed out.

Bunkers
The Bunkers folder contains information about the coal in the bunkers.  The type of
information displayed in the Bunker screens includes the amount of coal and the
quality of the coal in the bunkers as well as the quality of the coal being sent to the
boiler.

Bunker Overview
An overview of the Unit 1 bunkers is displayed in the Main View window by double-
clicking on the “Bunker Overview” icon under the “Bunkers” folder.
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A closed bunker gate is represented by a line at the top of the bunker.  A red line
represents the bunker gate from the east scraper conveyor; a blue line means the west
bunker gate is closed.  This is the same color scheme used in the Coal Handling
System Overview Diagram.  These data are entered manually using the Bunker
Gates command under the Equipment menu.

The circles to the left of the bunkers are the “lights” indicating the status of the high
and low level lights for each bunker.

The numbers below the bunkers are the actual feeder speeds.  These numbers
represent the amount of coal flow from the bunkers to the mills.

The layers in the bunkers represent the coal as it will be removed from the bunkers,
assuming that no new coal is added.  The amount of coal in each bunker is shown as
a percentage at the top of the bunker and graphically by the number of layers of coal
in the bunkers.

More detail about the coal in each level can be obtained by placing the mouse pointer
over a level of coal in a bunker.  A balloon appears listing the properties of the coal
in that layer.
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When you place the mouse
pointer over a bunker, a
balloon appears which lists
the details of the coal in the
layer.

The “Mass Averaged Properties Exiting to Mills” represent the mass-averaged
properties of the coal currently being sent to the burners (via the mills) from all of the
bunkers.  This is an instantaneous value.

There is no data entry in the “Bunker Overview” diagram so the Start Edit button
and command are grayed out.

Bunkers A through E
More detailed information about each individual bunker is available.  To access this
information, double-click on the bunker name under the “Bunkers” folder.

To access this screen, double-
click on the “Bunker A” item
under the “Bunkers” folder.

The layers of coal in the bunker are color-coded by seam number.  The amount of coal
in the bunker is represented by the level indicated in the bunker as well as by the
percentage number at the top of the bunker.
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When the mouse pointer is
placed on top of a level of
coal, a balloon appears
which shows details about
the coal in that level.

The feeder speed at the bottom of the bunker is the rate at which the coal is being fed
from the bunker to the mills.

The high and low level light values from the coal handling system are indicated to the
left of the bunker.

The data at the bottom of the screen indicate the properties of the coal being sent to
the burner from this bunker only.

There is no data entry in the individual bunker screen.  Therefore the Start Edit
button and command are grayed out.

Closing Bunker Gates
Not all data on the operations of the coal handling system are automatically recorded.
One data point in particular that is not recorded but has some impact on the Coal
Tracking model is the status of the bunker gates.  If a bunker gate is closed, coal
cannot flow into the bunker from the scraper conveyor belt.

To tell the program that a bunker gate has been closed, choose the Bunker Gates
command under the Equipment menu.  The “Unit 1 Bunkers Status” dialog box
appears.
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Click on the bunker gate that has been closed.  In this example, we are closing the
Bunker B gate feeding from the west scraper conveyor.  Click on OK to save the
changes.

The Bunker Overview changes to reflect the fact that the west gate to Bunker B is
closed as well as the east gate to Bunker A.  The bars at the top of the bunkers
indicate that they are closed.  The bars are color-coded to match the colors in the
Coal Handling System Overview Diagram for east and west equipment (east is red,
west is blue).

In addition, the Coal Handling System Overview Diagram shows that the gates to
these bunkers are closed by displaying bars across the top of the bunkers.



A Guide to Using PECOS CBAS Technical Description  •  51

CBAS Technical Description

Background to CBAS Technical Description
TransAlta Utilities’ Keephills plant has in the past experienced problems with high
and erratic opacity in their stack gases, resulting in plant derates in order to comply
with corporate environmental goals.  The losses in generation, and hence income, as
a result of the opacity-related derates were significant.

A series of studies and blend algorithm tests conducted by Praxis for TransAlta in
19951 proved the widely held belief that the Keephills opacity was seam-related, and
further demonstrated in field testing that the blend could be effectively controlled
even in the limited yard at Keephills.  As a result of this work, a set of decision rules
was developed for segregating the coal pile by different coal seams and subsequently
blending the plant feed to gain better control over the stack opacity.  This strategy
was enhanced and implemented by the fuels staff at the plant and the opacity-related
derates were mitigated.  Among their enhancements was the development of a
spreadsheet model of the coal pile which is updated daily.  The fuels engineers use
this model along with expected coal deliveries to make a suggestion for the operation
of syntrons for the next 24 hours.  This procedure has proven very beneficial to the
operation of the plant.

The next step in improving the fuel blending program at Keephills is the
implementation of CBAS, an on-line operator tool for optimal blend management.
CBAS is designed to aid in cost reduction and avoidance of derates or operational
problems due to fuel quality in real time.  It is part of PECOS, an on-line system that
assists the operator in selecting the mix of plant control setpoints which meet load,
emissions, and operational constraints at the lowest generation cost.

There are four central technical components of CBAS which allow it to assist with
blend management:

• Coal Tracking Model tracks coal through the entire coal handling
system from receipts to the mills, and displays the coal amounts and
quality in the piles and bunkers.  The Coal Tracking Model makes heavy
use of the Coal Pile Model and Silo Flow Model.

                                                                
1 Praxis Engineers, Inc. “Coal Quality Impacts on Opacity at Keephills Power Plant.” Final Report,  28 March 1995.
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• Coal Pile Model tracks the flow and storage of coal in the piles during
normal operation and during turnover.  The Coal Pile Model provides
data to the Coal Tracking Model.

• Silo Flow Model tracks the flow and storage of coal in the bunkers.
The Silo Flow Model provides data to the Coal Tracking Model.

• Coal Blend Advisor is blending strategy software which works with the
information provided by the Coal Tracking Model to make use of the
segregated coal pile.  The Coal Blend Advisor systematically determines
the best coal blends and suggests a coal handling system operational
procedure for achieving those blends.

The benefits of CBAS over the existing procedure include:

• Continual updating of the Coal Pile Model (using on-line syntron
operation and belt-scale data).  This reduces the odds of the coal not
being available when and where expected.

• Automated coal blend and syntron operation advice which can be
updated whenever coal availability, plant requirements, or handling
system equipment status change.

• Continually updated displays of the coal in the piles and bunkers,
showing both amounts and quality distributions at each feeder and
bunker.  This allows the operator to always be aware of the availability
of various coals.

• The ability to add blend control for additional coal-related parameters,
such as heating value for high load periods, SO2, and NOx.  All
parameters are considered in the blending recommendation.

• The ability to adapt advice to shifting coal qualities from the mine.

• Saving of fuels staff time.

This section describes the functions of the four major CBAS subsystems.

Coal Pile Model
The Coal Pile Model is designed to represent the flow and storage of coals in the pile
during normal operation and pile turnover.  Most aspects of Coal Pile Model
operation are automatic and are driven by on-line data.  However, the operator must
enter the coal tonnage, seam number, and loading point of coal receipts, and may
optionally update the coal quality data.  The start, pausing, or abortion of pile
turnover must also be entered manually.

The model is fully three-dimensional and adaptable to a wide variety of pile shapes
and flow conditions.  For ease of viewing, the pile contents are mapped to a two-
dimensional display in the order in which coal layers will be withdrawn from the pile.

The coal pile is modeled using an array of rectangular elements, called channels.  The
channel size is representative of the primary flow channel within the pile.  Cells within
each channel track the volume and type of coal they represent.  This representation
of the pile is shown in Figure 1.
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Figure 1.  Coal Pile Representation

Coal is withdrawn from the primary flow channel.  If the model detects that a surface
correction is needed, coal from adjacent channels is used to maintain the discharge
angle conditions defined for the coal pile.

Coal is also withdrawn from channels adjacent to the primary channel.  Coal
discharged in this manner is withdrawn at a point in the channel consistent with a
conical surface modeled by the discharge angle and discharge point to preserve
dead-storage coal information at the bottom of each channel.

In summary, coal can be removed from a channel in one of four ways:

• By being discharged from the discharge point (primary channels only)

• At the top of the channel through surface corrections toward the
primary channel

• By being discharged at the live/dead storage interface in expanded flow
modeling, or

• By a reclaim operation (pile turnover).

The advantages of modeling coal pile operations using this approach include:

• The simple geometry of the flow channels allows faster computation,
which, in turn, allows for increased model resolution.

• The vertical flow channels simplify the pile representation, which, in
turn, allows modeling of coal flow acted upon by two discharge points.

• The rectangular coordinate system allows for extensibility to a variety of
loadout and reclaim situations.

Pile Turnover
Pile turnover is performed at Keephills on a regular basis to move coal from dead
storage areas in the pile into syntrons where it is reclaimed.  The operation is
performed by pushing coal from dead storage into live storage areas over the
syntrons. The turnover operation is performed systematically from one end of the pile
to the other.  When a portion of the pile has been turned over, piles are rebuilt
"behind" the mobile equipment.

To incorporate the pile turnover, four states (or modes) of operation have been
defined:
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• Normal operation

• N to S turnover

• S to N turnover

• Turnover paused.

During normal operation, coal is reclaimed by the syntrons from live storage only.

When the pile turnover state is activated, a reference plane is established at one end
of the pile as shown in Figure 2.

Turnover Plane

Figure 2. Coal Pile Turnover Plane Representation

Initially all of the pile is on the "unprocessed" side of the plane.  When the Coal Pile
Model is in the turnover state, it processes the live coal as it would during normal
operation.  However, when the real-time data indicate that coal is being withdrawn
from a syntron whose live storage has been depleted, the withdrawn coal is provided
by relocating the plane, "slicing" the pile, and moving the coal between the old and
new positions of the plane to the empty syntron.  This represents the mobile
equipment moving dead coal into a syntron that is reclaiming the coal.

Pile turnover occurs in one direction only and cannot be reversed.  The reclaim
operation is completed when the plane reaches the other end of the pile.

The model can also be placed in the turnover paused state.  In this state, the position
of the turnover plane is retained and normal pile operation proceeds.  Turnover
operation can be resumed at any time from the point at which it was paused.

This approach utilizes a systematic approach to relocate coal which approximates the
reclaim process.  The turnover operation is performed systematically for efficiency
and operational purposes.

Coal Pile Adjustments
It is anticipated that adjustments to the coal pile will have to be performed
occasionally to reconcile the actual coal live pile inventory with the inventory
calculated by the model.  These corrections should be infrequent.  Possible errors, in
anticipated order of severity, are most likely due to:

• Systematic measurement errors

• Errors in data entry

• Differences between actual and modeled operations.
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Coal Pile Model adjustments begin with an operator or technician making a visual
observation of the coal pile.  The purpose of the observation is to determine if the
coal pile inventory calculated by the Coal Pile Model is reasonable.  Adjustments
should only be made when the inventory calculated by the Coal Pile Model varies
significantly from the actual, observed inventory.

If it is determined that an adjustment to the Coal Pile Model is necessary, the operator
enters the actual percentage of live coal above the syntron through the user interface.

Excess live pile inventories are corrected by simulating discharge from the pile and
removing the coal from the pile.  Shortages in inventory are corrected by simulating
addition of coal to the pile.  The model assumes that the properties of the coal added
are the same as those of the last coal loaded onto the pile at that location.

The approach utilized is designed to require a minimum of operator input, since it is
expected to be used infrequently and under conditions where the exact details of the
source of the discrepancies will likely not be known.

After an adjustment, it is possible that the percentage indicated for the live coal pile
will not be the same as the percentage input by the user.  This will occur when the
dead coal sections are not full. The Coal Pile Model adds a calculated amount of coal
during an adjustment.  The amount of coal added is the total live coal pile times the
difference between the percent specified by the user and the percent that the model
indicates is in the pile.  If the dead coal piles are not full, some of the coal added will
end up in the dead coal pile.

The solution is to continue specifying the actual percentage until the dead coal piles
fill up and the resulting percentage of live coal is the same as that specified.

Silo Flow Model
CBAS uses the Silo Flow Model to solve the complex flow equations involved in  coal
flow in silos and bunkers to predict the quality of the discharge coal from the load-in
sequence. The storage of coal in silos and bunkers presents a unique problem in that
the coals do not always come out of them in the sequence in which they were loaded.
Thus, even when a bunker has a large amount of one coal in it and another coal is
loaded on top, the second coal can begin to show up at the bunker discharge before
the first coal is fully withdrawn.

The relationship between the sequence of loading a coal into a bunker and the
sequence of its discharge is governed by complex flow regimes in the bunker, and
does not follow a straightforward first-in-first-out (FIFO) pattern.  An example of this
phenomenon is presented in Figure 3the figure below.  This figure shows the
discharge from a bunker which has been loaded with layers of four different coals.
As can be seen, the output sequence of coal quality does not match the FIFO
assumption, but is a complex blend where some of the coal loaded at the beginning is
discharged at the end, and some of the coal loaded in the middle discharges very
quickly.
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Figure 3.  Different Types of Flow Through a Silo

The actual resulting sequence of output quality is determined by a number of factors
including the quantity and quality of coal already in the bunker, the timing and rate of
loading and discharge operations, the geometry of the silo, and the flow properties of
the particular coal.

Silo Flow Model Auto-Correction
The Silo Flow Model periodically adjusts itself automatically to reconcile the actual
bunker inventory with the inventory assumed by the model. The primary source of
error in the Silo Flow Model coal inventory is systematic measurement error in coal
added to or discharged from the bunkers.

Bunker levels cycle hourly, as opposed to every 48 hours for the coal pile.  Also, the
bunkers contain a relatively small amount of coal compared to the coal pile
(approximately 300 tonnes compared to 3000 tonnes live storage for Keephills).  This
means that corrections to the Silo Flow Model will be much smaller, but more
frequent, than the coal pile adjustments.

A correction is initiated whenever a high or low level light comes on.  At that time, the
actual bunker level and coal inventory are calculated.  The Silo Flow Model calculates
its inventory and compares it to the actual inventory.  If the amounts differ by a
predefined tolerance, a correction is applied.

If the Silo Flow Model has an excess of coal, the coal withdrawn from the bunker is
increased over a predefined period of time.  The extra coal is discarded (not fed to the
mills).

Similarly, if the Silo Flow Model has less coal than is indicated by the actual data,
additional coal is added over a predefined period of time to make up the deficit.  The
additional coal has the same identifier as the coal being added.

It is not expected that the inventories inferred from the level indications will
correspond exactly with the inventories calculated by the model.  However, it is
expected that the values will be within the defined tolerance and corrections will only
be required for systematic errors (biased measurements).
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Coal Tracking Model
The purpose of the Coal Tracking Model is to follow the coal as it moves from the
point of receipt to the mills.  At the coal receipt, the movement of the coal is modeled
by the Coal Pile Model.  At the bunkers, the movement of the coal is modeled by the
Silo Flow Model.  In between, the Coal Tracking Model follows the flow of the coal
through a variety of coal handling equipment.

The Coal Tracking Model is composed of a collection of such equipment, e.g.,
conveyors, crushers, and diverter gates.  The coal feeds from one piece of equipment
to the next until it arrives at the bunkers.  The on/off status of the equipment is
determined by reading the real-time on-line data.

Coal Blend Advisor
The purpose of the Coal Blend Advisor is to recommend which syntrons are to be
used to provide the best coal blend.  The decision is based on the properties of the
coal above each syntron, the expected coal delivery, the availability of syntrons, the
flow rate capabilities of the syntrons, the historical operation, and the required power
production of the unit.  User-defined goals and constraints are also taken into
consideration.

The goal of the Coal Blend Advisor algorithm is to standardize the logic and simulate
the working mental model of the engineers and plant operators. This is done by
applying state-of-the-art calculation and programming techniques to the problem
solution.

Calculation Process
The calculations are made using a series of fuzzy engines and a heuristic program.
Several small fuzzy engines are used instead of one large one because this allows
greater flexibility in the parameters that can be incorporated into the overall decision-
making process.

There are several inputs to the Coal Blend Advisor:

• Dynamically changing properties of the coal in the pile

• Seam delivery forecast for the next 24 hours

• Opacity potentials of the coal in the pile and the coal to be delivered

• Sodium and sulfur contents of the coal in the pile and the coal to be
delivered

• Heating values of the coals

• Stack opacity measurements averaged over the previous four hours

• Sodium values of the coal burned averaged over the previous four
hours

• Average power produced in the last four hours by Unit 1

• Average power generation by Unit 1 predicted for the next four hours

• Operational status of the syntrons (working/not working)

• Minimum and maximum flow rates for each syntron

• User-defined opacity and heating value targets.
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An ESP deconditioning factor is estimated using the average value of the stack
opacity measured for the previous four hours and the sodium levels for that time
period.  This is used to determine a target opacity potential that the coal blend can
have without causing opacity problems.

This target coal blend opacity potential is further processed for power generation
changes.  If the predicted power is much higher than the power that had been
generated in the previous four hours, the target opacity potential of the coal blend is
decreased.

Note: The opacity target entered by the user is adjusted to take into account
historical operation of the unit as well as future power production.  Therefore, the
actual opacity target that the blends are meeting is not necessarily the same as the
user-defined opacity target.

Then the seam availabilities are calculated.  The inputs are the amount of coal of each
seam on the pile and the expected delivery of each coal.

Finally, the recommended syntrons are determined.  Basically, an objective function is
calculated for all possible syntron combinations.  Then the results are ranked by the
objective function.
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Glossary of Terms

balloon
a box that appears when you place the mouse pointer over a an area.  The box
displays information about the item over which the pointer is located.

BANCS
Boiler and NOx Control System.  The module of PECOS that models the boiler and
makes least-cost-setpoint boiler operation recommendations, while maintaining or
reducing emissions.

button
small markers on the toolbar containing graphics which generate button-specific
commands when clicked once with the mouse. The function of each button is
displayed in a balloon when the mouse pointer is held over it without clicking.

CBAS
Coal Blend Automation System.  This module of PECOS tracks the coal from the yard
to the boiler.  It also makes coal blend recommendations to the operator.

clipboard
a temporary Windows storage area for cut or copied text or graphics.  You can copy
data to the clipboard and use it in other Windows applications. The clipboard holds
the text or graphic until you cut or copy another text or graphic item.

Coal Blend Advisor
the CBAS module which makes coal blend recommendations as well as suggestions
on how to achieve the recommended coal blend.
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Coal Pile Model
the model of coal movement through the coal pile.  It takes into account dead and live
storage areas in the pile.  The Coal Pile Model is part of the Coal Tracking Model.

Coal Tracking Model
the CBAS module which models the coal handling system from the coal receipt to the
mills.  It includes the Coal Pile Model and the Silo Flow Model.

control menu
the top-level menu that contains commands that control the application.  The control
menu is accessed using the application control box.

dead coal
coal in a pile that does not move during normal operation.  This coal must be moved
manually (i.e., with bulldozers) in order to reclaim it from the pile.

dialog box
a special kind of window that either requests or provides information.  Many dialog
boxes present options to choose from before you can perform actions.

drop down list
a list of options accessed by clicking on a down arrow next to a selection box.

edit mode
mode in which data can be entered.  The Start Edit command is used to get into edit
mode.  The Save Changes and Cancel Changes commands get out of edit mode.

Edit Mode Timeout
time period of inactivity while in edit mode that causes the warning dialog box to
appear.  The warning tells the user that changes have been made, but not sent to the
server.

folder
a main category in the Tree View window.  It is designated by the folder icon.

icon
a small picture on the desktop representing a minimized window.
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insertion point
the point where data will next be entered.  To move the insertion point through a
document, scroll until the place you want to edit is visible or click the new location.
After selecting an insertion point, it is marked by a flashing cursor.

live coal
the coal that moves through the pile during normal operation.  It is also known as free
flow.

load point
the position in the coal pile where the coal is loaded.  There are nine load pointsCone
above each of the nine pairs of syntrons.

Log window
the window at the bottom of the screen.  It displays information about what is going
on in PECOS.  The most useful information displayed in the Log window for the user
is a listing of the edit changes made after the Save Changes command is given..

Main View window
the window which takes up most of the screen.  It displays the data and
recommendations.  The Main View window is controlled by navigation using the Tree
View window.

maximize button

Maximize icon
use this command to enlarge the active window to fill the available space.  Click the
Maximize icon on the title bar, or double-click the title bar.

menubar
located below the title bar, along the top of the window, and contains all PECOS
commands.  To view all the commands in a menu, click the menu name.

minimize button

Minimize icon
use this command to reduce PECOS to an icon.  Click the minimize icon on the title
bar.

On-Line Help
provides assistance in using PECOS which is accessible from the help menu and from
various help buttons in dialog boxes.
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pane
a view in the Tree View window.  Different panes are accessed by clicking on the tabs
at the top of the Tree View window.

PECOS
Plant Environmental and Cost Optimization System.  This is the program which
encompasses CBAS, BANCS, and SCYCLOPS.

radio button
the adjacent figure shows two circular radio buttons.  You can only select one radio
button in a given set.  When you use your mouse to click the desired radio button,
the middle of the circle darkens; the unselected radio button and the information
related to it “grays out.”

restore button
returns a window to its previous size before it was maximized or minimized.

scroll bar
appears along the right side and/or bottom of a window and is used to scroll
vertically or horizontally when the window contains more than can be displayed on
the screen.

SCYCLOPS
Steam CYCLe OPtimization System.  This module of PECOS makes least-cost setpoint
recommendations for the operation of the steam cycle.

seam number
the number of the seam from which the coal was mined.

Silo Flow model
a model developed by Praxis Engineers, Inc.  It predicts the coal discharged from a
silo or bunker, taking into account the loading and discharge schedules, as well as
several other parameters.  The Silo Flow model is included in the Coal Tracking
Model.

status bar
the bar at the bottom of the screen that displays the status of the program.
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tab
protrusions at the top of the Tree View window, similar to tabs on physical folders
(those antique things you use in filing cabinets).  Clicking on a tab accesses a pane.

title bar
the topmost area of a window which contains the control menu box and the maximize,
minimize, and restore buttons.

toolbar
the toolbar is displayed across the top of all windows, below the menubar.  The
toolbar provides quick mouse access to many commands used in PECOS.  Click the
desired tool button to execute the associated command.

Tree View window
the window on the left side of the screen which contains a hierarchy of the folders
and items to be view in the Main View window.



A Guide to Using PECOS Index  •  65

Index

A

Adjustment 18, 36, 54
Arial 3

B

Balloon 11
Blend Advisor See Coal Blend Advisor
Bold 3
Bugs 6
Bunkers 46

Bunker A - E 48
Bunker Overview 13, 46
closing gates 49
color coding 14
flow model 55
layers 14

Buttons
Cancel Changes 28
Copy 28
Cut 28
on toolbar 27
Paste 28
Print 28
Recalculate 42
Save Changes 27
Start Edit 27
View Dead Coal 28

C

Cancel Changes 25, 28, 33
CBAS 29, 51

benefits 2, 52
Bunkers 46
Coal Blend Advisor 29, 41, 57
Coal Handling System 44
Coal Pile 30

Coal Tracking Model 29, 57
components 29, 51
overview 1
Silo Flow model 55
Tree View pane 10, 29
tutorial 9

Clipboard
copying to 24, 28

Closing gates 49
Coal Blend Advisor 29, 57

fixing a syntron 20
goals and constraints 43
inputs 57
options 19, 42
Recalculate 42
recommendations 11, 41
syntron status 21, 44

Coal Handling System 44
Coal Plant Data 45
Overview Diagram 45

Coal Pile 30
Adjustment 18, 36, 54
coal property ranges 31
Coal Quality 15, 35
Coal Receipt 33
color coding 11, 31
data entry 15, 32
dead coal 12, 31
Expected Delivery 35
layers 11, 30
live coal 11, 31
recommendations 11
state 30, 37, 54
summary table 11, 30
Turnover 37, 53
Undo Receipt 38
view adjustment 12, 31

Coal Pile Model
Adjustment 54
Turnover 53

Coal Plant Data 45
Coal Quality 35
Coal Receipt 33
Coal Tracking Model 29, 57
Color coding

bunkers 14
Coal Pile 11, 31

Commands
Cancel Changes 25, 33
Copy 24, 28
Cut 24, 28
Paste 24, 28
Print 24, 28
Save Changes 25, 33



66  •  Index A Guide to Using PECOS

Start Edit 25, 32
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Introduction to PECOS

Description of PECOS
The Plant Environmental and Cost Optimization System (PECOS™) is an advisory
software system whose purpose is to recommend coal blends and least-cost control
system setpoints to the plant operator.  The operator will be able to minimize overall
power production costs while meeting load, staying within emissions requirements,
and observing safety and operational constraints.

PECOS also makes available information to the operators that is generally not known,
such as the properties of the coal currently being burned in the boiler.  PECOS is
designed for real-time use by operators in fossil-fired power plants.

PECOS consists of several modules:

• Coal Blend Automation System (CBAS)

• Boiler and NOx Control System (BANCS)

• Steam CYCLe OPtimization System (SCYCLOPS).

An installation of PECOS may include one or more of these modules.  Each module
consists of a model of the system and produces recommended actions for the
operator.

PECOS offers a variety of features, including:

• User-friendliness

• A powerful and versatile graphics display

• Real-time data collection

• LAN/WAN-based operation, allowing use by operators, engineers, and
managers throughout the utility.

Brief Overview of BANCS
The Boiler And NOx Control System (BANCS) is an on-line advisory software
product which recommends optimal, least-cost boiler side control setpoints to
operators in real time.  BANCS determines the setpoints by automatically assessing
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all of the economic tradeoffs inherent in the system while making sure that important
safety, environmental, operational constraints are not violated.

BANCS combines both physical models and neural models to simulate plant
performance.  It models all of the equipment and systems associated with the plant
and automatically collects data from the existing plant data highway to be used in its
models.  BANCS uses on-line data to validate and adapt its models to provide
accurate plant modeling even when plant conditions are changing with time.  Based
on these models, BANCS uses a powerful optimizer to calculate least-cost setpoints
within the specified operational constraints.

The benefits provided by BANCS include:

• It provides the operators with least-cost control setpoints on-line in real time.

• It provides the ability to change the limits on plant constraints so that the least
cost setpoints can be tailored to meet specified safety, environmental, and
operational constraints.

• It assists in avoiding derates used as a method of avoiding emissions
exceedences.

• It aids in eliminating differences in operator-to-operator performance.

• It provides detailed on-line cost information to highlight where costs are going,
giving more insight to maintenance and pricing strategies.

• It can be easily updated by the plant to integrate the performance of new,
advanced control subsystems as they become available in the future, allowing
utilities to maximize their benefits from the new systems.

 

Organization
This User’s Guide is intended to assist you in learning how to use BANCS and take
full advantage of the program’s capabilities. The Guide includes the following
sections:

BANCS Tutorial.  A tutorial that leads new users through the operations commonly
performed in BANCS.  This section provides step-by-step examples of viewing and
editing several different kinds of data, running a simulation, running an optimization,
and viewing results.

BANCS Menus and Commands.   A complete description of all the menus and
commands available in BANCS.  This section is a good place to look to find the
details of using a particular menu item or button.  It also describes how to use the on-
line help system.

Using BANCS.  Detailed descriptions of the operations that users will carry out in
BANCS, including step-by-step guides for running simulations and optimizations.
This section covers what data can be edited, how to edit data, which data affect
simulations and optimizations, running the simulations and optimizations, and
viewing results.

BANCS Technical Description.  A discussion of the models and techniques that are
used in BANCS to simulate boiler operations and to determine optimum setpoints for
least-cost operations.
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Glossary.  An explanation of the terms used in BANCS and the User’s Manual.

Index.  An index of items users can look up in the manual.

Getting Technical Support
If you are unable to resolve a technical problem using the information in this User's
Manual, contact Praxis Engineers, Inc. at (408) 945-4282 (tel), or (408) 263-2821 (fax), or
support@praxisengineers.com (E-mail).

About this Manual
Special typefaces are used in this manual to help you distinguish between menu
commands, keys that you press, data that you type, and terminology found in the
glossary.

Table 1.  Printing Conventions Used in This Manual

Convention Applies to Examples

Bold Menu commands and button
names

To open a new file, choose
File, New from the File
Menu

Italic Terms explained in the
glossary at the end of this
manual

menu bar, toolbar, button

“Quotation marks” PECOS data entry and dialog
box titles and names

“Time Period” box

Arial font Keys on your computer’s
keyboard

Shift, Ctrl, Alt, F1
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BANCS Tutorial

Overview
This chapter provides several step-by-step examples that are intended to quickly
familiarize users with BANCS operations.   In this chapter, you'll navigate through the
BANCS screens, edit data,  calculate plant variables by running a simulation, and
calculate optimum setpoints to achieve least-cost overall operation of the plant.

Navigating the BANCS Screens

Start PECOS/BANCS
BANCS is a module of a larger software package called PECOS (Plant Environmental
and Cost Optimization System).  The PECOS installation at your plant may contain
other modules (CBAS or SCYCLOPS) besides BANCS.

Look for the PECOS window.   It has the following label at the top left corner.

                Find this window à

                       OR

If you don't find the window, check the task bar at the bottom of your screen to see if
the PECOS window has been minimized.  If it is minimized, the following button is in
the task bar.

                 Click this button à

If you find this button, click it to open the PECOS window.

                       OR Otherwise, start PECOS from its icon on the desktop by double-clicking on it.

Double-click this icon  à
and enter user name and
password.

PECOS asks for a user name and password .  Enter the user name and password that
have been assigned to you in the two boxes.   The password that you type will
appear as '***' in the window, so that your password cannot be seen by anyone
standing near the monitor.  Then click OK.
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You should now have the PECOS window visible on your monitor.

The BANCS Windows

Click BANCS tab. The Tree View Window on the left displays a different tree for each PECOS module
installed at your site.  To display the BANCS tree, click the tab at the top of the Tree
View Window that is labeled BANCS.
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folders 

screens 

The Tree View Window controls what is displayed in the Main View Window.  The
Tree View Window contains folders and screens.  The folders are yellow and have
names, such as System Overview or Mills.  Each folder contains a number of screens.
The Boiler folder is open in the BANCS Tree View Window shown above, and it
contains four screens, Schematic, Table, Trend Graphs, and Bar Charts.  In the
picture above, the Boiler folder's Table screen is displayed in the Main View
Window.

Displaying Different Screens
Step 1:  Click +. To display a screen, first open a folder.  Click the '+' at the left of the System

Overview folder.  It will open and look like this.

Step 2:  Double-click
Setpoints

Then double-click the screen that you want to display.  Double-click either the
Setpoints icon or the word 'Setpoints '.  You'll see the Setpoints sliders (shown below)
appear in the Main View Window.   If the sliders don’t appear, try double-clicking a
little faster.

Slider view of Setpoints screen.
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Step 3:  Place cursor over
slide’s thermometer to
display numbers.

The slider view of the Setpoints screen shows the minimum, maximum, current, and
optimized setpoints using arrowheads of different colors.  The Current value
displayed for measured variables is a measured value that is obtained on-line from
the plant’s data acquisition system.   The Current value displayed for other variables
is a simulated value, one that BANCS calculates from measured values and user
inputs.  To see numeric values for current and optimized setpoints, place the cursor
over the slider, directly over the part that looks like a thermometer.  A balloon
appears displaying the numbers.

Step 4:  Double-click Table
under System Overview

Display the System Overview folder's Table screen by double-clicking on Table in the
Tree View Window.   The display in the Main View Window switches from the
sliders to a table.

System Overview folder's Table screen.
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Step 5:  Click and hold to
scroll.

The System Overview Table screen shows variables from many different parts of the
plant.  It contains the setpoints that you saw in the Setpoints screen's sliders.  Scroll

the table down by clicking and holding on the down arrow  at the bottom right
corner of the table.   Look for the mill exit temperatures which were shown in the
sliders.

Scrolling down in the System Overview folder's Table shows mill exit temperatures.

Step 6:  Click  -  to close. Close the System Overview folder in the Tree View Window by clicking on the '-'.

Step 7: Click + to open. Open the Boiler folder by clicking on the '+' left of the folder in the Tree View
Window.   The screens available for the boiler appear.

Step 8:  Double-click Trend
Graphs to display.

The Boiler folder has Schematic, Table, Trend Graphs, and Bar Charts screens that
display boiler data in different forms.  Display the Trend Graphs screen in the Main
View Window by clicking on Trend Graphs in the Tree View Window.
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This trend graph appears, showing Hot RH Steam Press.  This is a current value for
this variable.  Optimized, minimum, and maximum values are not available to be
trended.

Step 9:  Click Trend Graph to
bring up menu.

The variables displayed on a trend graph can be changed.  To change the displayed
data, click on the trend graph.  A small menu appears on the trend graph.

Step 10:  Click Data The menu that appears enables users to change the data, the time period (x-axis), and
the range of values (y-axis) for the variable.  Click Data to change the variable shown
on the graph.   Another window appears displaying a list of variables.

The left column shows all variables that can be displayed on the trend graph.
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Step 11:  Scroll to Boiler
NOx Loss.

Step 12:  Click

Step 13:  Click  

In this example, we'll change the trend graph to show Boiler NOx Loss rather than Hot
RH Steam Press.  First Scroll the "List of Available Variables" until you see Boiler
NOx Loss.  Click Boiler NOx Loss to highlight it.  Then click the Add>> button in the
middle of the window.  The Boiler NOx  Loss variable moves to the right into the
"Variables Shown" list.

After clicking Add>>, Boiler NOx Loss moves into the "Variables shown" column.

Step 14:  In right hand list,

click 

Step 15:  Click 

Trend graphs can display more than one variable, but in this example, we'll remove
Hot RH Steam Press from the display.  First click Hot RH Steam Press in the
"Variables shown" list to highlight it.  Then click the <<Remove  button.  Only Boiler
NOx Loss remains in the "Variables shown" list.

On clicking <<Remove, the Hot RH Steam Press disappears from "Variables shown" column.

Step 16:  Click Now click OK to get the Boiler NOx Loss to appear in the trend graph.  The trend
graph will clear all the old data points and start plotting Boiler NOx Loss at the
current time.
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Trend graph starts plotting Boiler NOx Loss after clicking OK.

Simulations
What is a simulation?  A simulation is a calculation of plant performance variables
including boiler related variables contained in the plant's data acquisition system
(DAS) (such as air heater temperatures) and some variables not contained in the DAS
(such as Net Power Output and Generation Cost).  The simulation is based on a
detailed mathematical model of the operation and performance of the power plant.
The simulation uses physical models guided by on-line measured data, empirical
constants, and data input by hand to make its calculations.

Edit Data for a Simulation

What Data to Edit

The data that users may edit which will affect the simulation results are called manual
inputs.  Manual inputs are values that are entered by hand because they are not
available on-line.   You can find out if your installation has any manual inputs by
looking in the Tree View Window.  If you find a folder labeled Manual Inputs, then
your installation is using some manual inputs.  To see what values are required,
display the screens in this folder. (A previous section of this tutorial, "Displaying
Different Screens" on page 2-3, explains how to display screens.)  If any values are
missing, you'll have to enter them prior to doing a simulation.   If BANCS has been
running for a while, someone else has probably entered values.  For this tutorial, it's
OK to use the values that are already there.

The Editing Procedure

Editing data requires four steps:

1) Display the appropriate screen,

2) Start an edit session,

3) Make the changes,
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4) End the edit session by saving or canceling the changes.

We'll walk through an example of editing a table.  Before starting to edit, be sure that
the toolbar is displayed.

If the toolbar is displayed, skip to Step 1.  If the toolbar is not displayed, click the
View menu to pull it down, then click Toolbar.

Step 0.  If toolbar is NOT
visible, click

 and click

Step 1a:  Click + to open

Step 1b:  Double-click

The first step in editing is displaying a screen that has the data you want to edit.  You
learned how to display screens earlier in this tutorial.  Open the Manual Inputs folder
(if it isn't open already) by clicking on the '+' at the left of the folder in the Tree View
Window.   Then display the Inputs screen by double-clicking on Inputs in the Tree
View Window.

The Inputs table appears in the Main View Window.  If the Main View didn't change,
try double-clicking on Inputs a little faster.

The second step is to start an editing session.   Click the Start Edit button on the
toolbar.  It has a little pencil on it and is the leftmost button on the toolbar.

Step 2a:  Click 

In the window that appears, type your password in the blank field.  The letters you
type will appear as *** in the box, so that your password isn't visible to anyone near
your monitor.
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Step 2b:  Type your
password.

Step 2c:  Click 

Then click the OK button on the “Password” window.  BANCS is now in edit mode
and will allow you to change data.  In the table, find Outside Air Relative Humidity
and click on its value.

Step 3a:  Click on a value.

The value highlights and moves to the left of the field when you click on it.  Type a
new number, 80, over the old number.

Step 3b:  Type a new value
over the old one.

Now click on another value, the value for Outside Air Percentage.  It highlights and
moves to the left for editing.

Repeat Step 3a:  Click on a
value.

Type a new number, 30, over the old number.

Repeat Step 3b:  Type a new
value over the old one.

The last step in the editing procedure is to exit  the edit mode.  BANCS ends the edit
session and exits edit mode when you either save your changes or cancel your
changes.   Up to this point, none of the changes you have made are saved.  They can
be erased by using the toolbar's Cancel Changes button or the Edit menu's Cancel
Changes command.  Both are described in "End the Edit Session" on page 4-22.  Save
the two changes you just made by clicking the toolbar's Save Changes button.  It has
a little lightning bolt on it and it's the second button from the left in the toolbar.

Step 4:  Click   to save.

The lightning button (Save Changes button) turns gray when you end the edit
session.  The gray indicates that the button is deactivated.

Run a Simulation
Running a simulation is very easy.  Click the Simulate button (the button with the red
'!' on it) in the toolbar.
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Step 1:  Click 

When the simulation starts, it prints a message in the Log Window at the bottom left
of the screen.

Look for "Simulate BANCS data…" to be sure that your simulation started.  You may
have to scroll the Log Window to see the message.  The simulation takes a few
seconds to run and will print another message in the Log Window when it completes,
either “Simulation succeeded!” or “Simulation failed!”

For more details about running simulations, see "Running a Simulation" on page 4-26.

View Simulation Results
The first result to look for is successful completion of the simulation.   Look in the
Log Window at the lower left corner of your screen for "Simulation succeeded!".  You
may have to scroll the Log Window to see the message.

Step 1:  Check for successful
simulation.

The values calculated by the simulation appear in many of the BANCS screens.  A
particular variable can be viewed in a Table, a Trend Graph, or a Bar Chart.  Some
variables can also be viewed on Setpoints, Constrained Variables, or Schematics
screens.  For more information on where to look for data, see “Where to Find Data”
on page 4-1.   In this example, we’ll look at Boiler Efficiency and Generation Cost
variables in a Table and a Bar Chart.

Step 2:  Click  

To view a particular variable, find the folder in the Tree View Window that contains
the screens for the appropriate plant section.  The Boiler Efficiency variable is in the
Boiler folder.  Open the Boiler folder (if it isn’t already open) by clicking on the ‘+’
left of the folder in the Tree View Window.

Step 3:  Double-click The Boiler Efficiency can be viewed in the Schematic, Table, Trend Graph, or Bar
Chart screens in the Boiler folder.  First display the table by double-clicking on
Table in the Tree View Window.

Step 4:  Scroll down to
Boiler Efficiency

Scroll the table down by clicking and holding the down arrow  at the bottom right
corner of the table until you see Boiler Efficiency.  The Current value for Boiler
Efficiency is the value produced by the simulation.
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Step 5: Find Current value
for Boiler Efficiency.

The values on your screen may not match these values.

Step 6:  Double-click Let’s look at Boiler Efficiency on a bar chart.  Under the Boiler folder (which should
be open), double-click Bar Charts.  The bar charts appear in the Main View Window,
but they aren’t displaying Boiler Efficiency.

The data displayed on a bar chart are changed similarly to the way you changed trend
graph data earlier in this tutorial.  Click on the bar chart to bring up a small menu.

Step 7:  Click anywhere on
the bar chart to get menu.

Step 8:  Click Data

Then click Data to change which variable is displayed on the bar chart.  The “Bar
Chart Variable Selection” window appears.
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Step 9:  Click “Boiler Eff”

Step 10:  Click 

In the “Bar Chart Variable Selection” window, click Boiler Eff to highlight it.  Then
click OK to display Boiler Efficiency on the bar chart.

Left bar is current value and
for this variable it is
calculated by simulation.

The current value is shown on the left bar.  On line, the left bar is blue and the right
bar (optimized value) is red.  Boiler Efficiency is a simulated variable, and the current
value shown is a result of a simulation.  Measured variables are obtained
automatically from the plant’s data acquisition system.  Measured variables are only
displayed in the Measured Variables folder.

Step 11:  Click + Now we’ll view another variable, Generation Cost.  All the calculated costs are kept in
a special folder, the Costs folder.  Find the Costs folder in the Tree View Window and
open it (if it isn’t already open) by clicking on the ‘+’ left of the folder.
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Step 12:  Double-click

Step 13:  Find Generation
Cost in table.

Then display the Costs folder’s table by double-clicking on Table.   The Generation
Cost is visible without scrolling.

The current value is underlined.  For Generation Cost, the current value is a simulated
value.

Optimizations
What is an optimization?  An optimization is a calculation of setpoints that results in
least-cost operation of the plant while meeting all safety, environmental, and
operating constraints.

Edit Data for an Optimization

What Data to Edit

Users may edit more variables that affect optimizations than affect simulations.
Manual Inputs are the only variables that affect simulations and can be edited by
users.  Editable data that affect optimizations include:

• Setpoints:  minimum/maximum

• Setpoints:  fixed

• Constrained Variables:  minimum/maximum

• Manual Inputs (if your installation has any)

 For more details on data that affect optimizations, see “Editing Data for an
Optimization” on page 4-30.

The Editing Procedure

Editing data for an optimization requires the same four steps as for a simulation:

1) Display the appropriate screen,

2) Start an edit session,

3) Make the changes,

4) End the edit session by saving or canceling  the changes.

In this example, we’ll edit setpoints and constrained variables.   Remember that the
tables in the Manual Inputs  folder can be edited prior to an optimization.  In this
section, we’ll skip editing of those data because we covered this in the previous
section.

Step 1a:  Click

Step 1b:  Double-click

First, display a screen for editing.  Open the System Overview folder in the Tree View
Window (if it isn’t already open) by clicking on the ‘+’ left of the folder.  Then
display the System Overview’s Setpoints screen by double-clicking on Setpoints
under the folder.  The slider view of the setpoints appears in the Main View Window.
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Slider view appears after double-clicking on System Overview’s Setpoints in Tree View.

The next step is to get BANCS into edit mode.  The same procedure is used here to
start an edit session (get BANCS into edit mode) as we used when editing tables.
Click the Start Edit button on the toolbar.  It has a little pencil on it and is the leftmost
button on the toolbar.

Step 2a:  Click 

In the window that appears, type your password into the blank field.  The letters you
type will appear as *** in the box, so that your password isn't visible to anyone near
your monitor.

Step 2b:  Type your
password.

Step 2c:  Click

Then click the OK button on the “Password” window.  BANCS is now in edit mode
and will allow you to change data.

We’re going to change the minimum and maximum values for FD Fan Bias. Find the
slider for FD Fan Bias.  Double-click on the thermometer portion of the slider to bring
up a big slider.



2-16  •  BANCS Tutorial Boiler and NOx Control System BANCS

Step 3a:  Double-click on the
thermometer part of FD Fan
Bias slider.

You must double-click on the narrow rectangle in the
middle of the slider to get the big slider to appear for editing.  Other portions of the
little slider do not respond to double-clicking.

Big slider appears after double-clicking on small slider’s thermometer.

This big slider window allows you to change the minimum or maximum allowed values
for this setpoint.   Change the values in the two text fields by clicking in the field,
deleting or backspacing over the old number, and then typing in a new number.

Step 3b:  Change the values.

Step 3c: Click

 and

To see the new values displayed on the slider, click the Apply to Max and Apply to
Min buttons.   Clicking these buttons does not save the new values.  These buttons
move the arrows on the slider to reflect the changes as shown.
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FD Fan Bias slider after clicking Apply to Max and Apply to Min shows new max and min.

In the example shown, the optimized FD Fan Bias is 52.4% which is above the
maximum value we just set. Your screen may show different values for the current and
optimized setpoints.  (BANCS uses different colors to distinguish the four values on
the slider.  If you are reading this manual in black-and-white printed form, you’ll have
to look at the monitor to see the colors.) When we run an optimization, it will take into
account the upper bound of 52% and will calculate an optimum setpoint between 48%
and 52%.

Step 3d:  Click Click OK to close the big slider window.

If you want an optimization to use a particular value for a setpoint, rather than finding
an optimum between the minimum and maximum allowed values, then you should fix
the setpoint.  As an example, we’ll fix the Excess Oxygen setpoint.  The procedure is
very similar to editing a setpoint’s minimum and maximum.

Find the Excess Oxygen slider in the Main View Window.  Click on the little box in the
upper left corner to bring up a big slider.  (The method for bringing up a big slider for
fixing a setpoint is different than the method for bringing up a big slider for setting
minimum and maximum values.)
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Step 3e:  Click the box in the
upper left corner of Excess
Oxygen.

A big slider appears.  It looks very similar to the big slider used for editing minimum
and maximum, but it has an extra text field and button.

This big slider appears after clicking on the little box in the upper left corner of a small slider.

Here, click in the text field, use the Backspace or Delete keys on your keyboard to
erase the old number, and then type the new number, 3.

Step 3f:  Change the values.

Step 3g:  Click To display the new value on the slider, click the Apply to Fixed button.  This button
moves the arrow on the slider but does not save the value.

The new value appears on the “Fixed” arrow pointing to the slider.
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After clicking Apply to Fixed, the slider displays the new fixed value on an arrow.

In this example, the optimized value is still at 5.28%.  The next optimization run will
take into account the fixed point and will use a value of 3% for the Excess Oxygen
setpoint.

Step 3h:  Click Click the OK button to close the big slider.  The Excess Oxygen small slider now has
a check mark in the upper left corner.

This check mark means that the Excess Oxygen setpoint is fixed and the optimization
will use the fixed value rather than trying to find an optimum value.  The value of the
fixed setpoint is displayed next to the check mark.  Here it is 3.

When you have finished editing minimums, maximums, and fixed points on this
screen, terminate your edit session by either saving changes or canceling changes.
Until this point, the changes you have made have not been saved and can be erased
by canceling.   See “Cancel Changes  Menu” on page 4-24 for more details about
canceling changes.  To save the changes made earlier to Excess Oxygen and FD Fan
Bias, click the Save Changes button in the tool bar.  It  has a yellow lightning bolt on
it.
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Step 4:  Click  to save.

In addition to saving changes, the Save Changes button takes BANCS out of edit
mode and ends the current editing session.  The lightning bolt turns gray after
clicking, indicating that it is now inactive.

Run an Optimization
Running an optimization is easy.  Click the Optimize button on the toolbar.  It has
two blue exclamation points (!!) on it.

Step 1:  Click 

When the optimization starts, it prints a message in the Log Window at the bottom
left of the screen.

                      Log Window à

Look for "Optimize BANCS data…" to be sure that your optimization has started.
You may have to scroll the log window to see the message.  The optimization takes a
few minutes to run and will print another message in the Log Window when it
completes, either “Optimization succeeded!” or “Optimization failed!”

For more details about running optimizations, see “Running an Optimization” on page
4-30.

View Optimization Results
Many BANCS screens display optimization results.  They can be found in the Table,
Bar Charts, Setpoints, and Constrained Variables screens.   In this tutorial, we’ll
look at a value in the Setpoints screen and a Table screen.   For more information on
where to find various kinds of data in BANCS, see “Where to Find Data” on page 4-1.

Step 1:  Look for successful
completion of optimization.

The first result to look for is successful completion of the optimization.  Optimizations
can take a couple of minutes to run.  When an optimization is completed, it posts a
message in the Log Window.  Look for “Optimization succeeded!” in the Log
Window at the lower left of your screen.  You may have to scroll this window
vertically to see the message.

                    Log Window à
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Step 2:  If not open, click

Step 3:  If not displayed,
double-click

In the Tree View Window, find the System Overview folder and display its Setpoints
screen.  The System Overview folder is probably already open from the previous
editing session, but if not, click on the ‘+’ at the left of the folder to open it.  Then
display the Setpoints screen that is in the folder by double-clicking on it.

Find the FD Fan Bias slider in the Main View Window.  During the previous editing
session, we restricted this to a range of 48% to 52%.  Check the new optimum value
just calculated by placing the cursor over the slider’s thermometer.  A balloon
appears with four values in it. The value labeled “Optimized” was calculated by the
optimization you just ran.  Notice that the optimum which was 52.4% when we edited
the minimum and maximum is now 50%.

Step 4: Place  cursor on FD
Fan Bias thermometer.

Look at the Excess Oxygen slider, too.  During the previous edit session, we fixed
Excess Oxygen at 3%.  For fixed setpoints, the optimizer does not calculate an
optimum value, but uses the fixed value.  Place the cursor over the Excess Oxygen
slider’s thermometer to bring up the balloon.  The new optimum is 3%, which is the
value we fixed earlier.

Step 5:  Place cursor over
Excess Oxygen thermometer.

A portion of the thermometer is shaded in this example.  The shading shows the
difference between current and optimized values.  If the current value is higher than
the optimized value, as it is here, the shaded area appears gray on the screen.  If the
optimum is higher than the current value, the shaded area is green.
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Step 6:  Click ‘+’ to open

Step 7:  Double-click

In addition to setpoints, the optimization calculates plant operating costs.   These
costs are available in the Costs folder.  Open the Costs folder by clicking the ‘+’ at
the left of the folder.  Display the Costs folder’s Table screen by double-clicking on
it.  In the table, find Generation Cost by scrolling, if necessary.  The value calculated
by the optimization you just ran is shown as the “Optimized” value.   In the example
below, the optimized value for Generation Cost, 0.34,  is significantly lower than the
plant’s current value of 0.76.
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BANCS Menus and Commands

Overview
This section describes how to navigate the BANCS screens, menus, and toolbar.
Users who are familiar with another PECOS module such as CBAS or SCYCLOPS
already know most of the material in this section.  BANCS Boiler operations are
described in "Using BANCS" on page 4-1.

The general operating method in BANCS is to first use the Tree View Window to
select a screen for display in the Main View Window.  Then execute commands for
the selected screen from the menus or the toolbar.

BANCS Windows
BANCS has three windows, the Tree View Window, the Main View Window, and the
Log Window.  In addition to the windows it has a menu bar, a toolbar, and a status
bar.

The Tree View Window is used to change the screen displayed in the Main View
Window.  The Tree View Window contains folders which each contain a  number of
screens.
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The Main View Window displays whatever screen was most recently selected from
the Tree View Window.  The Main View Window displays BANCS data.  Various
operations can be performed on the screens through menu commands and toolbar
commands.

The Log Window records and displays BANCS events.  For example, when an edit
session is started, “Edit mode started” appears in the Log Window.  This window can
be scrolled to see what operations were performed in the recent past.

The menu bar provides menus and commands to perform operations in BANCS.
Some examples of BANCS operations are editing data, running a simulation, and
running an optimization.

The toolbar provides shortcuts for the most common BANCS operations.  It provides
quicker ways to execute some of the menu bar commands.  The toolbar can be hidden
or displayed by the user.

The status bar indicates what BANCS is doing right now.  It can also provide brief
descriptions of toolbar functions.  A description appears when the cursor is placed
on the toolbar button.  The status bar may be hidden or displayed by the user.

Tree View Window
The Tree View Window controls what screen is displayed in the Main View Window.

Displaying BANCS Tree View Window
When  PECOS is running, all installed modules ( which may include CBAS, BANCS,
SCYCLOPS) are available to the user through the Tree View Window.  The Tree View
Window  is the narrow window at the left side of the screen.

The Tree View displays a different pane for each installed module.

Click BANCS tab to display
BANCS Tree View

 

To display the BANCS pane, click the  BANCS tab at the top of the Tree View
Window.
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Opening Folders

Click +

               OR

  Double-click folder

The yellow folders in the tree (labeled System Overview, Coal, Mills, …) each contain
several screens that may be displayed in the Main View Window.  To see the list of
screens available in a folder, open the folder by clicking on the [+] to the left of the
folder,  by double-clicking on the folder, or by double-clicking on the folder name.

               OR

Double-click name

Opening a folder does not change the screen displayed in the Main View Window.

Closing Folders

 Click  -

                OR

The yellow folders in the Tree View Window may be closed by either clicking on the
[-] to the left of the folder, double-clicking on the open folder, or double-clicking on
the name of the open folder.

 Double-click folder

                OR

Double-click name

 

Closing a folder does not change the screen displayed in the Main View Window.

Changing the Screen Displayed in Main View
Window
When the folders in the Tree View Window are open, they display a list of screens
that may be shown in the Main View Window.

Double-click screen name

For example, the Coal folder has Table, Trend Graphs, and Bar Charts screens.  To
display a screen in the Main View Window, double-click on its name.
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Changing the Size of the Tree View Window

 Drag border
The Tree View Window may be resized by dragging its lower or right border.  To drag
the border, position the cursor over the border so that the opposing arrows appear in
place of the cursor.  Then hold down the left mouse button and move the border to
its new location.

This example shows the opposing arrows at the bottom of the Tree View.

The File Menu

Opening the File Menu
The File menu is the leftmost menu in the menu bar located near the top of the PECOS
window.  Open the File menu by clicking on File.

Save As… Command
The Save As… command is not available for any BANCS operations and is grayed
out when any BANCS screens are displayed.

Print Command
The Print command prints the current Main View Window.   The Main View Window
is the big window on the right side of the PECOS display.  The Main View Window
displays trend graphs, tables, schematics, and setpoints.

To print, click File in the menu bar, and then click Print.
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Exit Command
The Exit command disconnects the PECOS user interface running on your computer
from the PECOS server and terminates the PECOS user interface.

To exit, first click File in the menu bar and then click Exit.

The Edit Menu

Opening the Edit Menu
The Edit menu is the second item from the left in the menu bar, which is located near
the top of the PECOS display.   To open the Edit menu, click Edit.

Start Edit
The Start Edit command allows the user to begin an edit session in the Main View
Window.  Start Edit is not available for most of the BANCS screens because many of
the screens cannot be edited.  When the Main View Window is displaying a screen
that cannot be edited, the Start Edit command will be grayed out.  It is active for the
screens in the Manual Inputs folder, for the Setpoints, and Constrained Variables
screens.   Clicking the Start Edit command brings up a dialog box requesting a
password.  A password is required to edit in BANCS.
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Save Changes
The changes made during an editing session are not saved until the Save Changes
command is executed.  To save the changes made during an editing session, open the
Edit menu and click Save Changes.

The Save Changes command is available only during an editing session.  When you
save your changes, the edit session ends and the Save Changes command is grayed
out.   (An editing session is started using the Start Edit command.)

If you forget to save your changes, BANCS will prompt you to save the changes after
a certain number of seconds.  Users may change the idle time before the prompt
appears using the Edit Mode Timeout command found in the Options menu.  BANCS
also prompts for saving changes when the user selects a different screen to display in
the Main View Window.  BANCS will ask if the user wants changes saved or
canceled.

If you don't want to save changes, but do want to end the edit session, use the Edit
menu's Cancel Changes command.  It is described in "Cancel Changes" on page 3-7.

 button does same thing
as Edit menu's Save Changes

The Save Changes command does exactly the same thing as the toolbar's  Save
Changes button.  See "Saving Changes from an Edit Session" on page 3-25 for a
description of the button.

Cancel Changes
If you are editing a BANCS screen and decide that you want to erase all the changes
you've made since starting the edit session, pull down the Edit menu and click Cancel
Changes.   (Editing sessions are started using the Edit menu's Start Edit command.)

The Cancel Changes command removes your changes from the screen and ends the
edit session.  When the session ends, the Cancel Changes command is grayed out.

 button does same thing
as Edit menu's Cancel
Changes command

The toolbar has a button that does exactly the same thing as the Edit menu's Cancel
Changes command.  For a description of the button, see "Canceling Changes from an
Edit Session" on page 3-26.
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The View Menu

Opening the View Menu
The View menu is the third item from the left in the menu bar, which is located near
the top of the PECOS display.   To open the View menu, click View.

Many of the commands in this menu are not used in BANCS.  All the commands
grayed out in the picture above are CBAS commands.

Toolbar Command
The Toolbar command toggles the display of the toolbar.  The toolbar is a set of
buttons that appears just below the menu bar.

                        The toolbar-à

If the toolbar is visible, then the Toolbar command has a check mark beside it in the
View menu.  Clicking on the checked Toolbar command hides the toolbar and
removes the check mark from the menu.

Clicking the Toolbar command when the toolbar is not visible will bring the toolbar
back into view.

Status Bar Command
The Status Bar command toggles the display of the status bar.  The status bar
displays a single line of text below the Log Window at the lower left corner of the
screen.  It displays text help and status information describing BANCS operations
and current status.  Placing the cursor over a button on the toolbar will display a
description of the button on the status bar.
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                    The status bar-à

The status bar here displays "Ready".

If the status bar is displayed, the Status Bar command appears in the menu with a
check mark beside it.  Clicking the Status Bar command hides the status bar.  Clicking
the Status Bar command when the status bar is hidden will bring it back into view.

Other View Menu Commands
If you have other PECOS modules installed besides BANCS, the View menu contains
grayed out commands for those modules.  For example, the Dead Coal command is
used in the CBAS module.  These commands cannot be used for any BANCS
screens.

The Options Menu

Opening the Options Menu
The Options menu is the fourth item from the left in the menu bar at the top left of the
PECOS display.  To open the Options menu, click Options.

BANCS Simulate Command
The BANCS Simulate command calculates plant performance variables (such as Net
Power Out and Net Plant Heat Rate)  from current measured on-line data and
parameters supplied by the user.  The results of the Simulate command appear in the
Table, Trend Graph, Bar Chart, Setpoints, Schematics , and Constrained Variables
screens in BANCS.  For example, Stack Opacity, a simulated variable, appears in the
Stack  folder's Table, Trend Graphs, Bar Charts, and Schematic screens.   Stack
Opacity also appears in the System Overview folder’s Constrained Variables, Table,
Trend Graphs, and Bar Charts screens. (The System Overview and Stack folders
appear in the Tree View Window.)



Boiler and NOx Control System BANCS BANCS Menus and Commands  •  3-9

To run a simulation from the Options menu, move the cursor over the BANCS
command to open the BANCS submenu.

Then click Simulate.

The Log Window displays "Simulate BANCS data…".  When the simulation is
complete, the Log Window displays either "Simulation succeeded!" or "Simulation
failed!".   See “Running a Simulation” on page 4-26 for more details on running
simulations.

BANCS Optimize Command
The BANCS Optimization calculates optimum setpoints for least-cost operation of the
plant based on current measured data, manual input data, and constraints set by the
user.  The user may enter unmonitored data in the Setpoints, Inputs, and On/Off
Status screens in the Manual Inputs folder (if this installation of PECOS has manual
inputs).  The user may constrain setpoints and other variables using the Setpoints
screen and the Constrained Variables screen.

Values that are calculated by the optimization appear in BANCS Table, Bar Charts,
Setpoints, and Constrained Variables screens.   They do not appear in Trend Graphs
or Schematics . Users may find the value of interest either in the System Overview
folder's screens or in the appropriate plant subsystem's screens.  For example, Excess
Oxygen may be viewed in the System Overview folder’s Table, Bar Charts, or
Setpoints screens or in the Furnace folder's Table or Bar Charts screens.

To run an optimization from the Options menu, move the cursor over the BANCS
command to make the BANCS submenu appear.

Then click Optimize.

The Log Window displays "Optimize BANCS data…".  When the optimization is
done, the Log Window displays either "Optimization succeeded!" or "Optimization
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failed!"  For more details on running an optimization see “Running an Optimization”
on page 4-30.

Edit Mode Timeout Command
If BANCS is in edit mode, and no activity has occurred (such as data entry) for a
specified period of time, a dialog box appears with the warning that the program is
still in edit mode and that the data have not been saved.  This functionality is
included to help the user remember to Save Changes after entering data.  The Edit
Mode Timeout is the amount of idle time that BANCS waits before showing the dialog
box asking the user to save changes.  During an editing session, the timeout period
will double each time the user is asked to save changes but prefers to continue
editing rather than saving.  After changes are saved and a new editing session is
begun, the timeout period resets to its original value.

Users can set the number of seconds that BANCS waits before prompting for
changes to be saved by using the Edit Mode Timeout command on the Options menu.

Clicking on Edit Mode Timeout brings up a dialog box.

Type in the number of seconds that you
want BANCS to wait before reminding you to save your changes and click OK.

Note that this Edit Mode Timeout period is used by all PECOS modules installed at
your site, not just by the BANCS module.  If CBAS is installed, it uses the same
timeout period as BANCS.

The Equipment Menu
The Equipment menu provides commands for CBAS only.  See the chapter on CBAS
Menus and Commands in the CBAS User's Manual..

The Help Menu

Opening the Help Menu
The Help menu is the rightmost item on the menu bar near the top of the PECOS
display.  To open the Help menu, click Help.
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About PECOS
The About PECOS command brings up a screen of information about PECOS,
including the version number, email addresses and phone numbers for support.  Open
the Help menu and click About PECOS to display the information screen.

Contents Command Opens Help Topics Window
The Contents command brings up the on-line help for all PECOS modules (CBAS,
BANCS, and SCYCLOPS) that are installed on your computer.    Click Contents to
bring up the “Help Topics” window.

The “Help Topics” window has three tabs, Contents, Index, and Find.

The Contents Tab in the Help Topics Window

Displaying the Table of Contents

Click the Contents tab near the top of the “Help Topics” window to get a table of
contents for the on-line help.
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Opening Chapters

double-click book

To display the sections in each chapter, click the book icon at the left of the chapter
to select the chapter, and then click the Open button at the bottom of the window.
Double-clicking the book icon also opens the chapter.

In
this example, "Getting Started" is highlighted, so clicking the Open button will display
the sections in the "Getting Started" chapter in the CBAS Manual.

Closing Chapters

double-click open book
To close a chapter in the table of contents, click the open book icon at the left of the
chapter name to select the chapter, and then click the Close button at the bottom of
the window.  Double-clicking the open book icon also closes the chapter.
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In
this example, the "Getting Started" chapter is open and selected.  Clicking the Close
button will close "Getting Started" in the CBAS Manual.

Opening Sections

double-click the "?"

To read a section,  click on the section name to select it, and then click the Display
button at the bottom of the help window.  The Display button does not appear until a
section name is selected.  Double-clicking on the section icon or section name also
displays the section.  The text is displayed in a separate text window.  See "The Text
Window" on page 3-22 for more details.
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In
the example shown, the "Description of PECOS" section is selected.  Clicking the
Display button brings up a text window showing the contents of this section.

Return to Contents after Viewing Section

click to return to
table of contents

When a section is opened, the help system replaces the window containing the table
of contents with a window displaying text.  To get back from the text window to the
table of contents, click the Contents button near the top left corner of the text
window.

The Index Tab in the Help Topics Window
If the "Help Topics" window is not visible on your screen, open it by clicking on the
Help menu and selecting Contents.  (For more details on how to open the "Help
Topics" window, see "Contents Command Opens Help Topics Window" on page 3-
13.)
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Displaying the Help System's Index

Click the Index tab in the “Help Topics” window to display an index of topics.

This index is very similar to the index in a book.

Select and Display a Topic

Selecting and viewing an index topic is a 3-step process.

1) The Index tab directs you to type the first few letters of the item you are
searching for in the top field.  As you type,  the second field finds topics that
match the letters you are typing.  This saves you from scrolling through all the
topics.

2) Select a topic in the second field by clicking on it.

3) Click the Display button.  This brings up the help system's text viewer.  See "The
Text Window" on page 3-22 for more details on the text viewer.
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In
this example, the user has typed "me" into the top field.  The help system
automatically positions the topics to display the first item starting with the letters
"me".  At any time, the user may select a topic from the list by clicking on it.  In this
example, "Memory requirements" is selected, so clicking the Display button at the
bottom of the window brings up a text window displaying the "Memory
requirements" topic.

Return to Index after Viewing a Topic

returns to Index

When an index topic is selected and displayed, the help system closes the “Help
Topics” window (which contains the index and table of contents) and opens a text
viewing window.  To get back to the index from the text window, click the Index
button near the top left of the window.

More information on this help text window is available in "The Text Window" on
page 3-22.
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The Find Tab in the Help Topics Window
The Find tab provides a text searching tool that finds sections of the manual
containing words or phrases of interest.  Users may select words from a list or type in
the words or phrases.

Displaying the Help System's Text Search Window (Find)

If the "Help Topics" window is not visible on your screen, open it by clicking on the
Help menu and selecting Contents.  (For more details on how to open the "Help
Topics" window, see "Contents Command Opens Help Topics Window" on page 3-
13.)

To display the text search window, click the Find tab near the top of the "Help
Topics" window.

Searching for Words

The Find tab has three fields that accept input or selections from the user.  These
three fields work together to find sections in the manual that contain the words of
interest.
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      “Help Topics” window à

Field 1:  Type the first few letters of the word that you are looking for in the top field.
As you are typing, the second and third fields change to show words and topics that
match the words you are typing into the first field.  If you don't want to type any
words, you may select words from the second field by scrolling it and clicking on the
word you want.

Field 2:  The second field displays the words in the manual that match the words you
typed in the top field.  There may be many matching words.  If so, you can select one
of them to narrow the search by clicking on the word in the second field.

Field 3:  The third field displays sections of the manual that contain the words
selected in the second field.  Click on the section that you want to read.

To read the section that is selected in the third field, click the Display button.  A new
window appears, displaying the text.  For more information about this text window,
see "The Text Window" on page 3-22.

You may enter words and select topics in the three fields in any order.   If the section
you want doesn't appear in the third field, go back to the first or second field and
make some changes.
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Returning to the Search (Find) Window

Click              or

      

Then click  

When a search topic is displayed from the “Help Topics” window's Find tab, a new
text window appears and the “Help Topics” window disappears.  To get back to the
“Help Topics” window to do another search, click either the Contents button or the
Index button near the top of the text window.  Then click the Find tab.

                       Text window à

The Text Window
A window displaying  text appears when a section, an index item, or a keyword item is
selected and displayed from the “Help Topics” window.

                       Text window à

See the sections "The Contents Tab in the Help Topics Window" on page 3-14 and
"The Index Tab in the Help Topics Window" on page 3-17 for more details about
using this text window.

Getting Back to the Contents

return to table of contents

From the text window, click the Contents button near the top left of the text window
to get back to the table of contents in the “Help Topics” window.

Getting Back to the Index

return to index

From the text window, click the Index button near the top of the text window to return
to the index in the “Help Topics” window.
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Getting Back to Text Search (Find)

Click                or

      

Then click 

From the text window, click either the Contents button or the Index button near the
top of the text window.  The Help Topics window will appear.  Then click the Find
tab.

Underlined Words have Glossary Definitions

Click on
underlined word to display
definition.

Glossary definitions for terms may be viewed in the text window by clicking on the
defined word.  Words that have glossary definitions are underlined and highlighted
in green.  Positioning the cursor over the underlined word changes the cursor from an
arrow to a little hand. Click on the underlined word to pop up a balloon
displaying the definition.

This example shows a balloon containing the glossary definition of BANCS.

The Toolbar

What is the Toolbar?
The toolbar is located near the top left of the PECOS screen under the menu  bar.

The toolbar contains buttons to Start Edit, Save Changes, Cancel Changes, Cut,
Copy, Paste, Print, Simulate, Optimize, and Help.  These commands are all available
as menu commands.  The toolbar buttons provide a shortcut so you don't have to
pull down a menu and click a command on it.   Some buttons may be grayed out.  If a
button is gray, the command cannot be used on the screen currently displayed  in the
Main View Window.
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Hiding and Displaying the Toolbar
If the toolbar is not displayed on your screen, pull down the View menu and click the
Toolbar command.  The Toolbar command toggles the toolbar display.  If the toolbar
is displayed and you want to remove it, pull down the View menu and click Toolbar.

Gray Buttons
When a toolbar button is gray, it is deactivated.  It does nothing if you click on it.
Toolbar buttons turn gray when their associated operation is inappropriate.  For
example, if you are viewing the System Overview’s Schematic screen, the Start Edit
button is gray because there is nothing in the Schematic that can be edited.  If you
switch the screen to the Manual Inputs' Unit Costs, then the Start Edit button's
pencil changes from gray to yellow.

Starting an Edit Session

   the Start Edit button
Some BANCS screens allow users to change data.  When you display an editable
screen in the Main View Window, the Start Edit button on the toolbar is activated.
The little pencil is yellow when the Start Edit button is active, and it is gray
otherwise.   Screens that can be edited include the Setpoints, Constrained Variables,
Unit Costs, Input, and On/Off Status screens.  When displaying other screens, the
Start Edit button is grayed out.  Clicking the Start Edit button will start an editing
session by asking you for a password.  After correctly typing  your password in the
window that appears and clicking OK, you are in edit mode and may make changes to
the screen.   When you have finished making changes, remember to save your
changes using the Save Changes toolbar button or the Edit menu's Save Changes
command.  If you want to erase the changes and end the edit session, use the Cancel
Changes command described in “Canceling Changes from an Edit Session” on page
3-26.

The toolbar's Start Edit button does exactly the same thing as the Edit menu's Start
Edit command.  See "The Edit Menu" on page 3-5 for more information on using this
menu command.

Saving Changes from an Edit Session

 the Save Changes button
When you have finished making changes to a screen, you can save the changes or
you can discard the changes.  To save the changes, click the Save Changes button.
The Save Changes button has a lightning bolt on it with an arrow pointing down.
The lightning bolt is red and yellow while you are in  edit mode, indicating that it is
possible to save changes.  When you save changes, BANCS leaves the edit mode
and the Save Changes button turns gray.

If you don't want to save your changes, end the edit session by clicking the Cancel
Changes button.  This is described in "Canceling Changes from an Edit Session" on
page 3-26.

The Save Changes button does exactly the same thing as the Edit menu's Save
Changes command.  For a description of the menu command, see "Save Changes" on
page 3-6.
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Canceling Changes from an Edit Session

 the Cancel Changes
button

If you are editing a BANCS screen and decide that you want to undo all the changes
that you've made in the current editing session, you can end the edit session by
clicking the Cancel Changes button.  The Cancel Changes button will turn gray,
indicating that you're no longer in edit mode.

If you want to save your changes, end the edit session by clicking the Save Changes
button described in "Saving Changes from an Edit Session" on page 3-25.

The Cancel Changes button does exactly the same thing as the Edit menu's Cancel
Changes command.  See "Cancel Changes" on page 3-7 for more information about
the Edit menu.

Cut, Copy, and Paste

 the Cut button

 the Copy button

 the Paste button

These buttons are not used for any BANCS editing or operations.  They are grayed
out when viewing any BANCS screens, indicating that these buttons cannot be used.

View Dead Coal

 the View Dead Coal
button

This button, which has a coal pile on it, is not used in BANCS.  It is used by another
PECOS module, CBAS.  When viewing any BANCS screens, this button is grayed
out.

Printing a Screen

 the Print button
The Print button on the toolbar prints the screen currently displayed in the Main
View Window.  This button does the same thing as the File menu's Print command.
The "Print Command" section on page 3-5 describes how to use the menu command.

Simulate

 the Simulate button
The Simulate button calculates plant performance variables (such as Net Power Out
and Net Plant Heat Rate)  from current measured on-line data and parameters supplied
by the user. The results of the Simulate command appear in the Table, Trend Graph,
Bar Chart, Setpoints, Schematics , and Constrained Variables screens in BANCS.
For example, Stack Opacity, a simulated variable, appears in the Stack  folder's Table,
Trend Graphs, Bar Charts, and Schematic screen.   Stack Opacity also appears in
the System Overview folder’s Constrained Variables, Table, Trend Graphs, and Bar
Charts screens. (The System Overview and Stack folders appear in the Tree View
Window.)

After you click the Simulate button, the Log Window displays "Simulate BANCS
data…".  When the simulation is complete, the Log Window displays either
"Simulated succeeded!" or "Simulation failed!".

A simulation usually follows an editing session.  Users typically want to change
some value and see how it affects the plant variables.  The editing, simulation, and
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viewing of results are described in detail in “Running a Simulation” on page 4-26.
“Simulations” on page 2-8 provides a tutorial example of running a simulation.

The Simulate button does exactly the same thing as the Options menu's
BANCS>Simulate command.  The "BANCS Simulate Command" section on page 3-9
describes how to use the menu command.

Optimize

 the Optimize button
The BANCS Optimize button calculates optimum setpoints for least-cost operation
of the plant based on current measured data, manual input data, and constraints set
by the user. The user may enter unmonitored data in the Setpoints, Inputs, Unit Costs
and On/Off Status screens in the Manual Inputs folder (if this installation of PECOS
has an manual inputs).  The user may also constrain setpoints and other variables
using the Setpoints screen and the Constrained Variables.  “Editing Data for an
Optimization” on page 4-30 provides a detailed description of the data that affect an
optimization and how to edit that data.

Values that are calculated by the optimization appear in BANCS Table, Bar Charts,
Setpoints, and Constrained Variables screens.   They do not appear in Trend
Graphs or Schematics . Users may find the value of interest either in the System
Overview folder's screens or in the appropriate plant subsystem's screens.  For
example, Excess Oxygen may be viewed in the System Overview folder’s Table, Bar
Charts, or Setpoints screens or in the Furnace folder's Table or Bar Charts screen.

After clicking the Optimize button, the Log Window displays "Optimize BANCS
data…".  When the optimization is complete, the Log Window displays either
"Optimization succeeded!" or "Optimization failed!"

The Optimize button does exactly the same thing as the Options menu's
BANCS>Optimize command.  See "BANCS Optimize Command" on page 3-10 for a
description of how to use the menu command.

For a full description of which data affect an optimization, editing data for an
optimization, running and viewing results of an optimization, see “"Running an
Optimization" on page 4-30.  A tutorial example is provided in “Optimizations” on
page 2-15.

Help

 the Help button
The Help button brings up the on-line help manual.  The use of the on-line manual is
described in "The Help Menu" on page 3-12.  The Help button does exactly the same
thing as the Help menu's Contents command.

Forgot what buttons do?  Use Button
Descriptions

 hold cursor over
button to get description

BANCS can display a label for each toolbar button.  To display a button's label, put
the cursor arrow over the button and leave it there for a second or two.  A balloon
appears with a few words describing the button.  You don't have to click anything to
see the balloon.  When you have read the balloon label, move the cursor and it will
disappear.
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Using BANCS

Viewing Data in BANCS

Where to Find Data
BANCS displays data in many different screens.  The screens are organized in folders
and displayed in the Tree View Window.  (The BANCS windows are described in
“BANCS Windows” on page 3-1.)

       The Tree View Windowà

Click ‘+’ to open folder.

Double-click on screen name
to display screen.

Here the Mills folder is open, and the screens that it contains (Schematic, Table,
Trend Graphs, Bar Charts, and Setpoints) are listed below it.  To open a folder, click
the '+' to the left of the folder.  To display a screen in the Main View Window, double-
click on the name of the screen in the Tree View Window.

If you don't see these folders in the Tree View Window, click on the tab at the top of
the window labeled BANCS.  If you have other PECOS modules installed besides
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BANCS (like CBAS or SCYCLOPS), the Tree View can display folders and screens for
those modules.

System Overview Folder:  Data from Many Plant Sections

The System Overview folder displays important variables from various sections of
the plant.  These variables are also available in the plant section folders.  For example,
the variable Mill A Bias is available in both the System Overview screens and in the
Mills folder's screens.  The Table, Trend Graphs, and Bar Charts screens in the
System Overview present the same data, but in different forms.  If you want to see
several values from different parts of the plant at the same time, the System Overview
is a good place to find that data.  Open the System Overview folder by clicking on the
'+' next to the folder in the Tree View.  Display one of the screens under the System
Overview folder by double-clicking on the screen name.

Using the System Overview screens can be cumbersome, though, because there are
many data items to scroll through to find any single item.  If you are interested  in
data for a particular part of the plant, use the screens in the folder corresponding to
that plant section.

By Plant Section

Most of the folders contain screens that show data relevant to a particular section of
the plant.  To see a particular value, find the folder that corresponds to the part of the
plant of interest.  Open the folder by clicking on the '+' next to the folder.  Then
double-click on one of the screen names under the folder.  For example, to view a mill
exit temperature, open the Mills folder and then double-click on either the Table,
Trend Graph, or Bar Chart screens which are listed under the Mills folder.  Some
data may also be viewed on a Schematic or Setpoints screen.  The Schematics  show
only a few selected values.  The Setpoints screen shows only data values that
happen to be setpoints in the plant's control system.

By Type:  Manual Inputs Folder

If the BANCS installation at your plant does not get all its data from the plant’s on-
line data acquisition system, the Tree View Window will have a Manual Inputs folder.
The Manual Inputs folder contains screens for data that are not available on-line and
must be input into BANCS by hand.  These values are collected in the Manual Inputs
folder for convenience, so that they can be edited at the same time.  The data in the
Manual Inputs folder are also available in corresponding plant section folders.  Some
of these data appear  in the System Overview folder.

By Type:  Costs Folder

The Costs folder summarizes current operating costs.  Examples of operating costs
are Coal Cost and Generation Cost.  They are calculated from Unit Costs and other
current plant data.  The Unit Costs screen is in the Manual Inputs folder and may be
edited by the user.
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By Type:  Measured Variables Folder

The Measured Variables folder has screens that show all the variables that BANCS
is acquiring from the plant's on-line data acquisition system.  These variables will
appear in other folders.  For example, Burner Tilt appears in the Measured Variables
folder's Table screen, and it also appears in the Furnace folder's screens.

By Type:  Setpoints Screens

Setpoints are not segregated into a separate folder, but are shown on separate
screens within other folders.  All setpoints may be viewed and edited from the
System Overview folder's Setpoints screen.  Open the System Overview folder by
clicking on the '+' at the left of the folder and then double-click Setpoints.

The Mills folder also contains a Setpoints screen.  To display the Mills Setpoints
screen, open the Mills folder by clicking on the '+' at the left of the folder and then
double-click Setpoints.

If any setpoints are not being read into BANCS automatically from the plant data
acquisition system and must be input by hand, they appear in the Manual Inputs
folder's Setpoints screen.  To display the Manual Inputs Setpoints screen, open the
Manual Inputs folder by clicking the '+' at the left of the folder and then double-click
Setpoints.

By Type:  Constrained Variables Screen

When doing an Optimization, some variables must be kept within minimum and
maximum values because of operational, performance, or safety constraints.
Variables with these kinds of bounds which are not setpoints are called constrained
variables.  The System Overview folder contains a special screen which displays
constrained variables and allows users to set the minimum and maximum for each.

Viewing Data in Tables
Some of the BANCS screens display data in tables.  If the table contains more values
than will fit in one screen, you may have to scroll the window using the scrollbar on
the right to find the data of interest.
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Blue  values are near Min or
Max

Red values exceed Min or
Max

* means Current value is
measured

Tables display a Current value, which is underlined, and an Optimized value for each
variable.  The Current value is either a measured value that comes from the plant data
acquisition system (measured variables are only displayed in the Measured Variables
folder) or it is a simulated value (that is, it is calculated from other variables.)  Tables
are one of the places where you can view the results of running a simulation.  For
more details on running a simulation, see "Running a Simulation" on page 4-26.

The Optimized value in the tables is the result of running an optimization.  Tables are
one place where you can view the results of an optimization.  For more details on
running an optimization, see "Running an Optimization" on page 4-30.

If a Current value is within 5% of a minimum or maximum, but does not exceed the
minimum or maximum, the value is displayed in blue and the corresponding minimum
or maximum is also displayed in blue.  If a Current value exceeds a minimum or
maximum, it is shown in red and the exceeded limit is also shown in red.

Viewing Data in Trend Graphs
Many of the BANCS folders in the Tree View Window contain Trend Graph screens.
The Trend Graphs display simulated or measured data over time.  Simulated and
measured values appear in Table screens as the “Current” value.

This example shows reheater steam temperature plotted at 10-minute intervals.  You
may change what variable is displayed, the time interval, and the range for the y-axis.
You may also display more than one variable on the same graph.

Changing the Variable(s) Plotted on a Trend Graph

In the Main View Window, click on the trend graph.  A small menu window appears
with three choices, Data, Time Period, and Data Range.
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Step 1:  Click on the graph to
get the little menu.

Step 2:  Click Data.

Click Data in the little menu.  The “Trend Graph Variable Selection” window appears.

Step 3a:  Click on a variable
in left hand column.

Step 3b:  Click Add>>

Step 4a:  Click on a variable
in right hand column.

Step 4b:  Click <<Remove

(repeat Steps 3 and 4 as
needed)

Step 5:  Click OK.

To add a variable to the trend graph, click on the name in the left hand column to
select the variable.  Then click the Add>> button.  To remove a variable from the trend
graph, click on the name in the right hand column to select it.  Then click the
<<Remove  button.  When you have finished adding and removing variables, click OK
and the trend graph is redisplayed showing the new variables.  The new variables are
plotted starting at the current time.

If you can't find the variable you want by scrolling, try a different Trend Graph
screen.  There are Trend Graph screens in all the folders corresponding to sections of
the plant (Coal, Mills, Furnace, Boiler, etc.), and the variable you are looking for may
be in a different folder.  The variable may also appear in  the System Overview folder's
Trend Graph screen.

BANCS, by default, will choose a data range (values on the y-axis) based on the
minimums and maximums of each of the variables displayed on a trend graph.  When
several variables are displayed on the same trend graph, BANCS chooses the
smallest of all the variables' minimums and the largest of all the variables' maximums to
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set the range.  You can change the data range if you don't like what BANCS has
chosen.  See "Changing the Data Range on a  Trend Graph" on page 4-7.  The time
interval on the trend graph may also be changed. This is described in the following
section.

Changing the Time Period on a  Trend Graph

By default, BANCS plots data points on trend graphs at 10-minute intervals.  To
change the time interval, click on the trend graph in the Main View Window.  A little
menu appears with three commands, Data, Time Period, and Data Range.

Step 1:  Click on the graph to
get the little menu.

Step 2:  Click Time Period

Then click Time Period on the little menu.  The “Trend Graph Time Period Selection”
window appears.

Step 3:  Select a number

using .

Step 4:  Click OK.

Set the time period to be displayed on the graph by choosing a value using the down
arrow at the right of the time period field.   Then click OK.  When you click OK, all
data points are removed from the trend graph, the time scale is changed, and the trend
graph starts plotting points from the current time.

Changing the Data Range on a  Trend Graph

To adjust the range of values shown on the y-axis of a trend graph, click on the trend
graph in the Main View Window.  A little menu appears that has three commands,
Data, Time Period, and Data Range.
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Step 1:  Click on the graph to
get the little menu.

Step 2:  Click Data Range.

Click Data Range to bring up the “Trend Graph Min Max Range Setup” window.

Step 3:  Type min and max
values or click Reset to
Default.

Step 4:  Click  OK.

Type the new values for Minimum and Maximum into the fields.  If you want to see
the BANCS default minimum and maximum values for this trend graph, click the Reset
to Default button.  The default values appear in the data fields.  Click OK to have the
new minimum and maximum values displayed on the y-axis of the trend graph.  When
you click OK, the trend graph erases the old data points and starts plotting new data
points at the current time.

Viewing Data in Bar Charts
Many of the BANCS folders in the Tree View Window contain Bar Chart screens.
Bar charts display the current value and the optimized value for a variable at the same
time.  Bar Chart screens display four bar charts.  Each bar chart  can display only one
variable at a time.  The variable displayed on a bar chart and the range of values on
the y-axis may be changed by the user.

Changing the Variable Displayed on a Bar Chart

To change a bar chart's variable, click on the bar chart in the Main View Window.  A
little menu appears over the bar chart.
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Step 1:  Click anywhere on
the bar chart to get little
menu

Step 2:  Click Data .

Click Data in the little menu.  The “Bar Chart Variable Selection” window appears.

Step 3:  Find the variable you
want to display and click on
it.

Step 4:  Click OK.

Scroll through the variables to find the one you want to display on the bar chart.
Then click on the variable name to select it.  Click OK.  The new variable appears on
the bar chart.

If you don't find the variable you wanted in the scroll list, you may have to go to a
different Bar Charts screen in a different folder.  The Bar Charts in the plant section
folders (Mills folder, Furnace folder, Boilers  folder, …) can only display variables
that are in that section of the plant.   In addition to being available in the plant section
folders, many variables are available in the System Overview folder's Bar Charts
screen.

Changing the Data Range on a Bar Chart

By default, BANCS sets the minimum and maximum values on the y-axis of a bar chart
to the minimum and maximum values for the variable displayed.  To change the range
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of values shown on the y-axis, click on the bar chart in the Main View Window.  A
little menu appears over the bar chart.

Step 1:  Click anywhere on
bar chart to get little menu.

Step 2:  Click Data Range.

On the little menu that appears, click Data Range.  The “Bar Chart Min Max Range
Setup” window appears.

Step 3:  Type new min and
max or click Reset to Default.

Step 4:  Click OK.

Enter the desired values in the Minimum and Maximum fields.  If you want to see
what the BANCS minimum and maximum for this value are, click the Reset to Default
button.  Click OK to install the new minimum and maximum into the bar chart.

Viewing Data in Setpoints and Constrained
Variables Screens
Most Setpoints and Constrained Variables screens may display the data in a table or
as a set of sliders.  Sliders look like thermometers.  Each slider displays  minimum,
maximum, current, and optimized values for a single variable.

Sliders

Sliders look like thermometers.  Arrowheads on the left of the thermometer point to
the current value, the optimized value, the minimum, and the maximum.  A red
arrowhead points to the minimum, and a yellow arrowhead points to the maximum. A
gray arrowhead points to the current value, and a green arrowhead indicates the
optimized value.  A portion of the thermometer is shaded.  The shading shows the
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difference between current and optimized values.  If the current value is higher than
the optimized value, as it is here, the shaded area appears gray on the screen.  If the
optimum is higher than the current value, the shaded area is green.

The numbers corresponding to the minimum and maximum are displayed on the slider.
In this example, minimum is 65 and maximum is 75.  The current and optimized
numbers are not shown.  To display the numbers, place the cursor on the
thermometer.  A balloon appears displaying all four numbers for this slider.

Place cursor over
thermometer to pop up
balloon with numbers.

The little box at the top left corner of the slider may have a check mark  in it.  If it has a
check mark, this setpoint has been fixed by the user at a particular value.

Check mark means "fixed".

In this example, the setpoint has been fixed at 67.  When an optimization is run, the
fixed value is used for this variable.  If the value is not fixed, the optimization may use
any value in the range between Min and Max to find the least-cost operating
setpoints  overall for the plant.  For more details on running optimizations, see
"Running an Optimization" on page 4-30.  Fixing a setpoint has no effect when
running a simulation.

Sliders can display variables which are measured and obtained from the plant data
acquisition system as well as variables that are calculated from other values.

Tables

The Setpoints and Constrained Variables tables follow the same conventions as all
the other BANCS tables.  See "Viewing Data in Tables" on page 4-3.
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Switching between Slider and Table Views

Most setpoints  and constrained variables can be viewed on sliders or in tables.  If
you are viewing a Setpoints or Constrained Variables screen, and it is showing
sliders, you can view the same variables in table form by clicking the Table View
button at the lower right of the Main View Window.

If a Setpoints or Constrained Variables screen is displaying a table, you can view the
same variables on sliders by clicking the Slider View button at the lower right corner
of the Main View Window.  The Setpoints screen in the Manual Inputs folder does
not have a slider view.  There's no button on that particular screen to switch it to a
slider view.

Rearranging Sliders

The arrangement of the sliders in a screen may be changed.  You may want to put the
variables that you look at frequently near the top.  To move a slider, place the cursor
anywhere on the slider, click and hold the mouse button down, and then drag it to the
desired position.

When this slider is moved to another position on the screen, the other sliders will
move to make space for it.   The automatic repositioning moves sliders “back” or
“forward” in order to fill in the gap left by the slider that was moved by a user.  The
sliders are ordered in a grid starting at the top left, counting down the first column,
counting down the second column, etc.

Slider order.
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If you drag the slider from position 1 to position 8, the sliders at position 2 through 8
will each back up one position.  The slider at position 2 moves to position 1.  The
slider at position 3 moves to position 2.  And similarly for the sliders at positions 4
through 8.  The sliders at positions 9 through 17 do not move.

Viewing Data in Schematics
A few selected variables are displayed on the Schematics  screens.  A schematic
shows a picture representing a portion of the plant and some current data for that
portion of the plant.

This is the Schematic screen in the Boiler folder.  Current values for some boiler
variables are displayed here.

 cursor changes to little
hand on expandable portions

You cannot change what variables are displayed in a schematic.  For the System
Overview folder's Schematic screen, you can see more data for a portion of the
schematic by expanding the schematic.  Move the cursor over the picture until you
find an area where the cursor changes from an arrow to a little hand.  Then you have
encountered a portion of the schematic that may be displayed in more detail.  Clicking
while the cursor is displayed as a little hand will bring up another schematic showing
more detail for that portion of the plant.

To get back to the System Overview schematic from an expanded (plant section)
schematic, click the Back button at the lower right corner of the schematic.

Editing Data
The general procedure for editing  has four steps:

1) Display the appropriate screen,

2) Start an edit session,
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3) Make the changes,

4) End the edit session by saving or canceling  the changes.

Display an Editable Screen
In the Tree View Window, find the screen that contains the data you want to edit.
Double-click on the screen name in the Tree View Window to display it in the Main
View Window.  For more details on using the Tree View Window to display screens,
see "Tree View Window" on page 3-2.

Not all BANCS screens can be edited.  The Setpoints, Constrained Variables, and all
the tables in the Manual Inputs folder can be edited.  You can determine if a screen is
editable or not by looking at the Start Edit button (the pencil button) in the toolbar.
The pencil on the Start Edit button turns yellow when you display an editable screen
in the Main View Window.  If the currently displayed screen is not editable, then the
pencil is gray.

Start an Edit Session
An editing session may be started from either the Edit menu or the toolbar’s Start
Edit button.  Both methods do the same thing, so choose the method that's most
convenient for you.

From the Edit Menu

Step 1:  Click Edit. Pull down the Edit menu and click Start Edit.  (If Start Edit appears in gray letters
rather than black letters, it means that the currently displayed screen is not editable.)

Step 2:  Click Start Edit.

Another window will appear asking for your password .

Step 3:  Type your password.
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Type your password into the empty field.  The letters you type will appear as
asterisks (***) so that your password can't be read by anyone near your monitor.  (If
you don't know your password, check with your system administrator, your MIS
manager, or Praxis Engineers.)

Step 4:  Click OK. Click OK.  BANCS is now in edit mode and will allow you to make changes.

For more details on using the Edit menu, see "The Edit Menu" on page 3-5.

From the Toolbar

An edit session can be started from the toolbar by clicking the Start Edit button,
which is the leftmost button in the toolbar.  It has a little pencil on it.  (For more
details on the toolbar and the Start Edit button, see "The Toolbar" on page 3-24 and
"Starting an Edit Session" on page 3-25.)

Step 1:  Click the pencil
button.

If the pencil is gray rather then yellow, it means that the screen currently displayed in
the Main View Window is not editable.  Choose a different screen in the Tree View
Window and display  (double-click) it.

A window will appear asking for your password.

Step 2:  Type your password.

Type your password into the empty field.  The letters you type will appear as
asterisks (***) so that your password can't be read by anyone near your monitor.  (If
you don't know your password, check with your system administrator, your MIS
manager, or Praxis Engineers.)

Step 3:  Click OK. Click OK.  BANCS is now in edit mode and will allow you to make changes.

Make the Changes
Two kinds of BANCS screens allow editing: tables and sliders.  Sliders are used in the
Constrained Variables and the Setpoints screens.

Changing a Table

Step 1:  Click on a value. After starting an edit session on a table, click on the value that you want to change.
The value is highlighted and moves to the left side of its field.
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In this example, the user has clicked on the field containing '75'.

Step 2:  Type the new value.

Repeat Steps 1 and 2, as
needed.

Type the new value over the highlighted value.  Repeat the process, clicking on
another value and typing over it, until you have made all the changes that you want
to make in this table.

Changing On/Off Status in a Table

Your PECOS installation may have a special table that shows what equipment is
currently running.  This table appears in the Manual Inputs folder (if your installation
has a Manual Inputs folder) and is called On/Off Status.  Bring up the screen by
double-clicking On/Off Status.

The On/Off Status screen.

The On/Off Status screen contains a list of equipment that may be on or off.  The
table has a column labeled "On/Off" displaying the current status.  It also has a
column labeled "Overridden" indicating whether or not the user has set the "On/Off"
value.  If  Overridden = YES, the value in the "On/Off" column is set by the user.  If
Overridden = NO, then BANCS is determining whether the equipment is on or off.
BANCS may not have on-line access to on/off status for a piece of equipment, and if
it does not, BANCS examines other on-line data from the equipment to determine
status.  BANCS cannot always determine if a piece of equipment is on or off based on
other data, though, so this table makes it possible for the user to override BANCS'
automatic on/off determination and input the status by hand.
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User sets On/Off Status:

Step 1:  Place cursor over

Step 2: Click up arrow to set
"Overridden" to "YES".

Step 3:  Place cursor over
status field.

Step 4:  Click arrows to
change on/off status.

If you want to set the status of a piece of equipment yourself rather than let BANCS
attempt to determine its status, first set "Overridden" to "YES".  Do this by placing
the cursor over the "NO".  The field highlights, and a pair of arrows appear on the
right side of the field.  Click the "up" arrow to set the field to "YES".  Then place the
cursor over the "On/Off" field.  It will be highlighted and a pair of arrows will appear
on the right side.  Click one of the arrows to change the equipment status either to
"Off" or "On".

BANCS sets On/Off Status:

Step 1:  Place cursor over

Step 2:  Click down-arrow to
set "Overridden" to "NO"

.

If you want BANCS to determine whether a piece of equipment is on or off, set the
"Overridden" field for that piece of equipment to "NO".   Place the cursor over the
"Overridden" field (the YES/NO field) to get the arrows to appear on the right hand
side of the field.  Then set the field to "NO" by clicking the down arrow.

Changing the Min or Max on a Slider

Setpoints and constrained variables can be displayed as either tables or sliders.
Users may change the minimum and maximum values for both setpoints and
constrained variables.  Setpoints may also be fixed, that is, set at a particular value
that will be used by the optimizer.  (For further description of fixed setpoints in an
optimization, see "Running an Optimization" on page 4-24.)

First Method:

There are two methods for changing the minimum and maximum values on a slider.  In
one method, the user enters values in text fields.  In the other method, the user drags
the arrows on the slider.  Both methods produce the same results, so choose the
method that is most convenient for you.

After starting an Edit session on a slider screen, expand a small slider to a big slider
by double-clicking on the thermometer.  Your cursor must be over the thermometer
portion of the slider, as shown here.

Step 1:  Double-click on the
thermometer.

A big slider appears.  It is shown here smaller than actual size.



Boiler and NOx Control System BANCS Using BANCS  •  4-17

Step 2:  Type in Min and Max
values.

Step 3:  Click Apply to Max
and Apply to Min.

Step 4:  Click OK.

Type in the values you want for “Min” and “Max” in the two text fields.  Display the
values on the slider by clicking Apply to Max and Apply to Min.  This does not save
the values.  It just moves the arrows in the big slider window.  Click OK when you are
finished changing the values.  The big slider disappears.

Second Method: The second method for changing the minimum and maximum on a slider is to click and
hold down on the Min arrow or the Max arrow and drag the arrow along the scale.
Double-click on a small slider's thermometer to get a big slider.

Step 1:  Double-click on the
thermometer.

To change a minimum or maximum, click and hold down on the "Min" arrow or the
"Max" arrow in the big slider.  Then drag the arrow up or down the scale by moving
the mouse.
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Step 2:  Click and hold down
on the "Min" or "Max" arrow
and drag the arrow up or
down.

Step 3:  Click OK.

In the example shown, the "Min" arrow, the bottom arrow in the picture, is being
moved upward.  When you have finished adjusting the arrows, click OK.

Fixing a Setpoint on a Slider

Fixed setpoints  affect optimizations.  The optimizer uses the fixed value and does not
consider any other possible values for the fixed setpoint while trying to find the best
overall operating conditions for the plant.  For more information about optimizations,
see "Running an Optimization" on page 4-24.  Fixing a setpoint has no effect on a
simulation.

Sliders that have a little box at the upper left hand corner can fix their setpoint.
Expand the little slider by clicking on the little box in the upper left corner.

Step 1:  Click on little box.

A big slider appears.  It is shown here smaller than actual size.
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Step 2:  Type value into white
text field.

Step 3:  Click Apply to Fixed
button.

Step 4:  Click OK.

Type the value for the fixed setpoint into the white text field next to the Apply to Fixed
button.  Then click the Apply to Fixed button to show the fixed value on the slider
scale.

Click OK when you are done.  The big slider disappears.

This big slider window shows text fields and buttons, Apply to Max  and Apply to
Min, for adjusting the minimum and maximum values.  They are deactivated and can't
be used here.  If you want to change a minimum or maximum, exit this window by
clicking either OK (to keep your new fixed value) or Cancel (to discard any changes).
Then double-click on the thermometer in a small slider.  This brings up a big slider
window that will allow you to change the minimum and maximum.  For more details on
changing the minimum and maximum, see "Changing On/Off Status in a Table".

End the Edit Session
When you have finished making changes on a screen, you must end the edit session
by either saving the changes or canceling the changes.  There are two ways to save
changes.  One method uses the Edit menu and the other uses a toolbar button.  Both
methods do exactly the same thing, so use whichever method you prefer.  Changes
may also be canceled from either the Edit menu or the toolbar, when you want to
undo all the changes made in the edit session.

Save Changes using the Edit Menu

When you are done making changes to a screen, you can save the changes by using
a menu command.   First click Edit in the menu bar to open the edit  menu.
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Step 1:  Click Edit.

Then click Save Changes in the menu that appears.

Step 2:  Click Save Changes.

If you open the Edit menu and find the Save Changes command grayed out, then
BANCS is not in edit mode.  Either the changes have already been saved, or an edit
session has not yet been started.  For more details about using the Edit menu and the
Start Edit command, see "The Edit Menu" on page 3-5.

This menu command does exactly the same thing as the Save Changes button (the
lightning bolt) in the toolbar.  Saving changes from the toolbar is described in the
next section.

Save Changes Using the Toolbar

Step 1:  Click 
When you are done making changes to a screen, save the changes by clicking the
Save Changes button on the toolbar.  The Save Changes button has an arrow that
looks like a lightning bolt.  The arrow is red and yellow while you are in  edit mode,
indicating that it is possible to save changes.  When you save changes, BANCS
leaves the edit mode and the Save Changes button turns gray.

If the Save Changes button is gray before you click it, then either changes have
already been saved or canceled, or the editing session was not started and no
changes were made.  For more information about the toolbar, see "The Toolbar" on
page 3-24.

The Save Changes button does exactly the same thing as the Edit menu's Save
Changes command.  The Save Changes command is described in "Save Changes" on
page 3-6.

Cancel Changes using the Edit Menu

If you decide that you don't want to keep any of the changes you made, you can end
the edit session by canceling the changes.  One way to cancel changes is to use the
Edit menu.  First click Edit in the menu bar to open the menu.

Step 1:  Click Edit.

Then click Cancel Changes in the menu that appears.
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Step 2:  Click Cancel
Changes.

If the Cancel Changes command is grayed out when you open the Edit menu, then
BANCS is not in edit mode.  Either the changes were already saved or canceled, or
the edit session has not yet been started.  For more details about using the Edit menu,
see "The Edit Menu" on page 3-5.

The Cancel Changes command does exactly the same thing as the toolbar's Cancel
Changes button.

Cancel Changes Using the Toolbar

Step 1:  Click .
If you decide that you don't want to keep any of the changes you made, you can end
the edit session by canceling the changes.  One way to cancel changes is to use the
toolbar's Cancel Changes button.  It has a pencil with a red X on it.  This button
erases all the changes that you made in the current editing session and takes BANCS
out of edit mode.  After you click the button, it will turn gray.

If the Cancel Changes button is gray before you click it, then the changes have either
already been saved or canceled, or and editing session wasn't started and no changes
were made.

The toolbar's Cancel Changes button does exactly the same thing as the Edit  menu's
Cancel Changes command.  For more information on the toolbar, "The Toolbar" on
page 3-24.

If You Forget to Save or Cancel

If you forget to save or cancel your changes, BANCS will remind you by bringing up
a dialog box asking you to save or cancel the changes.  A reminder window appears if
you try to change to another BANCS screen, if you try to leave BANCS and go to
another PECOS module (such as CBAS), or if BANCS sits idle for a while.

If you are editing a BANCS screen and try to switch to another screen without saving
or canceling, BANCS displays a dialog box asking you to save or cancel changes.
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If you try to leave BANCS and go to another PECOS module (such as CBAS) without
saving or canceling changes,  BANCS will remind you that you have to "Save your
changes or cancel your changes first!"

If your screen sits idle for a period of time while you are in edit mode, BANCS brings
up a window to remind you to save or cancel changes.

This window appears after a timeout period that users may change with the Options
menu's Edit Mode Timeout command.  It is described in "Edit Mode Timeout
Command" on page 3-11.

Running a Simulation

What is a Simulation?
A simulation is a calculation of plant performance variables including boiler-related
variables contained in the plant's data acquisition system (DAS) (such as air heater
temperatures) and some variables not contained in the DAS (such as Net Power
Output and Generation Cost).  The simulation is based on a detailed mathematical
model of the operation and performance of the power plant.  The simulation uses
physical models guided by on-line measured data, empirical constants, and data input
by hand to make its calculations.  You may want to simulate values to see how the
plant is operating right now.  You may also want to compare these values with
BANCS' optimized values.  If you are using BANCS' recommendations, did the plant
achieve the optimum values?

Editing Data for a Simulation
A simulation calculates data based on measured values obtained on-line from the
plant data acquisition system and from manual inputs (if your installation requires
any manual inputs).  All items contained in the Manual Inputs folder can affect a
simulation.
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To find out if your BANCS installation requires any data to be input by hand, look in
the Tree View Window for a folder called Manual Inputs.  If there is no such folder,
then all the required data comes to BANCS on-line automatically.  If there is a Manual
Inputs folder, than the screens in that folder (usually tables) must have values for
each variable.

Before starting a simulation, check the Manual Inputs and decide if you want to
change any values.  The editing sequence for each of the screens is the same.

1) Display the appropriate screen  (described in "Where to Find Data" on page 4-1),

2) Start an edit session  (described in "Start an Edit Session" on page 4-15),

3) Make the changes  (described in “Changing a Table” on page 4-17),

4) End the edit session by saving or canceling the changes  (described in "End the
Edit Session" on page 4-22).

“Edit Data for a Simulation” on page 2-9 provides a tutorial example.

Starting the Simulation
The simulation may be started from either the Options menu or from the toolbar’s
Simulate button. Both methods do exactly the same thing.

From the Options Menu

To start a simulation from the menu bar, click Options to display the Options menu.

Step 1:  Click Options menu.

In the menu that appears, click BANCS.

Step 2:  Click BANCS.

Slide the cursor right and click Simulate.

Step 3:  Click Simulate.

When the simulation starts, it prints a message in the Log Window, the small window
at the bottom of the screen.

You may have to scroll this window vertically to see the message.
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The Options menu command sequence does exactly the same thing as the toolbar's
Simulate button.  For more details about using the Options menu, see " Options
Menu" on page 3-9.

From the Toolbar

Step 1:  Click . To start a simulation from the toolbar, click the Simulate button, .  It has a red
exclamation mark (!) on it.  When the simulation starts, it prints a message in the Log
Window, the small window at the bottom of the screen.

You may have to scroll the Log Window to see the message.

The toolbar's  Simulate button does exactly the same thing as the Options
menu's BANCS>Simulate command.  For more details about the toolbar buttons, see
"The Toolbar" on page 3-24 and "Simulate" on page 3-27.

Viewing Results
The first result to look for is successful completion of the simulation.  It will take a few
seconds to run.  When it's complete, it prints a message in the Log Window, the small
window at the bottom of the screen.  You'll see  either

Simulation succeeded! or Simulation failed!

You may have to scroll the Log Window to see this message.

A successful simulation calculates many values.  They appear in many BANCS
screens, including Table, Trend Graph, Bar Chart, Setpoints, and Constrained
Variables screens.  Use the Tree View Window to find the folder and screen to view
the data you would like to see.  See "Where to Find Data" on page 4-1 for more
details on where to find particular variables.

In the Setpoint and Constrained Variables screens (slider view), the value labeled
"Current" is the simulated value for the variable.  The  gray arrowhead  points to the
current value on the thermometer, and in this picture it is the second arrowhead down
from the top.  Placing the cursor over the thermometer pops up a balloon that
displays the current value along with other values.  In this example, the current
(simulated) Mill A Bias is 30%.  For more information on using sliders, see "Sliders"
on page 4-11.
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Place cursor on thermometer
to display numbers.

Simulated values are also available in trend graphs.   Trend graphs show only current
values and not optimized, minimum, or maximum values.  For more information on
using trend graphs, see "Viewing Data in Trend Graphs" on page 4-4

Bar charts display simulated and optimized values.   The bar on the left (blue when
viewed on-line) displays the "Current" value, which for most variables is the
simulated value.    The simulated value in the bar chart below is 94.  For more
information on using bar charts, see "Viewing Data in Bar Charts" on page 4-8.

"Current" value (either
simulated or measured) is on
left bar.

What to Do If a Simulation Fails
If you get a "Simulation Fails!" message, the first thing to check is the Manual Inputs
folder.  In the folder, check to make sure that both pieces of equipment in a pair have
been turned off (example both FD Fans being off will cause a failure).  If this is the
case, turn one or more on and rerun the simulation.  Also check to make sure that
reasonable values have been entered for both the Inputs and Setpoints tables.  If any
values are suspect, change them and rerun the simulation.
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Next check the Measured Variables folder.  The simulation uses some measured
variables in its calculations, and if these values are not getting to the simulation
properly, it can fail.  If any of the measured variables are highlighted in Red or have
values of "N/A", this is the most likely reason for the simulation failure.  The most
likely cause of this failure type, is a loss of the network connection to the Server
machine.

Another potential cause for a simulation failure is if too much unknown coal is being
sent to BANCS from CBAS.  This can be caused be a Server problem as well or if coal
receipts are not being entered.

If a failure occurs that you cannot fix, write down the circumstances and contact
Praxis Engineers at:

email: support@praxisengimneers.com

phone: 408-934-3703 fax: 408-263-2821

Running an Optimization

What is an Optimization?
An optimization is a determination of setpoints that result in least-cost operation of
the plant, while meeting load, safety, and environmental requirements.  The
optimization uses models of the plant to calculate the optimum setpoints.  During an
optimization, other variables that are affected by setpoints are calculated and reported
as optimum.

Editing Data for an Optimization
The following items affect the optimization and may be changed by the user:

• Setpoints:  minimum/maximum

• Setpoints:  fixed

• Constrained Variables:  minimum/maximum

• Manual Inputs (if your installation has any)

The optimization considers possible setpoints  within the minimum and maximum
specified by the user.  If the user fixes a setpoint at a particular value, the optimization
will use that value and attempt to adjust other setpoints  to accommodate the fixed
value.  The minimums and maximums for constrained variables may further restrict the
setpoints, because some legal setpoints may push constrained variables beyond their
minimum or maximum.  Manual inputs are current plant data that are required for
calculations, but are not available on-line and have to be entered by hand.  These
include Unit Costs impact the optimization because the optimizer is looking for least-
cost setpoints.  Some BANCS installations do not have any manual  inputs.  To
determine if your installation requires manual inputs, look for a Manual Inputs folder
in the tree view.

Before running an optimization, check the five types of data listed above and decide if
you want to change any values.  The editing sequence for each type of data is the
same.

1) Display the appropriate screen  (described in "Where to Find Data" on page 4-1),
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2) Start an edit session  (described in "Start an Edit Session" on page 4-15),

3) Make the changes  (see table below),

4) End the edit session by saving or canceling  the changes  (described in "End the
Edit Session" on page 4-22).

Details on editing each kind of data are described in the following sections.

To find out how to: Look in:

change setpoints minimum/maximum "Changing the Min or Max on a Slider" on
page 4-19.

fix a setpoint "Fixing a Setpoint on a Slider" on page 4-21.

change constrained variable min/max "Changing the Min or Max on a Slider" on
page 4-19.

edit manual inputs "Changing a Table" on page 4-17

Starting the Optimization
An optimization may be started from either the Options menu or from the toolbar.
Both methods do exactly the same thing.

From the Options Menu

To start an optimization from the menu bar, click Options to display the Options
menu.

Step 1:  Click Options.

In the menu that appears, click BANCS.

Step 2:  Click BANCS.

Slide the cursor to the right and click Optimize.

Step 3:  Click Optimize.

When the simulation starts, it prints a message in the Log Window, the small window
at the bottom of the screen, "Optimize BANCS data…"
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To see this message, you may have to scroll the Log Window vertically.

Viewing Results
The optimization can take several minutes to run.  When it is complete, it prints a
message in the Log Window indicating success or failure.

Optimization succeeded! or Optimization failed!

The Log Window is a short window at the bottom of the PECOS screen that spans
the width of the screen.

 You may have to scroll this window to see the message.

A successful optimization calculates many values.  They appear in many BANCS
screens, including Table, Bar Chart, Setpoints, and Constrained Variables screens.
Optimized values do not appear in Trend Graphs screens.  Use the Tree View
Window to find the folder and screen to view the data you would like to see.  See
"Where to Find Data" on page 4-1 for more information about where to find particular
values.

In Table screens, the optimized values are shown below the current values and are
not underlined.   In the example below, Boiler Ash Loss has an optimized value of
0.42.  For more information on tables, see "Viewing Data in Tables" on page 4-3.

In Setpoint and Constrained Variables screens (slider view), the optimum values are
marked with a green arrowhead.  In the example below, the optimum arrowhead is the
third one down from the top.  Placing the cursor over the thermometer pops up a
balloon that displays the optimum value along with other values.  In this example, the
optimum Mill E Exit Temp is 66.8 C.  For more information on using sliders, see
"Sliders" on page 4-11.

Place cursor on thermometer
to display numbers.

In Bar Charts screens, optimum values are shown by the bar on the right.  The bar
representing the optimum is red on-line.  In the example below, the optimum value of
MillA Fineness is 81.75%.  The current value is 75%.  For more information on using
bar charts, see "Viewing Data in Bar Charts" on page 4-8.
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Optimum value is shown on
right- hand bar and is red on-
line.

What to Do If an Optimization Fails
If you get an "Optimization Fails!" message, the first thing to check is the Manual
Inputs folder.  In the folder, check to make sure that both pieces of equipment in a pair
have been turned off (example both FD Fans being off will cause a failure).  If this is
the case, turn one or more on and rerun the optimization.  Also check to make sure
that reasonable values have been entered for both the Inputs and Setpoints tables.  If
any values are suspect, change them and rerun the optimization.

The next thing to check is the Setpoints folder.  The optimization is highly dependent
on the settings for the setpoints.  Check to make sure that minimum/maximum
constraints are not set too tightly or that setpoints are not fixed at conflicting
conditions.  Make the same checks in the Constrained Variables folder if you still
have not found a problem.

Next check the Measured Variables folder.  The optimization uses some measured
variables in its calculations, and if these values are not getting to the optimization
properly, it can fail.  If any of the measured variables have values of "N/A", this is the
most likely reason for the failure.

Another potential cause for an optimization failure is if too much unknown coal is
being sent to BANCS from CBAS.  This can be caused be a Server problem as well or
if coal receipts are not being entered.

If a failure occurs that you cannot fix, write down the circumstances and contact
Praxis Engineers at:

email: support@praxisengimneers.com

phone: 408-934-3703 fax: 408-263-2821



Boiler and NOx Control System BANCS BANCS Technical Description  •  5-1

BANCS Technical Description

Overview
This section outlines how calculations are made in BANCS.  It covers all of the major
systems modeled by BANCS and gives a brief overview of how each system is
modeled, including the type of modeling used.  A detailed description of simulations,
optimizations, and important manual inputs is also presented.

Simulation

Simulation Techniques
A simulation is a mathematical model of the performance of the plant.  All of the
important performance variables are predicted by the simulation.

The goal of the simulation is twofold.  First, it should provide an accurate calculation
of current plant variables, to show that its predictions are valid in comparison to the
on-line measured data.  Second, it calculates important quantities that are not
measured on-line, including Net Power Output, Net Plant Heat Rate, and plant costs.

To make its calculations, the simulation uses mathematical models guided by on-line
measured data, empirical constants, and manual inputs.  The models used include
models based purely on physics as well as models that rely on on-line data to make
their predictions.  The most important on-line data used are setpoints.  Setpoints are
critical control parameters that dictate how the plant is operating and have a
significant impact on the results of a simulation.

The different types of modeling techniques used in the simulations and setpoints are
discussed in the following sections.

Modeling Techniques
Three different types of modeling are used in BANCS:  analytical, adaptive analytical,
and neural.

Analytical modeling is based on physical or empirical modeling.  The model does not
need to be updated over time because the performance of the device being modeled



5-2  •  BANCS Technical Description Boiler and NOx Control System BANCS

does not change or changes only very slowly.  An example of a device that is
modeled analytically is a fan unit.

Adaptive analytical modeling, on the other hand, is also based on physics but
contains modeling constants that can be updated.  This is used for systems that
change over moderate time frames and for which sufficient on-line data are available
to assign the changes.  An example is the air heater, where the updated value of the
heat transfer coefficient is used in the modeling.

Neural modeling is based entirely on measured data and is used for quantities that are
difficult to model analytically.  Neural modeling computationally mimics the nervous
system of the human body.  The system uses inputs (stimuli) to predict outputs
(responses) based on the training of the system.  Training is done by using historical
data.  Stimuli consist of control setpoints and known inputs, while outputs are what is
being modeled.  NOx, CO, and unburned carbon are examples of quantities that are
modeled neurally in BANCS.

Setpoints
Setpoints are operating control parameters that BANCS uses as inputs for its
simulations.  Setpoints include most of the variables controlled on the board,
including excess oxygen, mill bias, and fan bias.

Setpoints can have a significant impact on the results of a simulation.  For example, as
excess oxygen is increased for a particular load, fan settings increase, boiler
performance changes, and emissions and LOI are impacted.

Most of the setpoints used by the simulation are read directly from the plant data
highway.  However, several are not measured on-line and must be entered by hand in
the Manual Inputs folder of the software.

Optimization

Optimization Techniques
An optimization is the calculation of setpoints that result in least-cost operation of
the plant while meeting safety, environmental, and operating constraints.  The
optimization also calculates all of the resulting plant performance variables for the
optimal setpoints.

The goal of an optimization is to help the plant operators run the plant at lower costs
without violating any constraints (called constrained variables in the software).  It is
designed to be flexible, so that the user can adjust plant constrained variables or
place restraints on setpoints as needed.

The optimizer performs a series of simulations, each with a different set of setpoints in
an intelligent and efficient fashion, moving toward the optimal set of setpoints.  The
methodology used by the optimizer to arrive at the optimum setpoints relies heavily
on Genetic Algorithms (GAs).  GAs are an optimization technique that mimics
evolution and natural selection.  In essence, GAs create computational “families” that
are allowed to cross-breed and randomly mutate, with the genes of the strongest
families of each generation being passed on to the next.  Over time, the most
dominant or optimum family of setpoints is determined.
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GAs are used primarily for their unique ability to randomly search the entire
computational space for the optimum, which makes this technique the most likely to
find the global optima and not get trapped at a local optimum.  To help speed up the
process, BANCS employs a unique hybrid optimizer that uses conventional analytical
techniques once the GA gets close to the optimal solution.

Constrained Variables
Constrained variables represent important plant parameters that must be maintained
between prescribed limits for safety, environmental, or operational reasons.  An
example of a constrained variable is opacity, which must fall below a set regulatory
limit or a derate occurs.  Another example of a constrained variable is the superheat
steam exit temperature out of the boiler which must be kept below a certain value
because of thermal limits on the turbine blades.

Constrained variables impact the optimization by placing an economic penalty on the
proposed setpoints if they violate either the minimum or maximum limit.  However,
unlike the constraints placed on setpoints, constrained variable limits can be violated
by the optimization.  For example, if the user lowers the NOx upper limit to a very low
value, the optimizer may find a solution with NOx higher than the upper limit, simply
because the system cannot possibly produce NOx any lower.

Manual Inputs
Manual Inputs are important data used by both the Simulations and Optimization
entered by hand by the user.  Manual Inputs represent values for variables that are
not measured on-line or specify important modeling constants.  Manual Inputs
include Inputs, Setpoints, Unit Costs, and On/Off Status.  Each are discussed in detail
in the following sections.

Inputs
Inputs are important data for several pieces of equipment that are not measured on-
line or vary only over long time periods.  These include the following:

• Mill Air Fuel Ratio - the ratio of primary air flow to coal flow into the mill.
This should only be changed if significant maintenance has been done
on mill air dampers.

• Trisector Leakages - the three types of leakage from the trisector.  These
leakages are fractions on a per gas flow into the trisector basis.  These
should be changed whenever the leakages are measured.

• Mill Fineness - the coal fineness produced by the mill on a % 200 mesh
basis.  This should be updated whenever it is measured, particularly
when the mill comes back on line after maintenance.

• Outside Air Percentage - the ratio of outside to inside air used for the
fans.  This should be changed whenever the value is changed at the
plant.  The user can also check the impacts of this term be changing it
and recording the results.

• Outside Air Pressure and Relative Humidity - these terms should be
changed daily.
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• Inside Air Temperature, Pressure, and Relative Humidity - these terms
should be changed only when a significant change has been noticed in
the boiler room.

• Seal Air Split - the amount of mill seal air taken from the cold tempering
air flow.  This term should only be changed if a significant increase in
seal air is needed.

Setpoints
Setpoints are values for setpoints that are not measured on-line and must be entered
by hand by the user.  These are used only be the Simulation.  The setpoints that must
be entered are:

• Primary Air Temperature - controls the amount of economizer bypass

• Fan Air Inlet Temperature - controls the amount of recirculating air

• Fan Biases - controls the bias between one fan and the other

These values should be updated only when significant changes have been made in
these setpoints.  They should be checked daily.

Unit Costs
Unit Costs are costs on a $/kWh or $/tonne basis that are used by BANCS to
calculate plant costs on a $/hr basis.  Unit Costs include coal unit costs (fixed and
incremental), ash unit costs, lab and water treatment unit costs, environmental unit
costs, administrative unit costs, maintenance unit costs, and overhead unit costs.
These values should be changed by the utility on a weekly basis.

On/Off Status
On/Off Status represents whether a piece of equipment is on or off.  Every piece of
equipment at the plant has its on/off status calculated by key on-line data, but since
data is never absolutely accurate, the user can override the value given by BANCS in
this folder.  This section should be checked at the beginning of each shift and after
any piece of equipment has been turned on or off.

Plant Equipment Models

Overview of Equipment Models
Each piece of equipment contained at the plant is modeled by BANCS.  The
individual models for each piece of equipment are then computationally configured
together based on how they are arranged at the plant.  Control systems are used to
operate groups of equipment that work together to produce specified setpoints.  The
entire package is used for each simulation.

The plant is divided into the following systems:

• A coal handling model supplied by CBAS that provides the coal quality entering
each of the feeders in real time to BANCS.  A mill model calculates how the coal
is pulverized before entering the furnace.
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• An air handling model that contains all of the equipment necessary to supply the
air to the mills and furnace.

• A gas handling model that contains all of the equipment necessary to transport
the gas from the boiler out through the stack.

• A furnace and boiler model that calculates combustion and heat transfer related
variables occurring within.

• A steam cycle model that contains all of the equipment in the steam cycle
necessary to produce the steam power.  The primary purpose of the steam cycle
model is to calculate the net turbine heat rate and net turbine power for the
current conditions.

Models for major pieces of equipment contained in these systems are described in the
following sections.

Mills
The performance of each mill is modeled individually in order to predict the effects of
varying coal quality between the bunkers.  The mill model estimates the capacity of
the mill and the total power required based on the specified mill outlet temperature.
Both mill capacity and mill power are functions of the moisture contained in the coal,
the coal hardness, and the desired coal fineness.

In addition, a mass and energy balance is performed on the mill to determine the
required cold air to produce the specified mill outlet temperature, or to calculate the
mill outlet temperature when its specified maximum cannot be achieved even without
tempering.  The amount of drying of the coal done by the mill, which has a fairly
significant impact on the mill energy balance, is assumed to be a constant based on
measured data.

All of the relevant streams included in the mill modeling are shown in the following
diagram.

Mill

Coal
Seal Air

Cold Air

Hot Air

Primary Air Coal + Air

Schematic of Terms Used in the Mill Mass and Energy Balance

Fans
The fan performance model calculates changes in the pressure, temperature, and
density of the fluid through the fan as well as the power draw of the fan itself.  In
addition, the model calculates the inlet vane position required for the specified
system resistance, and checks if the fluid volumetric flow is within the operating
range of the fan.
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The inputs to the fan model include the inlet composition, pressure, and temperature
of the fluid, the volumetric flow rate through the fan, and the system resistance that
must be overcome by the fan.  The model uses empirical data to construct a curve fit
for the static pressure rise through the fan as a function of flow rate and system
resistance to calculate the change in total pressure through the fan.  The temperature
change is calculated based on the pressure change assuming no heat losses.  The
power draw of the fan is then calculated by conservation of energy, with imposed
efficiencies for the shaft and motor included.

Trisectors
The performance model for each trisector estimates the amount of heat transferred
from the hot flue gas to the cold primary and secondary air streams.  The regenerative
trisector is modeled as a simple counter-flow heat exchanger including the effects of
air leakage.  An energy balance and a heat transfer equation are combined to calculate
an overall effectiveness for the trisector.  The inputs to the model are air and flue gas
inlet temperatures and flow rates, flue gas composition, air leakages, and physical
constants for the trisector including geometry and design heat transfer coefficient.
Based on the inputs, the model calculates the outlet temperatures and flow rates, both
corrected to account for leakage, and the effectiveness of the trisector.

Air leakage can have a significant impact on the calculation of trisector performance.
Air leakage occurs from both air streams into the gas stream and also from the
secondary air stream into the primary air stream.  Air leakages are entered by the user
in the Manual Inputs folder.

The model is designed to be adaptive to the current condition of the trisector itself by
using the on-line measured temperatures to adjust the design heat transfer
coefficient.  In this way, the effects of fouling can be accounted for.

Electrostatic Precipitators
The model of the electrostatic precipitator (ESP) predicts the effects of coal
composition and operating conditions on particulate emissions.  Opacity is
determined first based on a neural model.  ESP collection efficiency is then calculated
based on the opacity and the known inlet particle concentration, accounting for the
impact of the inlet temperature of the gas entering the ESP, and the amount of
moisture and sodium contained in the gas stream.

The main variables that impact the stack opacity neural model are:

• Coal quality

• Sodium content of the gas stream

• Inlet gas temperature

• Load

• Excess oxygen

• Mill on/off status

• Mill biases

• Coal fineness

• Burner tilt angles
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Stack
The stack is modeled as a simple mixer of gas streams.  In addition, the pressure
change through the stack due to buoyancy is calculated and used in the fan models.

Furnace
The modeling of the furnace consists of a model for the combustion process
occurring within the furnace walls, a model for the furnace heat transfer, and models
for the principal components of incomplete combustion, namely carbon monoxide,
nitrogen oxides, and unburned carbon.

Combustion

The combustion mass calculations performed in the furnace model are based on
chemical stoichiometry.  Stoichiometry determines the excess air that must be
supplied to the furnace based on a chemical balance between the reactants (coal and
air) and products (only principal species are considered, namely, N2, O2, CO2, and
water since trace species are negligible) and the setpoint of excess oxygen.  The
excess air can then be converted to an actual flow rate of air that must be supplied to
the furnace accounting for any inleakage that may occur in the furnace walls.  Note
that this air flow rate is less than what must be supplied by the fans because of
leakage occurring at the trisectors.

The combustion model also calculates the adiabatic flame temperature for the
combustion process.  This temperature represents the hottest possible combustion
temperature assuming no heat losses.  It is calculated by assuming complete
combustion and performing an energy balance on the relative amounts of coal and air
supplied to the furnace and the resultant products.  The adiabatic flame temperature
is used in the furnace heat transfer model.

Furnace Heat Transfer

The furnace heat transfer model is based on a 2-D model of the furnace.  The furnace
is cut into rectangular zones over its height, and mass, energy, and momentum are
solved simultaneously for each zone as a function of time.  Combustion occurs in the
zones near the burners that are on, with burner tilt taken into account by shifting the
combustion zone up or down accordingly.  Combustion is modeled as an exothermic
heat release process, with oxygen depletion and fixed carbon burnout taken into
account.

A detailed radiation model is used to account for the gas and particle radiation as well
as the radiation from the furnace walls.  The radiation from the walls is dependent on
wall cleanliness which is estimated based on measured data.

The final output of the model is a mass-averaged temperature profile over the height
of the furnace and the radiation absorbed by the water in the furnace walls.  The
furnace exit gas temperature is passed onto the remaining sections of the boiler to
initiate the boiler heat transfer calculation.

Unburned Carbon (UC)

The unburned carbon model, which represents the incompleteness of the combustion
process, is based on the same 2-D model of the furnace used for the furnace heat
transfer.  Coal particle momentum and energy equations are solved simultaneously in
a series of computational rectangular zones which together comprise the geometry of
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the furnace.  Carbon burnout and oxygen depletion are calculated kinetically for each
zone based on the temperature and fluid mechanics determined for that particular
zone.  The sum of the remaining carbon particles that have not burned out and that
exit the furnace represents the total unburned carbon.  This can then be readily
converted to Loss On Ignition (LOI).

The unburned carbon model is highly dependent on the properties of the coal
entering the furnace, in particular the heating value, as well as the amount of excess
air supplied, the fineness of the coal, and which burners are being used.

Nitrogen Oxides (NOx) and Carbon Monoxide (CO)

Both NOx and CO are modeled neurally based on measured plant data.  Several
months of performance data taken from the plant was used to train neural models for
each.  The main variables that impact NOx and CO include:

• Coal quality

• Load

• Excess oxygen

• Overfire air damper positions

• Mill on/off status

• Mill biases

• Coal fineness

• Burner tilt angles

Boiler
The modeling of the boiler consists of a detailed boiler heat transfer model and a
model for boiler efficiency.

Boiler Heat Transfer

The boiler heat transfer model performs a series of energy and heat transfer balances
on each section in the boiler starting from the furnace and ending with the
economizer.  Both radiation and convection are accounted for in each section with
heat transfer coefficients based on design conditions and tuned using measured data.

A global iteration is performed to ensure that the setpoints for superheat and reheat
temperatures are met.  Each section uses the inputs from the preceding section to
calculate exit conditions for the section, including temperatures in particular.  Furnace
exit gas temperature is thus back-calculated and compared to the value determined in
the furnace model.

The economizer has a variable gas bypass that is accounted for in the modeling.  The
economizer bypass is calculated based on meeting the primary air temperature
setpoint.

Boiler Efficiency

The boiler efficiency is calculated based on the ASME PTC Heat Loss method.  This
method calculates all the system energy losses and credits from the fuel energy input.
The losses consist of the thermal energy in the wet and dry gases leaving at the
trisectors, the formation of CO and NOx, incomplete combustion in the form of
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unburned carbon, losses due to the heating of the bottom and fly ashes, losses due
to blow down, losses due to pulverizer rejects, and heat losses due primarily to
radiation.  Credits consist of the sensible energy of the incoming air, water, and fuel.

Turbines
Turbines are modeled based on a calculated turbine efficiency.  The turbine efficiency
is used to calculate turbine exit conditions.  The exit enthalpy of the turbine is
calculated by first calculating the isentropic or 100% efficiency exit enthalpy based on
the turbine inlet conditions and the calculated exit pressure.  Then the turbine
efficiency is used to back-calculate the actual exit enthalpy.  All other thermodynamic
variables can then be calculated as a function of pressure and enthalpy.

Turbine efficiencies are calculated based on measured plant data and are updated on-
line.  Turbine exit pressures are calculated based on the design expansion line for
each turbine.

Turbine power produced is dependent on how much steam has been bled off to the
feedwater heaters during the turbine expansion.  The amount of steam extracted to the
feedwater heaters is determined based on an empirical curve fit dependent on flow
rate and gross load.  Once the flow rate through each section of the turbine is known,
turbine power is simply the product of steam flow rate and steam enthalpy change
through the section.

Feedwater Heaters
Feedwater heaters are modeled using mass and energy balances with a characteristic
heat transfer equation that depends on the type of feedwater heater.  Drain cooler
feedwater heaters use the design drain cooler approach temperature, which
represents the difference between the drain condensate temperature and the inlet
feedwater temperature, while standard feedwater heaters without drain coolers
assume saturated conditions for the condensate.

All of the feedwater heaters in the chain, including the deaerator, are linked together
with the drain condensate being passed back in succession to the condenser.  Each
feedwater heater receives extraction steam from various stages of the turbines for the
feedwater heating.  The amount of extraction steam required for each feedwater heater
is calculated based on empirical curve fits dependent on gross load and flow rate.

Condenser
The condenser is modeled using standard HEI practices which involve mass and
energy balances and a heat transfer equation that is dependent on the geometry of
the condenser itself.  However, determination of the inlet steam conditions is highly
dependent on the condenser back pressure.  Since the condenser back pressure is
dependent on the cleanliness of the condenser and the temperature of the cooling
water available to the condenser, its value is taken directly from the on-line measured
value for the calculations.  Based on the back pressure and with the assumption that
the condenser exit conditions must be saturated liquid, all of the condenser exit
conditions for both the feedwater and cooling water can be calculated.  The current
heat transfer coefficient and log mean temperature difference can also be estimated
from a heat transfer analysis and the geometry of the condenser.
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Pumps
Pumps are modeled similarly to turbines relying on a pump efficiency to determine the
enthalpy change through the pump.  Combined with the known pump exit pressure,
all of the thermodynamic exit variables can then be calculated including exit
temperature.  The pump power required is then calculated proportionally to the
capacity of the pump.
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Glossary of Terms

balloon
a box that appears when you place the mouse pointer over a sensitive area.  The box
displays information about the item over which the pointer is located.

BANCS
Boiler and NOx Control System.  The module of PECOS that models the boiler and
makes least-cost-setpoint boiler operation recommendations, while maintaining or
reducing emissions.

bar chart
a graphical tool which displays current and optimized values side by side as
rectangular bars proportional in size to the magnitude of the values.

button
small markers on the toolbar or on other dialog boxes that  carry out commands when
clicked with the mouse.  They are usually small squares or rectangles with pictures or
words ("OK", "Cancel") on them.

CBAS
Coal Blend Automation System.  This module of PECOS tracks the coal from the yard
to the boiler.  It also makes coal blend recommendations to the operator.

Constrained Variable
performance variables that must be kept between set limits because of operational,
performance, or safety constraints.  (Example:  Opacity must be kept below a
regulatory limit.)  BANCS' constrained variables are displayed and edited in a screen
in the System Overview folder.
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current value
the instantaneous value of a performance variable.  This value can either be taken
from the on-line measured value or is based on the results of the most recent
simulation.

data range
the bounding range for data as presented in a bar chart or trend graph.  The user can
adjust the data range as desired.

dialog box
a window that either requests or provides information.  Many dialog boxes present
options to choose from before performing an action.  (Example:  When starting
PECOS, window appears requesting user name and password.  That window is a
dialog box.)

edit mode
mode in which data can be entered.  The Start Edit command puts PECOS modules
into edit mode.  The Save Changes and Cancel Changes commands gets PECOS
modules out of edit mode.

Edit Mode Timeout
time period of inactivity while in edit mode that causes a warning dialog box to
appear.  The warning reminds the user that changes have been made but not saved.
Users may change the amount of time that PECOS waits before prompting by using
the Edit Mode Timeout command in the Options menu.

edit session
the time that a PECOS module is in edit mode.  An edit session begins when the user
clicks the Start Edit command and ends when the user clicks either Save Changes or
Cancel Changes.

fixed
In BANCS, "fixed" refers to a setpoint that the user has held at a particular value
rather than allowing an optimization to calculate a value for the setpoint.  The user
may fix a setpoint because of equipment problems or maintenance schedules.
(Example:  Mill bias may be fixed for a particular mill based on the knowledge that
maintenance has just been completed.)

folder
a main category in the Tree View Window. Folders are a grouping mechanism, much
like a manilla folder in a file cabinet.   Folders in the Tree View Window hold groups of
related screen icons.  Folders are represented by yellow icons that look like manilla
file folders, which may be either open or closed.
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gray button
a deactivated button.  Buttons on the toolbar, dialog boxes, or other windows are
shaded gray when the associated action is not available.  Clicking on a gray button
does not execute any command or action.

icon
a small picture on the desktop or in a PECOS window that represents a minimized
window or screen that is not currently displayed.  When one "opens" an icon,
usually by clicking or double-clicking on it, the associated big window appears.

Log Window
a narrow window at the bottom of the PECOS display that spans the width of the
display.  It displays information about recent PECOS events, such as  a simulation
completing or an edit session starting.  The most useful information displayed in the
Log Window is a listing of the edit changes which is posted to the window after the
Save Changes command is given.

Main View Window
the biggest window in the PECOS display.  It can display many different screens
which provide data and recommendations to the user.  Users select which screen is
displayed in the Main View Window by double-clicking on screen icons in the Tree
View Window.

manual input
data used by the simulation and optimization that are entered by the user into a
PECOS screen.  These values are entered by hand because they are not available from
the plant's on-line data acquisition system.

measured value
a value for a variable that is obtained from the plant's data acquisition system.  Values
that are not obtained from the plant's data acquisition system are calculated by
BANCS and called "simulated" values.

menu bar
a horizontal gray bar near the top of the PECOS display with File, Edit, View, Options,
Equipment, and Help appearing on it.  Each of these words has an associated menu.
Click on a word to get the associated menu to appear.  All PECOS commands are
available in these menus.

module
a part of the PECOS program which may be run separately from other parts of the
program.  A PECOS installation includes one or more of the three modules, CBAS,
BANCS, and SCYCLOPS.
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on/off status
for a piece of equipment, the on/off status indicates whether or not that piece of
equipment is running or not running.

on-line help
provides assistance in using PECOS and is accessible from the Help menu.  This is an
on-line user manual that provides search capability and hyperlinks to cross-
referenced sections and glossary definitions.  Use the Contents command on the
Help menu to start on-line help.

optimization
a calculation of control setpoints that (if enacted) would result in least-cost operation
of the plant while meeting safety, environmental, and operating constraints.

optimized value
a value for a performance variable calculated by the optimization.

pane
a view in the Tree View Window.  The Tree View Window can display a different
pane for each PECOS module that is installed at your site.  The PECOS modules are
CBAS, BANCS, and SCYCLOPS.  To display the pane for a particular module, click on
the tab near the top of the Tree View Window for that module.  (Example:  To display
the BANCS pane in the Tree View Window, click on the tab near the top of the
window labeled "BANCS".)

password
a secret word that PECOS requires users to enter to start PECOS and get access to
various PECOS capabilities, such as editing data.  See your system administrator or
contact Praxis Engineers, Inc. regarding any questions about passwords.

PECOS
Plant Environmental and Cost Optimization System.  This is the program which may
include any or all of the  CBAS, BANCS, and SCYCLOPS modules.

screen
in PECOS, the displays that appear in the Main View Window and their associated
icons in the Tree View Window.  (Example:  The System Overview folder in the Tree
View Window contains a Trend Graph icon  which when double-clicked, displays the
Trend Graph screen in the Main View Window.)  This word is also used to refer to the
viewable display portion of the computer monitor.
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scroll bar
a vertical or horizontal bar that appears at the right side or bottom of a window.  It has
arrows at either end.    When the window contains more information than will fit in the
viewable area, the scroll bar can be used to move the viewing area up or down, right
or left.  To scroll, click and hold down on one of the scroll bar's arrows.

SCYCLOPS
Steam CYCLe OPtimization System.  This module of PECOS makes least-cost setpoint
recommendations for the operation of the steam cycle.

setpoint
a variable that is controlled on the board by the operator. (Examples: excess oxygen,
mill bias)  In BANCS, setpoints are available in separate screens which may be
displayed from the Tree View Window.

setpoint maximum
the upper limit on a control setpoint.  In BANCS, the maximum can be set by the user
by editing a Setpoints screen. The maximum is the largest value that is considered by
the optimizer when calculating least-cost setpoints.

setpoint minimum
the lower limit on a control setpoint.  In BANCS, the minimum can be set by the user
by editing a Setpoints screen.  The minimum is the smallest value that is considered
by the optimizer when calculating least-cost setpoints.

simulation
a calculation of plant performance variables based on current conditions.  A
simulation calculates boiler-related variables.  Some of these variables, such as air
heater temperatures,  are also available from the plant's on-line data acquisition
system.  Other variables calculated by the simulation, such as total plant costs, are
not available on-line.

slider
a graphical depiction of a setpoint or constrained variable the mimics an analog dial
gauge with arrows.  It looks like a thermometer.  A slider shows the current, optimized,
minimum, and maximum value for a setpoint or constrained variable.  The term "slider"
is used because the user can change the minimum or maximum values by clicking,
holding down, and  "sliding" an arrow up or down to the desired value.

status bar
the horizontal gray bar at the bottom of the PECOS display just below the Log
Window.  The status bar displays one line of information about what PECOS is doing
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right now.  It can also display information about what various toolbar buttons do.  To
get a description of a toolbar button, place the cursor over that button.

tab
protrusions at the top of the Tree View Window that look like the tabs on manilla file
folders used in filing cabinets.  Clicking on a tab causes the associated pane to be
displayed.  The Tree View Window has a tab for each PECOS module installed at your
site.  There may be a tab for each of CBAS, BANCS, and SCYCLOPS.  The on-line
help system also has tabs labeled "Contents", "Index", and "Find".

task bar
a bar normally displayed across the bottom of a monitor that contains buttons for
each of the programs currently running on the computer.  This bar is part of the
Windows 95 or Windows NT operating system.  It is not part of PECOS or BANCS.
This bar always contains a button labelled "Start" with the red, green, blue, and
yellow Microsoft icon displayed on it.  This bar may also be displayed vertically
along the right or left edge of  the monitor.

time period
the range of time over which data can be presented in a trend graph.  The user can
adjust the time period from one hour up to 25 hours.

toolbar
a set of buttons that appears near the top of the PECOS display just below the menu
bar.  The buttons in the toolbar provide a quicker way to execute some of the
commands in the menu bar's menus.  The toolbar may not be visible.  If it is not, click
on the View menu to pull it down and then click on the Toolbar command.

Tree View Window
the window on the left side of the PECOS display which contains a hierarchy of
folders and screen icons that can be viewed in the Main View Window.  The Tree
View Window is used to control the display in the Main View Window.  Double-
clicking on a screen icon in the Tree View Window causes the screen to be displayed
in the Main View Window.

Trend Graph
a graphical tool that allows the user to plot any variable contained in BANCS over
time.

unit cost
an incremental cost used by the software to calculate costs on a $/hr basis.  Unit
costs are entered by the user in a BANCS screen.  Example:  A coal unit cost in $/ton
is used to calculate total costs in $/hr.



Boiler and NOx Control System BANCS Index  •  7-1

Index

B

Back button 4:13
balloon

for glossary definitions 3:20
for slider 2:4, 2:21, 4:10, 4:25, 4:29
for toolbar buttons 3:23

BANCS
menu command 3:8, 3:9, 3:23, 4:24, 4:28
starting 2:1
what is it 3:20
windows 2:2, 3:1, 3:2, 4:1

bar chart
changing data displayed 2:12, 4:8
changing data range 4:9
default data range 4:9
viewing data in 2:11, 4:7, 4:26

blue numbers in table 2:13, 2:20–4:4, 2:20–4:4, 4:26
blue values in tables 4:4
Boiler 2:3, 2:5, 2:11, 2:12–4:5
Boiler folder 4:2
button

Back 4:13
Cancel Changes 2:10, 3:20, 3:22, 4:22
Contents 3:14, 3:19
Copy 3:20, 3:22
Cut 3:20, 3:22
Dead Coal 3:22
Find 2:1, 2:8, 2:10, 2:13–3:9, 2:13, 3:17–3:20, 3:11, 3:17–

3:20, 3:17–3:20, 3:23–4:3, 3:23–4:3, 4:5, 4:8, 4:10–
4:14, 4:13, 4:19–4:21, 4:19, 4:21, 4:24, 4:25

getting help description for 3:8, 3:23
gray 2:10, 2:20, 3:20, 3:21, 4:22
Help 3:20, 3:23
Index 3:11, 3:14–3:15, 3:14–3:15, 3:19, 3:14–3:15, 3:14–

3:15
Optimize 2:20, 3:20, 3:23
Paste 3:20–3:22
PECOS 2:1

Save Changes 2:10, 2:19, 3:20, 3:21, 4:21
Simulate 2:10, 3:22, 4:25
Slider View 4:11
Table View 4:11
toolbar's Cancel Changes button 2:10, 3:22, 4:22
toolbar's Copy button 3:22
toolbar's Cut button 3:22
toolbar's Dead Coal button 3:22
toolbar's Help button 3:23
toolbar's Optimize button 2:20, 3:23
toolbar's Paste button 3:22
toolbar's Print button 3:22
toolbar's Save Changes button 2:10, 3:21, 4:21
toolbar's Simulate button 2:10, 3:22, 4:25
toolbar's Start Edit button 2:9–2:10, 3:21, 4:14, 4:15

C

cancel
Cancel Changes menu command 2:10, 4:21
Cancel Changes toolbar button 2:10
ending edit session 2:8, 2:10, 2:19, 4:13, 4:24, 4:28
exiting edit mode 2:10

Cancel Changes
button 2:10, 3:20, 3:22, 4:22
menu command 2:10, 3:6, 3:22, 4:21

CBAS 2:1–3:2, 2:1–3:2, 3:7–3:8, 3:7–3:8, 3:10–3:11, 3:10,
3:22–4:2, 3:22–4:2, 4:22

Closing Chapters
in on-line Help 3:12

Coal folder 4:2
Cogeneration system

Selection 5:7
Contents button 3:14, 3:19
Contents tab 3:14, 3:19
Copy

button 3:20, 3:22
Costs folder 2:13–2:14, 2:13–2:14, 2:22–3:5, 2:22–3:5, 3:21
current

setpoint 2:4, 2:17
value in a schematic 4:13
value in table 4:4
value measured 4:4, 4:26
value on bar chart 2:13, 4:26
value on slider 2:4, 2:17
value simulated 4:4, 4:26
values input by hand 4:27

Cut
button 3:20, 3:22

D

Dead Coal
button 3:22



7-2  •  Index Boiler and NOx Control System BANCS

menu command 3:8
default

maximum values shown in bar chart 4:9
maximum values shown in trend graph 4:6, 4:7
minimum values shown in bar chart 4:9
minimum values shown in trend graphs 4:6, 4:7
time period on trend graph 4:6

definitions
provided in glossary 3:20

E

Economizer folder 4:2
edit

editable data 2:14, 3:23, 4:14, 4:24, 4:27
editing data for optimization 2:13, 2:14, 3:23, 4:27
editing data for simulation 2:8, 4:23, 4:24
editing data in tables 2:10, 4:17
editing procedure 2:8, 2:14, 4:13, 4:24, 4:27
in Constrained Variables screen 4:17
in Setpoints screens 2:15, 4:17
in sliders 2:15, 4:17
menu 2:10, 3:5, 3:21, 4:14, 4:21, 4:22

edit mode 2:10, 2:14–2:15, 2:14–2:15, 2:20–3:2, 2:20–3:2,
3:6, 3:10, 3:21–4:15, 3:21–4:15, 4:21–4:23, 4:21–4:23,
3:10

Edit Mode Timeout 3:10, 4:23, 3:10
edit session

timeout 3:10
editing session

ending 2:20, 3:6, 4:21, 4:22
starting 2:9, 3:5, 3:21, 4:14

Equipment
menu 3:10

ESP folder 4:2
ESP model 5:6
Exit

menu command 2:5, 2:10–4:2, 3:5, 4:4, 4:20, 4:29, 4:28–
4:29

F

failed
optimization 2:20, 3:10, 3:23, 4:29
simulation 2:11, 3:9, 3:22, 4:25

Fans folder 4:2
File

menu 3:4, 3:22
Find button in on-line Help 2:1, 2:8, 2:10, 2:13–3:9, 2:13,

3:17–3:20, 3:11, 3:17–3:20, 3:17–3:20, 3:23–4:3, 3:23–
4:3, 4:5, 4:8, 4:10–4:14, 4:13, 4:19–4:21, 4:19, 4:21,
4:24, 4:25

fixed value for setpoint 2:13, 2:18, 2:21–4:10, 2:21–4:10,
4:17–4:20, 4:17–4:20, 4:27

folder
Boiler 2:3, 2:5, 2:11, 4:2
Coal 4:2
Costs 2:13–2:14, 2:13–2:14, 2:22–3:5, 2:22–3:5, 3:21
defined 2:3
Economizer 4:2
ESP 4:2
Fans 4:2
Furnace 4:2
Manual Inputs 2:8–2:9, 2:8–2:9, 2:13–3:5, 2:13–3:5, 3:9,

3:23–4:3, 4:27–4:28, 4:11–4:14, 4:11, 4:14, 4:23, 4:27–
4:28

Mills 4:2, 4:3
opening 2:3, 2:4, 3:3, 4:1
Stack 4:2
Steam Cycle 4:2
System Overview 2:3–2:5, 2:3–2:5, 2:14, 2:21–3:3, 2:21–

3:3, 3:9, 3:22–4:3, 3:22–4:3, 4:6, 4:8, 4:13
Trisectors 4:2

Furnace folder 4:2

G

glossary definitions 3:20
display in balloon 3:20

H

Help
button 3:20, 3:23
closing chapters 3:12
displaying table of contents 3:11
Help Topics window 3:11–3:19, 3:11–3:19, 3:11–3:19,

3:11–3:19, 3:11–3:19, 3:11–3:19
in status bar 3:8
menu 3:11, 3:23
opening chapters 3:12
opening sections 3:13
Text window 3:19

Help Topics window 3:11–3:19, 3:11–3:19, 3:11–3:19,
3:11–3:19, 3:11–3:19, 3:11–3:19

I

Index for on-line Help 3:11, 3:14–3:15, 3:14–3:15, 3:19,
3:14–3:15, 3:14–3:15

Inputs Window
Existing System tab 5:4
Proposed Cogen tab 5:7
Technical description 5:2



Boiler and NOx Control System BANCS Index  •  7-3

L

Log Window 2:10, 2:20–3:2, 3:8–3:10, 3:22–4:25, 4:28–
4:29

M

Main View Window 2:3, 3:2, 3:3
displaying screens in 2:3, 2:4, 2:5, 2:9, 2:11, 2:14, 3:2,

3:3, 4:1, 4:14
printing 3:4, 3:22

Manual Inputs 2:8–2:9, 2:8–2:9, 2:13–3:5, 2:13–3:5, 3:9,
3:23–4:3, 4:27–4:28, 4:11–4:14, 4:11, 4:14, 4:23, 4:27–
4:28

maximum
blue numbers 4:4
constrained variables 2:13, 4:3, 4:17
default value for bar chart 4:9
default value for trend graph 4:6, 4:7
editing 2:15, 2:16, 4:17
in bar chart 4:9
in sliders 2:4, 4:17, 4:26
in tables 4:4
in trend graphs 2:5, 4:7
red numbers 2:10, 2:13, 3:21–4:4, 4:10, 4:21–4:22, 4:25,

4:30
setpoint 2:4, 2:13, 4:17, 4:27

measured
indicated by asterisk 2:13, 4:4, 4:10
value 2:13, 4:4, 4:10
value in bar chart 2:13
value in slider 4:10
value in table 4:4
value in trend graph 4:4
variable 2:13, 4:4, 4:10

menu
Edit 2:10, 3:5, 3:21, 4:14, 4:21, 4:22
Equipment 3:10
File 3:4, 3:22
Help 3:11, 3:23
Options 3:8, 3:23–4:25, 3:23–4:25, 4:23, 4:24, 4:25, 4:28
to change bar chart display 2:12, 4:8, 4:9
to change trend graph display 2:6, 4:5, 4:6, 4:7
View 2:9, 3:7, 3:8, 3:21

menu bar 3:1, 3:2
menu command

BANCS 3:8, 3:9, 3:23, 4:24, 4:28
Cancel Changes 2:10, 4:21
Dead Coal 3:8
Exit 2:5, 2:10–4:2, 3:5, 4:4, 4:20, 4:29, 4:28–4:29
Optimize 3:9, 3:23, 4:28
Save As 3:4
Save Changes 3:6, 4:21
Simulate 3:8, 3:9, 3:23, 4:24

Start Edit 3:5, 4:14
Status Bar 3:8

Mills 2:3, 2:3, 4:5, 4:8
Schematic 4:1

Mills folder 4:2, 4:3
minimum

blue value in table 4:4
constrained variables 2:13, 4:3, 4:10, 4:17, 4:26, 4:27
default value for bar chart 4:9
default value for trend graph 4:6, 4:7
editing 2:15, 2:16, 4:17
in bar chart 4:9
in sliders 2:4, 2:15, 2:16, 4:10, 4:17, 4:26
in tables 4:7
in trend graphs 2:5
red value in table 4:4
setpoint 2:4, 2:13, 2:15, 2:16, 4:10, 4:17, 4:26, 4:27

model
ESP 5:6

module
BANCS 2:1, 2:2, 3:1, 3:2, 3:10, 4:22
CBAS 2:1, 3:1, 3:2, 3:8, 3:10, 3:22, 4:22, 4:23
displaying Tree View pane for 2:2, 3:2
SCYCLOPS 2:1, 3:1, 3:2

O

Opening Chapters
in on-line Help 3:12

Opening Sections
in on-line Help 3:13

optimization
constrained variables in 2:14, 3:23, 4:3, 4:27
editing data for 2:13, 2:14, 3:23, 4:17, 4:27
failed 3:10, 3:23, 4:29
fixed values in 2:14, 2:19, 3:23, 4:10, 4:27
starting 2:20, 3:9, 4:28
succeeded 3:10, 3:23, 4:29
viewing results 2:20, 2:21, 3:10, 4:4, 4:29
what is it 2:13, 4:27

Optimize
button 2:20, 3:20, 3:23
menu command 3:9, 3:23, 4:28

Options
menu 3:23–4:25, 3:23–4:25, 3:8–3:10, 4:28

Overview
Technical description 5:1

P

password 2:9, 2:15–3:5, 2:15–3:5, 3:21–4:15, 3:21–4:15
Paste

button 3:20–3:22
PECOS



7-4  •  Index Boiler and NOx Control System BANCS

defined 2:1
modules 2:1, 3:1, 3:22, 4:22, 4:23
window or display 2:2

Preliminary Evaluation Window
Technical description 5:1

print
Main View Window 3:4, 3:22
menu command 3:4, 3:22
toolbar button 3:20, 3:22

R

red numbers in table 2:10, 2:13, 3:21–4:4, 4:10, 4:21–4:22,
4:25, 4:30

red values in tables 4:4

S

Save As
menu command 3:4

Save Changes
button 2:10, 2:19, 3:20, 3:21, 4:21
edit mode timeout 3:10
menu command 3:6, 4:21
prompt to save 3:10

saving
end edit session 2:8, 2:14, 2:20, 3:6, 3:21, 3:22, 4:13,

4:20, 4:24, 4:28
exit edit mode 2:20, 3:6, 3:21, 3:22
forgot to save 3:6, 4:22
prompt to save changes 3:6, 3:10, 4:22
Save Changes using menu 3:6, 4:20
Save Changes using toolbar 2:20, 3:6, 3:21, 3:22, 4:20
timeout on prompt (Edit Mode Timeout) 3:6, 3:10, 4:22

Schematic
Back button 4:13
current values in 4:13
expanding 4:13
in Mills folder 4:1
measured values in 4:13
screen 2:3, 2:5, 4:1, 4:13
simulated values in 4:13

screen
displaying in Main View Window 2:3, 2:14, 3:2, 3:3, 4:1,

4:11, 4:14
editable 3:5, 3:21, 4:14, 4:15
printing 3:22
Schematic 2:3, 2:5, 4:1, 4:13
Unit Cost 2:13–3:5, 2:13–3:5, 3:21

scroll 2:5, 2:7, 2:11, 2:20–4:3, 4:8, 4:24–4:25, 4:29
SCYCLOPS 2:1–3:2, 2:1–3:2, 3:11–4:2, 3:11–4:2
Setpoints

current 2:4, 4:3, 4:9
displaying 2:3, 2:14, 2:21, 4:3, 4:9

editing 2:17, 3:5, 3:21, 4:17, 4:19, 4:27
fixed 2:13, 2:21, 4:10, 4:19, 4:27
maximum 2:4, 4:3, 4:9, 4:17, 4:27
minimum 2:4, 4:3, 4:9, 4:17, 4:27
optimized 2:4, 2:13, 3:9, 3:23, 4:3, 4:9, 4:27
slider view 2:3, 2:14, 4:9, 4:11
table view 4:9, 4:11

Simulate
button 2:10, 3:20, 3:22, 4:25
menu command 3:8, 3:9, 3:20, 3:23, 4:24

simulated
value 4:4, 4:26
value in bar chart 4:26
value in table 4:4
value in trend graph 4:4, 4:26
variable 3:9, 4:4, 4:26

simulation
completion 2:11
editing data for 2:8, 2:14, 4:23, 4:24
failed 3:9, 3:22, 4:25
procedure 2:11, 3:9, 3:23, 4:4, 4:23
starting 2:10, 3:9, 3:22, 4:24
succeeded 3:9, 3:22, 4:25
viewing results 4:25
what is it 2:8, 4:23

slider
display numbers in balloon 2:4, 2:21, 4:10, 4:25, 4:29

Slider View
button 4:11

sliders
editing 2:15

Stack folder 4:2
Start Edit

menu command 3:5, 4:14
toolbar button 2:9, 2:14, 3:20, 3:21, 4:14, 4:15

Status Bar
menu command 3:8

Steam Cycle folder 4:2
succeeded

optimization 2:20, 3:10, 3:23, 4:29
simulation 2:11, 3:9, 3:22, 4:25

System Overview 2:3–2:5, 2:3–2:5, 2:14, 2:21–3:3, 2:21–
3:3, 3:9, 3:22–4:3, 3:22–4:3, 4:6, 4:8, 4:13

T

table
blue numbers 4:3
editing data in 2:10, 4:15, 4:24, 4:28
red numbers 4:3
viewing data in 2:4, 2:5, 2:11, 2:13, 2:22, 3:9, 3:22, 3:23,

4:3, 4:11, 4:25, 4:29
Table of Contents

displaying for Help 3:11



Boiler and NOx Control System BANCS Index  •  7-5

Table View
button 4:11

Text window 3:19
toolbar

Cancel Changes button 4:22
descriptions of buttons 3:8, 3:23
display button's function in balloon 3:23
displaying 2:9, 3:21
gray buttons 3:21
hiding 3:21
Optimize button 2:20
Print button 3:22
Save Changes button 2:10, 4:21
Simulate button 2:10, 4:25
Start Edit button 2:9, 2:14, 3:20, 3:21, 4:14, 4:15
Toolbar menu command 2:9, 3:7
what is it 2:9, 3:2, 3:20

Tree View Window 2:2–2:5, 2:2–2:5, 2:8–2:9, 2:8–2:9, 2:11,
4:14–4:15, 4:14–4:15, 2:21–3:2, 2:21–3:2, 3:3, 3:9,
3:22–4:2, 3:22–4:2, 4:4, 4:7, 4:14–4:15, 4:14–4:15,
4:24, 4:25, 4:29

trend graph
default time period 4:6

trend graph 4:4–4:7, 4:4–4:7, 2:11–3:9, 2:11, 3:22–4:2, 4:4–
4:7, 4:25

Trisectors folder 4:2

U

Unit Cost 2:13–3:5, 2:13–3:5, 3:21

V

View
menu 2:9, 3:7, 3:21



 

 
 
 
 
 
 
 
 
 
 
 

APPENDIX C 
CBAS Quick Starts for Keephills Plant 
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Plant Environmental and Cost Optimization System 
Version 1.5 
 
 

 
How do I bring up the data I want to see? 
 

When PECOS starts up, you will see that the main PECOS window is divided into three sub-windows: 

• Main View window—takes up most of the screen and displays the data, diagrams, graphs and 
advice.  The user decides what is displayed in the window through the Tree View window.  The 
user also has some control over how the data are displayed (using the View Menu). 

• Tree View window—located on the left side of the screen.  Through the Tree View window, the 
user defines what is seen in the Main View window.  

• Log window—located at the bottom of the screen.  The Log window displays information on what 
PECOS is doing.  A typical example of a Log Window message is “Receiving 1000 tonnes of 
Seam 4 in syntron 9...” followed by “Transaction completed”. 

 
 

 
 
 
To bring up data in the main view window, click on the folders and items in the Tree View window: 

1. Click on the “+” sign in front of a folder to expand it and display the items for viewing. 

2. Double click on an item to display it in the Main View window. 
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Plant Environmental and Cost Optimization System 
Version 1.5 

 
How do I get more information about the coal in a bunker? 
 

First, bring up the Bunker Overview in the Main View window: 

1. Click on the “+” in front of the “Bunkers” folder to expand it. 
2. Double click on the “Bunker Overview” item. 

The Main View window is showing all of the bunkers, the amount and type of coal in the bunkers by color 
coding, the status of the high and low level lights for each bunker, each bunker’s feeder speed, and the 
properties of the coal being fed to the boiler.  The layers represent the coal as it will be discharged from 
the bunker.  If a bunker gate is closed, this will also be shown in the display as a bar across the top of the 
bunker. 

To get more detailed information about the coal in each layer of the bunker, move the mouse so that the 
arrow sits on top of a layer of coal.  A balloon appears which lists the properties of that layer of coal. 
 

 
 
If you are interested in even more detail about a bunker, double click on the bunker which you would like 
to examine more closely.  Or you can open the view of the bunker in the Main View window using the 
Tree View window: 
1. Click on the “+” in front of the “Bunkers” folder to expand it. 
2. Double click on the “Bunker A” item (or “Bunker B” or …). 

Now the Main View window is showing Bunker A in more detail.  The properties listed below the bunker 
reflect the coal feeding the boiler from Bunker A only.  
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Plant Environmental and Cost Optimization System 
Version 1.5 

 
How do I close a bunker gate? 
 

Unfortunately, PECOS does not automatically read the signal that indicates that a bunker gate has been 
closed.  Therefore, it is necessary for a person to enter this information into the program.  If this is not 
done, the Coal Tracking model will fill the coal into the wrong bunker. 

To tell PECOS that the bunker gate feeding bunker C from the Scraper Conveyor West has been closed: 

1. Click on the Equipment menu in the menubar. 

2. Click on the Bunker Gates command. 

3. In the “Bunker Gates” dialog box, click on the box to the right of “West Closed” in the Bunker C row.  
An “x” appears in the box. 

 

 

4. Click on OK. 

The west gate to Bunker C is now closed.  The “Bunker Overview” diagram and the “Bunker C” view 
show a blue line across the top of half of Bunker C. 

 
 

The “Coal Handling System Overview” diagram also shows the Bunker C west gate as closed. 
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Plant Environmental and Cost Optimization System 
Version 1.5 
 
 

 
How do I get advice on which syntrons to use? 
 

The Coal Blend Advisor is continually updating its coal blend and coal handling system operation 
recommendations.  The results of the calculations are displayed in the Main View window on the screen 
with the coal pile.  To view the Blend Advice:    

1. Bring up the coal pile in the Main View window:  Click on the “+” in front of the “Bunkers” folder to 
expand it.  Then double click on the “Pile 1” item. 

2. Click on the Blend Advice  button in the bottom left hand corner. 

 
 

The first number in the first three columns represents the syntron from which to pull.  The second number 
is the amount to pull.  There may be two or three syntrons specified. 

Up to ten blends are listed.  They are ranked by the opacity potentials of the blend.  The blend with the 
highest opacity potential that still meets the all the criteria is listed first.  Moving the mouse pointer above 
any row in the blend table brings up a balloon which lists all the properties of that blend. 

The Options  button allows the user to specify the terms of the Blend Advice calculation.  The 
Recalculate button tells the Coal Blend Advisor to renew the recommendations immediately.   
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Plant Environmental and Cost Optimization System 
Version 1.5 
 

How do I enter a coal receipt? 
 

Since coal receipt is not automatically measured, it is necessary to enter the data manually.  The data that 
are entered include the seam number, amount, and loading location.  It is important that the coal receipt 
data be entered close to the actual time of coal receipt. 

To enter coal receipt data 

1. Frst bring up the Coal Pile in the Main View window: click on the “+” in front of the “Coal Piles” 
folder to expand it.  Double click on the “Pile 1” item. 

2. Make sure that the Coal Pile Table is displayed.  If the Blend Recommendations Table is on the 
screen, click on the Coal Table button in the bottom left hand corner of the Main View window to 
bring up the Coal Pile Table. 

3. Enter edit mode by clicking on the Start Edit button on the toolbar.   

4. Click on the Coal Receipt button.  The “Seam Number Selection” dialog box appears first.   

5. From the drop down list, choose the seam that has been delivered and click on the OK button. 

 

6. The “Coal Receipt” dialog box appears. Specify the loading point by clicking on the left or right arrow 
until the appropriate loading point number is displayed in the “Load Point” edit box.  Click on OK. 

7. Type in the amount of coal loaded at the location.  The dialog box should look like something this: 

   (continued) 



 

How do I enter a coal receipt?  (continued) 

8. To load the same seam of coal at another location, click on the left or right arrows again to move the 
next loading point and enter the tonnage delivered to the second location. 

9. Click on OK.   (continued on the next page) 

10. Now that the  data entry is complete, it is important to exit the edit mode and to save the changes.  
This is done by clicking on the Save Changes button or by selecting the Save Changes 

command from the Edit menu.   
 

The coal receipt data entries are listed in the Log window. 

The coal receipt does not appear on the screen immediately after the Save Changes command is given.  
The command to load the coal onto the pile is immediately sent to the Coal Pile Model, but the results of 
the coal receipt may take up to 30 seconds to return to the user interface. 
 
 
 



 

 
 
 
 
 
 
 
 
 
 
 

APPENDIX D 
BANCS Quick Starts for Keephills Plant 
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Boiler and NOx Control System 
Version 3.5 
 
 

What do I need to do before running an optimization? 
 

Before running an optimization, the user must make sure all of the inputs used by the optimization are set up properly.  
The things to do before running an optimization include: 

 

1.  Set Setpoints minimum/maximum 

The minimum and maximum values are constraints for the setpoint that the optimized value must be between.  If a 
setpoints constraints need to be changed, choose the setpoint and change the minimum or maximum 
accordingly. 

 

2.  Fix Setpoints 

If a setpoint needs to be at a particular value, you should fix that setpoint. 

 

3.  Set Constrained Variables minimum/maximum 

The minimum and maximum values are limits for the constrained variables that the optimized value tries to be 
between.  If the optimizer cannot produce a solution for which a constrained variable is between its set limits, 

4.  Edit Manual Inputs 

 

Manual Inputs are important data that impact the optimization must be entered by hand by the user.  They 
should be updated at least at the beginning of each shift. 
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Boiler and NOx Control System 
Version 3.5 

 
How do I use the Manual Inputs? 
 
Manual Inputs are important data used by both the Simulation and Optimization which are entered by hand 
by the user.  Manual Inputs are either important modeling constants or represent values for variables that 
are not measured on-line.  Manual Inputs include Inputs, Setpoints, Unit Costs, and On/Off Status. 

 

Inputs 

Inputs are important data for several pieces of equipment that are not measured on-line or vary only over 
long time periods.  Inputs impact both Simulations and Optimizations.  Inputs include the following: 

• Mill Air Fuel Ratio - the ratio of primary air flow to coal flow into the mill.  This should only be 
changed if significant maintenance has been done on mill air dampers. 

• Trisector Leakages - the three types of leakage from the trisector.  These leakages are fractions on a 
per gas flow into the trisector basis.  These should be changed whenever the leakages are 
measured. 

• Mill Fineness - the coal fineness produced by the mill on a % 200 mesh basis.  This should be 
updated whenever it is measured, particularly when the mill comes back on line after 
maintenance. 

• Outside Air Percentage - the ratio of outside to inside air used for the fans.  This should be changed 
whenever the value is changed at the plant. 

• Outside Air Pressure and Relative Humidity - these terms should be changed daily. 

• Inside Air Temperature, Pressure, and Relative Humidity - these terms should be changed only 
when a significant change has been noticed in the boiler room.  

• Seal Air Split - the amount of mill seal air taken from the cold tempering air flow.  This term should 
only be changed if a significant increase in seal air is needed. 

 

Setpoints 

Setpoints are values for setpoints that are not measured on-line and must be entered by hand by the user.  
These are used only be the Simulation.  The setpoints that must be entered are: 

• Primary Air Temperature - controls the amount of economizer bypass 

• Fan Air Inlet Temperature - controls the amount of recirculating air 

• Fan Biases - controls the bias between one fan and the other 

These values should be updated only when significant changes have been made in these setpoints.  
They should be checked at the beginning of each shift. 
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Boiler and NOx Control System 
Version 3.5 
 

 
How do I use the Manual Inputs? (cont.) 
 

Unit Costs 

Unit Costs are costs on a $/kWh or $/tonne basis that are used by BANCS to calculate plant costs on a 
$/hr basis.  Unit Costs impact both Simulations and Optimizations.  Unit Costs include the following: 

• Coal unit costs (fixed and incremental) 

• Ash disposal unit costs (fly and bottom ash) 

• Lab and water treatment unit costs 

• Environmental unit costs 

• Administration unit costs 

• Maintenance unit costs 

• Operating unit costs 

• Company use unit costs 

Unit Costs should be changed on a weekly basis. 

 

On/Off Status 

On/Off Status represents whether a piece of equipment is on or off.  Every piece of equipment at the 
plant has its on/off status calculated by key on-line data, but since data is never absolutely accurate, the 
user can override the value given by BANCS in this folder.  This section should be checked at the 
beginning of each shift and after any piece of equipment has been turned on or off. 
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Boiler and NOx Control System 
Version 3.5 
 

 
What should I do if an optimization fails? 
 

If you get an "Optimization Failed!" message, do the following: 

1. Check the Manual Inputs folder 

• Make sure that both pieces of equipment in a pair have not been turned off (example both FD 
Fans being off will cause a failure) in the On/Off Status window. 

 

• Make sure that reasonable values have been entered for the Inputs window. 

2. Check the Setpoints folder 

• Make sure that minimum/maximum constraints are not set too tightly 

• Make sure that setpoints are not fixed at conflicting conditions 

3. Check the Constrained Variables folder 

• Make sure that minimum/maximum constraints are not set too tightly 

4. Check the Measured Variables folder 

• Make sure no measured variables have values of "N/A" 

 
5. Contact Praxis Engineers, Inc. 

If a failure occurs that you cannot fix, write down the circumstances and contact us at: 

email: support@praxisengineers.com 

phone: 408-934-3703 

fax: 408-263-2821 
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Boiler and NOx Control System 
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What should I do if an simulation fails? 
 

If you get an "Optimization Failed!" message, do the following: 

1. Check the Manual Inputs folder 

• Make sure that both pieces of equipment in a pair have not been turned off (example both FD 
Fans being off will cause a failure) in the On/Off Status window. 

 

• Make sure that reasonable values have been entered for both the Inputs and Setpoints 
windows. 

2. Check the Setpoints folder 

• Make sure that minimum/maximum constraints are not set too tightly 

• Make sure that setpoints are not fixed at conflicting conditions 

3. Check the Constrained Variables folder 

• Make sure that minimum/maximum constraints are not set too tightly 

4. Check the Measured Variables folder 

• Make sure no measured variables have values of "N/A" 

 
5. Contact Praxis Engineers, Inc. 

If a failure occurs that you cannot fix, write down the circumstances and contact us at: 

email: support@praxisengimneers.com 

phone: 408-934-3703 

fax: 408-263-2821 
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How do I fix a setpoint? 
 

What is a fixed setpoint?  When a setpoint has been fixed, the BANCS optimizer uses the fixed value for that setpoint 
and does not consider any other possible values for the fixed setpoint while trying to find the best overall operating 
conditions for the plant.  Fixing a setpoint has no effect on a simulation. 

 

To fix a setpoint: 

1. Select the setpoints screen from the System Overview folder of the BANCS tree view. 

 

2. Click the “Start Edit Mode” tool button on the toolbar.  

3. Click the small box located in the upper left hand corner of the slider box containing the variable to be fixed. 

 

4. In the box labeled “Apply to Fixed” type in the desired value and click on the button.  After clicking on the 
button simply click on “OK” to remove the window. 

 

5. At this point there are two options, the changes can be saved and used by the optimizer or discarded and they 
will have no effect. 

- To save the changes click on the “Save Changes” button located in the toolbar.  

- To discard the changes click on the “Cancel Changes” button located in the toolbar.  

- If the changes are saved, a message will appear in the Log Window confirming the changes have occurred.  
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BANCS Acceptance Test Plan for Keephills Plant 
 

The following document describes the proposed plan for the BANCS Acceptance Test. The 
Acceptance Test is outlined in the following table: 
 

Sequence Task Duration 
1. Simulation Testing 3 weeks 
2. Praxis Update of BANCS Based on Simulation Test Results 1 week 
3. Off-line Optimization Testing  3 weeks 
4. Praxis Update of BANCS Based on Optimization Test Results  2 weeks 
5. On-line Optimization Testing  4 weeks 
6. Final Acceptance Report Based on On-line Optimization Testing 

Results 
 

 
A brief description of each task is presented below. 
 
1. Simulation Testing 
During this phase of the acceptance test, scheduled to last for three weeks, operators and shift 
supervisors will run BANCS simulations every hour and recording any comments, questions or errors 
on log sheets. The principal areas of interest are the accuracy of the calculated data presented by 
BANCS in comparison to measured data or experience and the appearance, ease of use and flexibility 
of the software. Obviously, any software bugs should be reported as well. 
 
The log sheets will be faxed daily to Praxis for review and analysis. E-mail can also be used to make 
comments if desired. A set of instructions for this phase of the test, including key data to observe, as 
well as a copy of the proposed format for the log sheets, is included with this document. 
 
This phase of the acceptance test will last for three weeks during which every crew will have a chance 
to review and make comments on the software. At the end of this three-week period, Keephills will 
replace the data tape in the BANCS server and mail Praxis the old tape containing the data covering the 
test period. 
 
2. Praxis Update of BANCS Based on Simulation Test Results 
After the three-week simulation testing period, Praxis will analyze and review the responses and correct 
any obvious bugs or errors in the calculations. Desired changes in software functionality or appearance 
can be discussed at this time. 
 
The updated version of BANCS will then be installed remotely onto the server machine at Keephills and 
new clients, if needed, will be sent to all users. 
 
This phase of the acceptance test will take approximately one week to complete, depending on how 
many changes need to be made to the software. 
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3. Off-line Optimization Testing 
During this phase of the acceptance test, operators and shift supervisors will run BANCS optimizations 
every hour and record any comments, questions or errors on another set of log sheets. The principal 
areas of interest are the value and believability of the setpoints presented by BANCS in comparison to 
experience, the calculated amount of savings in cost and heat rate, and the appearance, ease of use and 
flexibility of the software. Users should also test the impacts of changing constraints on the optimization. 
Note: The operators should not use the recommended setpoints to operate the plant. This phase 
of the testing is off-line only, to ensure that the optimization will not produce results that may be 
detrimental to the operation of the plant. 
 
The log sheets will be faxed daily to Praxis for review and analysis. E-mail can also be used to make 
comments if desired. A set of instructions for this phase of the test, as well as the proposed format for 
the log sheets, will be sent to Keephills one week before the optimization testing begins. This phase of 
the acceptance test will last for three weeks during which every crew will have a chance to review and 
comment on the software. At the end of this period, Keephills will replace the data tape in the BANCS 
server and mail Praxis the old tape containing the data covering the test period. 
 
4. Praxis Update of BANCS Based on Optimization Test Results 
Following the three-week optimization testing period, Praxis will analyze and review the responses and 
correct any obvious bugs or errors in the optimization calculations. In particular, if the optimization is not 
producing believable results, the optimization program can be recalibrated or updated to improve its 
accuracy. Desired changes in software functionality or appearance can be discussed at this time. 
 
The updated version of BANCS will then be installed remotely onto the server machine at Keephills and 
new clients, if needed, will be sent to all users. This phase of the acceptance test will take approximately 
two weeks to complete, depending on how many changes need to be made to the software. 
 
5. On-line Optimization Testing 
During this phase of the acceptance test, operators will run BANCS optimizations every hour and use 
the recommended setpoints to operate the plant. The operators should use the recommended values 
faithfully, unless they feel that the plant will be put at risk or its performance unnecessarily degraded. 
Log sheets will again be provided for users to write down any instances of problems that occurred that 
were attributable to BANCS, or occasions when recommendations were not followed and the reason 
why. As before, the log sheets will be faxed daily to Praxis for review and analysis. This phase of the 
acceptance test will take place over a four-week period. 
 
6. Final Acceptance Report Based on On-line Optimization Testing Results 
After completion of the on-line optimization tests, a final acceptance report will be written documenting 
the experiences and benefits accrued while using BANCS over the entire test period. Heat rate 
calculations taken from both BANCS and the heat rate monitor can be used to estimate any gains in 
heat rate. The monthly coal inventory analysis can also be used to approximate any savings in coal used 
by the plant. 
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BANCS Simulation Testing Instructions 
 
The purpose of this document is to provide an outline for how the simulation testing should be 
performed on BANCS. The steps in the procedure are listed in order. 
 
1. Perform a simulation every hour during your shift. 
 
2. Before running a simulation, make sure that the data contained in the Manual Inputs folder is 

correct. In particular, make sure that the following values are correct: 
 

• PA Temp in the Setpoints window 
• Fan Air In Temp in the Setpoints window 
• Inside Air Temp, Pressure and Relative Humidity in the Inputs window 
• Outside Air Relative Humidity and Percentage in the Inputs window 
• Mill Fineness in the Inputs window (if a mill fineness test has been done recently) 
• Trisector Leakages in the Inputs window (if a leakage test has been done recently) 
• Boiler Blowdown On/Off Status in the On/Off Status window 

 
3. Look over the calculated data presented by BANCS for any errors or discrepancies. Use 

measured data or experience to judge the accuracy of the calculation. Some key data to observe 
include: 

 
• Data contained in the Performance folder especially the values for Heat Rate-Net Plant, Heat 

Rate-Net Turbine and Net and Auxiliary Power. 
• Data contained in the Economizer schematic especially the values for Bypass, Gas In Temp, and 

Gas Exit Temp. 
• Data contained in the Trisector schematic especially the values for PA Exit Temp, SA Exit 

Temp, and Gas Exit Temp. 
• Data contained in the Mill folder, especially Mill Air In Temp and Mill Coal Feed Rate. 
• Data contained in the Stack folder, especially Stack Opacity, Stack NOx, and Stack SO2. 
• Data contained in the Steam Cycle folder, especially Feedwater Temp and Total Feedwater 

Flow. 
 
4. Write down any comments on the log sheets concerning the accuracy of the calculated data 

presented by BANCS in comparison to measured data or experience and the appearance, ease of 
use and flexibility of the software. Enter your name and the date at the top of the sheet. In the table, 
enter the time you ran the simulation, whether you noticed in problems or errors with any data 
values (“Data OK?”), any comments you have on the data values, whether you noticed any 
problems or weaknesses in the software (“Software OK?”), and any comments you have on the 
software itself. 

 
5. Fax the log sheet to Praxis daily. 
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BANCS Simulation Log Sheet 
 

Operator Name:          Date:        
 
 

Time Data OK? Comment Software OK? Comment 
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BANCS Off-line Optimization Testing Instructions 
 
The purpose of this document is to provide an outline for how the off-line optimization testing should be 
performed on BANCS. The steps in the procedure are listed in order. 
 
Before taking part in the Off-line Optimization Testing, every operator and shift supervisor should go 
over the BANCS manual or use the on-line help to get up to speed on the functionality and usage of 
BANCS. If anyone is still unclear on how to use BANCS or has any questions concerning this part of 
the BANCS Acceptance Test Plan, feel free to contact Praxis by phone at (408) 934-3730 or by e-
mail (support@praxisengineers.com or andrew@praxisengineers.com). 
 
Note: Under no circumstances in this phase of the test, should operators use the setpoints 
recommended by BANCS. 
 
1. Perform an optimization every two hours  during your shift. The optimization will take approximately 

5 minutes to complete. The software will inform you when the optimization is finished. Before 
performing an optimization, make sure to perform a simulation. This will ensure that the 
simulation values contained in the software will be current when compared against the optimized 
values. 

 
2. Before running an optimization, make sure that the data contained in the Manual Inputs folder are 

correct. This will only need to be done once at the beginning of a shift. In particular, make 
sure that the following values are correct: 

 
• Inside Air Temp, Pressure and Relative Humidity in the Inputs window 
• Outside Air Relative Humidity and Percentage in the Inputs window 
• Mill Fineness in the Inputs window (if a mill fineness test has been done recently) 
• Trisector Leakages in the Inputs window (if a leakage test has been done recently) 
• Boiler Blowdown On/Off Status in the On/Off Status window 

 
3. In addition, before running an optimization, make sure that the min and max constraints for the 

Setpoints and Constrained Variables are valid. 
 
4. Look over the calculated optimized data presented by BANCS for any errors or discrepancies. 

Things to look for include: 
• If a value is not shown (indicated by N/A) or is outside the displayed min/max bounds (it will be 

highlighted in red). 
• If a value does not seem accurate based on either your own experience or corresponding 

measured values off the board. 
• If the look, feel or functionality of the software is not right in your opinion or if a software bug is 

found. Feel free to experiment with the software to make sure it is to your liking. 
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5. For every optimization, operators should check over the Setpoints window and the Costs table. For 
the Setpoints window, operators should use their knowledge and experience to assess whether the 
recommended setpoints are realistic and feasible and whether they feel the recommended setpoints 
make sense. In addition, operators should note if any recommended setpoint would produce unsafe 
operation of the Unit. For the Costs table, operators should check to make sure the optimized costs 
are lower than the current costs. Any comments on the recommended Setpoints or Costs should be 
entered on the log sheet. 
 

6. In addition, the operator should check over the results of the optimization in comparison to the 
current values. The operator should note if the optimized value is in error on its own and also if it is 
substantially different from the current value. To reduce the amount of time needed to check over 
the results of an optimization, a schedule has been devised for the part of the BANCS optimization 
that you are responsible for checking over during your shift and the day of the week. There are 7 
main data categories to check: 

  

 Data Categories 
1. Performance folder (especially Heat Rate-Net Plant, Heat Rate-Net Turbine and Net and 

Auxiliary Power) 
2. Fan schematic 
3. Economizer schematic (especially Bypass, Gas In Temp, and Gas Exit Temp 
4. Trisector schematic (especially PA Exit Temp and Gas Exit Temp) 
5. Mill folder (especially Mill Air In Temp and Mill Coal Feed Rate) 
6. Stack folder (especially Stack Opacity, Stack NOx, and Stack SO2) 
7. Steam Cycle folder (especially Feedwater Temp and Total Feedwater Flow) 
 
During your shift, you will be responsible for investigating only one of the above categories. The 
schedule for checking the above 7 categories of data is as follows: 

 
 Schedule 
 Monday, Day Shift:   Category 1 
 Monday, Night Shift:  Category 2 
 Tuesday, Day Shift:   Category 3 
 Tuesday, Night Shift:  Category 4 
 Wednesday, Day Shift:  Category 5 
 Wednesday, Night Shift: Category 6 
 Thursday, Day Shift:  Category 7 
 Thursday, Night Shift:  Category 1 
 Friday, Day Shift:   Category 2 
 Friday, Night Shift:   Category 3 
 Saturday, Day Shift:  Category 4 
 Saturday, Night Shift:  Category 5 
 Sunday, Day Shift:   Category 6 
 Sunday, Night Shift:  Category 7 
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7. Write down any comments on the log sheets concerning the accuracy of the calculated data 
presented by BANCS in comparison to measured data or experience and the appearance, ease of 
use and flexibility of the software. Enter your name and the date at the top of the sheet. In the table, 
enter the time you ran the optimization, whether you noticed any problems or errors in the Setpoints 
window or Costs table, whether you noticed in problems or errors with any optimized data values 
on their own or in comparison to current values (“Data OK?”), any comments you have on the 
optimized data values, whether you noticed any problems or weaknesses in the software (“Software 
OK?”), and any comments you have on the software itself. 

 
8. Fax the log sheet to Praxis daily. 



Praxis Engineers, Inc.  BANCS Acceptance Test Plan 
January 1998  Page 8 
 

 

BANCS Off-line Optimization Log Sheet 
 

Day Shift Operator Name:              Date:       
 

Night Shift Operator Name:            
 
Time Setpoints and Costs OK?  Data OK? Comment Software OK? Comment 

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

 


